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Licence agreement

Please read this agreement before using your copy of this NetSupport Software application. This is a
legal agreement between you and NetSupport Limited. If you do not wish to be bound by the terms of
this licence agreement you must not load, activate or use the software.

TERM: Subject to termination under Termination Clause below the licence shall be perpetual.

GRANT OF LICENSE: Subject to the payment of the applicable license fees, and subject to your
abidance by the terms and conditions of this agreement, NetSupport Ltd hereby grants to you a non-
exclusive, non-transferable right to use one copy of the specified version of the software which you
have acquired.

USE: The software is licensed with volume use terms specified in the applicable order
acknowledgement, product invoice, license certificate or product packaging. You may make, install
and use as many additional copies of the software on the number of devices as the terms specify. You
must have a reasonable mechanism in place to ensure that the number of devices on which the
software has been installed does not exceed the number of licenses you have obtained.

SERVER USE: To the extent that the applicable order acknowledgement, product invoice, product
packaging or license certificate sets forth, you may use the software on a device or on a Server within
a multi-user or networked environment ("Server Use"). A separate license is required for each device
or "seat" that may connect to the software at any time, regardless of whether such licensed devices or
seats are connected to the software concurrently, or are actually using the software at any particular
time. Your use of software or hardware that reduces the number of devices or seats that connect to
and use the software directly or simultaneously (e.g., "multiplexing" or "pooling" software or
hardware) does not reduce the nhumber of licenses required. Specifically, you must have that number
of licenses that would equal the number of distinct inputs to the multiplexing or pooling software or
hardware "front end"). If the number of devices or seats that can connect to the software can exceed
the number of licenses you have obtained, then you must have a reasonable mechanism in place to
ensure that your use of the software does not exceed the use limits specified for the license you have
obtained.

COPYRIGHT: This software is protected by international copyright laws. You may copy it only for
backup purposes. The software is licensed to you, but not sold to you.

RESTRICTIONS: Neither you nor any reseller may rent, lease, sell licensed copies [on approval], or
otherwise transfer the right to use this software to another person, except that you may sell or give
away your original copy, as long as you do not keep any copies. The software may not be modified,
disassembled or reverse engineered except with the prior written consent of NetSupport Ltd.

LIMITED WARRANTY: NetSupport Ltd warrants that the software will perform substantially in
accordance with the accompanying documentation for a period of ninety (90) days from the date of



NetSupport School 15.10

purchase. NetSupport's entire liability and your exclusive remedy shall be either a) the replacement of
the defective software or b) return of the price paid. This remedy shall be at NetSupport's option and
subject to proof of purchase from an authorised source.

Any implied warranties including any warranties of quality or fitness for a particular purpose are
limited to the terms of the express warranties. NetSupport Ltd. shall not in any event be liable for loss
of profits, data or information of any kind or for special, incidental, consequential, indirect or other
similar damages arising from any breach of these warranties or use of the software even if they have
been advised of the possibility of such damages. Some countries do not allow the limitation or
exclusion of incidental or consequential damages, so the above limitation or exclusion may not apply
to you. This warranty does not affect your statutory rights, and you may have other rights that vary
from country to country. In any event NetSupport's maximum liability shall not exceed the price paid
by the end-user / licensee.

TERMINATION: You may terminate this licence and this Agreement at any time by destroying the
program and its documentation, together with any copies in any form.

NetSupport Ltd. may terminate this licence forthwith by notice in writing to you if you commit any
serious breach of any term of this licence and (in the case of a breach capable of being remedied) shall
have failed within 30 days after receipt of a request in writing from NetSupport Ltd. so to do, to
remedy the breach (such request to contain a warning of NetSupport's intention to terminate). Upon
termination you will destroy or return to NetSupport Ltd the original and all copies of the software and
will confirm in writing to NetSupport Ltd that this has been done.

SUPPORT: If you have a problem with the installation of the software you should in the first instance
contact your supplier. You can separately purchase support and maintenance which will also cover the
supply of enhancements and upgrades.

GOVERNING LAW: This agreement shall be governed by the laws of England.
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What is NetSupport School for Windows?

NetSupport School is the market-leading classroom software solution for schools. Working across all
platforms, NetSupport School supports teachers with a wealth of dedicated assessment, monitoring,
collaboration and control features to ensure they can leverage the very best from their ICT equipment.

Rising to the challenge and requirements of the modern classroom, NetSupport School provides the
ability to organise and deliver lesson content, work collaboratively and monitor students' PCs,
ensuring that complete attention and focus is maintained at all times. There are no hidden extras: all
features are included as standard including dedicated Teacher, Classroom Assistant and Technicians'
modules.

NetSupport School is designed to work flawlessly over both wired and wireless networks with
desktops, laptops or tablets and for use in traditional PC, thin client or virtualised environments.

Tutor Assistant

A free component available from the Apple App store, the NetSupport Tutor Assistant delivers greater
mobility for teachers around the classroom and is also the ideal tool to allow teaching assistants to
help with monitoring student progress.

Once installed on an iOS device, the app pairs with the NetSupport School desktop Tutor software,
allowing teachers the freedom to move around the classroom, helping retain key control and
monitoring of all student machines/devices.

Tutor for Android

The NetSupport School Tutor for Android extends the product's capabilities into dedicated tablet-
based classrooms, giving the teacher the power to connect to each student device and enabling real-
time interaction and support.

Note: Student tablets must be running the NetSupport School Student app.

Student for Android and Browser for iOS

The NetSupport School Student for Android and Browser for iOS meets the challenges presented by
the increased use of mobile technology in the modern classroom. Enabling mobile learners to
participate in NetSupport School-managed lessons, once installed on students' Android tablets and
iOS devices, teachers can interact with and support students from the traditional desktop Tutor
application.

Student for Google Chrome

Utilise the power of NetSupport School in a Google Chromebook education environment. For use in an
existing or new NetSupport School-managed classroom, the NetSupport School Student for Google

11
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Chrome extension can be installed on each student Chromebook running Google ChromeQOS. From the
teacher's Windows desktop, you can then connect to each system, enabling you to monitor and
interact with each student quickly and efficiently.

Teacher App - Windows 10

Provided in addition to the desktop Teacher application for Windows, the native Teacher App is
designed for installation on Windows tablets and touch-enabled devices. In addition to all the expected
core classroom features, the Teacher app also gives particular focus to the integration of key Windows
10 and Office 365 educational services.

NetSupport School for Mac

For use within your Mac classroom, NetSupport School for Mac is a focused classroom management
software solution that ensures teachers have the tools they need to monitor, engage and collaborate
with their students.

Note: The NetSupport School Windows Tutor can connect to Mac Students if required.

12
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Conventions and terminology used

Conventions used

* Step-by-step instructions, which should be performed in sequence, are shown as numbered
paragraphs, beneath a clearly stated, 'To do' heading.

* As there is often more than one way of carrying out a task, you will find 'Or' options also
included.

« Additional tips or explanatory notes regarding these instructions appear as bulleted paragraphs
under the heading 'Note'.

Terminology used

Tutor/Control The '"Tutor' is the machine or device that shows to or
views/takes over the Student. This is sometimes called the
Control.

Student/Client The 'Student' is the machine or device that is being shown
to, viewed or taken over. This is sometimes called the
Client.

Available Student When a Student has been installed on a machine, it
becomes available for connection to a Tutor. A Student
must be available before a Tutor can connect to it.

Known Student Having browsed for available Students, NetSupport School
stores a list of Students in the Client.NSS file. These are
Known Students.

Connected Student All available Students or groups of Students can be chosen
for simultaneous connection. A Tutor can only interact
with a Student they are connected to.

Selected Student A Student or group of connected Students can be selected
by the Tutor. The Tutor can then perform a variety of
functions such as, View and Message etc. A Tutor can
switch between multiple Students, making each of them,
in turn, the selected Student.

13
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Planning an installation

Installing NetSupport School is exceptionally easy and you should be up and running within a very
short time.

Decide what functions to install

If you wish to manage the class as the teacher, you will need to install the Tutor (Control) on your
machine.

On every student machine you wish to connect to, you need to install the Student (Client).

To allow technicians to manage and maintain the school's network, as well as providing technical
support, you can install the Technicians' Console.

Note: The NetSupport School Tutor is configured to use TCP/IP.

Recommended method to connect to Students (Clients)

Room Mode is a quick and easy method to connect to the Students in a given room. A start-up wizard
will allow you to assign machines to a particular room, and, at the start of a lesson, the teacher simply
indicates which of the pre-defined rooms they wish to connect to. 'Roaming' Students also have the
option of connecting to a designated room.

The Room settings can also be configured at the Student in the NetSupport School Student
Configurator.

Other ways to connect the Tutor to the Students are via Browse mode, PC mode, User mode or SIS
mode.

You are now ready to install NetSupport School Tutor and Student programs.

14
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System requirements

Some areas of NetSupport School's functionality rely on the presence of certain files/applications;
please ensure these are available before installing NetSupport School.

General

Windows 7*, Windows 8/8.1, Windows 10 and Windows 11.

250MB free disk space for Student-only installation.

400MB free disk space for a Tutor-only installation.

400MB free disk space for an IT Technician-only installation.

600MB free disk space for full installation.

50MB free disk space for a NetSupport Connectivity Server-only installation.

* For the NetSupport School Tutor and Tech Console to run on Windows 7, Aero needs to be enabled.

Choose Start > Control Panel. In the Appearance and Personalization section, click Customize
Color. Choose Windows Aero from the Color Scheme menu and then click OK.

NetSupport School operates in Terminal Server, Thin/Zero Client, Virtual Desktop and shared-
resource computing environments and is supported on Google Chromebooks, iOS and Android tablets.

Tutor Assistant app supported on iOS devices running version 9 and higher.
Native Teacher app supported on Windows 10 devices.
Tutor for Android app supported on Android tablets running version 5.0 or later.

Student for Android app supported on Android tablets running version 12 or above.

Note: From version 15.10.0003 the NetSupport School Student for Android only supports Android
devices compatible with the latest CPU architecture - arm64-v8a ABI for 64-bit ARM processors. For
more information, see NetSupport School Student for Android - change to CPU architecture support
from version 15.10.0003.

NetSupport Browser app (iOS) supported on iOS devices running version 14 or later.

Mac support also available with NetSupport School for Mac.

The NetSupport School Tutor requires a screen resolution of 1024 x 768 or above.

Synchronised Multimedia Player for WAV, MOV, AVI, MPG, etc. files.

15
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NetSupport Connectivity Server

Windows 7 and above or Windows Server 2008r2 and above.

Touch-enabled support
NetSupport School Tutor running Windows 7 and above.

NetSupport School Student running Windows 8/8.1 and above.

Testing Module

The Test Designer requires MDAC 2.1 or higher and COMCTL32.dll version 5.80 or higher. During
installation, NetSupport School will check to see if these files are present and advise if not. However, if
installing 'silently' using the NetSupport School Deploy utility, you will not be warned if the files are
missing.

Note: To enable printer notifications to be sent to the Tutor PC, the installer applies the following
changes to the Student PCs:

Windows Firewall

On installation, Windows Firewall entries are automatically added to allow the product to be used for
the active network. If you change to another network, you may need to extend the scope of the
Windows firewall entries to allow connections to continue to be allowed through the Windows firewall.

Local Security Policy settings

On workgroup-connected PCs, the following local policy settings are set:

Network Access: Allow anonymous SID/Name translation ENABLED
Network Access: Do not allow anonymous enum of SAM accounts DISABLED
Network Access: Do not allow anonymous enum of SAM accounts & shares DISABLED
Network Access: Let "everyone" permissions apply to anonymous users ENABLED
Network Access: Restrict anonymous access to Named Pipes and Shares DISABLED

16
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Starting the installation

Download your copy of NetSupport School from www.netsupportschool.com/downloads.asp.

Click the appropriate language from the menu and select the option to install NetSupport School.
Select which installer to use: setup.exe or MSI file (Active Directory deployments only).
If an Active Directory deployment is required, you will need to install using the MSI file.

Note: For further information on installing via Active Directory, please visit our Knowledge Base and
refer to product article: Installing NetSupport Manager or NetSupport School via Active Directory

Group Policy.

The NetSupport School installation will start displaying a Welcome screen.
i_%‘ NetSupport School - InstallShield Wizard x

Welcome to the InstallShield Wizard for
NetSupport School

q" NetSupEssrt

Schoo

The InstallShield(R) Wizard will install NetSupport Schoaol on
your computer. To continue, dick MNext.

WARNING: This program is protected by copyright law and
international treaties,

Help < Back Cancel

Click Next to continue.

Notes:

» If you are upgrading your Windows operating system, you must ensure that you uninstall
NetSupport School prior to upgrading. NetSupport School can then be re-installed once the
operating system upgrade has been completed.

 When installing, make sure that you are logged in as an administrator.

* When installing NetSupport School on Windows 7, Windows 2008 Server R2, Windows 8 and
Windows 2012 Server the Filter Driver may not be installed if you do not have the required
Service Pack and hotfixes. You can still proceed with the NetSupport School installation without
the Filter Driver, but some internet control features will be unavailable. For further information,
please contact our Support team.

17
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NetSupport School Installer program

Licence Agreement

15 NetSupport School - InstallShield Wizard *
License Agreement s L

) i NetSupgsst

Please read the following license agreement carefully. | SCHEJO

Please read this agreement before using your copy of NetSupport ~
Software. This is a legal agreement between you and NetSupport
Ltd. If you do not wish to be bound by the terms of this licence
agreement you must not load, activate or use the software.

TERM: Subject to termination under Termination Clause below
the licence shall be perpetual.

GRANT OF LICENSE: Subject to the payment of the applicable .,
(®) I accept the terms in the license agreement Print
()1 do not accept the terms in the license agreement

InstallShield

The NetSupport Licence Agreement is displayed. Please read the Licence Agreement carefully and
select 'l accept the terms in the Licence Agreement' and click Next to continue.

If you reject the Licence Agreement, ('I do not accept the terms in the Licence Agreement') click
Cancel. NetSupport School is not installed and you are directed to exit from the install program.

Licence Information

ﬁ MetSupport Scheol - InstallShield Wizard *
License Information [tz
s &
If you have a license, please enter the details here. q%‘f NEf‘-: u D D?\\rf
CapltalS and spaces are important. L J Schoo
30 day evaluation ~ | | Al platforms w

Use <Ctrl= V to paste License details

Licensee Mame: |

Serial Mumber: |

Maximum Clients: |

Expiry Date: |

Authorisation Code: |

InstallShield
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Select Register and enter the NetSupport School licence details you have been provided with. If you
are evaluating NetSupport School, select 30 day evaluation.

Choose what type of licence you wish to use:

All Platforms: Your Students are all Windows-based or using a mixture of Windows, macOS,
ChromeOS, Android and iOS.

Non Windows: Your Students are all using non-Windows devices (macOS, ChromeQOS, Android or
i0S).

Click Next.

19
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Select setup type

Choose the setup type to install on the machine.

]ﬁ MetSupport School - InstallShield Wizard X
Setup Type ¢ 3
el =

Choose the setup type that best suits your needs. | N Ffr: u D D-\f'“\\'rf

School
This computer is used by:

() Student

Select this option to install the Student software

Select this option to install the Tutor software

() IT Technician
@ Select this option to install the Technidian console and admin tools

(®) Custom
@ Select this option to install a combination of the above

InstallShield

Student

Installs the Student software. This feature (the Client) should be installed on machines/devices that
will be remote controlled.

Tutor

Installs the Tutor software. This feature (the Control) should be installed on machines/devices which
will be used to remote control other PCs.

Note: When installing the Tutor, additional NetSupport School components are also installed by
default, including the 'Test Designer', allowing you to design and playback customised tests at
Student PCs; the Remote Deployment utility; and Replay File Conversion utility. To install a preferred
combination of tools, choose Custom Setup.

IT Technician

Installs the Tech Console. This feature should be installed on machines that will be managing and
maintaining computers.

Custom

Allows you to pick and choose which features to install on the machine.

Click Next. If you have selected Custom setup, the Custom Setup screen will be displayed.

20
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Custom setup

Select the component(s) to install on the machine.

bic
Custom Setup q;-"_-:: o
Select the program features you wantinstalled. Eﬁl N Frr: U ECES"\S}rr
Student
Install Configurator
Add Configurator Start Menu shortout
Tutor Console
Add desktop shortcut for Tutor Console
Remote Deployment Utility
[ Tech Console (indudes Remote Deployment)
Add desktop shortcut for Tech Conscle
Name and Connectivity Server
Replay Conversion Utility
Design and playback tests
Install to:
C:\Program Files (x88) \NetSupport\NetSupport Schoaly Change...
InstallShield
Help < Back Cancel

Student

Install this component (the Client) on machines/devices that will be remote controlled. By installing
this component, you are enabling a Tutor machine to establish a link with the Student. The range of
features available to students is limited to those that enable them to communicate with the teacher:
for example, sending a help request.

Install Configurator: The NetSupport School Student Configurator is used to customise the Student
setup at each machine. For example, setting the transport to be used, allocating a Student name and
setting security.

When you choose the Student component, you will also be given the option of installing the Student
Configurator.

Clear this checkbox if you do not want to install the component; you can still configure the Student
machine by running the Student Configurator at a later stage of this installation.

Note: If you are installing the Tutor component, the Student Configurator will be installed by default.
Add Configurator Start menu Shortcut: Choose whether to create a Start Menu shortcut to the
Student Configurator at the Student machine. The advantage of installing this at the Student machine

is that it is easier to make changes to the settings in the future. The disadvantage is that the Students
themselves could access the option and make changes.
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Tutor Console

This component (the Control) should be installed on machines which will be used to remote control
other PCs. It gives teachers access to NetSupport School's full range of features: for example, viewing
student screens and showing their screen to students.

Selecting this component will also install a Portable Tutor folder. This allows you to run the Tutor from
a portable device such as USB Pen Drive, Memory Stick or Flash Drive.

For further information, please visit our Knowledge Base and refer to product article: Running the
NetSupport School Tutor from a portable device.

Note: If you need the flexibility of allowing other machines to view this one, you can also install the
Student component.

Add Desktop Shortcut for Tutor: Choose whether to create a desktop icon for the Control (Tutor)
to enable easy access to the Tutor program.

Remote Deployment Utility: The Remote Deploy Utility enables you to perform multiple NetSupport
School installations without the need to visit each individual machine.

Tech Console (includes Remote Deployment Utility)

This component should be installed on machines that will be managing and maintaining computers. It
provides network managers with the main NetSupport School features.

Selecting this component will also install a Portable Tech Console folder. This allows you to run the
Tech Console from a portable device such as USB Pen Drive, Memory Stick or Flash Drive.

Add Desktop Shortcut for the Tech Console: Choose whether to create a desktop icon to enable
easy access to the Tech Console program.

Name and Connectivity Server

This provides a simple and reliable method of locating and connecting to Student PCs.

Note:

e The NetSupport Connectivity Server is only supported on Windows 7 and above or Windows
Server 2008r2 and above.

* The NetSupport Connectivity Server can't be installed on a machine that has the NetSupport
DNA Local (Server) Gateway installed on it.

Replay Conversion Utility

This utility allows you to convert replay files to video files.
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Note: This will be installed by default if you are installing the Tutor or Tech Console component.

Design and Playback Tests

Installs the NetSupport School "Test Designer' component allowing you to create and run customised
tests, exams and quizzes including text, picture, audio and video questions.

Install to:

By default, NetSupport School will be installed in the folder C:\Program Files\NetSupport\NetSupport
School. If you want to install in a different folder, click Change.

Click Next.
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Room identification

Enter the value for the room you wish to connect to. The default room value is Eval. The room value
can be updated later in the Tutor Configuration settings.

ﬁ MetSuppert School - Installshield Wizard x
Room Identification -'\?4
q;i\: NetSuposgst
Please enter the name of your room 1 SChéO

By Default the Tutor program will only find Student PCs configured to use the matching Room
value that you enter here. This can be updated later to allow connections across multiple
rooms as well as for use in environments where you do not wish to group student computers

by room

Room: |ICT Room 2|

InstallShield

Click Next to continue.
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Completing the installation

Ready to install the program

To start the installation, click Install. To change any of the previous selections, click Back. To quit the
installation, click Cancel.

Note: If you have elected to install a Client (Student), the Setup program will make the required
amendments to your System.INI and/or registry, to load the Student as Windows initialises.
NetSupport School will not replace any of your existing Drivers.

Installation complete

To complete the installation:

* Choose whether to run the Client Configurator. This enables you to set basic Student
information and security.

* Choose whether to run the Remote Deploy utility. This provides you with the facility to install
and configure NetSupport School on multiple machines.

Click Finish to exit the Setup program.
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Existing installation detected

This screen will appear if a copy of NetSupport School is already installed on the machine.

ﬁ] NetSupport School - InstallShield Wizard X

Program Maintenance |t .
i NetSuppsst

Modify, repair, or remove the program. Ul
= Schoo

® Modify
@ Change which program features are installed. This option displays the

Custom Selection dialog in which you can change the way features are
installed.

O Repair

Repair installation errors in the program. This option fixes missing or
corrupt files, shortouts, and registry entries.

O Remove
@ Remove NetSupport School from your computer.
-

Installshield

= ==

You can choose to:

Modify

Change the program features that are installed.

Repair

Repair any installation errors in the program.

Remove

Remove NetSupport School from the computer.

Select the required option and click Next.
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Creating an administrative (network) installation

An administrative installation (distribution copy) of NetSupport School is designed to assist
administrators to install NetSupport School on networked PCs where the installation media or licence
details may not be readily available and it is anticipated that a number of installs will be performed
either at once or over a period of time.

This type of installation can also be pre-configured to setup NetSupport School with certain options,
therefore ensuring that all NetSupport School installations are configured the same.

Once created, the distribution copy can be used when performing a standard installation, a silent
installation or as part of a remote deployment.

To set up a distribution copy of NetSupport School on a Server
1. Create a folder on the network that is accessible to all PCs that you may want to install on.
2. Copy, from your original source media, the file SETUP.EXE.

3. Create and copy a valid NSM.LIC file to this folder. If a licence file is not present in the folder
when running the install, NetSupport School will be installed using the default evaluation
licence.

4. Create and copy a CLIENT32U.INI file to this folder.

Note: You can make the network folder 'read-only' to avoid the configuration being altered by
unauthorised users.

To install NetSupport School from a Server onto individual workstations

1. Atthe required machine, navigate to the network folder containing the NetSupport School setup
files.

2. Run Setup.exe.

3. Follow instructions in Starting the Installation.
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Silent installation

A silent installation is one which requires no input from the user, providing a convenient method for
performing a set installation at several machines.

To perform a silent install

1.

Create a distribution copy of NetSupport School containing the required NetSupport School
installation files, NSS.ini and NSM.lic (the NSM.lic is not required if you are evaluating).

To determine the properties for the installation, at the command line run INSTCFG.EXE /S from
the NetSupport School program folder. The Install Configuration Options dialog will appear. The
selected properties are stored in a parameter file, NSS.ini.

Choose {File}{Save} and save the 'NSS.ini' file to the folder containing the distribution copy of
NetSupport School.

To perform the silent install at the required machine, from the folder containing the distribution
copy, run:

msiexec /i "NetSupport School.msi" /gn (MSI installer)

setup /S /v/gn (setup.exe installer)

Note: NetSupport School can be installed via Active Directory. The software installation Group Policy
Object (GPO) must be applied to organisational units (OUs) containing computer accounts rather than
users. Please note that for software installation to take effect immediately, it is necessary to enable
the, "Always wait for the network at computer start-up and logon" parameter in the Computer
Configuration| Administrative Templates| System| Logon| leaf of the Group Policy controlling the
computers that are subject to software installation. Without this change, an additional log off/log on
cycle is required to effect installation.
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Install Configuration options

When performing a silent installation or using NetSupport School Deploy, you can customise the
installation to suit individual requirements. This dialog, accessed by running INSTCFG.EXE /S from the
NetSupport School program folder if performing a silent installation or, if using NetSupport School
Deploy, via the Install Properties General tab, enables you to specify the variables for the installation.
The information is stored in a parameter file: default name NSS.ini.

Install Configuration Options -[Untitled] *
File Help

[ Student

™ Tech Console fincludes Remote Deployment)
|

™ Name and Connectivity Server

I” Replay Conversion Lkility

™ Design and playback tests

Install Directary |
Leave blank for default

QK Cancel Help

Icons
Select the relevant checkboxes to indicate which NetSupport School components will be installed on
the Student machines.

General
Install Folder: Specify the directory where NetSupport School will be installed. Leave blank to install
in the default directory C:\Program Files\NetSupport\NetSupport School.
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NetSupport School Deploy - Getting started

Installing the Deploy utility

When installing NetSupport School, you decide which combination of components to include. To install
NetSupport School Deploy, select the Remote Deployment Utility along with any other components
you require.

NetSupport School Deploy is currently supported on the following operating systems:

*  Windows Server 2008r2
e Windows 7

« Windows 8/8.1

¢ Windows Server 2012

*  Windows 10

e Windows Server 2016

e Windows Server 2019

¢  Windows 11

e Windows Server 2022

Planning

NetSupport School Deploy is a powerful utility that makes installing NetSupport School packages on
multiple machines a quick and easy process. However, while we endeavour to ensure that there are no
limitations or incompatibility issues in the use of the software, it is recommended that a trial deploy is
performed on a small number of machines to ensure there are no conflicts with other similar products
such as remote control or desktop security packages. In addition, for added security and protection,
you must have appropriate administrator rights for the machines you are deploying to.

Starting NetSupport School Deploy
1. Select NetSupport School Deploy from your NetSupport School Program Group.

2. The NetSupport School Deploy main window will appear.

How does NetSupport School Deploy work?

Once the Deploy options have been configured, the NetSupport School Deploy utility works by
connecting to the target computer using File and Print Sharing.

This method requires access to the target computer's Admin$ and will need to connect as a user with
local administrator access (user details may be requested).
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Once authenticated, the NetSupport School package files are copied to the following folder on the
remote PC using the connection to the Admin$ share:

C:\Windows\pcirdist.tmp\

Finally, once the files have been sent to the target PC, the installer file is executed using the Remote
Procedure Calls (RPC) Service.

What are the requirements?

In order to successfully deploy NetSupport School components to your target PCs, the following items
are required:

File and Print Sharing must be enabled on the target PC.
* The Sharing and Security for local accounts policy must be set to {Classic} on the target PC.

* The user account used to connect to the target PC must have local administrator permissions on
the target PC.

* Network discovery must be enabled.

« UAC Remote Restrictions must be disabled for target PCs in a workgroup environment.

31



NetSupport School 15.10

About NetSupport School Deploy

The NetSupport School Deploy utility provides network administrators with the facility to install and
configure NetSupport School on multiple machines without the need to visit the machines individually.

Within the NetSupport School Deploy utility, you have the ability to deploy using an IP address range
(specified IP ranges or computers with an IP range local to the Tutor machine), Windows Domains or,
alternatively, you are provided with a view of your network. These methods allow you to pick and
choose which machines you want to deploy to.

Note: NetSupport School can also be deployed using Microsoft Intune. For further information, please
visit our Knowledge Base and refer to product article: Deploying NetSupport School via Microsoft
Intune.

[E] NetSupport School Deploy m] =
File View Tools Deploy Help
2 Network ‘ B LogFIIDs| 4~ Security s = D I;l = g — |;| I;I :I_ I:_] .
(J'Local Ip Ranges Name Name Name Name Name Name Name Name Name Name Name
v E‘T:pﬂp Range Networking U ilabl... Ul ilabl... U ilab u ilabl.. U ilabl.. Unavailabl.. U ilabl... Lk ilabl... U ilabl.. U ilabl.. Unavailabl
57 10.20.10.00 - 10.20.10.100
3 104100- 10410255 B O 8 000005 8 =
! Windows Domains Name Name Name Name Name Name Name Name Name Name Name
) Windows Networking Unavailable ... Unavailable .. Unavailable .. Unavailable .. Unavailable .. Unavailable .. Unavailable .. Unavailable .. Unavailable .. Unavailabl.. Unavailabl...
Name Name Name Name Name Name Name Name Name Name Name
Unavailable ... U lable... Ui ilable ... U ilable ... Unavailable ... Unavailable .. U lable ... Lk ilable ... U lable ... Unavailable ... Unavailable ...
Name Narme Name Name Name Narme Name Mame MName Name Name
Unavailable ... U U lable ... Ui ilabl J kbl Ur ilable ... U lable ... Lk ilable ... Uk ilable ... Unavailable ... Unavailable
Name Mame MName MName MName Mame Name Mame Name Name Name
Unavailable ... Unavailable .. Unavailable ... Unavailable .. Unavailable ... Unavailable .. Unavailabl... Unavailable ... Unavailable ... Unavailable ... Unavailable ..
Name Name Name MName MName Name Name Mame MName Name MName
Unavailable ... Ui lable .. Unavailable ... U ilable ... U ilable... Unavailable ... U lable ... Unavailable ... Uk ilable ... Unavailable ... Unavailable ..
Name Mame Name Name Name Mame Name Mame MName MName Name
Unavailal . L i . ilable ... L i lable ... Unavail . U lable ... L i - L i . Unavaila . U
[ — —/ — — [ — (| — (| — [ — (— e
NetSupport Deploy (Objects Discovered 101) Current Dataset Size 101 .\Tcp/Ip Range Networking'10.41.0.0 - 10.41.0.255

With NetSupport School Deploy, you can:

* Remotely install a NetSupport School package on multiple machines simultaneously.

* Create and download specific Client configurations to multiple machines.

« Remotely update NetSupport School licence details on multiple machines.

* Remotely uninstall a NetSupport School package from multiple machines simultaneously.

* Enter the settings in advance and deploy when it is convenient.

Note: When deploying to a PC within a domain, the console user must be either logged onto the
domain or enter the user credentials (when prompted) of a domain account that has local
administrator rights to the target PC.
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Log Files

When using NetSupport School Deploy, information about each deployment, whether a package
install, licence update, configuration download or uninstall, is recorded. This provides a useful
reminder each time you use the utility of what you have previously deployed. The information is stored
in a Log File.
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Deploy Main window

[l NetSupport School Deploy [m] X
File View Tools Deploy Help
5 v | @ i | 2 sy O 0O @2 B 0B OB @B O O:;
> (3 Local Ip Ranges Name Name Name Name Name Name Name Name Name Name Narne
~ (0 Tep/Ip Range Networking Unavailabl.. Unavailabl.. Unavai . Unavai Unavailabl.. Unavailabl.. Unavailabl.. Unavailabl.. Unavai L . i .
& 10.20.10.00 - 10.20.10.100
& 104100- 10410255 B U 8 0 0O 0O 00 8 8 O
> () Windows Domains Name Name Name Name Name Name Name Name Name Name Name
(] Windews Networking Unavailable .. Unavailable ... Unavailable .. Unavailable ... Unavailable .. Unavailable .. Unavailable .. Unavailable .. Unavailable .. Unavailabl..  Unavailabl..
Mame Name Mame Name MName Name Mame Mame MName Name MName
Unavailable .. Unavailable... U lable .. Unavailable ... Unavailable ... Unavailable ... Ui lable .. Unavailable .. Unavailable ... Unavailable ... Ui lable ...
Name Name Name Name Name Name Name Name MName Name Name
Unavailable ... Unavailable ... Unavailable ... U ilable ... Ui ilable ... Ui ilable _. Ul ilable _ 1 ilable _ U ilable . U ilable U .
Name Name Name Name Name Name Name Name Name Name Name
Unavailable ... U lable ... U lable ... U ilable ... Unavailable ... Unavailable .. Unavailabl.. Unavailable ... Unavailable ... Unavailable ... Unavailable ...
Name Name Name Name Name Name Name Name Name Name Name
Unavailable ... | lable .. Unavailable .. Unavailable .. Unavailable.. Unavailable ... Unavailable . Unavailable .. Unavailable ... Unavailable ... Ui lable ...
Name Name Mame Name Name Name Name Name Name Name Name
Unavailable ... Unavailable ... Unavailable ... U lable ... Ui ilable ... Ur ilable ... Us ilable .. Uy ilable ... L ilable... Ur ilable ... U ilabls
[ | =1 (—| ==l 1 = | m— (— | | o | | f==x1 ot
NetSupport Deploy (Objects Discovered 101) Current Dataset Size 101 .\Tcp/Ip Range Networking\10.41.0.0 - 10.41.0.255

The Deploy main window is divided into the following sections:

Menu bar

The menu bar contains a series of drop-down menus that can be used to access the various tools and
configuration utilities for the deploy process.

Left-hand pane

Contains three tabs: Network, Log Files and Security.

Network and Security tabs: List, in a Tree view, the available networks, domains and workgroups
that can be selected for a deploy routine.

Log Files tab: Lists, in a Tree view, a history of previous deployments.

Right-hand pane

With the Network tab selected, you are provided with a range of general information about the
machines located on the selected network/domain (machine name, Client address, Mac address,
NetSupport School Client version and platform).

The Log Files tab provides a breakdown of past deployments categorised by type.

The Security tab also lists information specific to each individual machine located on the chosen
network/domain. In addition to the machine name, IP address, Client version and platform, you will be
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able to see whether the Client is password protected or has user acknowledgement set. With this
information to hand, you can decide in advance which machines to include or exclude from the
forthcoming deployment. For example, if a current NetSupport School Student is already installed at
some of the machines, you might choose to ignhore it.
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Deploy - preparing a deployment

Choosing who to deploy to:

1. From the Deploy window, select the Network or Security tab.

NetSupport School Deploy [m] >
File View Tools Deploy Help

9w | ) og s | 2 secury O 0O 8 8 0O 8 08 8 0O O4deg

(' Local Ip Ranges Name Name Marme Name Name Name Name MName Name Name Name
hd Ij‘l'zpflp Range Networking Unavailabl.. Unavailabl... Unavailable.. Unavailabl.. Unavailabl. Unavailabl.. Unavailabl.. Unavailabl. Unavailabl.. Unavailabl.. Unavailable ...
2710.20.10.00 - 10.20.10.100
& 104100- 10410255 O 8 OO 000 & 8 &
y D‘Wf"dws Domains Name Name Mame Name Name Name Name Name Name Name Name
(£ Windows Networking Unavailable ... ble .. Unavailable .. Unavailable .. Unavailable ... Unavailable ... lable .. L lable .. U ble .. Unavailabl.. Unavailabl...
Name Name Name Name Name Name Name Name Name Name Name
Unavailable ... Unavailable... Unavailable .. Unavailable ... Unavailable ... Unavailable ... Unavailable .. Unavailable .. Unavailable .. Unavailable ... Unavailable ..
Name Name Mame Name Name Name Name Mame MName Name Name
Unavailal 1 - U lable ... .. Unavai .. Ui lable ... L - U e U lal - |
Name Name Name Name Name Name Name Name Name Name Name
Unavailable ... . Unavailable .. Unavailable ... Unavailable ... Unavailable .. Unavailabl.. Unavailable .. Unavailable ... Unavailable .. Unavailable ...

=

O B B O O OO0 a0 O

[t

Name Name Name Name Name Name Name Name Name Name Name
Unavailable .. U lable ... Us lable ... Uk ilable U ilable... Unavailable ... U lable . Ur ilable ... U ilable ... Unavailable ... Unavailable
Name Name MName Name Name Name Name MName Name Name Name
Unavailable ... | i - U lable .. L i U . Unavail U lable .. L r 1 . Unavailable ... | ;
[ — (o | / [ [— / [ mr [ | [ — (— v
MetSuppart Deploy (Objects Discovered 101) Current Dataset Size 101 .\Tcp/Ip Range Networking\10.41.0.0 - 10.41.0.255

2. Alist of available networks, domains and workgroups will appear in the left-hand pane. Expand
or reduce the Tree list by clicking on the arrows.

Note: You can also deploy to specific IP ranges by adding the appropriate address range to the
Tree. Select {Tools}{Add IP Range} from the menu bar.

3. Highlight the required group in the Tree view.

4. The names of the machines belonging to the selected group will appear in the right-hand pane.
Click between the Network and Security tabs to view specific information about each machine.
You can change the appearance of the list view by selecting {View} from the menu bar.

5. Select the machines to include in the deploy routine. (You can use CTRL-Click or SHIFT-Click).
Before deciding to include or exclude a machine, you can view its properties by right clicking on
the machine name.
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Deploy a NetSupport School package

Deploy a package
1. Select the required machines.

2. Choose {Deploy}{NetSupport School Package} from the Deploy main window drop-down
menu.

Or

Right-click on the selected machines and choose Deploy - NetSupport School Package.

3. The Deploy summary dialog appears.

Deploy Summary X

This is a summary of the options you have selected. Check the details and
click Deploy to start. You can change the properties of the deploy by
clicking Properties

Type o) Deploy
NetSupport School Package

. Cancel
Description
NetS rt Scheol

eiSUpport Schao Properties

Deploy License Details
Licensed to EVAL for 40 Clients Help

Deploy Setup Files
C:\Prcgram Files (x86)\NetSuppecrt\NetSupport Schecl\Deploy

Product Version

Parameter File

[N

This dialog provides a summary of the options you have selected for the deployment. If a first-
time deployment, the text will appear in red to indicate that the required information has not
been entered. To enter or amend the information for the deployment, click Properties.

4. The Install Properties dialog appears.
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[E] NetSupport School Install Properties ? X

General Options Acknowledgement Message Restart

Descripticn
NetSupport School

Click Browse to specify the NetSupport School
installation source folder

C:\Program Files (x86)\NetSupport\NetSupport Sche Browse

NetSupport School Version : V15.10.0000

Install Parameters File

INSS ini Edit

Enter the properties for the deployment by selecting the five tabs in turn.
General tab

Options tab

Acknowledgement tab

Message tab

Restart tab

5. When you have completed all five tabs, click OK to return to the Deploy summary dialog. You
can review your selections and edit if required.

6. Click Deploy to commence the installation. A progress dialog appears, enabling you to monitor
the deployment as it installs on each machine. The dialog has two tabs:

Log tab: Enables you to monitor the deployment as it reaches each machine.

Status tab: Lists the stage the deployment has reached on each machine. For example, the
installation may be complete on one machine but still in progress on another.

7. Click Close to return to the Deploy main window when the installation is complete.

Note: If you close while the deployment is in progress, the installation continues but the log is not
updated.
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Deploy package - Properties General tab

[&] NetSupport School Install Properties ? X

General Options Acknowledgement Message Restart

Description
NetSupport Schooll

Click Browse to specify the NetSupport School
installation source folder

C:\Program Files (x86)\NetSupport\NetSupport Sche Browse

NetSupport School Version : V15.10.0000

Install Parameters File
NSS.ini Edit

Used to specify the NetSupport School package to deploy and which components are to be installed.

+ Enter a description for the package being deployed. If left blank, the package name/version
number will be used.

* Click Browse and select the folder containing the NetSupport School package to install. Ideally,
this will be a folder containing a distribution copy of NetSupport School.

* Click Edit to specify the components to install. The Install Configuration options dialog will
appear.

Choose {File}{Exit} to return to the Install Properties dialog.
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Deploy package - Properties Options tab

[E] NetSupport School Install Properties ? X
General Options Acknowledgement Message Restart
NetSupport School Options

[[] Skip machines already running NetSupport School
[[] Update new or older systems to current version

[ verify Client running after restarting

Use the information supplied in the Network and Security tabs to identify which machines may already
have NetSupport School installed, you can then choose to:
« Ignore them by selecting Skip machines already running NetSupport School.

* Update the machines with the latest version by selecting Update new or older systems to
current version.

* After deploying the package, you can confirm that the Student is running by selecting Verify

Client running after restarting. Ensure that machines are restarted automatically after the
deploy for this option to work.
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Deploy package - Properties Acknowledgement tab

[E] NetSupport School Install Properties ? X
General Options Acknowledgement Message Restart

Options
(®) Install NetSupport School immediately

(C) Warn user before installing NetSupport School

() User can postpone NetSupport School installation

S

Consider whether the machines will be in use when commencing the deploy. You can choose to:

Install NetSupport School Immediately

No prompt will be received at the machines being deployed to.

Warn user before installing NetSupport School

The user will receive a prompt and needs to click OK for the install to commence. Users cannot cancel
this.

User can postpone NetSupport School installation

You can specify the number of times a user can postpone the installation. If the user does choose to
postpone, they will be re-prompted at hourly intervals or the next time they restart the machine
whichever comes earlier.
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Deploy package - Properties Message tab

[E] NetSupport School Install Properties ? X

General Options Acknowledgement Message Restart

Options

Title: NetSupport School

Message:

You can specify a custom message to be displayed at each machine while the installation is in
progress.
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Deploy package - Properties Restart tab

[E] NetSupport School Install Properties ? X

General Options Acknowledgement Message Restart

Only if required to complete the installation
Options

() Advise user to restart machine

(7) Insist user restarts machine

(C) Force restart

[] Automatic restart if not logged in

Only if required to complete the installation

The options below are only applicable if the target PCs require a forced restart to complete the
installation.

Note: If you have asked for verification that the Student is running, you must choose an option that
will force the machines to be restarted immediately.

Options
Advise user to restart machine: At the completion of the deployment, a message will be displayed

at machines asking the user to restart the PC at the next convenient opportunity. Do not choose if the
above note applies.

Insist user restarts machine: A message will be displayed at machines advising the user to restart
the PC to complete the installation.

Force restart: At the end of the deployment, a message is displayed advising users that the machine
will be restarted. A time bar is displayed indicating how many seconds it is before the restart

commences.

Automatic restart if not logged on: If the machine being deployed to is not logged on, a restart
will commence automatically.
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Deploy a Client Configuration

Using NetSupport School Deploy, you can remotely deploy a Client Configuration file containing
specific Client settings.

Deploy a Client Configuration

1.

2.

Select the required machines.

Choose {Deploy}{Client Configuration} from the Deploy main window drop-down menu.
Or

Right click on the selected machines and choose Deploy - Client Configuration.

The Deploy summary dialog appears.

Deploy Summary X

This is a summary of the options you have selected. Check the details and
click Deploy to start. You can change the properties of the deploy by
clicking Properties

Type A

4 . Deploy
Client Configuration
Description Sance
Client Configuration -
Deploy License Details
Licensed to EVAL for 40 Clients Help

Configuration File
C:\Program Files (x86)\NetSupport\NetSupport School
\client32u.ini >>

New settings will take effect next time the
machine restarts

Click Properties to enter the details for the deployment.

Click Browse to specify the folder containing the Client Configuration file that is to be deployed.
The default Configuration file is CLIENT32U.INI and is stored in the NetSupport School
installation directory.

Note: The default configuration file for Students pre-v12.50 is CLIENT32.INI.

Click Edit to access the Client Configurator in order to make changes to the Configuration file.

You can specify additional Client parameters if required. For example, this may be the location of
an additional Configuration file to which you want to add specific user credentials (name and
password).

For the new settings to take effect immediately, the Client Service will be automatically
restarted after the deployment. If a restart is not required, uncheck the Restart the Client
service option.

Click OK to return to the Summary dialog. You can view the contents of the Configuration file by
clicking on the file name.
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10. Click Deploy. A progress dialog appears, enabling you to monitor the status of the deployment.

11. Click Close when complete.

45



NetSupport School 15.10

Deploy licence file

When installing a NetSupport School package, a licence file is sent to each machine. However, there
may be occasions when the licence information needs updating. For example, you have purchased
additional licences and the licence file needs updating to reflect this. By using NetSupport School
Deploy you can remotely update the file on user machines.

Deploy a licence file

1.

2.

Select the required machines.

Choose {Deploy}{NetSupport School Licence file} from the Deploy main window drop-down
menu.

Or
Right-click on the selected machines and choose Deploy - NetSupport School Licence file.

The Deploy summary dialog appears.

Deploy Summary X

This is a summary of the options you have selected. Check the details and
click Deploy to start. You can change the properties of the deploy by
clicking Properties

Type ~

. . Deploy
NetSupport School License File
- Cancel
Description
NetSupport School License File -
Deploy License Details
Licensed to EVAL for 40 Clients Help

License File

C:\Program Files (x86)\NetSupport\NetSupport School
\NSM.LIC >>

New settings will take effect next time the
machine restarts

Click Properties to enter the details for the deployment.

Click Browse to specify the folder containing the licence file that is to be deployed. The default
file is NSM.LIC.

For the new settings to take effect immediately, the Client Service will be automatically
restarted after the deployment. If not required, uncheck the Restart the Client service
option.

Click OK to return to the Summary dialog. You can view the contents of the licence file by
clicking on the file name.

Click Deploy. A progress dialog will appear, enabling you to monitor the status of the
deployment.

Click Close when complete.
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Deploy - remote uninstall

Using NetSupport School Deploy, you can remotely uninstall a NetSupport School package.

Remotely unistalling
1. Select the required machines.

2. Choose {Deploy}{Uninstall NetSupport School} from the Deploy main window drop-down
menu.

Or
Right-click on the selected machines and choose Deploy - Uninstall NetSupport School.

3. The Deploy summary dialog appears.

Deploy Summary X

This is a summary of the options you have selected. Check the details and
click Deploy to start. You can change the properties of the deploy by
clicking Properties

Type ~

N Deploy
Uninstall NetSupport School
A Cancel
Description
Uninstall NetSupport School -
Deploy License Details
Licensed to EVAL for 40 Clients Help

Acknowledgement
Uninstall immediately

No message is displayed while uninstalling

Restart Mode

4. Click Properties to enter the details for the deployment. The Uninstall NetSupport School dialog
appears.

[E] Uninstall NetSupport School ? X
General Acknowledgement Message Restart

Description

Uninstall NetSupport Schoo\'

5. Enter the properties for the deployment by selecting the four tabs in turn.
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General tab
Acknowledgement tab
Message tab

Restart tab

When you have completed all four tabs, click OK to return to the Deploy Summary dialog. You
can review your selections and edit if required.

Click Deploy to commence the uninstall. A progress dialog will appear, enabling you to monitor
the deployment as it uninstalls each machine.

Click Close when complete.
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Remote uninstall - Properties General tab

] Uninstall NetSupport School ? X

General Acknowledgement Message Restart

Description

|Uninstall NetSupport Schonll

o | e

Provides a description of the package being uninstalled.
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Remote uninstall - Properties Acknowledgement tab

[E] Uninstall NetSupport School ? X
General Acknowledgement Message Restart

Options
(®) Uninstall NetSupport School immediately

(©) Warn user before uninstalling NetSupport School

(0) User can postpone uninstall of NetSupport School

one |5

Cancel Help

Consider whether the machines will be in use when commencing the deploy. You can choose to:

Uninstall NetSupport School Immediately

No prompt will be received at the machines being deployed to.

Warn user before uninstalling NetSupport School

The user will receive a prompt and needs to click OK for the uninstall to commence. Users cannot
cancel this.

User can postpone uninstall of NetSupport School

You can specify the number of times a user can postpone the uninstall. If the user does choose to
postpone, they will be prompted the next time they restart the machine.
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Remote uninstall - Properties Message tab

[l Uninstall NetSupport School ? X

General Acknowledgement Message Restart

Options
Display a message

Title: ‘Uninslall NetSupport School ‘

Message:

You can specify a custom message to be displayed at each machine while the uninstall is in progress.
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Remote uninstall - Properties Restart tab

[E] Uninstall NetSupport School ? X

General Acknowledgement Message Restart

Options

(®) Insist user restarts machine

() Force restart

[] Automatic restart if not logged in

Cancel Help

To completely remove all NetSupport School files, the machines must be restarted.

Options

Insist user restarts machine: A message will be displayed at machines advising the user to restart
the PC to complete the process.

Force restart: At the end of the deployment, a message is displayed advising users that the machine
will be restarted. A time bar is displayed indicating how many seconds it is before the restart

commences.

Automatic restart if not logged in: If the machine being deployed to is not logged in, restart will
commence automatically.
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Entering deploy settings in advance

There may be occasions when you want to defer a deployment until a more convenient time of the
day. With NetSupport School Deploy, you can prepare the settings in advance and choose when to
perform the deployment.

Note: You select the machines to deploy to when you are ready to run the deployment.

To prepare the settings for a future deployment

1.

2.

Choose {Deploy}{Configuration} from the Deploy main window drop-down menu.

The Deploy list dialog appears.

Deploy List X
=2 == =\ —\ Neanlay
P ?ﬁ ) :\\H i' 3 ) :\\‘H Deploy
WL (NP Ny (N
NetSupport Client NetSupport  Uninstall Properties
School P... Configuration School Li... NetSupp...
Close
Help

Deploy to:
110.0.0.0 (Server)

Select the required Deploy option. (NetSupport School Package, Client Configuration,
NetSupport School Licence File or Uninstall NetSupport School)

Click Properties and enter the required settings.

When all settings are entered, click Close to return to the Deploy main window.

To run the deployment

1.

2.

Select the machines to deploy to. See..

Choose {Deploy} from the main window drop-down menu.
Or

Right-click on the selected machines and choose Deploy.
Select the required Deploy option.

The Deploy summary dialog appears, showing your pre-defined selections.
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Deploy Summary X

click Deploy to start. You can change the properties of the deploy by
clicking Properties

E This is a summary of the options you have selected. Check the details and

Type ) ) n Deploy
NetSupport School License File

L Cancel
Description

NetSupport Schocl License File

Deploy License Details
Licensed to EVAL for 40 Clients Help

License File
C:\Program Files (x86)\NetSupport\NetSupport School
ANSM.LIC >>

New settings will take effect next time the
machine restarts

You can edit these if required.

Click Deploy to start the deployment.
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Deploy - log files

When using NetSupport School Deploy, information about each deployment, whether a package
install, licence update, configuration download or uninstall, is recorded. This provides a useful
reminder each time you use the utility of what you have previously deployed. The information is stored
in a log file.

To view log files

1. From the NetSupport School Deploy Main window, select the Log Files tab.

[ NetSupport School Deploy - a x
File View Log Help
) Mon Jul 03 09:53:43 10.20.10.20 - Checking Chent Varsion
Tnewwork | [BLog Files | /2 sacuriy | Mon Jul 03 09:53:43 Checking 10.20.10.20 Chent version
"B pm s s e
el Man Jul 43 10.20.1 - Retrieving platform information
v @l NetSupport School Mon 4. 03 08 5343 Retreing latfo rfomaton for 10.20.10.20
[ Mon Jul 03 09-53-43 2023 Mon Jul 03 09:54:15 10.20.10.20 running Windows
[ Deploy Log MmMD}%Sd%CWMVﬁSWW:MDmmm
Mon Jul 03 09
= Deployed To Mmuoz.nasu-s 10.20.10.20 - Copying NatSuppa School files to machine
Mon Jul 03 09:55:56
Mon Jul 03 09:55:56 Installation started on 10.20.10.20
Mon Jul 03 09:55:56
Mon Jul 03 09:55:56
Man Jul 03 09:55:56 NGS\.DW Schoal sert to 1 machines
Mon Jul 03 09:55:57 10.20.10.20 - Instaling NetSupport School on machine
Mon Jul 03 095702 10.20.10.20 - Installing NetSuppod School on machine
NetSupport Deploy (Objects Discovered 266) Current Dataset Size 11..\Log Files\NetSupport SchoolMon Jul 03 09-53-43 2023\Log Files\NetSupport Schoel\Mon Jul 03 09-53-4

2. Inthe left-hand pane of the main window, increase or decrease the Tree view to see a
description of each type of deployment, the date and time the deployment took place and the
machines that were deployed to.

3. Asyou select an item from the left-hand pane, itemised information about that deployment will
appear in the right-hand pane.
Printing a log file
1. Select the required log file in the Tree view.

2. Choose {Log}{Print} from the Deploy main window drop-down menu.

Deleting a log file
1. Select the required log file in the Tree view.

2. Choose {Log}{Delete} from the Deploy main window drop-down menu.
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Starting NetSupport School

After installation, the Student program is automatically loaded on the Student machines as they start
up.

To start the NetSupport School Tutor Console

1. Double-click the NetSupport School Tutor Console icon in your NetSupport School Program
Group.

Or

Click the NetSupport School Tutor Console desktop icon (if you installed a desktop shortcut for
the Tutor Console).

Or

Click the Start screen, choose All apps/Programs, NetSupport School, NetSupport School
Tutor Console.

Note: On Windows 8, only the Tutor and Tech Console icons will appear in the Start screen. You can
access the other NetSupport School components by right-clicking and selecting All apps along the

bottom of the screen. If you want any of the other NetSupport School components to appear on the
Start screen, right-click the item and choose Pin to Start.

NetSupport School provides three modes for viewing the Tutor user interface: advanced, intermediate
and easy.Advanced mode provides full access to all of NetSupport School's features and functions.
Intermediate mode provides access to the primary features and frequently used teaching tools. Easy
mode provides access to a focused set of classroom management features needed to maintain control
over a class. When NetSupport School loads, you can select which mode to use.

The Welcome wizard will appear if you have chosen advanced or intermediate mode. From here, you
can deploy the Student software onto new computers in your current classroom by clicking
Classroom. If you need to deploy the Student software across your network or need more advanced
options, click Network to open the NetSupport School Deploy utility. To just start the Tutor Console,
click Start and the Class wizard will appear.

The Class wizard enables you to enter the general properties of a new lesson and allows you to choose
how to locate and connect to your Students. You can create multiple classes using different connection
methods. The required class can then be loaded at the start of the lesson and you can quickly connect
to Student machines.

Note: The options available in the Class wizard will depend on the Tutor user interface mode you have
selected.

56



NetSupport School 15.10

As the Tutor program loads, NetSupport School will then browse the network for the specified
Students. While it is searching, the browsing message will be displayed. All connected Students will
have their icons displayed in the Tutor Console. A warning icon will highlight machines you have been
unable to connect to. Mouse over the icon to display the reason why the connection failed.

Note: If you selected the 'Non-Windows' licence type during installation, the Tutor Console has a cut-
down set of features.

You can enter or alter the lesson details for the current class in the Home view. This pane can be
minimised by clicking the Minimise View & icon.

Note: To prevent the Tech Console from automatically connecting to the Tutor machine, ensure the
NetSupport School Student is installed and set the Enable User Acknowledge option in the Student
Configurator. You will have to confirm the connection before it can take place.
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NetSupport School Deploy - Room mode

NetSupport School provides a quick and easy way to assign PCs to a particular room and quickly
deploy the Student software to those machines. The Tutor specifies the required room at the start of a
lesson and will connect to all computers in that room.

Note: If you need to deploy the Student software across your network or need more advanced deploy
options, you need to use the NetSupport School Deploy utility. This can be accessed by clicking
Network on the NetSupport School Startup wizard or selecting {Start}{Programs}{NetSupport
School}{NetSupport School Deploy?}.

Deploy the Student software to machines in a room
1. From the NetSupport School Startup wizard select Classroom.

2. The NetSupport School Deploy dialog appears.

MetSuppart School Deploy pe
| Choose which computers you want to deploy the NetSupport School student software to from the "Available Computers' list and add them to the 'Selected Computers’ list.

Click 'Finish to deploy to the selected computers.

Room: English Yr 7

Workgroup,/Domain: Add a new IP range...

Available Computers Computers to deploy to
MName Description A Name Description
10.0.0.163 £10.0.0.176
10.0.0.164 £10.0.0.174
£10.0.0.185 =10.0.0.171
£10.0.0.166 210.0.0.161
10.0.0.167 10.0.0.160

10.0.0.168 10.0.0.159
10.0.0.169 Add All ->>
£10.0.0.17
10.0.0.170
210.00.171
10.0.0.172
10.0.0.173
10.0.0.174 <<= Remove All
10.0.0.175
10.0.0.176
10.0.0.177 -

Finish !

w

Enter the room to assign the computers.

4. The Workgroup/Domain drop-down list displays all the available domains and workgroups, you
can also deploy to specific IP ranges by selecting Add a new IP range from the list.

5. The available computers are displayed in the Available Computers list.

6. Select the computer(s) to deploy the Student software to and click Add. The computer(s) will be
moved to the 'Computers to deploy to' list.

7. Click Finish to commence the installation. A progress dialog appears, enabling you to monitor
the deployment as it installs on each computer.

8. The NetSupport School Student software is deployed to the requested machine and assigned to
the room specified.
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Note: You can also access the NetSupport School Basic Deploy dialog from the Tutor Configurator.
Click Options in the Tutor Console, select Network Settings from the drop-down menu, choose
Network and Wireless Settings and click Deploy.
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Finding and connecting to Students

The Class wizard enables the Tutor to select the connection mode that best suits their requirements.
The Class wizard is displayed when the Tutor program is initially started and when a class is restarted.
You can also specify how Students are connected to and configure these settings in the Tutor
Configuration. Click Options in the Tutor Console, select Network Settings from the drop-down
menu and choose Student Selection.

Settings for Configuration: NetSupport Schoel *

Search settings
Room Mode

b @ﬂ Start Options B4 connect to Students in Room(s):
Start Options T2
£03 Restrictions :
Select from kst of rooms
@ﬁ‘ Network and Wireless Settings o
@)g Performance
(f Student Selection [ Prompt at startup
~ " Adminstration [ Acknowledge Roaming Students
t:k Security
£03 Profie Browse Mode

[JBrowse and connect to Students starting with:

Fixed List Mode
[Jconnect to a kst of Students

SI5 Mode
[ connect to SIS
School name:

OK Cancel Help

The connection methods available are:

Room mode: Connect to Student computers by room(s).

PC mode: Connect to a fixed list of Student computers by machine name.

User mode: Connect to a fixed list of Students (by logged on user name).

Browse mode: Browse the network and connect to Student computers with a specific machine name.
SIS mode: Connect to your SIS environment using OneRoster or Google Classroom.

The default method is 'Room mode'.

Notes:

« If the expected Students are not found, it may be because NetSupport School has not been
configured to browse the required networks. See Configuring NetSupport School for subnet
browsing for more information.

60



NetSupport School 15.10

If a 'NetSupport Connectivity Server/Gateway' has been configured, the Tutor Console will use
the details registered here rather than perform a browse across the network.

A warning icon will highlight machines you have been unable to connect to. Mouse over the
icon to display the reason why the connection failed.

If required, a message can be displayed at the Student machine when a connection is made.

61



NetSupport School 15.10

Class wizard

The Class wizard enables you to enter the general properties of a new lesson and allows you to choose
how to locate and connect to your Students. You can create multiple classes using different connection
methods. The required class can then be loaded at the start of the lesson and you can quickly connect
to Student machines.

Note: The options displayed will depend on the Tutor user interface mode you selected at startup.

MNew Class

Lesson Details

Teacher username/email:

Teacher name:

Lesson title:

Mrs Smith

| | English - Poetry

Qutcome:

What time does this Lesson finish?

Objectives:

i = 13 o
[~ open lesson

Connect to devices in list "Y1 9 group &'

©@ @ =B

ICT 2

| Select |

New

2
&5
Room4  ¥r 9 group & Yr 7 group 2

Edit
Remove

Power On

@ Create 3 Student Register O

@i Create a Journal

Configure Quit oK Help

Lesson Details

You have the option to input the teacher name, lesson title, lesson objectives and outcomes. If these
details are completed, they will form part of the Student Register and be displayed in the Student
Toolbar.

Note: The Teacher username field will only be available when connected to SIS mode. Select the
required teacher name from the drop-down list; a list of classes will appear in the Connect to pane.

What time does this lesson finish?: Enter the time you want the class to finish; a timer will appear

while the lesson is in progress. If you do not want the lesson to be timed, enable the Open Lesson
option.
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Connect to

Select the method to locate and connect to Students.

Click New to create a connection method for your class. The Select Startup Mode dialog appears: you
can connect by room, a list of PC names, a list of Student logon names or browse the local network to
locate Students.

Note: To connect using SIS mode, you need to click Configure. For further information, see
Connecting to Students using SIS Mode.

When the connection method for your class has been defined, it appears in the Class wizard and is
available for selection. Double click the required class or highlight the class and click Select.

Note: If you're connecting by Room mode, you can connect to multiple rooms by highlighting the
required rooms (click Ctrl and select the required rooms) and clicking Select.

Once the connection list is populated with the required class(es), you can click the Large Icon and
Details View buttons to switch view mode. Details View is useful when connecting using SIS Mode as it
imports additional class details (if previously entered into your student information system) to help
identify the correct item if a number of similarly named classes are listed.

To modify an existing class, select the required class and click Edit. The dialog relating to the method
of connection will appear, allowing you to modify the details.

Note: For SIS Mode connections the Edit dialog is read-only, allowing you to view the imported SIS
data including the individual student names.

To delete a class, select the required class and click Remove.

Power On: Turns on all computers when connecting by Room or PC names.

Ad-hoc room: From here, you can enter an ad-hoc room to connect to. This option will only be
displayed if the Prompt at startup option has been selected in the Tutor Configuration - Student

Selection settings.

Create a Journal

Allows you to start or open an existing Journal.

Create a Student Register

Before the lesson starts, you can prompt the Students to login with their names. These will be
displayed at the Tutor instead of the machine names.
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Don't show this dialog again

Turn on if you don't want the Class wizard to appear at startup.

Note: To re-activate the Class wizard to appear at startup, set the Display Class wizard option in
the startup section of the configuration.

Configure

Provides access to a selection of Tutor configuration settings that allow you to set network settings,
such as, enabling the NetSupport Connectivity Server and choosing which connection method to use.

Click OK to start the lesson. The Tutor will now browse and connect to Students using the selected
connection mode. If you have asked for Students to register their names, the Student Register dialog
will appear.
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Connect to Students via Room mode

NetSupport School provides a quick and easy method to connect to the machines in a given room. An
intuitive startup wizard enables you to assign PCs to a particular room and quickly deploy the Student
software to those machines. At the start of a lesson, the teacher simply indicates which of the pre-
defined rooms they want to connect to. 'Roaming’ Students also have the option of connecting to a
designated room.

The Room settings can also be configured at the Student in the NetSupport School Student
Configurator.
Connecting using the Class wizard

1. Inthe Class wizard, select New.

2. Click Room Mode.

3. Enter the name of the new room.

4. To make this class the default connection method, select Make this the active connection
method.

5. Click OK.

6. The new class appears in the Class wizard.

Note: You can connect to multiple rooms by highlighting the required rooms (click Ctrl and
select the required rooms) and clicking Select.

7. The Tutor will browse for and connect to all Students found and display their icons in the Tutor
Console.

Configuring rooms using the Tutor Configurator
1. Click Options in the Tutor Console and select Network Settings from the drop-down menu.
2. Select Student Selection.
3. Click the Connect to Students in Room(s) option and enter the required room.

4. To choose from a list of rooms in the Class wizard, click Select from list of rooms. Enter the
required room names, separating each value with a comma.

5. To allow students to join your room, click Acknowledge Roaming Students.

6. Click Prompt at startup if you want the Tutor to be able to specify an ad-hoc room to connect
to in the Class wizard.

7. Click OK.

8. Click Yes to re-initialise the Tutor Configurator.
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9. The Class wizard appears, showing the room(s) you have set. Select the required room, click
Select and click OK.

Note: You can connect to multiple rooms by highlighting the required rooms (click Ctrl and
select the required rooms) and clicking Select.

10. The Tutor will connect to all Students found and display their icons in the Tutor Console.

Note: A warning icon will be displayed next to Students that have been unable to connect. Mouse over
this icon to see the reason for the failed connection.

Students manually connecting to a room

Roaming Students can be configured to either manually enter the room or choose from a list of
available rooms from the Student icon in the system tray. If the Student icon is hidden in the system
tray, the Student can still manually enter the room by running the setroom.exe. This file is located in
the Program folder on the Student machine.

Note: For a roaming Student to be able to connect to a room, you must ensure that the
Acknowledge Roaming Students option is selected in the Tutor Configurator. In the Student
Configurator, one of the following mobile options must be selected: This is a mobile computer and
may be in one of the following rooms or This is a mobile computer and its room will be
entered manually. For Students to be able to browse all available rooms, select Display all
available rooms.

1. Select the NetSupport School Student icon in the system tray and choose {Commands}
{Enter/Leave Room} from the Student drop-down menu.

Or
Right-click the Student icon and choose Enter/Leave Room.

2. The Enter/Leave Room dialog will appear and, depending on the option set in the Student
Configurator, the Student can enter the required room name, choose a room from a drop-down
list, or see all available rooms.

3. Click OK or Enter Room.

4. The Student will connect to the selected room and appear in the Tutor Console.

Note: For information on how to use Room mode when connecting to Students in a
BYOD environment, please visit our Knowledge Base and refer to product article Using NetSupport
School in a BYOD environment.
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Connect to Students using Browse mode

Browse mode allows you to browse the local network and connect to all available Students that match

your search criteria.

Connecting using the Class wizard

1.

2.

In the Class wizard, select New.
Click Browse Mode.
The NetSupport School Browse dialog will appear.

Enter the first few characters of the Student names that you want to connect to. For example,
entering Class1 would connect to all machines whose Student name started with Classl. e.g.
Class1_Wk1, Class1_WKk?2 etc.

To make this the active connection method, select Make this the active connection method.
Click OK.
The new class will appear in the Class wizard. Click OK.

The Tutor will browse for and connect to all Students found and display their icons in the Tutor
Console.

Connecting using the Tutor Configurator

1. Click Options in the Tutor Console and select Network Settings from the drop-down menu.

2. Select Student Selection.

3. Click Browse and connect to Students starting with and enter the first few characters of
the Student names you want to connect to. This can be left blank to search for all Students.

4. Click OK.

5. Click Yes to re-initialise the Tutor configurator.

6. The Tutor will browse for and connect to all Students found and display their icons in the Tutor
Console.

Notes:

If a machine is not available at the time the Tutor initialised, you can subsequently connect to it
by clicking the class in the status bar and choosing Refresh. This will re-search the network
and connect any additional Students meeting the criteria.

It is essential that you have a logical naming convention for the Student machines. If you need
to change the names of any Student machines, see Configuring the Student - Advanced
settings.
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Connect to Students using PC mode

PC mode allows you to connect to a fixed list of Student computers by machine name. When
connecting to Students using PC mode, the Students become part of the Fixed list of PCs. The Fixed list
of PCs is a list of available Students that have been found on the network. These details are stored in
the Client.NSS file.

Connecting using the Class wizard
1. Inthe Class wizard, click New.

2. Click PC Mode.

The Create Class dialog appears.

ol

Specify a name and description for your class.

5. Enter a prefix for the Students' computer names in the text box (leave blank to search all
computers).

6. Click Browse.

7. All Students matching the prefix will appear in the Available Students list.

8. Select the Studenticons to include in your class and click Add.

9. To make this the active connection method, select Make this the active connection method.
10. Click OK.
11. The new class will appear in the Class wizard. Click OK.

12. The Tutor will connect to the selected Students and display their icons in the Tutor Console.
These Students have now been added to the Fixed list of PCs.

Connecting using the Tutor Configurator
1. Click Options in the Tutor Console and select Network Settings from the drop-down menu.
2. Select Student Selection.
3. Click Connect to a list of Students.
4. Click OK.
5. Click Yes to re-initialise the Tutor Configurator.

6. The Class wizard will appear. Follow the above steps in Connecting using the Class wizard.

To remove Students from the Fixed list of PCs
1. Click the class hame on the status bar and select Modify Class.

2. The Modify Class dialog appears.
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Select the Student icon from the Student in class list.

3

4. Click Remove.

5. The Student is now available but is not part of the Fixed list of PCs.
6. Click OK.

7. The Student icon will be removed from the Tutor Console.

Note: In order to reconnect to a removed Student, you must browse for them and add them to the
Students in class list.
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Connect to Students using User mode

User mode allows you to connect to a fixed list of Students by their logged on user name. When
connecting to Students using User mode, the Students will become part of the Fixed list of users. The
Fixed list of users is a list of available Students that have been found on the network. These details are
stored in the Client.NSS file.

Connecting using the Class wizard

1.

U

© ® N

In the Class wizard, click New.

Click User Mode.

The Create Class dialog appears.

Specify a name and description for the class.

Enter the Student logon names, one per line.

To make this the active connection method, select Make this the active connection method.
Click OK.

The new class will appear in the Class wizard. Click OK.

The Tutor will browse for and connect to the Students and display their icons in the Tutor
Console. These Students have now been added to the Fixed list of users.

Connecting using the Tutor Configurator

1.

2.

Click Options in the Tutor Console and select Network Settings from the drop-down menu.
Select Student Selection.

Click Connect to a list of Students and then click This is a list of student user names.
Click OK.

Click Yes to re-initialise the Tutor configurator.

The Class wizard appears. Follow the above steps in 'Connecting using the Class wizard'.

To modify Students in the Fixed list of users

1.

2.

Click the class name on the status bar and select Modify Class.
The Modify Class dialog appears.
Delete or add the required Student logon names to the list.

Click OK.
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Note: For information on how to use User mode when connecting to Students in a BYOD environment,
please visit our Knowledge Base and refer to product article Using NetSupport School in a BYOD
environment.
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Connect to Students using SIS mode

NetSupport School provides direct integration with SIS (Student Information Systems) using
OneRoster or Google Classroom, allowing you to instantly access your SIS classrooms and student
accounts at the start of a NetSupport School-managed lesson.

Note: The NetSupport Connectivity Server must be installed on a Windows Server to use this method.

Configuring the NetSupport Connectivity Server

1.

Right-click the NetSupport Connectivity Server icon in the system tray and select
Configure Connectivity Server.

Select the Classes tab. Enter your OneRoster Tenant ID and associated NetSupport School
Security/API key, browse for OneRoster CSV files or if using Google Classroom, browse for the
JSON file and sign into Google G Suite with administrator credentials (for information on how to
set up a Google Classroom Project and create the required JSON files, see Integrating
NetSupport School with Google Classroom).

Note: A Connectivity Server key needs to be created and also entered at both the Tutor and
Student.

Open the NetSupport School Tutor and in the Class wizard, click Configure.

In the Network and Wireless Settings, select Use Name & Connectivity Server, click
Settings and enter the Connectivity Server IP address, port and key you created.

Click OK.

Connecting to Students

1.

2.

In the Class wizard, click Configure.

In Student Selection, select Connect to SIS and select the required school name from the
drop-down list.

Click OK.
Select the required teacher from the Teacher username drop-down list.

A list of available classes appears. Double-click the required class. If the displayed list contains
duplicate or similarly named classes that makes it difficult to identify the required item, click the
Details View button to see additional information. The class Location and Periods columns, if
defined in your data, are imported.

The Tutor browses for and connects to all Students found and display their icons in the Tutor
Console.
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Notes:

If you are using Active Directory, the Teacher username field in the Class wizard will be pre-
populated with the logged on user's hame and a list of available classes is displayed. You can
switch to a different teacher from the drop-down list, or click Configure and choose a different
school name from SIS Mode.

If you are integrating with Google Classroom and there is a photo associated with the student
account, this will be displayed instead of the standard Student icon. To turn this off, clear the
Display Student photos from Google Classroom option in the Tutor User Interface
settings.

For information on how to use SIS mode when connecting to Students in a BYOD environment,
please visit our Knowledge Base and refer to product article: Using NetSupport School in a
BYOD environment.
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Integrating NetSupport School with Google Classroom

NetSupport School supports integration with SIS (Student Information System) environments via
OneRoster and Google Classroom, allowing teachers to access their online SIS classrooms and student
accounts at the start of a NetSupport School-managed lesson. Before you can integrate with Google
Classroom, you first need to set up a Google Classroom Project.

For a video tutorial, please click here.

Step 1 - Setting up a Google Classroom Project

1. Goto https://console.cloud.google.com and log in as the global admin for G Suite for Education
domain.

2. From the Select a Project drop-down menu, select New Project.

Enter a project name, e.g. Chrome Town High (this must be unique to the school or school
district).

Click Create.
Select your recently created project to display it in the Console dashboard.
3. Inthe navigation menu, select APIs & Services -> Library.
Search for, and enable, the following three APIs:
B Google Classroom (required for roster information)
®  Cloud Pub/Sub (required for class change notifications)
®  Admin SDK (required for Google Management).
4. Inthe navigation menu, select APIs & Services -> Credentials.
Click OAuth consent screen.
Select Internal and press Create.
Under Application Name, enter the name of the application, e.g. Chrome Town High.
Under Scopes for Google APIs, select Add Scope and locate the following three scopes:

®  https://www.googleapis.com/auth/classroom.courses.readonly

®  https://www.googleapis.com/auth/classroom.rosters.readonly

®  https://www.googleapis.com/auth/classroom.push-notifications

Click Add.
Click Save.
5. Select Credentials, then Create Credentials -> Service account key.

Enter a name and description, e.g. pubsubadmin. Click Create.
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In Service account permissions, add the role Pub/Sub Admin.

Click Continue.

Click Done.

Select the Edit icon to edit the service account just created.

Navigate to Keys.

Select Add key -> Create key.

In the dialog, select JSON and press Create. A JSON file will be saved to your downloads folder.

Note: The file created here is required for the Name & Connectivity Server.

6. Select API-Credentials -> Create Credentials -> OAuth client ID, select Desktop app,
enter a name and click Create.

The Client ID and client secret will be displayed. Click OK.

7. Click the Download % icon to download the JSON file for the OAuth Client ID you have created,
and save the JSON file so this can be copied to the Name & Connectivity Server.

8. Inthe navigation menu, select IAM & admin.
On the IAM tab, click Add.
Enter the following email:
classroom-notifications@system.gserviceaccount.com
Select the suggestion.
From the Select a role drop-down list, select Pub/Sub publisher.

Click Save.

Step 2 - Configuring the Name & Connectivity Server for Google Classroom

The two JSON files created above are required to configure the Name & Connectivity Server. Copy
these files and place them on the machine where the Name & Connectivity Server is installed.

1. Open the Connectivity Server Configuration utility by right-clicking the NetSupport
Connectivity server @ icon in the system tray and selecting Configure Connectivity
Server.

2. Select the Classes tab.

3. Select Google Classroom and click the Browse --- icon to browse for and select one of the

JSON files that you have copied to the machine (both files must be present, but either file can be
selected).

4. Click Apply. You will be prompted to sign into Google G Suite with administrator credentials and
grant access to NetSupport School.
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You can now use SIS mode to connect to the required students.

Troubleshooting

For the above to work, you may need to add the Client ID into Google Admin.

1. Goto https://console.cloud.google.com and log in as the global admin for your G Suite for
Education domain.

2. Navigate to API & Services -> Credentials.

Under OAuth 2.0 Client IDs, click the Copy icon next to the Client ID for your application. You
will need this for the next section.

Log into Admin.google.com with your G Suite for Education administrator account and navigate
to Security -> API Controls.

Tick the option to Trust internal, domain owned apps.

3. Under the third-party apps configured section, click Manage Third-Party App Access.
4. Ensure the Apps tab is visible and select Configure new app.
5. From the drop-down menu, select OAuth App Name or Client ID.

6. Paste your Client ID from the Developer Console and press Search.

7. Select the application that is returned.

8. On the next page, tick the boxes and click Select.

9. On the Configure an app page, select Trusted and then press Configure.
10. Check the application now shows in the list of third-party apps.
11. Select the application and press Change access.

12. Tick Limited: can only access unrestricted Google Services.
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Class lists

With NetSupport School, you have the option to create class lists, this provides you with a quick and
convenient way of saving multiple Student lists for all your different classes. The class list can then be
loaded at the start of a lesson and you can quickly connect to the Student machines.

Class lists are created automatically when using PC Mode or User Mode connection mode. You can
switch to these modes in the NetSupport School Tutor Configurator or in the Class wizard.

Note: A command line utility can be used to generate class lists outside the Tutor program. The 'Class
List Processor' enables you to produce Class lists in advance based on data that may have been
supplied from an external source. The file, classlistprocessor.exe is installed in the Program folder
along with explanatory notes as to its use, classlistprocessordocumentation.txt.

To end a class
1. Click the class name on the status bar and select End Class.

2. Your current class will be ended and the Class wizard will appear, allowing you to start a new
lesson.

Notes:

« If the Tutor machine does not have write access to the Class Lists folder, the Tutor will not be
able to create new class lists or edit existing ones.

* You can specify the location for the class lists to be stored by using the following registry key
and then specifying a location:
Files\Classlist
[HKEY_LOCAL_MACHINE\SOFTWARE\Productive Computer
Insight\PCICTL\ConfigList\Standard]
"Files\\Classlist"="C:\\Temp"
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Connecting to NetSupport School for Mac

NetSupport School for Mac is a classroom management tool providing support for Mac classrooms. The
NetSupport School Tutor can also connect to NetSupport School for Mac Students if required.

Before the NetSupport School Tutor is loaded, copy the NSW.LIC into the NetSupport School program
directory:

32bit C:\Program Files\NetSupport\NetSupport School
64bit C:\Program Files (x86)\NetSupport\NetSupport School

The NetSupport School Tutor will then allow connections to NetSupport School for Mac Students.
Licence count restrictions will apply to each individual product.

Note: Mac Students will only have functionality that is available in NetSupport School for Mac.

To find out more information about NetSupport School for Mac, please refer to our Mac
documentation.
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The Tutor Console

The Tutor Console is the primary interface for:

» Configuring the Tutor (Control)

* Connecting to Students

¢ Maintaining Student information

¢ Selecting which Students to work with

¢ Selecting tasks to carry out.
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NetSupport School provides three modes to view the user interface: advanced, which provides full
access to all NetSupport School's features, intermediate, which provides access to the primary
features and frequently used teaching tools and easy, which provides access to a focused set of
classroom management features. You can switch between advanced and intermediate mode by
clicking the Intermediate Mode/Advanced Mode icon on the toolbar. Easy mode can only be

selected when the Tutor Console first starts up.

Note: The options described here are if you are using the Tutor Console in advanced mode. Fewer

options are available when using intermediate or easy mode.
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The caption bar
This indicates that you are in the Tutor Console and displays the name of the NetSupport School Tutor

machine. If the Teacher Support feature is enabled in the Tech Console, a Support B support jeon
appears here, allowing you to chat or message a technician.

Note: If you have hidden the view modes on the left-hand side of the Tutor Console, the current view
mode is displayed here. Clicking the icon allows you to switch view modes.

The following options are available on the right-hand side:

= Opens the Quick Access list, allowing you to add commonly
used features to the caption bar. By default, Mute All, Lock

[Hamburger menu icon] All, Internet and the lesson timer are displayed.

L . ) Minimise the window.
[Minimise window icon]

B

Maximise the window.
[Maximise window icon]

s

Close the window.
[Close window icon]

Options

From this drop-down menu, you can switch the user interface to intermediate mode; turn off the
colour-coded user interface; access the settings, help file, version number, licence and Technical
Support information; and access any Tutor Console updates (Options is highlighted if there is an
update available).

The ribbon

The ribbon provides access to all the features and tools.Positioning the cursor over an icon will display
a brief description of its function. The ribbon is organised into the following tabs:

Class: From here, you can ask Students to register their details at the start of a lesson, access
individual Student features, set the level of web access and communicate with Students.

Note: Additional icons may appear here depending on which view mode you are currently in.

Group: Provides access to the group functions within NetSupport School.

Select: From here, you can select which Students to work with and view in the List view.

Feedback & Wellbeing: Allows you to give rewards and animated stickers to Students (these appear

on the Student Toolbar), request feedback from Students to check their wellbeing, access the Test
Designer and run tests at Students.
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Journal: Allows you to start a Student Journal and decide what content is added for Students to
review after the lesson.

Work Planner: Send files to or collect files from Students, manage the available Student resources,
set a class timer and create and manage lesson plans.

Administer: Provides access to the Student management functions of NetSupport School such as
power on/off, reboot, log in, log out and manage user accounts, modify and apply settings to Android
Students, access replay files and create user-defined tools that can automatically run a task on a Tutor
Console machine.

View: Allows you to select the view mode, how Students are displayed in the List view (large icons or
details view) and whether to view the group, action bar and Student Toolbar. You can also print or lock
the current layout and set a background.

Whiteboard: A full-screen interactive whiteboard is provided and from here, you can access a range
of screen annotation tools.

Note: This option only appears when Whiteboard view is selected.

The lesson plan bar

The lesson bar allows you to create a lesson, provides tools to manage the lesson once in progress and
advises you on the current activity.

Note: To enable/disable the lesson plan bar, select the Work Planner tab in the ribbon and click/clear
the Lesson Plan option. It is displayed automatically when a lesson plan is running.

The group bar

Until you have defined groups of Students, only the 'All' group appears. Once defined, the group name
and the number of members appear. With the required group selected, you can change properties
such as the displayed name and icon image by clicking the Group options — icon and selecting
Properties.

Clicking the right-hand side of a group tab displays a drop-down menu, allowing you to access
commonly used features.

To enable/disable the group bar, select the Group or View tab in the ribbon and select the Group Bar
option.

View modes

The left-hand side of the Tutor Console lists the available view modes. Clicking an icon here changes
the display of the List view and the icons applicable to the mode are displayed in the Class tab.
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Note: You can hide these icons, allowing more space in the List view. Select the View tab in the ribbon
and clear the Action Bar option. The view mode icon is displayed on the caption bar, showing which
view mode you are in and clicking this icon allows you to switch views.

The following view modes are available:

Home view
Monitor view

Audio view

QR&A view

Web view
Application view
Survey view
Print view

Device view

] BPOBS®CeUD

Typing view

Whiteboard view

2l

Note: You can customise the view modes displayed by selecting the View tab in the ribbon, clicking
the drop-down arrow in the Mode section and clicking Customise.

By default, the colour used in the Tutor user interface changes to match the current view mode. You
can turn this off by clicking Options in the Tutor Console and selecting Colour Coded UI (this option
is highlighted when turned on) from the drop-down menu. You can also enable/disable this in the
Tutor User Interface settings.

The List view

The List view displays the currently connected Students or groups. You can switch the display mode
between large icons and details view from the View tab in the ribbon or the status bar.

The status bar

The status bar is displayed at the bottom of the Tutor Console. It shows the current class you are in
(you can end and refresh the class from here), the number of currently connected Students and
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number of Students in the selected group. You can select which Students to perform actions to from
here and how Students are displayed in the List view.
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The List view

The List view displays the currently connected Students or groups. You can switch the display mode

between large icons and details view by clicking the Large icons &t icon or the Details == icon on the

status bar.
9] o o ] @ o
v Y 9 9 9 @9
Ernma e Sam| Simon

When you mouse over a Student icon, details of the student machine are displayed.

Student properties, such as the displayed name, can be changed by right-clicking the Student and
clicking the Properties & icon. The Student icon image can be customised; right-click the Student

and click the Customise & icon.

Note: Student names can also be customised using the Student Register function.

The wireless status and battery power level can be displayed next to the Student thumbnail. You can
choose which indicators to display in the Tutor User Interface settings.

The List view can be viewed in the following modes:

Home view

¢ Monitor view

e Audio view

e Q&A view

«  Web view

¢ Application view
e Survey view

¢ Print view

« Device view
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e Typing view

e Whiteboard view

Click on the individual icons on the left-hand side of the Tutor Console, or select the View tab in the
ribbon and click the drop-down arrow in the Mode section. You can customise the available modes by
selecting Customise. The default view mode is Home view.

Note: The action bar (where the view mode icons appear on the left-hand side of the Console) can be
hidden to allow more space in the List view. Select the View tab in the ribbon and clear the Action Bar
option. If you are in a view with lower panes, these can also be hidden by clicking the Minimise View

El icon.

The Student icon indicates the current device state:

&
o The device is turned on, connected to the Tutor and logged
in.
[Logged in Student icon]
O
O The device is turned on, connected to the Tutor and logged
off.

[Logged out Student icon]

4

[Device off icon - monitor with a red
slash]

The device is turned off and not connected to the Tutor.

Student icons can be rearranged in the List view to reflect the classroom layout by dragging the icon to
the required position (the layout can be locked). A background image can also be added to further
customise the Tutor Console.
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Status bar

The status bar is displayed at the bottom of the Tutor Console. It shows the current class you are in
(you can end and refresh the class by clicking the class name), the number of currently connected
Students, currently selected Students and number of Students in the selected group.

Note: In Monitor, Audio and Q&A views, the thumbnail tools appear on the status bar.

You can select which Students to work with in the List view. For example, you can select all machines
that are powered off, so you can power them on. The following icons are available:

] ] Select all Studentsthat are logged in.
[Logged-in Student icon]

|

i

A

Select all Studentsthat are logged out.
[Logged out Student icon]
[
[Powered off machines icon - Select all devicesthat are powered off.
monitor]

Note: You can also select all Students and clear the current selection from the Select tab in the
ribbon.

You can choose how Students are displayed in the List view (details view or large icons) by clicking the

== ao
Details == icon or the Large icons 00O icon (if the mode you are in supports that view).

Note: If you have minimised the lower pane(s) in the List view, you can see these again by clicking
the Maximise view &) icon.
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Selecting Students to work with

You can easily select which Students to work with from the Select tab in the ribbon.

Students can be randomly selected; use the slider to choose the number of Students to select
randomly and click Random Student. By default, a sound is played at the Student when they are
selected. Clear the Play sound at student option to disable this.

You can choose to work with logged-in, logged out or powered off Students by clicking the relevant

icon in the ribbon or status bar. For example, you can select all powered off machines, allowing you to
power them on.
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Intermediate mode

NetSupport School provides three modes for viewing the user interface: advanced, intermediate and
easy. Advanced mode provides full access to all of NetSupport School's features and functions.
Intermediate mode provides access to the primary features and frequently used functions. Easy mode
provides access to a focused set of classroom management features needed to maintain control over a

class.

Using Intermediate mode

1.

Start the NetSupport School Tutor Console.

Click the Intermediate mode @ icon.
Click Start.
Enter the required details in the Class wizard, choose the class to connect to and click OK.

The Tutor Console loads.

B NetSupport School : ECWIN10-1 Lock All memet) O = _ O X

Class Group Select Thumbnails View ~ Options
[E3) student Register | Actions 5% ) é Lock T show ~ e Access @ unrestrictea @'anroﬁ - 0., Login CcoLuguut (D) crat C Feedback and welloeing (53 Message

| D [EXEN =

DoMto @ Zoomin & & O

WYrogroup6 ~ S%3Students 551 Selected O=——=

By default, the available view modes are:

Monitor view
Web view
Application view
Survey view

Print view
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Note: To customise the available view modes, select the View tab in the ribbon, click the drop-down
arrow * in the Mode section and choose Customise.

By default, the available features on the ribbon are:

* Student register

e View Students

» File Transfer

* Lock/unlock Students' keyboards and mice
e Setthe level of web access

e« Show

« Power Students on/off

* Login Students

* Logout Students

¢ Student feedback and wellbeing
« Send a message

e Chat.

To switch the user interface between modes

1. Select Options in the Tutor Console and click Reduced Interface (it's highlighted when you
are in intermediate mode).

Note: You can only select easy mode when the Tutor Console first starts.
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Easy mode

NetSupport School provides three modes for viewing the user interface: advanced, intermediate and
easy. Advanced mode provides full access to all of NetSupport School's features and functions.
Intermediate mode provides access to the primary features and frequently used functions. Easy mode
provides access to a focused set of classroom management features needed to maintain control over a
class.

Using easy mode

1. Start the NetSupport School Tutor Console.

2. Click the Easy Mode @ icon.
3. Enter the required details in the Class wizard, choose the class to connect to and click OK.

4. The Tutor Console appears in easy mode.

B NetSuppert School : ECWINT0-1 — *

cJo Mute Audio = Get Student Names [[»End class (@

() Lesson Time 00:05

)

Blank Block Internet Feedback and
Wellbeing

2, 3 Students in class

§ Nersuppsst

5. From here, you can see the humber of Students in your class, the time the lesson has been
running (you can pause the time by clicking on it) and the available feature icons (the icon
changes if the feature is active).

6. The userinterface can be minimised by clicking the MenuE icon and selecting Minimized
Interface. When minimised, it will remain on top of any other open windows.

Note: Double-clicking in the window switches between minimised and maximised mode.

7. You can change the theme/colour of the user interface by clicking the Menu E icon, selecting

Theme and choosing the required theme from the list.
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Click Power On to power on Student machines. You can request the Student names by clicking
Get Student Names. To mute audio at all Students, click Mute Audio.

Note: The Power On icon only appears if there are Student machines that need to be powered
on.

A notification appears in the window if a Student has requested help. Clicking this opens the
Help Request window, allowing you to respond to the Student.

To end the class and start a new one, click End Class. Click Quit to exit the Tutor Console.

The available features in easy mode are:

Lock/unlock Students' keyboards and mice
Blank Student screens

Power Students on

Block all internet access

Request Student feedback and wellbeing
Mute audio at Students

Lesson timer

See Student help requests

Get Student names.
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Tutor Toolbar

When the Tutor Console is minimised, the Tutor Toolbar provides details of the current lesson and
access to key NetSupport School functions. You can mute sound at all Students, add notes to the
Student Journal, scan, chat, message, announce, show, lock/unlock Students, blank Student screens
and block all internet access by clicking the relevant icon. When the Tutor program is maximised, the
Tutor Toolbar will disappear and any settings applied will show in the Tutor Console.

English Yr 7 NER-YS) J80o8 S O
Me Sound  Mobes  Sean  Chat  Message Announce Show Lock Blank Al Block Al Restore

Note: The Tutor Console can be maximised by clicking Restore.

To disable the Tutor Toolbar, click Options in the Tutor Console, select Settings from the drop-down
menu, choose User Interface - Tutor and clear Show Tutor Toolbar on minimizing option.

Note: A Student Toolbar is also provided; if enabled, this provides the Student with feedback on the
current lesson and access to tools.
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Student automatic login

If a generic naming convention is used for your classroom PCs, you can automatically log the Students
in to save time at the start of a lesson.

To automatically log in Student machines
1. Select the Student machine(s) you wish to login.

Or

To select all Student machines that are not logged in, click the Select Logged out Students &
icon on the status bar.

2. Select the Administer tab in the ribbon and click Login.

E Login x
Login Details

Username: |\ | Login

Password: | |

Dorvain: | |
Status

Name User Name Status View

@‘ Emma 2 Emma

@& Mark & Administrator

® ; Sam & testing

@ & VIRT4SERV...

Close Help
(o]

3. Enter the user name, password and domain and click Login. The user name will appear once the
login has been successful.

4. You can also view Student screens from this dialog. Select the required Student and click View.

5. Click Close when complete.
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Student Register

By default, NetSupport School displays the machine name of the Student machine in the Tutor
Console. However, there may be times when you want the Tutor to display the actual name of the
student and request additional information.

The Student Register option enables the Tutor to prompt the Students for their details.

Note: You can also change the name of the Student machine by editing the Client Properties Details
tab.

To prompt Students to log in

1. If specific Student details are required, select the relevant Student icons in the Tutor Console.
Alternatively, to prompt all connected Students, leave the icons unselected.

2. Select the Class tab in the ribbon and click Student Register.

3. The Register Student(s) dialog appears.

i Register Student(s) - Selected Students X

Client Mame Name Register I

© @ AD-523231498d45 Emma Close

HPLAP-2 Sam

INVH7 84 Mark
View
INVH767 Andy

- Chat...
O HPLAP sarah z

Help

All available students have registerad
(%) Successful (%) Unsuccessful

Class Details Required Student Details
Teacher Name:

h Get Logged on User Name
Mrs Smit!
| | First Name Surname

Lesson Title:
| English Yr 6 | Class Student ID/No.

Room:
| €T 2 |

Custom Fields:

Objectives:

[J Auto save Register

You can then select the information that the Student will be required to complete.

4. Click Register to send the form to Student machines. You can monitor progress as the Students
respond.

5. Click Close when all Students have signed in.

6. Ifyouenabled the Auto Save Register option, you are prompted for a file name, extension
type and location for the registration report. Click Save.

7. The Studenticons in the Tutor Console now display the registered name.
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Note: The Student Register also appears if you select Create a Student Register in the Class
wizard.

Sign out

At the end of a lesson, you can reset the Student names using the sign out option.

1. Select the Class tab in the ribbon, click the Student Register icon and choose Sign Out.

2. Confirm that you want to unregister the Students.

Note: If you don't want to see this message in the future, click Don't show this again. It can be
turned back on in the Tutor User Interface settings.

Registration report

Student registration and printer usage details can be viewed in a report, but this will be lost when the
Tutor disconnects.

Note: If you want to automatically store a copy of the report, ensure the Auto Save Register option
is enabled in the Register Student dialog when requesting the Student details. The report can be
stored in .CSV, .HTML or .XML format.

1. Select the Class tab in the ribbon, click the Student Register icon and choose Registration

Report.
B2 Registration Report O X
Student Registration Detail g
Teacher Name : Mrs Smith
Lesson Title : English - Poetry
Room : ICT 2
Objectives :
Date : Thu, 29/Jun/2023
Time : 11:22:11
First . Computer Student Pages
Surname Teom Login Name TEorr Class 1D/ No. Printed
Emma testing HPLAP-2 0 0
Sam  |Administrator]  INVH764 0 0 v
[ show printer usage Save... Print... | Close |
o]

Notes:

* To print a copy of the report, select the Class tab in the ribbon, click the Student Register
icon and choose Quick Print.
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* The student register can be added to the Tutor Journal. Select the Class tab in the ribbon, click
the Student Register icon and choose Student Register.
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Student Register dialog

This dialog enables the Tutor to create a customised registration form, which will prompt Students for
their details. By selecting a name, the Tutor can also interact with Students using the View and Chat

options.
! Register Student(s) - Selected Students X
Client Name Nare | Register
© 6 AD-523231498d45 Emma Close
[ ]
) g HPLAP-2 Sam Cancel
O e NVHIEA Mark .
Py View
(] w [NVH767 Andy -
@ g HPLAP Sarah e
Help
All available students have registered
() Successful (3 Unsuccessful
Class Details Required Student Details
Teacher Name:
Get Logged on User Name
| Mrs Smith |
First Name Surname
Lesson Title:
| English Y7 6 | Class Student ID/No.
Room: )
| T2 | Custom Fields:
Objectives:
[J Auto save Register
o]

Class Details
If required, the teacher name, lesson title, room and lesson objectives can be included on the
registration form that is sent to Students. These details will be completed if you have already input

them in the Class wizard.

Note: By default, the start-up mode is Connect to Student in Room(s). In this mode, the Room
field displays the room specified at start-up, and cannot be changed.

Required Student Details
Decide which details to prompt the Students for. You can also add two custom fields to the form.

Note: If the Get Logged on User Name option is selected, the first name and surname will be
greyed out and the Student name will automatically default to the login name.

Auto Save Register

Student registration details can be viewed in a report, but this will be lost when the Tutor disconnects.
If you want to store a copy of the report, check this option. You will be prompted for a file name,
location and file format (CSV, HTML or XML).
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Click Register to send the form to Student machines. You can monitor progress as the Students
respond. Click Close when all Students have signed in, the Student icon in the Tutor Console now
displays the registered name.
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Display the login name of Students

When registering Student details, rather than prompt them for their actual name you can default to
their login name.
Display Students user names

1. Click Options in the Tutor Console and select Settings from the drop-down menu.

2. Select User Interface - Tutor.

Settings for Configuration: NetSuppert School »

| Search settings I Tutor

b @? Remote Control

§o3 View

t:ﬁ Replay Files
fo3 Audio
@l cnat

File Transfer
v @} User Interface

Tutor

fo3 Student
@? Tutor Assistant
Group Leaders
Student Toolbar

Journal

af® show

t;ﬁ Keyboard/Mouse

I Display Student User Names

CIremember Student User/Login names

I Display Student photos from Google Classroom
[ Silent Disconnect

EA Automaticaly Reconnect Students

On Exit
[ save Student history

[[] 5ave Student Web history to Tutor Joumnal

EA Show icons for restricted websites
£ show Tutor Toolbar on minimizing
[ show active Print Jobs

[ show Student alert level

[Juse context colours in user interface

Show wireless and battery status Show when battery islow  ~

Massage Prompts

Resat "‘Don’t show this again’ prompts so you see them again Reset
Update Configuration: NetSupport School
oK Cancel Help

Select Display Student User Names.

Click OK.
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Save the Students login name

Enable this option to permanently store the Students login names.

Save the Students login name
1. Click Options in the Tutor Console and select Settings from the drop-down menu.

2. Select User Interface - Tutor.

Settings for Configuration: NetSupport School X
Search settings 2 Tutor
- @@Remo'ne Control |_| Display Student User Names
£03 View [+] Remember Student User/Login names
Q Keyboard/Mouse || Display Student photos from Google Classroom
98 Replay Files [ Silent Disconnect
# Audio o . .
@@ Chat [ ally Reconnect
@ File Transfer On Ext
v 23 User Interface [ save Student history
Q [] save Student Web history to Tutor Journal
£03 Student
Iy N -
 Tutor Assistant 7] Show Icons for restricted websites
@Q Group Leaders o
Student Toolbar [~ Show Tutor Toolbar on minimizing
&7 doumal [+#] Show active Print Jobs
& show ) Show Student alert level

[+ Use context colours in user interface

Show wireless and battery status Show when battery is low
Message Prompts |
Reset 'Don't show this again' prompts so you see them again Resat

Update Configuration: NetSupport Schoo

o

3. Select Remember Student User/ Login names.

4. Click OK.
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Working with classroom layouts

Once you have selected a classroom or group, you can rearrange the individual Student icons in the
List view to reflect the layout of the classroom. A background image can also be added to further
customise the Tutor Console.

When using Room mode, the classroom layout will be automatically saved against the room selected.
When you start the Tutor and select your room, the layout will automatically load.

Note: For information on how to save and load layouts when not in Room mode, refer to the following
article: Changes to the layout functionality when using Room mode.

B NetSupport School : ECWIN10-1 Mute &l €])  Lock AN Internet (=) @ = _ o
Class Group Select Feedback & Wellbeing Journal Work Planner Administer View ~ Options

B 0 &6 D09 3 & O B P &

Student View File Lock Blark Show  Quick  Student Uneestricted  Chat  Announce  Message Help Tutor
Register  Clhient  Transfer Al *  Launch ~ Desktop~ o = Requests~  Assistant

Class Student Web Access Communicate Tablet

&% a5
()
® [ ] [ o] =)
0O e ® 9 @ L 4
Emma Jane sam) Andly
¥ ° o] e} ®
@ ®» © @ ©
@ ° [
@ h_J =
] Mark
-
6 o
® L ° o
ol = =) @ O
Po)
BEy
G] Lesson Details B
E Teacher Mrs Smith ] Description [ Englsh - Poetry
@ Objectives Outcome

.
ge
o
"
Q9
Qo

W vrogroup 6 ~ S%15 Students 25 1 Selected

To arrange icons

1. Select the Student icon and drag it to the desired position.

To lock a layout
1. Arrange the Studenticons in the required positions.
2. Select the View tab in the ribbon and click Lock Layout.

3. Studenticons will be fixed in position and unable to be moved.

Note: The current classroom layout can be printed. Click Print Layout from the View tab in the
ribbon.
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Setting a background

As well as tailoring the position of Student icons in the List view to reflect the layout of the classroom,
you can choose alternative images to decorate the background and enhance the layout of the icons.

Note: Background layouts support .bmp, .gif, jpg, .png and transparent images.

To set a background
1. Select the View tab in the ribbon and click Set Background.

2. The Set Background dialog appears.

Set Background X
Background Image
Image file location:
(C:\Program Files (x86)\NetSupport\NetSupport S Trre Apply
Width: 1910 Height: 1075 Cancel
Image position on display:
Reset
Top Left ~ Align Clients to tiled Images
Help

Background Colour

Top: Set Colour...
Bottom: Set Colour...

Preview

3. Select the location of the image you wish to use. The default image files are stored in the
NetSupport School program folder. A preview of the selected image is provided.

4. Select the Image position on display drop-down to select the position of the image. If you
select Tile, you can also choose to align the Student icons on the image.

5. If required, select a background colour.

6. Click OK to add the background to the List view.

If you wish to clear the currently set background, select Clear Background from the View tab in the
ribbon.
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Power management

Power consumption equates largely with heat generation and increased energy consumption. With
millions of machines in use, and sometimes hundreds located within the same company or School, the
desire to conserve energy has grown from a minor-issue to a major issue over the last ten years.

Power management is a technique that enables hardware and software to reduce system power
consumption. It works by shutting down portions of the hardware during periods of downtime,
meaning that the machine is ready to work when you are and conserve energy when you are not.
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Student power on

To power on a NetSupport School Student, the machine must have a Wake-on-LAN network adapter
and a BIOS that will support it (consult your network adapter documentation for more information).
The Student must also be known to the Tutor. The Tutor sends a Wake-on-LAN packet to the Student
network adapter, which instructs the machine to power on.

To power on a NetSupport School Student
1. Select the icon(s) of the Students you wish to power on.

Or

To select all Student machines that are powered off, click the Select powered off machines
L icon on the status bar.

2. Select the Administer tab in the ribbon and click Power On.

3. The Student machines will now power on.
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Student power off

NetSupport School uses the Advanced Power Management (APM) features of the Windows Operating
System (where supported) to provide Student power-down capabilities. APM relies on the Student
machine having an ATX motherboard and ATX power supply.

A Tutor can remotely power off a Student machine using the NetSupport School Power Management
function.

To power off a NetSupport School Student
1. Ensure all open applications at the Student machines are closed.
2. Select theicon(s) of the Students you wish to power off.

3. Select the Administer tab in the ribbon and click Power Off.
Or

Right-click a Student and click the Power Off & icon.
Or

To power off all Student machines that are not logged in, select the Administer tab in the ribbon,
click the Power Off icon drop-down arrow and select Power off logged out machines.

4. Click Yes to confirm that you want to power off the selected Student machines.

Note: If you don't want to see this message in the future, click Don't show this again. It can
be turned back on in the Tutor User Interface settings.

5. The Student machines will now power off.

105



NetSupport School 15.10

Student disconnects from an active session

During an active session, you may find that Students inadvertently disconnect, for example, when

they reboot their machine. Each time a Student disconnects, a message will appear advising which
Student has disconnected. You can dismiss this prompt or leave it to time out, as it will allow you to
continue working. This message can be disabled if required.

To disable the disconnect prompt
1. Click Options in the Tutor Console and select Settings from the drop-down menu.
2. Select User Interface - Tutor.

3. Select the Silent Disconnect option and click OK. The next time a Student disconnects, no
message is displayed.

Note: To automatically reconnect to Students when they become available, ensure that the
Automatically Reconnect Students option is selected in the Tutor User Interface settings.
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Removing a Student from a class

You can delete old Student icons from a class.

1. Right-click the required Student icon and click the Remove U icon.

2. A prompt will appear asking for confirmation. Click Yes.

Note: If you don't want to see this message in the future, click Don't show this again. It can be
turned back on in the Tutor User Interface settings.

107



NetSupport School 15.10

Configuring NetSupport School for subnet browsing

If your network is running across multiple TCP/IP subnets, you need to configure NetSupport School to
use the additional subnets when browsing for Students.

Before configuring NetSupport School to browse on a remote IP subnet, it is useful to understand how
IP addresses are made up and, in particular, what an IP broadcast address is.

To configure the NetSupport School Tutor to browse IP subnets

1. Click Options in the Tutor Console and select Network Settings from the drop-down menu.

2. Select Network and Wireless settings.

3. Click Settings in the Browsing section.

4. The Configure TCP/IP Client Browsing dialog appears.

5. Click Add and enter the broadcast address of the network you wish to browse if known.
Or
To enable NetSupport School to calculate the broadcast address, click Advanced and enter a
target IP address followed by the subnet mask or enter the required address range.

6. Click OK.

Notes:

When adding the address of a remote subnet, you must ensure that the broadcast address for
the local subnet is also present. If not, the Tutor will not find any local Students when you
perform a browse.

Some network routers will suppress broadcast packets from being transmitted across WAN
links. If this is the case, then even if the Tutor is correctly configured, you will not be able to
browse the remote subnet.
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Understanding IP addresses

An IP address is made up of 4 bytes, each byte being made up of eight bits, which can have a value of
1 or 0. This gives possible IP addresses of 0.0.0.0 to 255.255.255.255.

Each IP address is also split into two portions, a network portion, which identifies the network the
device is on, and the local or host portion, which identifies a particular device.

The subnet mask defines the position of this split between the network and host portions of the
address, which is associated with the address. The subnet mask is also a four byte number. Each bit in
the subnet mask that is set to 1 denotes that the corresponding bit in the IP address is part of the
network portion.

For example, if we have an IP address of 10.10.2.21 and a subnet mask of 255.255.255.0

IP address 10 .10 .2 .21
Subnet mask 255 . 255 . 255 .0

IP address in 00001010 . 00001010 . 00000010 . 00010101
binary

Subnet mask in 11111111 .11111111 . 11111111 . 00000000
binary

Network portion of 00001010 . 00001010 . 00000010 . 00000000
IP address

Host portion of IP 00000000 . 00000000 . 00000000 . 00010101
address

Network portion of 10 .10 .2 .0

IP address

Host portion of IP 0 .0 .0 21
address

Therefore, when we send an IP packet to 10.10.2.21, we are actually sending a packet to device 21 on
network 10.10.2.0

In the example above, the network 10.10.2.0 can have 256 host addresses, 0 to 255. However, two of
the host addresses, the first and last, on each IP network are reserved. The reserved host address with
all bits set to 0 is the network address, and the one with bits set to 1 is the broadcast address.

In our example network of 10.10.2.0

10.10.2.0 is the network address
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10.10.2.255 is the broadcast address.

When an IP packet is sent to a networks broadcast address each device on the IP network will receive

this packet.

It is this IP network broadcast address, which is used when configuring NetSupport School Tutor to
browse on an IP subnet other than its own.
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Implementing NetSupport School in a Terminal Server
environment

A NetSupport School Tutor can connect to Students within a Terminal Server environment.

For ease of implementation, NetSupport School provides a downloadable setup package which will
guide you through the required installation and configuration processes. For full instructions, please
visit our Knowledge Base and refer to product article: Setting up NetSupport School to runin a
Microsoft Terminal Server environment.

Note: Terminal Server and other thin clients may not be configured to use the NetSupport
Connectivity Server.

Connecting to a NetSupport School Student running in a Terminal Server
session

The preferred method to connect to the Students running in the Terminal Server Sessions is using the
Connect via Room Mode option. Using this method, it's possible to configure the Students running
in the Terminal Server sessions to be located in a particular room depending on the user logged onto
the session.

Once the Tutor is configured to the same room as the Students, it will automatically connect to all
Students located in the room.

Note: The Student Terminal Server settings can be configured in the NetSupport School Student
Configurator.
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Installing and configuring the NetSupport Tutor
Assistant

For use in your existing NetSupport School-managed classroom environment, the NetSupport Tutor
Assistant delivers greater mobility for teachers around the classroom and is also the ideal tool to allow
teaching assistants to help with monitoring student progress. The NetSupport Tutor Assistant works
on iOS devices running version 9 and higher and is available for free from the Apple App store.

Stage 1 - Configuring the NetSupport School Tutor to connect to the
NetSupport Tutor Assistant

||O !
When you first run the Tutor Console, a Tutor Assistant =% icon appears in the Class tab in the

ribbon (if this has been hidden, you can access it in the Administer tab). From here, you can set a
passcode to authenticate connections from the Tutor Assistant. To access the full Tutor Assistant
configuration settings:

1. Click Options in the Tutor Console, select Settings from the drop-down menu and choose
Tutor Assistant.

2. The Tutor Assistant configuration settings dialog will appear.

3. Enter a name for the NetSupport School Tutor that will appear at the Tutor Assistant.

4. Enter the connection port and if required, enter a connection password that the Tutor Assistant
will need to enter to connect to the Tutor.

5. Decide whether to allow Tutor Assistants to be automatically authorised or manually authorised.
6. Click Start to start the Assistant Server - The current IP address will be displayed.

7. Click OK.

Stage 2 - Installing the NetSupport Tutor Assistant
1. Download the NetSupport Tutor Assistant from the appropriate app store.
2. Open the Tutor Assistant app.

3. Enter the IP address of the NetSupport School Tutor Console and the connection password (if
set).

4. The default portis 37777. This can be changed but would also need to be amended at the
NetSupport School Tutor.

5. Select Connect and the Tutor Assistant will connect to the selected Tutor Console.

Note: Depending on the settings in the Tutor Console, the Tutor Assistant may need to be authorised
before it can connect to the Tutor Console.
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Once the Tutor Assistant service is started and connections are allowed, the Tutor Assistant icon in

the Administer tab in the ribbon changes to . An indicator appears on the icon showing the
number of Tutor Assistants connected. Click the Tutor Assistant icon to start/stop the Tutor
Assistant service, authorise devices if using manual authorisation (a warning indicator appears
advising you that devices are waiting for approval), disconnect devices and access the configuration.
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Features supported on tablets:

Support for iPad tablets.

View student thumbnails.

Send students a pre-set message.
Block restricted websites.

Set approved websites.

Block all internet access.

Lock/unlock student computers.

Logoff student computers.
Blank/unblank student screens.
Restrict student printing.

Set approved applications.

Block restricted applications.

Select a group of students.

Details view - showing key student information in sortable columns.
View student help request notifications.
Zoom on student.

Sort students by hame/tutor order.
View current application.

View current websites.

Set connection password.

Tutor badge, displaying the number of currently connected Tutor Assistants.

Features supported on smartphones:

Support for Apple iOS smartphones.
Send students a pre-set message.

Block restricted websites.
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Set approved websites.

Block all internet access.
Lock/unlock student computers.
Logoff student computers.
Blank/unblank student screens.
Restrict student printing.

Set approved applications.
Block restricted applications.

Set connection password.
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Installing and configuring the NetSupport School
Student for Google Chrome

NetSupport School delivers the tools you need to help maximise the effectiveness of computer-led
teaching in a Google Chrome environment.

The NetSupport School Student for Chrome extension can be installed on each student machine
running Google ChromeOS. From the teacher's machine (Windows), you can then connect to each
Chromebook system, enabling you to monitor the screens and interact with each student quickly and
efficiently.

Note: The Chrome Student extension now supports Manifest V3. The minimum supported version of
ChromeOS is 99.

Planning an installation

For a teacher to be able to monitor and interact with their students using Google Chromebooks, the
NetSupport Connectivity Server must be installed on a Windows Server; the NetSupport School Tutor
must be installed on a Windows computer and the NetSupport School Student for Google Chrome
extension must be installed onto each of the students' Chromebooks.

Configure NetSupport School Windows Tutor to connect to Google Chrome
Students

1. Click Options in the Tutor Console and select Network Settings from the drop-down menu.
2. Select Network and Wireless Settings.
3. Under TCP/IP settings, select Include Chromebooks and click Settings.

4. Enter the Gateway address, port number and security key. This must be the same as set in the
Name and Connectivity Server. Ensure that Connect by Hostname is not selected.

5. Click OK.

6. You can now browse for Google Chrome Students in Room mode, User mode, using the Fixed
List or SIS mode.

Installing and configuring the NetSupport School Student for Google
Chrome extension

If your organisation uses Google Apps for Domains, you can centrally manage the NetSupport School
settings within the Google Admin Console. For full instructions, refer to technical document: Centrally
configuring and deploying the NetSupport School Student extension for Google Chrome.
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1. Download the NetSupport School Student for Google Chrome extension from the Google
Chrome store.

2. Enter the URL chrome://settings/extensions to access the 'Extensions' configuration page.

3. Locate the NetSupport School Student for Google Chrome extension and click Options.
4. Enter the Gateway address and port number of the Name and Connectivity Server.

5. If connecting to Students using Room mode, decide what room the Student is going to be
assigned to.

6. Optionally, enter a name that identifies this Student.

7. Once you have entered the required student configuration options, it is recommended that you
protect the settings by entering a password.

8. Click Save to store the configuration.

9. Rather than having to manually configure each Chromebook, multiple installations using the
stored options can be centrally managed in the Google Admin Console. Click Export As File to
create a configuration file containing the settings. Before the file is generated, you have the
option to allow changes to the Client name and MAC address fields on the Options page. By
default, the generated file will disable these two settings.

10. Click Generate File. By default, the file will be named Config.json. This file can then be
uploaded in the Google Admin Console in order to centrally apply the NetSupport School Student
configuration to the required devices. If you require any assistance with this, our Support team
will be happy to help.

A connection status indicator is displayed at the Student, showing the current connection state
between the Student device and Tutor machine. The indicator colours are:

Red = no connection.

Yellow = attempting a connection.

Orange = connected to the NetSupport School Name & Connectivity Server.

Green = connected to NetSupport School Tutor/current class.

Note: To ensure you retain full visibility of your students' internet use, it is recommended that you
'disallow' Incognito Mode in the ChromeOS User Settings via Google Apps for Education.

If you selected the 'Non-Windows' licence type during installation, the Tutor Console has a cut-down
set of features.

Feature highlights
* View a real-time thumbnail of each student Chromebook in a single view.

e Zoom in to view a larger thumbnail of any selected student Chromebook.
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* Open a separate view session to discreetly monitor a selected student's screen and take a closer
look at activity - perfect for ensuring students are on task with their learning activities. (The
open browser activity can be viewed in Thumbnail and View modes, along with the option to
view the full desktop if required.)

* The teacher can set objectives and expected outcomes for the current lesson.
* Ask students to register at the start of each lesson.

+ Show the teacher's screen. Ensure student attention and focus when presenting by 'showing' the
teacher's desktop to selected student Chromebooks.

* Multi-monitor support. If the teacher is using multiple monitors, select an individual screen to
show to students or show all.

¢ Show an application to selected students.
e Lock the student's mouse and keyboard when instructing.
* Send an instant survey or request for feedback to each student and display results in real-time.

* Open a discussion session with selected or all students, enter their comments and share with the
rest of the class.

* Send an attention-grabbing message or instruction to each student Chromebook.

* Request help facility - students can send a request for help to the teacher.

¢ Block unauthorised websites.

* Use approved websites only.

e Block all internet access.

e Launch a website on the Student Chromebook.

* Copy the content of the clipboard between teacher and student machines during a view session.

» See details of the website that students are currently viewing.

Note: To view the full desktop of a Student, the Student needs to acknowledge an on-screen prompt.
If you prefer not to offer this option and only want to view the Student's open browser window, the
prompt can be disabled. For further information, refer to technical document: Behaviour when viewing

Student Chromebooks from a NetSupport School Windows Tutor.
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Licensing for Google Chrome

Each Google Chrome device that connects to the NetSupport Connectivity Server needs to be licensed.
Google Chrome licences can be purchased independently of the main NetSupport School product and
are registered with the Name and Connectivity Server by loading a new licence file (NSW.LIC). This file
controls the number of Google Chrome Students that can connect. If this file is not present, then the
usual Name and Connectivity licence file (NSM.LIC) will allow Google Chrome to connect, but this will
reduce the licence count available for NetSupport School Students.

e.g.

With both an NSM.LIC (ten user) and NSW.LIC (ten user) the software will independently limit to ten
connections of each type. With ten NetSupport School Students connected, the eleventh Google
Chrome Student would be rejected.

With just a NSM.LIC (twenty user) the software would limit to a maximum of twenty connections of
regardless of whether they are from Google Chrome or standard NetSupport School Students.
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Installing the NetSupport School Tutor for Android

For installation on a teacher's Android tablet, the NetSupport School Tutor for Android extends the
product's capabilities into dedicated tablet-based classrooms, giving the teacher the power to connect
to each student device and enabling real-time interaction and support.

Note: Student tablets must be running the NetSupport School Student app.

Installing the NetSupport School Tutor for Android

If you wish to manage the class as the teacher, you will need to install the NetSupport School Tutor
(Control) on your device.

The NetSupport School Tutor for Android app works on Android v5 or later tablets and is available from
the Google Play store.

For further information on installing and using the Tutor for Android, please refer to our Android Tutor
documentation.

Features:
¢ View Student thumbnails
e Watch Student screen
¢ Real-time student assessment (Question and Answer mode)
¢ Class surveys
e Student register
* Lesson objectives
e Chat
* Sending messages
e Student request help
e Launch websites
e Student rewards
e File Transfer
¢ Lock/unlock student computers
e Blank Student screens
* Wi-Fi/battery indicators

¢ Launch at Start-up. The NetSupport School Student for Android will launch when the device is
powered on and will automatically sign in (where the device is located in a fixed room).
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Installing and configuring the NetSupport School
Student for Android

NetSupport School delivers the tools you need to help maximise the effectiveness of technology-led
teaching on Android devices.

The NetSupport School Student for Android can be installed on each Android tablet. From the teacher's
desktop, you can then connect to each system enabling you to interact with each student quickly and
efficiently.

The NetSupport School Student for Android app works on Android tablets version 12 or above and is
available for free from the Google Play store.

From version 15.10.0003 the NetSupport School Student for Android only supports Android devices
compatible with the latest CPU architecture - arm64-v8a ABI for 64-bit ARM processors. For more
information, see NetSupport School Student for Android - change to CPU architecture support from
version 15.10.0003.

Note: A NetSupport School Tutor for Android app is available to use on your Android devices.

Set up and configure the NetSupport School Student for Android

You can pre-configure each device with the required password-protected classroom connectivity
settings from the device or 'push’ the settings to each device from within the NetSupport School Tutor
program:

1. Select the Administer tab in the ribbon and click Apply Student Settings.

2. The Student Settings dialog will appear.

3. Select the students you wish to send the settings to.

4. To amend the configuration settings, click Modify.

5. The Modify Student Settings dialog will appear.

6. Setthe required options and click Save.

7. Ifapassword has already been set at the Android device, enter this.
8. Click Send.

9. You can now browse for Android Students in Room mode.

Note: In certain environments, the NetSupport School Tutor Console may not locate the Android
Students during its browse. For further information on how to locate and connect to Android devices,
please visit our Knowledge Base and refer to product article: What to do if the Android Students are
not found by a Tutor Console browse at startup.

120


https://play.google.com/store/apps/details?id=com.netsupportsoftware.school.student&hl=en
https://kb.netsupportsoftware.com/knowledge-base/netsupport-school-student-for-android-change-to-cpu-architecture-support-from-version-15-10-0003
https://kb.netsupportsoftware.com/knowledge-base/netsupport-school-student-for-android-change-to-cpu-architecture-support-from-version-15-10-0003
https://kb.netsupportsoftware.com/knowledge-base/what-to-do-if-the-android-students-are-not-found-by-a-tutor-console-browse-at-startup/
https://kb.netsupportsoftware.com/knowledge-base/what-to-do-if-the-android-students-are-not-found-by-a-tutor-console-browse-at-startup/

NetSupport School 15.10

If you selected the 'Non-Windows' licence type during installation, the Tutor Console has a cut-down
set of features.
Features supported on Android:
e Student register.
* Lesson objectives.
* Receive messages from the Tutor.
¢ Student request help.
e Groupor1:1chat.
¢ Student survey.
¢ Lock/unlock student computers.
¢ Real-time instruction (Show mode).
e View Student thumbnails.
e Watch Student screen.
e Student rewards.
« Wi-Fi/battery indicators.
e Launch URL at the Student.
e Blank Student screen.
¢ Question and Answer mode.
» File Transfer.
« File Distribution.

¢ Launch at startup. The NetSupport School Student for Android will launch when the device is
powered on and will automatically sign in (where the device is located in a fixed room).

Note: When you view a Student's screen, a prompt appears asking the Student to confirm before you
can connect. If they don't allow this, you are unable to view their screen.
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Installing and configuring the NetSupport Browser app
(i0S)

NetSupport School delivers the tools you need to help maximise the effectiveness of technology-led
teaching on iOS devices.

The app also supports NetSupport DNA's core desktop management capabilities, enabling you to
gather key system inventory details and monitor online activity. For more information on NetSupport
DNA, visit our website.

The NetSupport Browser app can be installed on each iOS device. From the teacher's desktop, you can
then connect to each system enabling you to interact with each student quickly and efficiently.

The NetSupport Browser app works on iOS 14 and above and is available for free from the iTunes
store.

Note: NetSupport School functionality is supported on tablets only.

Set up and configure the NetSupport Browser app

You can centrally configure and push out the settings using an MDM solution. For further information,
please refer to our NetSupport Browser app for iOS documentation.

If you selected the 'Non-Windows' licence type during installation, the Tutor Console has a cut-down
set of features.

Features supported on iOS:

+ Student register - The teacher can request standard and custom information from each
student at the start of a lesson.

+ Lesson objectives - If provided by the teacher, once connected, students are presented with
details of the current lesson along with the objectives and expected learning outcomes.

« Sending messages - The teacher can broadcast messages to selected devices.

* Chat - The student and teacher can initiate a 1:1 chat session and participate in group
discussions.

« Request help - Students can alert the teacher when they require assistance.
* Lock screen - The teacher can lock the app to gain attention.

+ Restrict Internet -The teacher can employ a list of approved/restricted websites for use during
the lesson.

« Question and Answer module - Enables the teacher to conduct instant student and peer
assessment. Deliver questions verbally to the class, then select students to answer - randomly,
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first to answer or in teams. Bounce questions to multiple students and ask the class to peer
assess a response.

Class survey - Teachers can conduct on-the-fly surveys to gauge student knowledge and
understanding.

Show screen - While presenting, the teacher can show their desktop to connected devices.
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NetSupport School Windows 10 Tutor App

Provided in addition to the desktop Teacher application for Windows, the native Teacher App is
designed for installation on Windows tablets and touch-enabled devices. It is a complementary
component and is available for download from the Windows store.

Note: For further information on installing and using the Teacher App, please refer to our Windows
10 Teacher App manual.

Simplicity and ease of use are at the heart of the Teacher App and many of our core classroom
features are provided within the new streamlined interface:

Transfer documents and resources directly from local or cloud-based OneDrive files, to all or
selected students.

Copy key lesson content into and work with OneNote Class Notebooks using NetSupport
School's digital Student Journal feature.

Direct integration with Microsoft School Data Sync, enabling teachers to instantly access their
online Student Information Systems (SIS) classrooms and student accounts at the start of a
NetSupport School-managed lesson.

Launch NetSupport School features using Cortana voice commands. 'NetSupport School blank
screens!’

Support for Microsoft Surface Dial - display a radial menu of NetSupport School features for
quick and easy execution of common tasks.

Multi-platform support - connect in any combination to Students using Windows, Chrome OS,
Android, Apple Mac or iOS devices.

Power on or off, log in/log out or reboot classroom computers.
Present lesson objectives and expected outcomes.

Gather and print a student attendance register.

Monitor student help requests.

Lock or blank students' screens to gain attention.

Monitor student screen thumbnails.

View individual students.

Chat and send messages to the class.

Monitor and restrict internet use.

Monitor and control application use (desktop and store).

Launch applications and websites on student screens.

124


https://www.microsoft.com/store/apps/9NBLGGH1NTSQ
http://resources.netsupportsoftware.com/resources/manualpdfs/NSS_Win_10_Manual_UK.pdf
http://resources.netsupportsoftware.com/resources/manualpdfs/NSS_Win_10_Manual_UK.pdf

NetSupport School 15.10

Conduct quick end of lesson surveys.
Measure progress - including peer and individual assessment, scores and more.

Prevent data being copied to or from USB storage and CD/DVD devices, plus mute/unmute
sound at student machines.

Virtual whiteboard supported by a wealth of drawing tools for improved classroom collaboration.

Toggle the NetSupport School Student Toolbar on or off on the fly.

125



NetSupport School 15.10

Licensing for Tablets

Each Android or iOS tablet that connects to the NetSupport School Tutor needs to be licensed.
Licences for tablets can be purchased independently of the main NetSupport School product and are
registered with NetSupport School by loading a new licence file (NSW.LIC). This file controls the
number of tablet Students that can connect. If this file is not present, then the usual licence file
(NSM.LIC) will allow tablet Students to connect, but this will reduce the licence count available for
NetSupport School Students.

e.g.
With both a NSM.LIC (10 user) and NSW.LIC (10 user) the software will independently limit to 10
connections of each type. With 10 NetSupport School Students connected, the 11th tablet Student
would be rejected.

With just a NSM.LIC (20 user) the software would be limited to a maximum of 20 connections,
regardless of whether they are from a tablet Student or a standard NetSupport School Student.
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Integration with Active Directory

NetSupport School integrates with Microsoft's Active Directory structure enabling you to centrally
manage Student configurations and Tutor configurations.

To make the task a little easier NetSupport School supplies four ready-made Administrative
Templates, NSS_Student_machine.adm, NSS_Student_User.adm, NSS_Tutor_Machine.adm and
NSS_Tutor_User.adm containing the configurable options. When you install NetSupport School the
template is copied to the NetSupport School program folder. In turn, you will need to copy this to the
folder containing any existing ADM templates.

To apply Student configuration changes via Active Directory
1. Atthe Domain Controller, select the Active Directory Users and Computers tool.

2. Decide at which level to apply the policies, domain or organisational. Right click and select the
Group Policy tab.

3. Select the desired policy to add the NetSupport School template to and click Edit.

Or

Select Add to create a new Policy.
4. Inthe Group Policy Editor under Computer Configuration, select Administrative Templates.
5. Rightclick and select Add/Remove Templates.

6. Click Add and specify the location of NetSupport School's ADM file and click Open. The new
NetSupport School policy will be added.

7. Click Close.

8. By default, each NetSupport School policy option is disabled.

To enable certain configurations at the Student or Tutor using the NetSupport School ADM Template
files, you are required to enter an encrypted value, for example, the security key policy requires an
encrypted security key to be entered. When configuring this through the ADM Template files, you
cannot enter the security key in plain text as this would not be recognised by the Student, so you have
to enter the encrypted security key value into the policy.

Note: Please refer to the NetSupport website support area, www.netsupportsoftware.com/support for
the latest information on installing via Active Directory, Active Directory policy files, instructions on
upgrading from previous versions and applying NetSupport Student profiles within Active Directory.
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Using NetSupport School in a wireless classroom

It is recognised that wireless networks generally do not perform as reliably as wired networks as they
use radio frequencies to transmit data and these are susceptible to interference. In addition,
simultaneously connecting a large number of devices to a wireless access point will have a negative
impact on the bandwidth allocated to each.

When using NetSupport School in an un-optimised wireless environment, the above can result in poor
performance and student devices frequently disconnecting from the Tutor Console.

NetSupport School uses advanced techniques to limit the effects of an unreliable wireless network. For
further information about planning an installation of NetSupport School within a wireless environment,
please see the following technical document: Using NetSupport School in a wireless Classroom.

Optimising NetSupport School for use in a wireless environment

Once you have established a reliable wireless connection between the devices in your classroom, there
are some settings within the Tutor Console that you can change to optimise performance on your
wireless network.

A school will have a finite amount of network bandwidth available; viewing the students' screens,
distributing files or broadcasting the teacher's screen simultaneously will consume this bandwidth.

NetSupport School provides multiple configuration options designed to reduce the amount of data sent
across the network, which will result in improved performance. These options can be found under their
respective configuration sections in the Tutor Console.

Note: For general advice on reconfiguring your access point. Please visit our Knowledge Base and
refer to product article: Optimising NetSupport School on wireless networks.

For a wireless environment, it is recommended that the options within the Performance section of the
Tutor settings are set as follows:

Colour reduction: Allows you to set the maximum colour depth when viewing and showing to
Students. By default, this is set to 256 (high) colours.

Low bandwidth mode: The humber of video frames transferred will be reduced to around 5 per
second. Setting this to Wireless will automatically turn on low bandwidth mode when wireless
students have been detected.

Additionally, within the Network and Wireless Settings section of the Tutor Console, it is recommended
that the following option is enabled when using NetSupport School on a wireless network:
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Enable Broadcast Show and File Distribution: When broadcasting the teacher's screen or
distributing files to multiple students, enabling this option will result in the screen data or files being
sent to all machines simultaneously.

Finally, performance can further be enhanced by reducing the speed that the Tutor Console sends data
onto the network to match the speed that the wireless access point can deliver the data. Sending data
onto the network too quickly may result in packets being lost, which will result in the students
requesting the data again and additional traffic being produced on the network.

For a wireless environment, it is recommended that the following options are set:

Wireless Network: Select this option to optimise NetSupport School for best performance in a
wireless environment.

Maximum Throughput: This option provides the ability to fine tune the speed that the Tutor Console
sends data to the connected student devices.
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Using the NetSupport Connectivity Server to find
Student PCs

The NetSupport Connectivity Server or 'Name & Connectivity/Gateway', is provided as an optional
installation component. Its purpose is to provide a simple and reliable method of locating and
connecting to Student PCs in LAN/Wireless network environments. This can be particularly useful
where students transport laptops from class to class, making it difficult for traditional connectivity
options to find them.

Once configured, Student PCs connect to the NetSupport Connectivity Server on start-up and register
their availability and current IP address with the Server. At the Tutor end, when browsing to locate
Students, a search of the NetSupport Connectivity Server is performed rather than a UDP browse
across the network. The Tutor program uses the IP address registered with the NetSupport
Connectivity Server.

The NetSupport Connectivity Server can be used with all start-up modes.

The advantages of using a NetSupport Connectivity Server over traditional browse options are:

Negates the need to browse the network to locate Student PCs.
* Reduces the time taken to locate Students.
e Reduces the need to configure and maintain broadcast range entries in the Tutor configuration.

* More reliable connection method in wireless LAN environments. The Tutor uses the current IP
address when establishing connections. Avoids problems in wireless environments where
Student laptops change access points and are assigned new IP addresses.

¢ Connect to your SIS environment using OneRoster or Google Classroom.
The basic requirements for using a NetSupport Connectivity Server are:

« It needsto beinstalled on a PC that is accessible to all Tutor and Student PCs.
+ It needs to have a static IP address.
* The Tutor and Student PCs need to be configured to use the NetSupport Connectivity Server.

* The Connectivity Server, Tutor PC and Student PC must have a matching NetSupport
Connectivity Server Security key configured.
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Installing and configuring the NetSupport Connectivity
Server

A 'NetSupport Connectivity Server' or 'Gateway' is designed to run on a machine that is accessible
from both the Tutor and Student PCs. It must, therefore, have a fixed or static IP address. The
Connectivity Server can be installed as a standalone component on the machine you wish to use, or
along with other NetSupport School components.

When performing a NetSupport School installation, select the Name and Connectivity Server
component from the Custom Setup screen. You will also need to configure the Server (Gateway)
properties. At the end of the installation the NetSupport Connectivity Server Configuration dialog will
appear or after installation, you can launch the dialog by right-clicking on the Connectivity Server
icon in the system tray, or from the NetSupport Connectivity Server Console File menu.

Note: To display the Connectivity Server icon in the system tray, choose {Start}{Programs?}
{Startup}{Connectivity Server}. On Windows 8 machines, right-click in the Start screen and choose
All Apps at the bottom of the screen. Click the NetSupport School Name Server Console icon.

The Connectivity Server is configured with the IP address of the Connectivity Server machine and a
security key. This same information must also be entered at both the Tutor and Student machine, thus
validating connections between the various components.

Once the Tutor and Student connectivity options are set to use the designated Connectivity Server,
each time the Student machine starts up, its current IP address will be registered with the Server. In
turn, the Tutor will check the currently defined method for browsing for Students at start up but rather
than performing a UDP browse of the network it will poll the Connectivity Server to find Students
matching the criteria.

Note: If connecting to Students via the Name & Connectivity Server in Room mode, it is necessary to

set the NetSupport Connectivity Server settings at the Tutor in both the Tutor Configurator and the
Student Configurator.
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NetSupport Connectivity Server Configuration Utility -
General tab

You use this dialog to configure the properties of the NetSupport Connectivity Server (Gateway).

You can access the dialog at the end of the installation, when the dialog will appear automatically, or
via the NetSupport Connectivity Server ki icon which appears in the system tray. Right-click on
the icon and select Configure Connectivity Server. The dialog can also be accessed from the
NetSupport Connectivity Server Console, select {File}{Configure Connectivity Server} from the drop-
down menu. Alternatively, you can run the file Pcigwcfg.exe from the NetSupport School program
folder.

Note: To display the NetSupport Connectivity Server icon in the system tray, click the Start screen,
choose All apps, NetSupport School and click NetSupport School Name Server Console.

@ NetSupport Connectivity Server Configuration Utility had
General Keys Licenses Security Classes
Listening Port and Interfaces

(®) Listen on all TP interfaces

Port(s): 443
(e.0. 443C, 3085C, 4000 etc.)

(O Listen on specified TP interfaces

IP Address Paort

Comms. Management Packet Interval

CMPI (secs):

Event Log Files

Location: C:\Program Files (x86)\Common Files\MNSL\Conn

Max. file size (KB): 1000 Browrse...

[ autormatic recovery if service stops abnormally

Cancel Apply Help

Listening Port and Interfaces

Listen on all IP interfaces: By default, the installed NetSupport Connectivity Server component
uses the local IP address(es) and communicates through port 443.

Listen on specified IP interfaces: You can add multiple IP addresses or enter a specific IP address,
select Add and enter the IP address.

Note: The IP address of the Connectivity Server machine and key will also need to be configured at
both the Tutor and Student machine.
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Comms. Management Packet Interval

CMPI (secs:): When configured for NetSupport Connectivity Server connections, the Student
machine confirms its availability by periodically polling the NetSupport Connectivity Server. By
default, a network packet is sent every 60 seconds, but you can change this if required.

Event Log Files

NetSupport Connectivity Server activity during an active session is recorded in a text file, default
GWO001.LOG. This can be useful for checking which Students and Tutors have connected through the
NetSupport Connectivity Server.

Location: By default, the log file is stored in: C:\\Program Files\Common Files\NSL\Connectivity
Server\GWO001.log. Select Browse to specify an alternative path.

Max file size (KB): Over a period of time, the log file could become quite large, you can manage this
by specifying a maximum file size. When the limit is reached the existing information in the file is
overwritten by the new records.

Note: For changes to the log file settings to take effect, you need to restart the Gateway32 service.

Automatic recovery if service stops abnormally

By default, the Gateway service will automatically recover if there is an abnormal shutdown.
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NetSupport Connectivity Server Configuration Utility -
Keys tab

@ NetSupport Connectivity Server Configuration Utility X
General Keys Licenses Security Classes
Connectivity Server Keys:
Description Creation Date
NCS Key 1 Mon Oct 30 11:13:53 2...
OK Cancel Apply Help

Connectivity Server Keys

Access to a NetSupport Connectivity Server is protected by use of a security key.

The NetSupport Connectivity Server will not accept connections from a Tutor or Student unless a
'Connectivity Server key' is specified, and that same key is also configured at both the Tutor and
Student end. The NetSupport Connectivity Server can support multiple keys. At least one key must be
specified.

Select Add to specify the key. The key must be at least 8 characters.
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NetSupport Connectivity Server Configuration Utility -
Licences tab

Displays all licences stored in the NetSupport School directory. If you do not have an internet
connection, you can manually activate your NetSupport School licence here.

@ NetSupport Connectivity Server Configuration Utility X
General Keys Licenses Security Classes

Available license files:

License File Serial Quantity Status
C:\Program Files (x86)\NetSupp... EVL1000 40 Clients Eval

[o ]| o | oaw | e

An activation code is required. Contact NetSupport or your reseller for this. Click Activate and enter
the code. You will then need to restart the NetSupport Connectivity Server.

Note: If an internet connection is available, the licence will activate automatically and the NetSupport
Connectivity Server does not need to be restarted.
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NetSupport Connectivity Server Configuration Utility -
Security tab

The NetSupport Connectivity Server provides support for an enhanced level of encryption to be used
when initiating communications from remote computers.

@ NetSupport Connectivity Server Configuration Utility X
General Keys Licenses Security (Classes

Enable encryption of communications to remote computers

[[]Block any remote computers not using encrypted communications

Enable encryption of communications to remote computers

When enabled all communications in the connection process are encrypted.
Note: The remote computers (Tutors and Students) need to be running version 10.61 or later.
Block any remote computers not using encrypted communications: Earlier versions of the

Tutor and Student programs do not support the enhanced level of encryption. Selecting this option will
block connections from remote computers running earlier versions of the Tutor or Student software.
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NetSupport Connectivity Server Configuration Utility -
Classes tab

The NetSupport Connectivity Server provides direct integration with OneRoster or Google Classroom,
providing access to your online SIS (Student Information Systems) classrooms and student accounts.

@ NetSupport Connectivity Server Configuration Utility X
General Keys Licenses Security Classes
Class datasource
@® None

O ClassLink OneRoster
Tenant Id:

Key:
O OneRoster zipped CSV files
File:
As user: Set
O Google Classroom

Project: ’

Syncs per day: ’ 1 at: 00 ~| |00 v

Last Checked:
Last Updated:

o ][ concel || aosly Hep

Class datasource

None: Select this option if you are not integrating with SIS.

ClassLink OneRoster: Select this option to link to ClassLink OneRoster and enter your school's
Tenant ID. For added validation, enter the matching NetSupport School Security/API Key provided in
your Roster Server Portal. (The key can be found in the OneRoster Server Portal by selecting,
Applications > NetSupport School > API Key and Secret.) For information on integrating with
ClassLink OneRoster, please see the following technical document: NetSupport School SIS integration

with ClassLink OneRoster.

OneRoster zipped CSV files: Alternatively, you can use zipped CSV files. Click and browse to
the required files.
Notes:

* For further information on creating CSV files and performing bulk and delta imports using these
files, please refer to the following technical document: Using CSV files to import SIS/MIS data.

e The CSV files must conform to the OneRoster standard.
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* The first time you configure the NetSupport Connectivity Server to use OneRoster zip files, you
must do a bulk export of your SIS data.

Google Classroom: Select this option to link to Google Classroom. Click to browse for and select
one of the JSON files that you have copied to the machine (both files must be present, but either file
can be selected). For information on how to set up a Google Classroom Project and create the required
JSON files, please see the topic: Integrating NetSupport School with Google Classroom.

Click Apply and you will be prompted to sign into Google G Suite with administrator credentials and
grant access to NetSupport School.

Syncs per day

By default, the Connectivity Server will sync with OneRoster or Google Classroom once a day. This can
be amended by entering a different value here. You can also specify the time the sync will take place.

Click Sync now to synchronise the NetSupport Connectivity Server. Clicking Reset Data will clear all
previous data stored and, if there is a lot of data to download, this may take some time.
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NetSupport Connectivity Server Console

The key to a successful remote support solution is the ability to locate and connect to devices no
matter where they are. NetSupport School provides a range of connectivity methods as standard.

The NetSupport Connectivity Server is a central hub for managing all your NetSupport School
connections across the internet. From the console, you can see what NetSupport School Connectivity
components are installed and in use.

To open the NetSupport Connectivity Server, right-click the NetSupport Connectivity Server
icon in the system tray and select Open or double click the icon.

fm MetSupport Connectivity Server Console - m] X
File Help
@ 2 Chant(s) connected (2 Web Chents) (Web Chents: 40) Max. Chents: 40

D 0 agent(s) connected Max. Agents: 0

O Clients = Active Sessions [@)] Services [ Servers
Chent ° IP Address MAC Address  Channel Extamal IP Security Ke... Servar
7= 7= 7 - 7= 7= 7 - 7
DJECWIN1O-1 >10.0.4.158  001550048... 10.0.4.158 Connectvi... ECWINLO-1
HPLAP-2 >10.0.4.80 68942392C.., 10.0.4.80 Connectve... ECWIN1O-1

An overview of how many Students are currently connected is displayed. Further information can be
found in each of the tabs:

* Clients: Displays a list of all the NetSupport School Students currently connected to the
NetSupport Connectivity Server.

* Active sessions: Displays a list of current connections between a NetSupport School Control
and a NetSupport School Student with the date and time that the connection started.

* Services: Displays a list of NetSupport School Tutors that are active in Room mode. This allows
NetSupport School Students to connect to the room through the NetSupport Connectivity
Server.
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Note: You can filter the contents of the Clients, Active Sessions and Services tabs, so that only items
meeting certain criteria are displayed. Enter the search term in the Filter field under the required
column heading and the matching items will be displayed. Click ¥ to clear the filter.

Exporting data

Data can be exported to a .CSV file, allowing further analysis. Select the tab you want to export data
from and select {File}{Export} from the drop-down menu bar.

To configure the settings for the NetSupport Connectivity Server, select {File}{Configure Connectivity
Server} from the drop-down menu bar.
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Working with groups

NetSupport School provides you with sophisticated grouping functions to enable you to manage and
organise different groups of Students. You can use the following functions on groups as a whole:

e« Show

e File Distribution

e Scan

* Launch applications

¢ Message

e Lock/unlock

¢ Multimedia support

» Send/collect work

* Chat

¢ Question and answer team mode

To create a group
1. Select the Group tab in the ribbon and click Add.
Or
Click the Group options = icon on the group bar and select Add.
2. The Add a group wizard appears asking you to provide a name and brief description of the

group. It will then assist you in creating your group.

Your newly created group will appear on the group bar.

Group Students randomly
1. Select the Group tab in the ribbon and click Group Randomly.
2. The Group Randomly dialog appears.

3. Select how to group the teams:

Assignh Randomly: Students are randomly assigned to groups. Enter the number of groups
required.

Student chooses: Students can choose what team to join. Enter the group names and
separate each value with a comma.
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4, Click OK.

5. The newly created group(s) appears on the group bar.

To change the members of a group
1. Select the required group on the group bar.
2. Select the Group tab in the ribbon and click Properties.
Or
Click the Group options = icon on the group bar and select Properties.
Or

Click the drop-down icon on the required group tab (mouse over the right-hand side of the group
tab to display this) and click Properties.

3. Choose the Members tab and select the Students to be removed or added.

4, Click OK.

Note: You can also remove Students from a group by right-clicking the selected Student icons and
selecting the Remove from Group * icon.
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Deleting a group

If you no longer need a group that you have defined, you can remove the group. This will not affect the
Students that are members of the group.

To delete a group
1. Select the group that you want to delete.
2. Select the Group tab in the ribbon and click Remove.
Or
Click the Group options = icon on the group bar and select Remove.
Or

Click the drop-down icon on the required group tab (mouse over the right-hand side of the group
tab to display this) and click Remove.

3. Click Yes to confirm you want to remove the group.

Note: If you don't want to see the warning prompt again, click Don't show this again. You can re-
enable this in the Tutor User Interface settings.
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Assigning a group leader

When working with defined groups of Students, the Tutor can assign 'group leader' status to a selected
member of the group. The designated leader can then take control of the group, performing many of
the tasks that the main Tutor can. The main Tutor retains overall responsibility while a group leader is
in place, and can remove the status at any time.

You can choose the functions to be performed by the group leader by clicking Options in the Tutor
Console, selecting Settings from the drop-down menu and choosing Group Leaders.

To assign a group leader
1. Select the required group from the group bar.
2. Select the required Student icon.

3. Right-click the required Student and select Assign group leader.

The Student icon in the Tutor Console is highlighted to indicate that they are a group leader. A
connection bar showing the link from the group leader to the Students is displayed. This can be
disabled by clicking Options in the Tutor Console, selecting Settings from the drop-down menu,
choosing Group Leaders and clearing the Show Visual Group Leader Connections option.
Different groups will have different colour connection bars; these will be displayed in other views when
in large icons view.

Sarah
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The Student receives a message indicating that they have been given group leader status (the Student
Toolbar shows that the Student is leading the group). They can choose to run the group leader
features immediately by clicking Run Now or at a later stage by clicking on the Run Group Leader

g icon on the Student Toolbar or the Run Group Leader. icon on the system tray. A cut-down
version of the Tutor Console opens, allowing them access to the selected features.
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Notes:

Although a Student may be in more than one group, they can only lead one group at a time.

Each defined group can have a group leader, even if one of the group members is already
leading another group.

The main Tutor can continue to monitor all Students, including group leaders.
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Suspend group leaders

During a Tutor session where group leaders are in place, the Tutor may want to perform a task without
conflicting with something the group leaders are doing. Rather than remove and reinstate each group
leader individually, you can globally suspend and reinstate group leader access as required.

To suspend group leaders
1. Select the Group tab in the ribbon and click Suspend All.

2. All group leaders will be suspended.

To reinstate group leaders
1. Select the Group tab in the ribbon and click Suspend All.

2. All group leaders will be reinstated.
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Remove group leader status

The main Tutor can remove group leader status from Students at any time.

To remove a group leader
1. Select the group containing the required Student.
2. Right-click the Student icon and select Remove group leader.

Or

Click the drop-down icon on the required group tab (mouse over the right-hand side of the group
tab to display this) and click Remove group leader.

The Student receives a message informing them that group leader rights have been removed.
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Customise Student and group icons

The Student and group icons displayed in the Tutor Console can be customised to suit individual
requirements. A choice of images can be used and you can apply these to the machine name or the
logged on user.

Customise Student and/or group icons
1. Select the required Student or group from the group bar.
2. Right-click the Student and click the Customise 2 icon.
Or
Select the Group tab in the ribbon and click Customise.

3. The Image Customisation dialog appears. Select one of the three tabs:

All Computers Applies the selected image to the machine name.

Assigns the image to the user name, so it will load at
Logged on User Name whatever machine the Student logs onto. This option takes
precedence over images applied to the machine name

Enables you to apply an image to each defined group of

Groups
P Students.

4. Select the Student name or group from the list and click Modify. If using the logged on user
name option, click Add and enter the Student's logon nhame.

5. Browse for the required icon image. A number of default libraries (*.ncl) are provided in the
Program folder, or you can select a picture of your own choosing. Highlight the required image
and click OK. Repeat this process for any other Students and groups.

6. Click OK when complete.
Note: Individual Student and group icons can be changed by amending the properties of the selected
item. Right-click the Student and click the Properties 5| icon, select the Details tab and click

Customise in the Appearance section or click the drop-down icon on the required group tab (mouse
over the right-hand side of the group tab to display this), click Properties, select the General tab and
click Customise in the Appearance section.
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Using NetSupport School

This section guides you through starting NetSupport School. It covers all the functionality such as
showing the Tutor's screen to Students, viewing the Student's screen, sending messages and much
more.

The main point to remember when using NetSupport School is that the machine doing the showing or

remote controlling, is called the Tutor or the Control and that the machines/devices being shown to or
remote controlled are called the Students or Clients.

Note: This section assumes you have already installed Students on the machines to be controlled. If
you have not done this, do so now. See Installation for details.
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Lock/unlock Students’' mice and keyboards

When you perform a Show, the Students' mice and keyboards are automatically locked. However,
there may be other occasions when you want to lock Students' keyboards and mice.

You can only lock/unlock Students that are connected.

To lock Students

1.

2.

Select the Student(s) or groups of Students you wish to lock.
Select the Class tab in the ribbon and click Lock.

Or

Right-click on a Student icon and click Lock.

Or

To lock all Students, click Lock All on the caption bar (you can do this from any window). If this
is not showing, click the Configure Quick Access List = icon on the caption bar and select
Lock/Unlock all students from the drop-down list.

Note: By default, sound is muted at the Students when locking all Students. This option can be
disabled in the Student User Interface settings.

A graphic appears on the Student machines, informing them that you have locked their mouse
and keyboard.

q;;i? NetSupEsst
School
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To unlock Students
1. Select the Class tab in the ribbon and click Unlock.
Or
Right-click a Student icon and select Unlock.
Or

If you have locked all Students, click Unlock All on the caption bar.
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Changing the graphic when locking a Student

A default graphic is displayed on a Student's screen when you lock their keyboard and mouse. This
image can be changed if required.

The lock image is stored on Student machines in C:\Program Files\NetSupport\NetSupport School.
You can change the image by replacing the nss_lock_image file with your own. Alternatively, you can
use the Student Configurator to select a different image file and then use the NetSupport School
Deploy function to deploy the new settings to all connected Student machines.

Note: The custom graphic needs to be distributed to the Student machines, and you can do this using
File Distribution.

To change the graphic using the Student Configurator

1. Inthe Student Configurator, select Advanced.

MetSupport School Client Cenfigurator e

| Search settings ( Stisdent Identification
Network Settings 1 Student Name (* = machine name, ECWIN10-1):
Room
Security Whie Viewed
@g Audio [ Slent Mode ino refresh when Viewing)
5§ User Interface [[] Send Physical Forts
& Advanced [ Enable Scrsen Scrape
@@ Journal
& Terminal Services o ©
Cache Size: 16 MB w
Image Opton
Image File
.nss_lod\ image jpg | Browse

Enable DVD Playback and Dirsct 30 support

[[] Except while viewed [ Except while connected
Keyboard Fiter Driver
[Defaut v|
cancel et

2. The Image File field shows the default file.
3. Click Browse to select an alternative file.
4. The Image File field shows the new file.

5. Click OK.

Notes:
« If you view a locked Student, the display graphic is not shown on the Student screen.

« Ifanimage file cannot be located, a black screen is displayed on the Student screen.
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Viewing a Student's screen

Having connected to a Student, you can now remote control it. This is called viewing. The Student's
screen will be displayed in a window on the Tutor machine. NetSupport School allows you to view

multiple Student screens, each in its own window, simultaneously.

Note: If required, a message can be displayed at the Student machine confirming it is being viewed.

To view a Student

1.

Double-click the required Student icon in the List view.

Or

With the required Student icon selected, select the Class tab in the ribbon and click View

Client.
Or
Right-click the Student icon and choose View Client.

The View window for that Student appears at the Tutor.

® Emma - Viewing
Home Tools Audic
@ Share @ (o] ) @ A — I"\I [y Aspect Ratio fﬁ I‘fﬁ
how L o o, O B& B
Optimise  Ctri=Alt«Del Screenshot logowt Reboot Message Scale to fit Full Touch Serd Retrieve Auto
2 Control > bt Screen  Border [\ Navigation Chipboand
Remate Wiew Clipboard

Our Solar System Planets ~ Moons v Asteroids & Comets ~ Skywatching ~

Solar System

Exploration

During June, NASA, NOAA, and people around the world are celebrating
Earth's Ocean as part of National Ocean Month. NASA has been observing
Earth's ocean from space for more than 20 years. Now, NASA is launching
missions to explore other ocean worlds.

Mute Al €} Lock Al memet(@) O = 7 B

Quick Launch

Add ~

—_oX

To aid navigation of the Student screen, a thumbnail of the screen appears (if the Student is
running multiple monitors, they are all displayed), enabling you to scroll the Student desktop
more easily. Click inside the thumbnail to view specific areas. The navigation window can be

enabled or disabled by clicking the Navigation icon on the View window ribbon.
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Notes:

» For acceptable performance while viewing, ensure that the Student's Active Desktop is turned
off.

» If the Student uses multiple monitors, you can switch between the monitors or show the whole
desktop by clicking the Monitor tab in the ribbon.

« Ifthe Tutor and the Student are both using touch-enabled devices, the Tutor can control the
Student's machine using touch commands. You can also enable a touch border. This border
makes it easier to access certain functions when using drag-touch gestures.

To stop viewing and return to the Tutor Console

1. On the caption bar, click the Close * icon.
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View modes

You can view Students in three modes:

Share The Student's screen is displayed at both the Tutor and the Student. Both the Tutor
and the user at the Student can enter keystrokes and mouse movements.

Watch The Student's screen is displayed at both the Tutor and the Student. Only the user at
the Student can enter keystrokes and mouse movements. The user at the Tutor is
locked out.

Control The Student's screen is displayed at both the Tutor and the Student. Only the user at
the Tutor can enter keystrokes and mouse movements. The user at the Student is
locked out.

To change the view mode

1. While viewing the Student, select the Home tab in the View window ribbon and select Share,
Watch or Control.

Other View window customisation options:

View

Allows you to select which monitor to view if the Student is running multiple monitors. You can view
the whole desktop or a specific monitor. If you are viewing a specific monitor, the monitor number is
displayed on the View icon image. You can see more information about the monitors by clicking the
Monitor tab in the ribbon.

Note: This option only appears if the Student you are viewing has multiple monitors.

Scale to fit

Sets the display mode for how the Student screen is displayed. Turning scale to fit on enables you to
display the whole of the Student screen in the available View area.

Full Screen

Uses the whole of the available screen area on the Tutor to display the Student's screen. A floating
toolbar is provided in Full Screen mode, allowing access to a selection of tools.

Note: To return to Windowed mode, select Ctri+Left Shift+Right Shift (these shortcut keys can be

—

customised in Tutor Configuration - Keyboard/Mouse settings) or click the Windowed () icon the
floating toolbar.

155



NetSupport School 15.10

Touch Border

When viewing a Student on a touch-enabled device (the Tutor must also be using a touch-enabled
device), you can enable a touch border. This border makes it easier to access certain functionality
when using drag touch gestures.

Aspect Ratio

Maintains the correct aspect ratio of the remote screen.

Screen Scrape

NetSupport School's favoured, and the most efficient, method for capturing screen data is to hook into
the Video Driver of the machine being viewed. However, there may be occasions when this method will
not work because certain applications bypass the driver. In these circumstances, you can enable
'screen scrape' mode in order to take a snapshot of the screen. Although this will have a greater
impact on the network, it will at least provide an accurate representation of the Student's screen.

Navigation

To aid navigation of the Student screen, a Navigation window showing a thumbnail image of the
screen is displayed (if the Student is running multiple monitors, they are all displayed). This enables
you to scroll the Student desktop more easily. Click and drag inside the thumbnail to view specific
areas.

Optimise
By default, when viewing a Student screen, the colour depth is set to 256 colour (high quality). This
option allows you to change the quality when viewing Student screens.
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Blanking the Student's screen while viewing

For security reasons, you may require the Student screen to be blank while you are remotely
controlling it.

Note: This feature is only available on Students running Windows 10 v2004 and above (legacy
support is provided for Students running Windows 8 and below).

Blank a Student's screen
1. Select the Home tab in the View window ribbon and click Blank Screen.
2. The Student's screen will be blanked.

3. To restore the screen, click again.
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Sending Ctri+Alt+Delete

You can send Ctrl+Alt+Delete to a machine that you are viewing.

To send Ctrl+Alt+Del to a Student you are viewing

1. Press the Ctrl+Alt+Esc keys simultaneously.
Or

1. Selectthe Home tab on the View window ribbon and click Ctrl+Alt+Del.

2. Click Yes to confirm you want to send Ctrl+Alt+Delete.
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Blank all Student screens

An individual Student screen can be blanked while you are viewing it. This option enables you to blank
all Student screens simultaneously.

To blank all Student screens
1. Selectthe Class tab in the ribbon and click Blank All.

2. The Student screens will be blanked.

Note: By default, sound is muted at Students when blanking all screens. This option can be
disabled in the Student User Interface settings.

3. Torestore the screens, repeat the above process.

Note: You can blank an individual Student screen by right-clicking the Student and selecting Blank.
This feature is only available on Students running Windows 10 v2004 and above (legacy support is
provided for Students running Windows 8 and below).
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Remote clipboard

During a View session, you can copy the content of the clipboard between the Tutor and Student
machines.

The Clipboard section on the Home tab of the View window ribbon provides the following options:
Send: Used when copying from the Tutor to a Student and using the {Edit}{Cut/Copy} menu option.

Retrieve: Used when copying from the Student to the Tutor and using the {Edit}{Cut/Copy} menu
option.

Auto Clipboard: When enabled, it provides the quickest method for copying data. Use the shortcut
keys (Ctrl+C and Ctrl+V) to automatically copy to and from the clipboard at both the Tutor and
Student machines.

Sending the content of the clipboard from a Tutor to a Student machine
1. View the required Student.
2. Open appropriate applications on the Student and Tutor machines.
3. Select and copy the required data from the application at the Tutor.
If Auto Clipboard is enabled, using Ctrl+C copies the data directly to the clipboard.
Or

If you have used {Edit}{Cut/Copy?}, return to the Student's View window and click the Send
icon on the ribbon.

4. To paste the data at the Student application, choose {Edit} from the Student application drop-
down menu and select Paste.

Or

Use the shortcut keys (Ctrl+V) to paste the data.

Sending the content of the clipboard from a Student to a Tutor machine
1. View the required Student.
2. Open appropriate applications on the Student and Tutor machines.

3. Copy the required data from the application at the Student as above but if using menu options
rather than the shortcut keys, click the Retrieve icon on the ribbon.

4. Return to the Tutor application and paste the data using the appropriate menu options or the
shortcut keys (Ctrl+V).
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Scanning Students

The Scan function enables you to cycle through each connected Student in turn, displaying its screen
on the Tutor.

Multiple Student screens can also be scanned in one Scan window.

To scan one Student screen at a time

1.

2.

Select the Group tab in the ribbon.

Select the One Client at a time [ icon.

In the List view, select the Students to include in the scan (if you select a group, all Students are
included).

Use the slider to specify the interval before the scan is advanced to the next Student. The scan
period can be set anywhere between five seconds and two minutes.

Click Start.

The Scan window will appear and immediately show you the first Student in the sequence. It will
cycle through the selected Students, showing their screens on the Tutor until you end the scan.

@ NetSupport School - Scan (Sarah) Mute Al ) Lock Al memet(X) (O = 7 @ _ O X
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« > C O @ bbc.co.uk/bitesize/subjects/z3kw2hv
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To end the scan

1. On the caption bar, click the Close * icon.
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Scanning multiple Student screens

Multiple Student screens can be scanned simultaneously in one Scan window.

Note: You can display up to 16 Student screens in one Scan window at a time.

To scan multiple screens simultaneously

1.

2.

Select the Group tab in the ribbon.

In the List view, select the Students to include in the scan (if you select a group, all Students are
included).

Select the number of Student screens to be displayed in the Scan window by clicking the
relevant icon:

53]

Students are arranged 2x2.
[2x2 scan icon]

[3x3 scan icon]
£

Students are arranged 3x3.

Students are arranged 4x4.
[4x4 scan icon]

If scanning more than four Student screens, select a scan interval using the slider. The scan
period can be set anywhere between five seconds and two minutes.

Click Start.

The Scan window appears.

@ Scan Mute Al ]9 Lock Al memet(®) O = 2 @ _ 0O X

oo O 6022 ©®

Scaletofit Maximize lock Chat  Share  Screemshot

Home
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Note: If scanning more Student screens than the number of screens displayed in the Scan window, by
using the Next, Auto Advance and Previous icons, you are able to switch between Scan windows.

To end the scan

1. Onthe caption bar, click the Close * icon.
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The Scan window

The Scan window will cycle through the selected Students, showing their screens on the Tutor until
you end the scan. If you want to start scanning from a particular Student, highlight their icon before
you start the scan.
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The Scan window is divided into the following sections:

The caption bar

The caption bar displays the name of the Student you are currently scanning (this will not appear
when scanning multiple Students simultaneously). If the Teacher Support feature is enabled in the

Tech Console, a Support B support jeon appears here, allowing you to chat or message a technician.
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The following options are available on the right-hand side:

Opens the Quick Access list, allowing you to add

[Hamburger menu icon] commonly used features to the caption bar. By default,
Mute All, Lock All, Internet and the lesson timer are
displayed.

?

Access the online help and version number, licensee,

[Online help icon - question mark] Technical Support and compression information.

i
Access the settings for the current scan session.
[Settings icon]

o . i Minimise the window.
[Minimise window icon]

8

Maximise the window.
[Maximise window icon]

=

Close the window.
[Close window icon]

The ribbon

The following icons are available for a single Student scan:

Previous, Auto Advance and Next: Allows you to turn auto timing on or off, or choose to move
forwards or backwards between individual Students. The Previous icon shows the previous Student
screen scanned. The Next icon shows the next Student's screen in the scan cycle.

Scale to fit: It may be that the Student is running in a higher resolution than the Tutor. Selecting this
option will resize its screen to fit the window in which it is displayed.

Full Screen: Allows you to scan in Full Screen mode. You can use the Scan Floating toolbar to control
the operation.

Screenshot: A snapshot of the current Student screen can be taken.
The following additional icons are available for a multiple Student scan:

Maximise: Maximises a selected Student's window. You can also click the Maximise = icon in the
top right-hand corner of the Student window.

Lock: Locks a selected Student's keyboard and mouse.
Chat: Initiates a Chat session between a Student and the Tutor.

Share: To view a Student in Share mode.
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The Student screen area

This displays the screen of the Student or multiple Student screens when performing a scan.

The status bar

The status bar shows the scan timer, indicating how far you are through the scan interval.
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Monitor mode

Monitor mode enables the Tutor to view multiple Student screens simultaneously. A convenient
thumbnail view of each connected Student screen is displayed at the Tutor, providing a quick and easy
method for monitoring Student activity.

1. Click the Monitor View D icon on the left-hand side of the Tutor Console.
Or

Select the View tab in the ribbon, click the drop-down arrow * in the Mode section and choose
Monitor View.
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The List view will display each Student thumbnail. By mousing over a thumbnail, you can zoom into
that screen. Double-clicking on a thumbnail will open a View session to the Student, right-click and
you can select from a range of available Student features. For example, by selecting multiple
thumbnails, you can invite those Students into a Chat session.

When viewing a 'zoomed' thumbnail, you can:

* lock the Student by clicking the Lock icon

« open a View window by clicking the View “©" icon
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* capture a snapshot of the thumbnail by clicking the Capture Screenshot @ icon. (The

screenshot is saved as a .png to NetSupport School\Screenshots in your local Documents folder.
You are notified if there is an error taking a screenshot).

Notes:
* The zoom facility can be toggled on/off by clicking Zoom In on the status bar.

» By default, the battery level and wireless strength (if applicable) are displayed on the Student
thumbnails. You can turn these off in the Tutor Configurator - Tutor User Interface settings.

Customise thumbnail size

Student thumbnails can be resized to suit personal preferences. This is particularly useful when
connected to large numbers of Student machines.

1. Use the slider on the status bar to select the required size.

Auto-fit size of student thumbnail

This option will automatically adjust the size of the displayed thumbnails to fit the window.

1. Click Auto on the status bar.

Changing the thumbnail refresh rate

Depending on how closely you want to monitor Student activity, you can adjust the frequency at which
the thumbnails are refreshed. By default, this is set to high.

1. Select the Class tab in the ribbon and select the required option (real-time, high, medium or
low) from the Update drop-down list.

Show active application

When enabled, an icon will appear in the top left of each thumbnail indicating which application is
currently active at the Student machine.

1. Select the Class tab in the ribbon and click the Show current application Ifl icon.

Show active website

Displays an icon in the top right of each thumbnail indicating which site the Student is currently
visiting.

1. Selectthe Class tab in the ribbon and click the Show current website @ icon.
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Show help requests

This option highlights when a Student has outstanding help requests (it is enabled by default). The
Student thumbnail is highlighted to show when a Student requests help (the colour matches the type
of alert selected; green for work is complete, amber for help needed and red for urgent help required).

1. Select the Class tab in the ribbon and click the Show Students help requests @ icon.

Multiple monitors

If a Student is running multiple monitors, icons are displayed on their thumbnail, allowing you to
switch between each monitor or view the whole desktop. Click the Multi Monitor Menu S icon to
view the whole desktop or select which monitor to view. Click the Whole Desktop @ icon to view the

whole desktop. Click the Number ® icon to view an individual monitor.

Note: You can set the thumbnails to automatically show all monitors for Students by selecting the
Class tab in the ribbon and clicking Show All Monitors.
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Keyboard monitoring

Allows the Tutor to monitor Students keyboard usage while using any approved application, providing
a real-time insight into Student activity during a class. The Tutor can monitor the entire class, quickly
viewing any typed content and keeping an eye on Student activity levels. To further enhance the
monitoring process a Tutor can create 'target' and 'inappropriate' word lists. When a Student types a
word on the list, it will be immediately highlighted at the Tutor.

The keyboard monitor also provides a perfect monitoring tool when Students are online in forums or

search forms.

Note: Keyboard Monitoring is not available in the following languages: Korean, Simplified Chinese,
Traditional Chinese, Arabic, Japanese and Russian.

B NetSupport School ; ECWIN10-1 Mute Al Lotk a1 emet® (D= _ O X
Class Group Select Feedback & Wellbeing Journal ‘Work Planner Administer Wiew Cptions~
&3 660099 &® 0 B A &@ 0%

= @ Ouhscate
Student Lock  Unlock Bark Show  Cuick  Studemt Uncestricted ~ Chat  Arnounce  Message Help Tutor Monitor  iear .
Registe A Launch ~ Deskiop Requests~ Assistant~ |ty Text (B word ikt -
Class Stugant Wb Access Commanicate Tatiiet Typing Cptiors
R s =
Name User Name Current Application Text Target Inappropriate
D O Ap-mebssssbazt Adam
- Emma ebrown sessien-twe-notestet - Notepad n was formed 4.6 n@biion years ge. The BT 4 2
\g} - S sthomas @ facebock - Google Search - Google Chro Hiacebook Sl
- Andy a.3mith & New Tab - Google Chrome IR esterday > 1
@ - Mk mking 7 sclersystem.rtf - WordPad AR s v mcons and 3
- i e.green & how many moans does mars have - Goog.. How many mocns does [ heve @ 1 [}
@ O meeros m.wright
‘ M . khan T selarsystem.rti - WerdPad smallest planet in the solar system. <{fIE has 2 [}
©) Target Words + [5) appropriste Words + ®
Earth Saturn facebaok
gravity Sisnh featbell
Iura results
Mars seores
Mercury twitter
M|~
+« & 08

Bciassd ~ 555 Students [a]IoRGr sty

In "Typing' mode, you can view details of target or inappropriate words and use the available icons to:

* Create a new word list.
e Load an existing word list.

* Monitor Student typing activity.

Note: Details view is the default layout, you will be unable to view Keyboard Monitoring in any other

layout.

The lower panes can be minimised to make more room for the Student icons. Click the Minimise

View @ icon.
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The current application will be displayed along with the text the Student is typing, any target or
inappropriate words will be identified with either a green (target) or red (inappropriate) visual
indicator. A count of how many target/inappropriate words that have been typed by each Student will
also be displayed.

Note: Keyboard Monitoring can be enabled at startup. Click Options in the Tutor Console, select
Network Settings from the drop-down menu and choose Start Options - Restrictions.

Monitoring activity

1. Click the Typing View @ icon on the left-hand side of the Tutor Console.
Or

Select the View tab in the ribbon, click the drop-down arrow * in the Mode section and choose
Typing View.

2. Select the Class tab in the ribbon and click Monitor Activity.

3. Anicon showing the current application running on the Student machine is displayed next to
each Student, along with any typed content and any target/inappropriate words will be
identified.

4. A Monitor Activity icon is displayed on the status bar, showing that keyboard activity is being
monitored (This appears in all view modes). Clicking this icon turns off keyboard monitoring.

Notes:

« Inappropriate words can be obscured at the Tutor Console; select the Class tab in the ribbon
and click Obfuscate.

* You can clear the typed text in the Text column for Students. Select the Class tab in the ribbon
and click Clear Text.

172



NetSupport School 15.10

Setting up word lists

While Keyboard monitoring provides real-time tracking of what Students are typing, you can ensure
Students are on track during the lesson by creating target or inappropriate word lists. There may be
certain words that you will expect Students to include during a written lesson. When a Student types a
word on the list, it will be identified with a visual indicator, green (target) or red (inappropriate).

Notes:

» The target word list can be sent to the Student Journal, allowing the Student to refer back to

this after the lesson. Click the Journal E icon above the Target Words pane.

« The target word list can be viewed in the Student Toolbar.

Add a word to the target or inappropriate word list
1. Click the Add _|_ icon to add a word to the target or inappropriate word list.
Or
Right-click in the Target or Inappropriate Words pane and select Add Word.
2. The Add Word list dialog will appear.

3. Type the word to be added.

Note: Only single words can be added.

4. Click OK.

5. The word will appear in the appropriate list.

Remove a word from your target or inappropriate word list
1. Toremove a word from the list, highlight the chosen word and click the Remove X icon.

Or

Right-click in the Target or Inappropriate Words pane and select Remove Word.

Create a new word list

1. Select the Class tab in the ribbon and from the Word list drop-down menu, click Create New
Word List.

2. Enter a file name and click Create.

3. A new blank word list will appear.
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Open an existing word list

1. Select the Class tab in the ribbon and from the Word list drop-down menu, click Load Existing
Word List.

2. Highlight the relevant file and click Open.

3. The existing Word list will appear.

Save a word list

1. Select the Class tab in the ribbon and from the Word list drop-down menu, click Save Word
List As.

2. Enter a file name and click Save.

3. The current Word list will be saved.

Notes:

* Any changes that have been made to the new or existing word list will be automatically saved
when a new word list is created or when you have exited from the NetSupport School program.

* The default word list is saved as NetSupport School.wdl.
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View typing history

This feature of Keyboard Monitoring enables you to monitor the keyboard usage of connected
Students and if required, store or print a permanent record.

View typing history
1. InTyping View, select the Class tab in the ribbon and click History.

2. The Typing History dialog appears.

(3] Typing Histery O x
Show History for: % Al Students v

Student Mame Login Mame Computer Name Application Started Typing

‘ Mark testing HPLAP-2 Document - WordPad 06/29/23 14:50:28 John Keats was only 25 when he died but h

; Emma Administrator INVH764 Document - WordPad 06/29/23 14:46:17 Wilian m Shakespeare was a famous poet f

‘ Emma Administrator INVH7 64 Search 06/29/23 14:46:13  word

; Mark testing HPLAP-2 Home - BBC Bitesize - Google Chrome  06/29/23 14:45:35 bbc

< >
Save... Export... Print... Help Close

©

This provides details of the Students keyboard activity during the currently connected session.

The available options are:

Show History for

You can view the history for all Students, the currently selected Students or you can select the
required Student from the list.

Refresh

While viewing the list, click Refresh at any time to update the display.

Save

To keep a permanent record of the displayed items, you can save the details to a text file before
disconnecting.

175



NetSupport School 15.10

Export
Exports data to a CSV file allowing the data to be imported if needed.

Print

Prints details of the currently displayed items.

Close

Closes the History dialog but details will continue to be recorded while the Tutor is connected.
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Screen capture

Screen capture enables you to take a snapshot of the current Student screen whilst viewing or
scanning and save this to a file. The machine name, Student name, date, time and product name is
also recorded when saved.

Capture a Student's screen
1. When viewing or scanning a Student, select the Home tab in the ribbon.
2. Click Screenshot.

3. The current Student screen is captured and automatically saved as a .png to NetSupport
School\Screenshots in your local Documents folder.

Note: An indicator appears on the Screenshot icon showing the number of screenshots taken
(up to a maximum of nine).

4. Clicking the Screenshot icon drop-down arrow lists the last nine screenshots taken (you can
view or delete them as required) and you can open the folder where the images are stored.

Notes:

« When scanning multiple Students, a Student screen must be active (highlighted) for the
screen capture to become available.

» When capturing in the Scan session (one Student at a time), auto scan is temporarily
suspended until the screen capture operation is complete. Once complete, auto scan is re-
enabled automatically and the scan of the next Student continues.

* You can take a screenshot of a Student thumbnail in Monitor mode. Zoom in to the required

Student thumbnail and click the Capture Screenshot @ icon.
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Showing to Students

The Show feature enables the Tutor to emphasise key learning points by displaying the information on
their screen to a selected Student, all Students or a group of Students. You can also show a stored
replay file, audio file, a video or an application that is currently running at the Tutor.

During a Show, the Tutor can nominate a selected Student to take over the demonstration, making
them the show leader.

Note: You can apply internet restrictions at the Tutor, preventing inappropriate websites from being
displayed to Students during a Show (this can be set in the Show menu).

To include a 'snapshot’ of the screen in the Student Journal, click Print Screen during the Show or
right-click the Show icon on the system tray and select Add Screenshot to Journal. A dialog
appears displaying the image to be added to the Journal and notes can be added to accompany the
image.

To show a Tutor screen
1. If you want to Show your screen to one Student or a group, ensure they are selected.
2. Select the Class tab in the ribbon and click the Show icon.

3. Show options can be set by clicking the relevant option in the Show menu. To set further Show
properties, click the More # icon.

Note: If you are running multiple monitors, you can choose which monitor to show Students by
clicking the relevant icon.
4. Click Quick Show.

Note: If you want to show to one Student, a Quick Show option to show to the selected
Student appears in the menu. You can also right-click a Student in the List view and click Quick
Show.

5. Your desktop is displayed to the Student(s).

Note:
To improve performance when showing to a large number of machines, NetSupport School's
Broadcast Show facility is enabled by default. This results in the screen information being sent to all

machines simultaneously, thus improving the speed of transfer. Turning this feature off results in the
screen information being sent to each Student machine in turn.

Whilst reducing overall network traffic generated by NetSupport School, using this feature will
generate additional broadcast packets on your network. It is recommended that you consult your
network administrator before using this feature.
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The Show can be sent to Students using multicast. The broadcast will only be sent to machines
included in the specified IP multicast address.
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To end the Show

To end the Show
1. Double- click the Showing[x] icon on the taskbar.
Or
Double-click the NetSupport School Tutor icon on the desktop.

2. This displays the Show Suspended dialog.

MetSupport School - Show Suspended H
Currently showing to: End
Mame Description
[ ] .
w Etle
; Emma Contirue
; b ark, Show Leader...
< > Help
3. Click End.

Or

1. Right-click on the Showing icon on the taskbar.

2. Click End Show.
Or

1. Use the hotkey combination CTRL+ALT+END.

To end a Show while suspended
1. Select the Class tab in the ribbon, click the Show icon and choose End Show.
Or
Click the Suspended icon on the status bar and click End Show.

2. Students will now see their own display.
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Allow the Tutor to continue working in the background
while showing

There may be times when you need to work in the background during a Show. You can suspend the
Show and continue working without the Students seeing what you are doing.
Allow the Tutor to work during a Show

1. Double- click the Showing & icon on the taskbar.

2. The Show Suspended dialog is displayed.

MetSupport School - Show Suspended =
Currently showing to: End
M arne Description
L] .
w Elie
; Emma Continue
; b ark Show Leader. ..
< > Help

3. Click Continue.

4. The Tutor Console is displayed and the caption bar indicates that the Show is suspended. You
can now continue to use the Tutor machine without the Students seeing what you are doing. The
Student screens will still display the previous Show.
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Resume a Show while suspended

Resume a suspended Show

1. Selectthe Class tab in the ribbon, click the Show icon choose Resume.

Or
Click the Suspended icon on the status bar and click Resume.

2. The Show Suspended dialog is displayed.

MetSupport School - Show Suspended =
Currently showing to: End
)
Mame Description
@ .
w Elie
; Emma Contirue
; I arke Show Leader...
< > Help

From here, you can choose to End or Resume the Show.
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Show leader

While the Tutor screen is being shown to the class, it may be appropriate for a Student to take over the
demonstration. For this purpose, the Tutor can assign Show leader status to a selected Student. The
mouse and keyboard of the Show leader's machine are unlocked and they can continue the
presentation on the Tutor's behalf.

The Tutor can still interact simultaneously with the Show leader and can suspend or end the session as
required.

To create a Show leader

1.

2.

10.

Start showing to Students as normal.

When you are ready to create a Show leader, double- click on the Showing & icon on the
taskbar.

This will display the Show Suspended dialog and the Show will be suspended. Student screens
will still display the Tutor screen.

Click Show Leader.

The Show Leader dialog is displayed.

MetSupport School - Show Leader *

Select the Show Leader [Show is currently suspended)

(I Mane

Cammal
@® This Client anee

Mame Dezcription
L] .

w» Elie

L)

- Ermma

; tark.

WARMING: The Client leading the show will hawve full access ta pour
Dezkiop

Note: If the Show icon on taskbar option has previously been selected, you can create a Show
leader by right-clicking on the icon and choosing Show Leader.

Click This Client and select the Student to make Show leader.

Note: The Show leader will have full access to your desktop.

Click OK.

The message 'You are leading the Show' appears at the selected Student's machine.
Click Resume to restart the Show.

The Show leader and Tutor can now interact together in leading the Show.
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Note: To remove the Show leader, click Show Leader in the Show Suspend dialog and select None.
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Exhibit - showing one Students' screen to others

With NetSupport School, it is possible to show the Tutor's screen to a number of connected Students.
It is also possible to show one Student's screen to other connected Students; this is called Exhibit. For
example, Student 1 has produced some work, which you wish to show to the rest of the class.

To show a Student's screen
1. Select the Student whose screen you want to show to the other Students.
2. Select the Class tab in the ribbon, click Show and choose Exhibit from the menu.
Or
Right-click the Student icon and choose Exhibit.

3. The Exhibit Client dialog appears.

Exhibit Client X

@ Ready to start exhibiting Student Administrator to:

Name Description Exhibit
® ; Sam
® Cancel
® @ Emma
Help
< >
[ ] set Show Mode at Client Full Screen

[ ]Enable Audio Support

4. Select the Students to include.

5. Set the Show Mode to be used at Student screens (Full Screen, Windowed or Maximize
Window) and whether to include audio support.

6. Click Exhibit.

7. The selected Student's screen is displayed on the screens of the Tutor and the other Students.
Only the Tutor and the exhibiting Student will be able to change the screen.

Switching between full screen and windowed mode at the Tutor

1. Select the Home tab in the Exhibit window ribbon and click Full Screen.
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Notes:

* While in full screen mode, a floating toolbar appears.

—
* To return to Windowed mode, click the Windowed uEL icon on the floating toolbar or use the

hotkeys <CTRL>+<LSHIFT>+<RSHIFT>.

Suspend or stop the exhibit

The Tutor can choose to end the exhibit or temporarily suspend it. While suspended, the Tutor and/or
Student can prepare a new demonstration in the background. The previously exhibited screen remains
on the other Student screens until the exhibit is resumed.

To suspend the exhibit
1. Select the Home tab in the Exhibit window ribbon and click Suspend.

2.  While suspended, the Tutor and exhibiting Student can work in the background. The other
Student screens remain frozen.

3. To resume the exhibit, click Suspend again.

To stop the exhibit

1. Select the Home tab in the Exhibit window ribbon and click Stop.
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Student Feedback and Wellbeing

NetSupport School provides a simple and quick way to receive feedback from Students, helping to
capture how they feel, their confidence in a topic and whether they need extra support. Teachers can
choose between several visual options to send to Students. The Student then clicks on the appropriate
icon and the feedback results are reported to the Tutor in a simple list view or bar chart.

Note: NetSupport School also offers more comprehensive ways to ask Students questions and
collaborate with them, see Survey mode or Question and Answer module.
Requesting feedback

1. Select the Feedback & Wellbeing tab in the ribbon and click Feedback and Wellbeing.

2. The Feedback and Wellbeing dialog appears.

B2 Feedback and Wellbeing X

Request feedback on understanding or wellbeing

Ask students (optional):

Type:

Simple Yes/No ~

e
" b

@D v

] Anonymise results

3. Enter the question to ask Students in the Ask students field (a drop-down list of the previous
ten entries will appear, or you can type a new one - there is a 128-character limit), or you can
verbally ask the question. Select the visual indicators to send to Students. If you want the
results to be anonymous, click Anonymise results.

4. Click OK.

5. At the Student, the Student Toolbar will switch to Feedback mode and a dialog will appear

showing the question (if entered) and a selection of icons for them to choose from. The Student
simply clicks on the required icon.

6. A Feedback and Wellbeing Results dialog appears at the Tutor, allowing you to see the results as
they come back. The results can be viewed in a list or bar chart. To switch between views, use
the List or Chart buttons. The results can be saved or printed by clicking the appropriate icon.

7. Click Close when finished.
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Interactive Whiteboard

A full screen interactive whiteboard is provided, enabling the Tutor to use NetSupport School's
annotation tools to highlight the screen and show the results to a selected group of Students.

Note: To include the whiteboard image in the Student Journal, select the Whiteboard tab in the ribbon
and click Add to Journal.

1. Select the Whiteboard View g icon on the left-hand side of the Tutor Console.

Or

Select the View tab in the ribbon, click the drop-down arrow * in the Mode section and choose
Whiteboard View.

B NetSupport School : ECWINT0-1 Mute Al ) Lock Al intermet () (D) = (m
Class Group Select Feedback & Wellbeing Journal Work Planner Administer View : ~ Optiol
= B & MmO @O™ 7= ENa e ece se
Paste o
Shew Swe  Load Font. Clea et | @ mLecC vidth e@ecvcee
mage Whiteboard  Image D a4 : L I ]
Whiteboard Edit Toolks Colour
= @
~lIH @E
B o Ma
B o sah

Use the range of annotation tools provided in the Whiteboard tab in the ribbon to highlight the
screen and add any stored graphics.

2. Ifrequired, you can save the content of the whiteboard for later use. Select the Whiteboard tab
in the ribbon and click Save.

Note: You can save the currently selected area in the whiteboard by clicking the Save drop-down
arrow and selecting Save Selection.

To show the whiteboard to Students

1. If showing a stored whiteboard image, select the Whiteboard tab in the ribbon and click Load
Image.
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2. You can show the whiteboard to a group of Students by selecting the required group tab in the
group bar. The Student list on the right-hand side of the Tutor Console shows which Students
are included.

Note: You can set the whiteboard size displayed on Student screens. Select the Whiteboard tab
in the ribbon, click Canvas Size and choose the required size from the drop-down menu.

3. Select the Whiteboard tab in the ribbon and click Show.
4. The content of the Whiteboard will appear on the selected Student screens. The Tutor can

continue to annotate the whiteboard in real-time.

Note: The Show and Whiteboard View icon turns red and the Whiteboard g icon appears

next to the Student icons in the Student list, showing that the whiteboard is being displayed to
Students.

5. Toremove the whiteboard from Student screens, click Show again.

Whiteboard leader

When Students are viewing the whiteboard, they cannot initially annotate the screen themselves.
However, the Tutor can nominate a Student to be the 'whiteboard leader'. This activates the
annotation options at the selected machine. The Tutor can switch control to any of the other
participants as required by selecting their icon in the Student list.

1. Select the required Student from the Student list.
2. Select the Whiteboard tab in the ribbon and click Give Control.
Or

Right-click on the required icon in the Student list and select Give Control.

3. The Student can now use the available tools to add content to the whiteboard.

Note: The Whiteboard icon in the Student list turns red to show that the Student is now in
control. A flashing Leader icon is also displayed on their Whiteboard toolbar.

4. Control can be switched to another Student by selecting their icon in the Student list and
repeating step 2.

Note: The whiteboard leader can send the current whiteboard image to their Journal by selecting
{File}{Add to Journal} from the Whiteboard toolbar.
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Annotating screens

The Show, Exhibit and View features provide a useful annotate tool that can be used to highlight areas
of a Tutor or Student's screen in order to emphasise a key learning point.

To annotate a Show screen

While the Tutor screen is being shown, you may want to draw the student's attention to a particular
area. The annotate tools can be used to highlight the relevant part of the screen.
1. While showing, right-click the Showing & icon in the system tray and select Annotate Screen.

Or
Double-click the AnnotateE icon.

2. The Annotate toolbar appears.

3. Select the tool, colour etc. and use the mouse to draw over the relevant part of the Tutor screen.

Note: If you do not want the Students to see the screen being annotated in real-time, click Suspend
Show. This freezes the Show enabling you to continue working in the background. Click Suspend
Show again to restart the Show, this refreshes the display at the Student screens.

To annotate a screen while viewing

While viewing, you can use the annotate tools to highlight a particular area of the Student screen. In
Share and Watch mode, the Student can also use the Annotate toolbar. You can still use the other
View window options while annotating, such as Chat, File Transfer etc.

1. View the required Student.

2. Select the Tools tab in the View window ribbon and click Annotate.

3. The Annotate toolbar will appear.

To annotate a screen while exhibiting

The screen of a Student that is being exhibited can be annotated in order to draw the attention of the
other Students to a particular learning point. Depending on the mode being used, both the Tutor
and/or the exhibited Student can use the annotate options.

1. Exhibit the required Student screen.

2. Select the Home tab in the Exhibit window ribbon and click Annotate.

3. The Annotate toolbar will appear.
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File Edit Taol

B.2.N. 0 A Il B

Width Font Suspend Show End Show

The following options are available:

File
Save Screen

Save Selection

Exit

Edit
Clear Annotations

Undo
Redo

Tool

Colour

Width

Font

Suspend Show
End Show

Saves the annotated screen to a file.

When the 'select region' tool is active, you can highlight an area of the screen
and save it to a file.

Ends annotate but stays in Show, Exhibit or View mode.

Clears the annotations.
Undo the most recent annotation.

Redo an annotation that has been undone.

Choose from a range of tools with which to annotate the screen. For example,
freehand draw, draw an arrow and select a region.

Sets the pen colour.

Sets the width of the line.

Sets the text font.

Suspends the Show (not available when viewing or exhibiting).

Ends the Show and takes you back to Tutor Console. (Not available when
viewing or exhibiting.)
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Audio monitoring

Audio monitoring allows the Tutor to monitor audio activity on all Students' machines. The Tutor is
instantly alerted to any microphone or speaker/headphone activity at the Student and can select one
of the displayed Student thumbnails to listen to the audio being played on that PC. Audio activity can
also be recorded and played back to Students.

Note: If the Student Toolbar is enabled, Students will be advised when their audio activity is being
listened to or recorded.

1. Select the Audio View b4 icon on the left-hand side of the Tutor Console.
Or

Select the View tab in the ribbon, click the drop-down arrow ** in the Mode section and choose
Audio View.

W NetSupport Sehool : ROB-MAIN VAl O LA @ 0= _OX
Class Group Select Feedback & Wellbeing Journal Work Planner Administer ~ Oypstiony

= 68009 8206 B9 0 3 A
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1002542 Thoman Bign P

ingoes 10 184
1002 905

A thumbnail of each connected Student screen is displayed and the microphone or speaker icon
indicates if there is audio activity at the Student machine.

Note: Audio Monitoring can be set up at startup. Click Options in the Tutor Console, select Network
Settings from the drop-down menu and choose Start Options - Restrictions.
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Listen to Student audio
1. Select the required Student in the List view.
2. Select the Class tab in the ribbon and click Listen.
Or
Right-click the Student and click Listen.

3. Details of the Student you are listening to and how long you have been listening is displayed on
the status bar.

4. To stop listening, click Listen again.

Record audio activity
1. While listening to audio activity, select the Class tab in the ribbon and click Record.
2. Ared flashing icon is displayed on the status bar to show you are recording the audio.

3. To stop recording and carry on listening to the audio, click Stop.

Note: Once you have stopped recording, an indicator on the Recordings icon in the ribbon shows
that a recording has been saved. Click the Recordings icon to access the saved recordings.

Volume control

You can control the volume at both the Tutor and the Students.

1. Selectthe Class tab in the ribbon and click the Volume icon.

2. From here, you can adjust and mute the volume at the Tutor, adjust the volume for all Students,
lock the volume at Students and set the maximum volume for Students (Students cannot
increase their volume higher than this).

Or

1. While listening to audio, the volume sliders appear in the ribbon, allowing you to adjust the
Tutor and Student volume.

Mute sound at the Student

Sound can be muted at Student machines.

[y

Select the required Student in the List view.
2. Select the Class tab in the ribbon and click Mute Sound.
3. Anicon appears on the selected Student thumbnail(s), showing that the sound has been muted.

4. Click Unmute Sound to reinstate the sound.
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Notes:

» By default, sound will be muted at Students when locking the mouse/keyboard or blanking
screens. This option can be disabled in the Student User Interface - Configuration
settings.

* You can quickly mute all Student machines by clicking Mute All on the caption bar. If this is
not displayed, you can add by clicking the Configure Quick Access List = icon and selecting

Mute/Unmute audio at students.

Mute sound at the Tutor

Sound can be muted at the Tutor machine.

1. Selectthe Class tab in the ribbon and click the Volume icon.

2. Click Mute next to the Your volume slider.

Customise thumbnail size

Student thumbnails can be resized to suit personal preferences. This is particularly useful when
connected to large numbers of Student machines.

1. Use the slider on the status bar to select the required size.

Auto-fit size of Student thumbnail

This option will automatically adjust the size of the displayed thumbnails to fit the window.

1. Click Auto on the status bar.

Notes:

* You can send an audio announcement to Students' headphones or speakers. Select the Class
tab in the ribbon and click Announce.

» Recordings can be played back to Students using the Show function.
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Using audio

NetSupport School allows you to use audible communications to connected Students via microphones,
headphones and speakers while viewing and showing. NetSupport School will only operate audio if the
machines have audio hardware and software installed.

Notes:

* NetSupport School also allows you to monitor all Student audio activity, see Audio monitoring
for further information.

* You can quickly mute all Student machines by clicking Mute All on the caption bar. If this is
not displayed, you can add by clicking the Configure Quick Access List = icon and selecting
Mute/Unmute audio at students.
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Using audio announce

This feature sends the audio announcement to all the selected Students' headphones or speakers.
They will be able to hear the Tutor but will not be able to speak back.

To make an announcement
1. Selectthe Class tab in the ribbon and click Announce.

2. The Announce dialog appears. Include or exclude Students from the announcement and click
Announce.
3. Adialog appears, indicating that you can now announce. Click OK when you have finished

speaking.
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Using audio support while viewing and showing to a
Student

NetSupport School allows you to use audible communications to connected Students via microphones,
headphones and speakers while viewing and showing. NetSupport School will only operate audio if the
machines have audio hardware and software installed.

Note: You can quickly mute all Student machines by clicking Mute All on the caption bar. If this is not
displayed, you can add by clicking the Configure Quick Access List = icon and selecting
Mute/Unmute audio at students.

To use audio support while viewing
1. The audio options are displayed in the Audio tab of the View window ribbon. From here, you can:
e Turn audio on or off.
» Enable only the Tutor or the Student to talk.

e Listen to the Student.

Note: Click Settings # to access the Audio settings. From here, you can also set the microphone
sensitivity and select the audio quality.

To use audio support while showing

1. Select the Class tab in the ribbon, click the Show icon and select the Enable audio during
show option.

2. During the Show only the Tutor has Announce functionality. (If you are showing to only one
Student, both the Tutor and Student can speak. If you are showing to many, only the Tutor can
speak (announce).)

The audio settings set in the Tutor Configurator - Audio apply during these sessions.

197



NetSupport School 15.10

Adjusting microphone and speaker volume

You can adjust the audio settings within NetSupport School to match the capabilities of your
multimedia machines or to fine-tune performance. However, you should note that the higher the
quality of sound you select, the greater the volume of data that needs to be sent. This can affect
screen update performance on slower machines.

To access the volume controls

1. Right-click on the Speaker icon in the system tray.
To change other options, such as sound quality, do one of the following:
Global method (changes default setting for all Students):
1. Click Options in the Tutor Console and select Settings from the drop-down menu.

2. Select Remote Control - Audio.

Individual Student method (while viewing):

1. Go to the Audio tab in the View window ribbon and click Audio settings .

Settings for Configuration: NetSuppert School x
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@'3 Journal
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In both cases, the Audio settings are displayed and you can set the following properties:

Volume
Threshold: Microphone sensitivity.

Microphone: Volume of microphone.
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Speaker: Volume of speakers.

Test: Tests all of the above settings (this is only available when applying settings to all Student
sessions).

Enable

Off: Turn audio off.

On: Turn audio on.

Talk only: Turn the Tutor audio to talk function only.
Listen only: Turn the Tutor audio to listen function only.

Selecting Change Transmission Format allows you to change the transmission format. Use only the
level you need for acceptable quality. High-quality settings can affect screen update performance.
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Video Player

NetSupport School provides exceptional multimedia support with full audio, video and remote control
capabilities. This section deals specifically with the use of the Video Player. Please see audio support
and showing for more details.

While the Video Player can be used to run a video file on the local machine, NetSupport School's
remote control capabilities combined with full audio support enable you to use this tool to enhance
training sessions and demonstrations across multiple PCs simultaneously.

All standard video files, for example, avi and mpg, are supported. The Video Player runs locally on
each Student machine and the video file can be accessed locally or from a network drive. If video files
are stored locally the impact on the network is minimised as only the data to control the player, e.g.
start, stop, pause and synchronisation packets, are sent. If each Student machine retrieves the video
file from a network drive, you will place additional demands on the network.

For optimum performance, store the video files locally on each machine, you may wish to use File
Distribution to do this.

Other influencing factors will be:

The number of Student workstations accessing the file.
* The speed of the network, e.g. 10/100 MB.

» The size of the video file.

* Student machine memory/performance specification.
e Other traffic on the network.

Notes:

» Ifthe video file to be played does not exist on the Student machine NetSupport School will
automatically send it to the Student.

« If a Student machine is required to retrieve files from a Server, for smooth operation, ensure
that the Student machine has sufficient access rights to the relevant drive and files.

» The video adapter of the machine and how the screen resolution is configured will affect the
quality of the display.
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To play a video file on a Student machine

You can show a video file to Students.

Playing a video to Students
1. Selectthe Class tab in the ribbon, click the Show icon and choose Show Video.

2. The Show Video dialog appears.

MetSupport School - Show Video X

@ Select the video to Show
Video Fie

| lideo file |

In the Video File field enter the location and name of the required video, you can select the
Open = icon to browse for the file.

3. Click Show.

4. A check will be made to ensure that the video file is available at the Student. If not, the video file
will be automatically copied to the Student machine.

5. When the video file is launched, the Video Player control panel appears. Standard operations are
available, play, stop, pause etc.

Note: While the video is running, the Student machines are locked.
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Video Player control panel

The Video Player control panel operates in a similar manner to all audio and visual aids.

00:00 /01:57

File

The File drop-down menu contains the following options:

Open: Allows you to select and load the appropriate video file.

Close: Closes the open video file.

Exit: Shuts down the Video Player.

View

The View drop-down menu contains the following options:

Toolbar: Hides and displays the Video Player toolbar.

Status Bar: Hides and displays the status bar of the Video Player.

Zoom: Resizes the video screen

Play

The Play drop-down menu contains the following options:

Play: Starts the loaded video file.

Stop: Returns to the beginning of the loaded video file.

Pause: Blanks the Students video screen and pauses the video file at the Tutor machine.

Repeat: The video file will be repeated until the Tutor stops this.

Start: Returns to the beginning of the video file.

End: Fast forward to the end of the video file.
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Mute Clients: If students are not using headphones while they are watching a video, the sound
coming from each machine can be distracting. This option turns audio off at the Student machines but
leaves it on at the Tutor machine.

Help

Provides access to the online help and general version information.
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Using replay files

When a Tutor remote controls a Student machine, they can record the screen, keyboard and mouse
activity taking place. In addition, if the PCs are configured for audio, any narration that takes place can
also be recorded.

The information is stored in a file that can be replayed at the Tutor machine and, if required, shown to
other Students.

The Replay facility can be configured to record at all or individual Student machines. Local activity at
the Tutor machine can also be recorded.

Once enabled, activity is recorded as soon as a View session is opened. Recording stops when the View
session is closed, at which point the stored replay file becomes available for playback.

A Show session can also be recorded, enabling Students to playback the demonstration at their
convenience.

By default, a replay file is saved as a .rpf file, these can be converted to AVI or WMV video files. Pre-set
options will be provided for converting replay files to video files. More advanced users can access the
Replay Conversion utility where you can control video resolution, audio quality, start and end points of
the video and much more. To launch the Replay Conversion utility, select {Start}{Programs?}
{NetSupport School}{NetSupport School Replay}. On Windows 8 machines, right-click in the Start
screen and choose All Apps at the bottom of the screen. Click the NetSupport School Replay icon.

Note: Replay files store screen images and can, therefore, become very large. Good housekeeping

plays a vital role in maintaining files of this nature. It is recommended that old files are deleted on a
regular basis.
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Record replay files for all Students

Replay files can be created at any Student machine that the Tutor views.

Record replay files

1. Click Options in the Tutor Console, select Settings from the drop-down menu and choose

Replay Files.
| Search settings L I Replay Fles
v @@ Remate Control £ Recond Fles
t:? View Oinciude Audic
@ Keyboard/Mouse [ Predfix Files With Clert Name
§03 Rephay Fies
O Audio In Directorny:
@"-':" Chat Browse...
@? File Transfer
v @‘F’ User Interface
@ Tutor
{03 student

& Tutor Assstant
{?j@ Group Leaders
(:‘)@ Student Toolbar
@ﬁ‘ Journal

@ﬁ} Show

OK Cancal Help

2. Enable the Record Replay Files checkbox. A replay file will be created each time the Tutor
opens a view session at any Student machine.

3. Include Audio

In addition to the screen, mouse and keyboard activity, if the machine is configured for audio,
you can record any microphone narration from the Tutor. Check this option to enable.

Note: Desktop sounds, music, etc, are unable to be recorded.
4. Prefix Files With Client Name

In order to identify each replay file, file names are prefixed with the Student name and the
date/time of the recording. Alternatively, by unchecking this box, the files will be named
sequentially in the format 00000001.rpf etc.

5. In Directory
Specify where the replay files are to be stored.

6. Click OK.
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Record replay files for individual Students

Replay files can be created at selected Student machines.

Record replay files
1. View the required Student machine.

2. Click the Settings % jcon in the caption bar and select Replay Files.

Settings for Client: INVH764 o
| Search settings ( ;l Replay Files
v ¢ Remote Control [] Record Replay Files
? View [Jinclude Audic
ﬁ Keyboard/Mouse . . ) )
# Replay Files | Prefix Files With Cliant Name
ﬁ Audio In Directory:

Browse...

3. Enable the Record Replay Files checkbox. A replay file will be created each time the Tutor
opens a view session at any Student machine.

4. Include Audio

In addition to the screen, mouse and keyboard activity, if the machine is configured for audio,
you can record any microphone narration from the Tutor. Check this option to enable.

Note: Desktop sounds, music, etc, are unable to be recorded.
5. Prefix Files With Client Name

In order to identify each replay file, file names are prefixed with the Student name and the
date/time of the recording. Alternatively, by unchecking this box, the files will be named
sequentially in the format 00000001.rpf etc.

6. In Directory

Specify where the replay files are to be stored. A separate folder can be specified for each
Student.

206



NetSupport School 15.10

7. Click OK. Recording will start immediately, close the View session to stop recording.

8. Repeat steps 1-7 for any other Student machines.
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Record replay files at the Tutor

Activity at the local machine can be recorded and shown to Students.

Record replay files
1. Select the Administer tab in the ribbon and click Replay Files.
Or
Select the Class tab in the ribbon, click the Show icon and choose Replay Files.

2. The Replay Files dialog appears.

!Rep\ayFi\es x|
® ® &x X P 0

Create Play Replay Show Delete Rename Convert

Replay File Replay File File File

File name Size Recorded Date and Time Recorded On Converted
(JLocal_30102023_1554 25 42,948 30/10/2023 15:54:25
(Local_30102023_1401_49 3,550,156 30/10/2023 14:01:49
(J1Local_30102023_1357_41 57,300 30/10/2023 13:57:41

Replay File Location

Replay files are stored in C:\Users\testing\Documents\My Recordings Change

Existing replay files are listed.

3. Click Change to specify where you want the replay files stored.
4. Click Create Replay to start recording.
5. Adialog appears. Select Include Audio if the machine is configured for audio. Click OK.

6. The Recording = icon appears in the system tray (double-click this to stop recording).

7. By default, file names will be prefixed with 'Local' and the date and time of the recording. You
can rename the file by overtyping the default name. Click OK.

8. The replay file will appear in the list.
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Watching replay files

Stored replay files can be watched by Tutors and, if required, shown to Students. At a local level, the
NetSupport School Student program also provides a Replay option enabling Students to launch files.

At the Tutor

1.

Select the Administer tab in the ribbon and click Replay Files.
Or
Select the Class tab in the ribbon, click the Show icon and choose Replay Files.

The Replay Files dialog appears.

!Rep\ayFHes x|
0 ® 1 X O CF
Create Play Replay Show Delete Rename Convert
Replay File Replay File File File
File name Size Recorded Date and Time Recorded On Converted

(JiLocal_30102023_1554_25 42,948 30/10/2023 15:54:25
(1 Local_30102023_1401_49 3,550,156 30/10/2023 14:01:49
(MLocal_30102023_1357_41 57,300 30/10/2023 13:57:41

Replay File Location

Replay files are stored in C:\Usersitesting\Decuments\My Recordings Change

Existing replay files are listed.
Select the required replay file and click Play Replay File.

The Replay window opens and starts playing the file.
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The Sun holds the solar system together,
keeping everything - from the biggest
planets to the smallest debris - in its orbit.

5. Use the replay controls in the ribbon to start/stop the file.

At the Student
1. Right-click the NetSupport School Student icon in the system tray and choose Replay.
Or
Double-click the Student icon and choose {Commands}{Replay} from the drop-down menu.
2. Navigate to the folder where the replay files are stored.
3. Select the file to replay.

4. Click Open. The Replay window appears. Use the replay controls to start/stop the file.
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Replay window - control panel

When viewing a replay file in full screen mode a control panel is displayed, this provides the controls
for playing the recorded information. The control panel contains a replay time index that indicates
where in the replay file you currently are and displays information about the file being played.

Replay Controls n

- |
fo0 200 400 600 800 10.00 12.00  16.02

® Q) ®) || @ 0:00:16:02

Help Local 29-Jun-2023, 12:14:22

The individual sub-menus and available functions are:

Stop and play

The Stop button is shown when you are playing a replay file and the Play button when the file is
stopped. Only one of these buttons is displayed at a time. The file is played until the end is reached or
the pause marker is encountered.

Rewind

Start playing the file from the beginning if it is already playing otherwise moves the replay index to the
beginning of the file.

Skip to previous marker

Moves the replay index to the previous activity marker or to the beginning of the file if there isn't one.
These markers are added at points when lots of activity was recorded at the Student.

Frame advance

Advance the replay index to the next frame. Press and hold this button to fast-forward through the
replay file.

Skip to next marker

Moves the replay index to the next activity marker or to the end of the file if there isn't one.

Mute

Turn audio on/off within the replay file.

Other information

The current time index is displayed to the right of these controls in the hh:mm:ss.ms format. The
name of the Student that the replay was recorded on, the date and time are displayed at the bottom of

211



NetSupport School 15.10

the window.

Replay marker

This marker can be positioned anywhere within the time frame of the replay file. The marker is the
small black triangle beneath the time index control. Click and drag this to the position where you want
the file to stop playing. When the marker is encountered the replay stops, and you can then press play
to continue past it.

Help

Provides access to the on-line help and general licensee, version, Technical Support and compression
information.
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Showing replay files to Students

Using NetSupport School's Show feature, a Tutor can show a stored replay file to any number of
connected Students.

To show replay files
1. Select the Class tab in the ribbon, click the Show icon and choose Show Replay.

Or

Select the Administer tab in the ribbon, click Replay Files, select the required replay file and
click Show Replay.

2. The Show Replay dialog appears.

MetSupport School - Show Replay x

Select the reply file to Show
Replay File

|C:'\Users‘.‘testing'-\Dncuments\l‘«h,r Recordings\Local_290 v| | Browse...

Help Cancel Show

3. Browse for and select the required replay file.

4., Click Show.

5. The Replay window opens at the Tutor machine and starts playing the replay file to the selected
Students.

6. On the caption bar, click the Close * icon to end showing the replay file.
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Converting replay files to video files

NetSupport School replay files can be converted to video files allowing them to be played outside of
NetSupport School on a range of media players. Replay files can be converted to WMV and AVI
formats.

Converting a replay file
1. Select the Administer tab in the ribbon and click Replay Files.
Or
Select the Class tab in the ribbon, click the Show icon and choose Replay Files.
2. The Replay Files dialog opens.
3. Select the replay file to convert and click Convert File.

4. The wizard guides you through the conversion process.

Using the Replay Conversion utility

For more advanced options when converting replay files, a Replay Conversion utility is provided
allowing you to control video resolution, audio quality, start and end points of the video and much
more.

Note: The Replay Conversion utility is installed by default when installing the NetSupport School
Tutor or Tech Console. You can also install the utility as a standalone component.

1. Select {Start}{Programs}{NetSupport School}{NetSupport School Replay Conversion Utility}.

Note: On Windows 8 machines right-click in the Start screen and choose All Apps at the
bottom of the screen. Click the NetSupport School Replay Conversion Utility icon.

2. The Replay Conversion utility opens.
3. Browse for the required replay file and set the required properties.

4. Click Start Encoding.
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Show application

The Show feature enables you to display the Tutor screen to Students. However, if a number of
programs are open at the Tutor, there may be occasions when you want to show a single application in

isolation.

To show an application

1.

2.

Select the Class tab in the ribbon and click the Show icon.

Show options can be set by clicking the relevant option in the Show menu. To set further Show
properties, click the More & icon.

Click Show Application.

The Show Application dialog appears.

NetSupport Schoel - Show Application X

Select which Application you would lke to Show

Application:
@ | [overview | Sun — NASA Solar System Exploration - E| Select... Cancel
Drag the icon to the Application you want to Show, —
or click Select IQI Help

Drag the ‘Q) icon to the required application on the Tutor's desktop and release. (A pink border
will appear around the selected application as you move the mouse around the desktop.)

Or
Click Select and choose the application from the displayed list.

Click Show.
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Chatting to Students

NetSupport School allows you to chat to any number of connected Students simultaneously via a
scrolling text window.

Note: A history of all chat sessions can be saved to a .txt file. You can enable this in the Tutor Chat
settings.

To chat to Students

1. Select the Students or group of Students you want to chat to in the List view. If you do not select
a Studenticon, all connected Students will be included.

2. Select the Class tab in the ribbon and click Chat.
Or
Right-click on an individual Student and choose Chat.

3. The Create Discussion dialog appears.

Create Discussion x

Topic: Assignment feedback]

Cptions D_..I

[] Members can decline to join

] Members cant leave the chat
[ Chat Windaw is always visible

[JAdd to Joumal
Members
Name Description
L ]
(-] Andy
» Mak
; Sarah
Cancel
Help

Select any additional properties that should apply. Click OK to start the Chat session.
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4. The Chat window appears on the Tutor and Student machines.

(D) Chat: Assignment feedback — O *
Chat  Window

Close

Sarah has joined Help
Mark has joined
- Members
Andy has joined
Andy

Mrs Smith says: Mark

Can you let me know your thoughts on section 2 in the assignment? Mre Smith
Andy says: Sarah

1 thought that it was difficult to think of more than one answer.
Sarah says:

I could think of 2, but not 3!

Invite...

Eect

Send Message

Notes:

* Students can also initiate Chat sessions by opening the Student main window (click the
Student icon in the system tray) and choosing {Commands}{Chat} or by clicking the Chat =
icon on the Student Toolbar.

» By default, the Student can only chat to the Tutor. However, you can enable Students to chat
with each other by selecting the Student to Student Chat option in the Student User
Interface settings.

Chat to a Student whilst viewing
1. Selectthe Tools tab in the View window ribbon and click Chat.

2. The Chat window opens on the Tutor and Student machine.

To end a chat
1. Click Close in the Chat window.
Or

Select {Chat}{Close} from the Chat window drop-down menu.
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The Chat window

This window is displayed at each participating members machine and lists the progress of the Chat
session.

Note: Unless the option is disabled in the Create Discussion dialog, Students can choose to leave the
session.

(D) Chat : Assignment feedback — [m} e
Chat  Window

Close

Sarah has joined Help

Mark has joined
Members

Andy has joined
v . Andy

Mrs Smith says: Mark

Can you let me know your thoughts on section 2 in the assignment? Mrs Smith
Andy says: Sarah

1 thought that it was difficult to think of more than one answer.
Sarah says:

I could think of 2, but not 3!

Invite...

Eect

Send Message

The following options are available from the Chat window:

Chat Menu

The content of a Chat session can be stored for future reference. Choose Save As to create a file
containing the text or Copy to be able to paste the Chat content into another application or file.

Each message is restricted to 128 characters. Check Auto Send long message to automatically
send the message when the limit is reached.

You can add the content of the Chat session to the Student Journal by selecting Add to Journal.

Window Menu

Only the Tutor's Chat window will have a window drop-down menu. This menu enables you to swap
between opened screens or tile them.

Chat Progress

The main body of the Chat window is used to record the progress of a Chat session. It holds details of
members who have joined or left the discussion, as well as the messages that have been sent by each
member.
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Send Message

This is where you type your comments. Type the message and hit Enter or click Send. Each message
is restricted to 128 characters. You can automatically send the message when the limit is reached,
select {Chat}{Auto Send long Message} from the Chat window drop-down menu.

Note: Emoticons can be included within the message.

Close

Ends the Chat session.

Members

Members currently included in the Chat session are listed here. The Tutor can add or remove Students
from the Chat session as required. Unless disabled, Students have the option to leave the session of
their own accord.

Invite

To add Students when the Chat session is in progress, click Invite. The Add Members dialog will
appear, select the required Students and click Add. You can send a copy of the Chat progress to new
members by checking the Send discussion history option.

Note: Students that have been removed or have decided to leave the Chat session can be invited
back.

Eject
To remove Students from the Chat session, select the Student in the Members list and click Eject.
Ejected Students can be invited back into the session if required.
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Sending a message to Students

With NetSupport School, you can send a message to all connected Students or the currently selected
Students. If you send the same message on a regular basis, you can store up to five pre-defined

messages.

To enter and send a new message

1.

2.

Select the Students you want to send the message to.
Select the Class tab in the ribbon and click Message.
Or

Right-click and choose Message.

Or

To send a message to a group, select the Group tab in the ribbon (ensure the required group is
selected) or click the drop-down icon on the required group tab (mouse over the right-hand side
of the group tab to display this) and click Message.

The Send Message dialog appears.

Send Message >

Send a message to:

(®) Al connected Clients
() currently selected Clients

Don't forget to hand you assignments in!

Icon: () Information ~ @ %
Cancel Help

Choose whether to send the message to all connected Students, the currently selected Students
or group. Enter the message (any URLs entered are clickable at the Student), you can choose an
icon to be displayed alongside the message from the drop-down list and decide whether to show
it at Student machines for a specified time. You can further highlight the message by playing a

sound at the Student's machine. Click the Play a sound 23] icon.

Note: If a Student Journal has been started, you have the option to add the message to this.

Click Send. The message is displayed at the Student screens and remains until the user closes
the dialog or the specified time limit expires.
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To send a pre-defined message
1. Select the required Student icons.
2. Select the Class tab in the ribbon and click the Message icon drop-down arrow.
Or
Right-click and select the Message icon drop-down arrow.
Or

To send a pre-defined message to a group, select the Group tab in the ribbon (ensure the
required group is selected) or click the drop-down icon on the required group tab (mouse over
the right-hand side of the group tab to display this) and click the Message drop-down arrow.

3. The pre-defined messages are displayed. Click on the required message to send it to Students.

Note: If you have not created any pre-defined messages, you can do this by selecting Preset
Messages.

To send a quick message to all Students
1. Select the Class tab in the ribbon and click the Message icon drop-down arrow.
2. Enter the message in the Quick Message field and click the Message = icon.

3. The message is sent to all connected Students.

To send a message while viewing
1. Inthe View window, select the Home tab in the ribbon and click Message.

2. The Send Message to Client dialog appears.

3. Enter the message. Decide whether to show it at the Student's machine for a specified time. If a
Student Journal has been started, you can add the message to this.

4. Click Send.

5. The message is displayed on the Student screen currently being viewed.
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Preset messages

You can store up to five commonly used text messages that can be quickly broadcast to Students
using the Message feature.

Creating preset messages

1. Select the Class tab in the ribbon, click the Message icon drop-down arrow and select Preset
Messages.

Or

Right-click on a Student icon, click the Message drop-down arrow and select Preset

Messages.
Preset Messages x
Don't forget to send you waork in by 2.00pm. oK
/ Cancel
v Help
Icon: (@ Information v ® |:| ﬁ
Please log out of the computers. ~
7]
w
Icon: (X) Stop v @ l:l ﬁ
If you need help during the lesson, please ask. ~
i)
w
Icon: (@ Information w @ l:l ﬁ
o~
#
Tcon: Hone ®© l:l ﬁ

2. Enter the required text message.
3. Setany additional properties for the message:

» Choose an icon to be displayed alongside the message. This can be used to quickly identify
the type of message, information, question, warning or stop.

+ Indicate how long the message should remain on the Student's screen.
* You can further highlight the message by playing a sound at the Student's machine. Click
the Play a sound 23] icon.

4. To add a new message, click the Add a new message! + | icon. Use the arrows to arrange
the order of messages in the list. Click the Remove this message ~ icon to delete a
message.

5. Click OK.
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6. The message will show in the Message icon drop-down list in the ribbon, allowing you to quickly
send this to Students.
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Raising a help request

NetSupport School allows a Student to request help from a Tutor. They do this either by selecting the
Request Help command from the Student menu (assuming that it has not been configured for quiet
mode, which hides the Student icon) or by pressing the hotkeys set in the Student Configurator.

Note: If the Student Toolbar is enabled, Students can request help by clicking on the Help request

@ icon.

To raise a help request
1. Press the hotkeys, usually ALT+LSHIFT+RSHIFT.
Or
Click the Help request icon in the Student toolbar.
Or
Right-click the Student icon in the system tray and select Request Help.
2. This opens a dialog box into which the Student can type the message.
3. Click OK.

4. The help request will then be sent to the connected Tutor.

Note: Students can send an alert to the Tutor when work is complete, they need help or they need
urgent help. They do this by clicking the Help Request icon in the Student Toolbar, selecting an
option from the Alert Teacher drop-down list and clicking OK. The Student Toolbar will change colour
depending on the alert selected. The Student icon at the Tutor will change colour to notify the Tutor
what alert has been raised; green for work is complete, amber for help needed and red for urgent help
needed.

The Tutor can request support directly from a technician. A Support B suwerert jcon can be displayed in
the Tutor Console caption bar, allowing the Tutor to chat or send a message directly to the technician.
This feature needs to be enabled in the Tech Console.
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Dealing with help requests

If a Student raises a help request, an alert will be raised at the Tutor, provided it currently has that
Student connected. Any outstanding help requests will be visible to the Tutor with a Help Request icon
displayed next to the Student and a badge indicating the number of outstanding help requests on the
ribbon. This will show until that help request has been cleared.

To display current help requests
1. Select the Class tab in the ribbon and click Help Requests.

2. The Help Requests window opens, listing the outstanding requests.

{® Help Requests "
L Lp”
> D@D D
View Chat Clear Clear
Client All
Mame Help Message Received r';*:lessage Description
- Andy (% | have finished my work. 11:23:35
; Ermma [® | need some help with ... 11:21:00
< >

3. You can reply to the Student's help request by clicking the View Client or Chat icons.

Note: If a Student has raised an alert at the Tutor, the Student icon at the Tutor will change
colour to notify the Tutor what alert has been raised; green for work is complete, amber for help
needed and red for urgent help needed. You can switch these alerts off in the Tutor
configuration.

4. Once the help request has been dealt with, click the required Student's request in the Help
Requests window and click Clear or right-click the required Student icon and click Clear. To
clear all help requests, click Clear All in the Help Requests window. A Student can also clear
previous help requests from the Request Help dialog.
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Transferring files

NetSupport School includes sophisticated File Transfer functionality that enables you to transfer files
to and from a Tutor and Student machine.

File Transfer functionality can be configured by clicking Options in the Tutor Console, selecting
Settings from the drop-down menu and choosing File Transfer.

Note: While viewing a Student, you can drag and drop files from the Tutor Windows Explorer directly

to the Student's desktop.

To transfer files and folders between a Tutor and a Student

1.

2.

4,

Select the required Student in the List view.

Select the Class tab in the ribbon and click File Transfer.

Or

Right-click the Student and choose File Transfer.

Or

If you are viewing the Student, select the Tools tab in the View window and click the File

Transfer icon.

The File Transfer window to that Student opens.

Sarah - File Transfer Mute sl €])  Lock AN memet () (D) = 7 @
Home
Ea = = 8 @ O
@ a
B Files
Create Synchronise Invert  Clear Print Recent
Folder Folders [ Folders Filesw
Folder Select General Favourites
« > 1 Contents of CA\ v |[Filter vt~ ¢ 0[5
; Local Computer Name Type File Description Modified Size  Attributes
L] Favourtes HS5 12.60.0003 File Folder 03/04/2019 14:52:24 ]
m ges"t”p‘ . Perflogs File Folder 07/12/2019 10:14:54
;g Documents: Program Files File Folder 22/06/2023 11:40:38 -
¥ Downlosds P Files (86 File Fold 21/06/2023 143438
3 Floppy Drive (4] regram Files (x86) ile Folder /06/ ;34 -r--
S Users File Folder 02/06/2021 16:02:32 -r--
N & Compact Disc (D) Windows File Folder 27/06/2023 17:33:54 ----
= Versions$ on 'nsfiled04.GBR netsupportnet Z) Windows10Upgrade File Folder 28/05/2021 12:07:50
« > 1 Contents of CA\ v |[Filter v Ny ¢ o (E e
D Remote Computer - Sarah Name Type File Description Modified Size  Attributes
-] Favourites inetpub File Folder 03/08/2012 23:39:52
m ges"t”p‘ . PerfLogs File Folder 26/07/2012 08:33:48
] Documents: Program Files File Folder 31/07/2014 16:10:20 T
‘ Downloads: .
Do Program Files (x86) File Folder 27/04/2023 08:28:52 -
2 RECOVERY (D) SWSetup File Folder 14/09/2012 13:16:58 ---
Users File Folder 31/07/2014 08:21:16 -r--
Windows File Folder 15/05/2023 15:06:52 ---
D Recovery TET Text Document 18/07/2022 15:41:22 4 a

From the local or remote pane, select the destination drive or folder into which the items will be

copied.
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Note: The path to any open folders (Explorer windows) on the Student desktop is displayed at
the top of the remote pane to enable quick selection.

5. From the local or remote List view, select the item(s) to be copied to the Student. To select all
files, click the Files icon on the ribbon. To select all folders, click the Folders icon. If you want to
transfer all files and folders, click the All icon.

Note: NetSupport School provides a list of files the Tutor has recently worked with that can be
sent to a Student. Click Recent Files (the last 20 files are displayed) and select a file from the
list. The file will be copied to the current folder at the Student.

6. Click Copy File.
Note: The selected item(s) can also be 'dragged' from the List view and 'dropped' into the

destination drive or folder.

7. A confirmation dialog will be displayed. Click Yes.

8. The Copy Progress dialog will appear, showing the progress. From here, you can choose to
ignore any error messages and overwrite prompts until completion. These will then be displayed
in a summary window at the end of the operation.

Note: When a file is transferred to Android Students, it will be copied across to the File Explorer for
the Students to access.

To transfer files between Students

It is also possible to copy files and folders between two Students.

1. Display the File Transfer window for each Student.

2. Arrange the File Transfer windows so you can see both Students and simply drag files/folders
from one to the other.

Note: You can see more of a Student's files and folders by clicking Window OJ, located above the
remote pane.
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Managing files and folders

You can easily manage the file and folders you wish to work with during a File Transfer operation.

To create folders

New folders can be created at the Tutor or the Student.

=

v A WN

Select the local or remote Tree view.

Select the drive or folder in which the folder you want to create will appear.
Click the Create Folder icon on the ribbon.

The Create Folder dialog will be displayed.

Enter a name for the folder and click OK.

Add a folder to Favourites

Folders that need to be accessed regularly can be added to the Favourites folder in the Tree view.

1.
2.
3.

Select the required folder in the local or remote pane.
Click the Add icon on the ribbon.

The folder will appear under Favourites in the Tree view.

To rename a file

Select either the local or remote pane List view.
Select the file to be renamed.

Click the Rename File icon on the ribbon or press F2.
Enter the new name for the file.

Press Enter.

Changing file attributes

You may want to change the attributes of a file, for example, to read-only.

1.

2.

Select the file whose attributes you want to view or change.

Click the Properties icon on the ribbon.
Or

Right-click and choose Properties.
Or

Select the tab displaying the file name in the ribbon and click Modify.
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3. The File Properties dialog will appear.

4. Check or clear the attributes you wish to set.

Editing a remote file

You can edit a file on the Student machine at the Tutor machine and send the updated version back to
the Student.
1. Double-click the required file in the remote pane.
Or

Select the required file in the remote pane. Click the Open Item icon on the ribbon to open the
file using the default application, or click the drop-down arrow to select an application to open
the file with.

2. Adialog will appear asking you to confirm that you wish to upload the file and open it. Click
Open.

3. Make the relevant changes to the file and save and close it.

4. A prompt will appear. Click Yes to send the updated file to the Student. You can change the
name of the file by entering a new name in the Save As field. If you click No, the file won't be
copied to the Student and any changes you made will be lost.

Note: You will be advised if the file has changed while you were editing it. You can choose to
save your copy of the file with a different name, overwrite the remote file at the Student or
cancel and lose any changes you made.

Note: You can quickly edit a file using NetSupport School's internal text editor by right-clicking the
required file and selecting Quick Edit.

Deleting files and folders

You can delete files and folders from either a Tutor or Student machine.

To delete a file
1. Select the file you wish to delete.
2. Click the Delete File icon on the ribbon.

3. A confirmation dialog will be displayed. Click Yes.

To delete a folder
1. Select the folder you wish to delete.
2. Click the Delete Folder icon on the ribbon.

3. The Remove Folder dialog will be displayed.
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4. Select the Include Contents checkbox.

5. Click Yes.

Notes:
You cannot remove more than one folder at a time. If you have several folders selected in the

List view when performing the delete operation, only the last selected folder will be removed.

By default, all files deleted from the local pane will be sent to the Recycle bin. This can be

changed in the File Transfer settings.
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Synchronising folders

You can synchronise the contents of selected folders on the Tutor and Student. When you synchronise
two folders, any new or updated files in either folder will be automatically copied to the other folder.

To synchronise folders
1. Select the folder from the local pane Tree view to be synchronised with the Student.
2. Select the folder from the remote pane Tree view to be synchronised with the Tutor.
3. Click the Synchronise Folders icon on the ribbon.

4. The Synchronise Folders dialog appears.

Synchronise Folders X

B Synchronise folders between Control and Client

Local Computer
Desktop:\History resources

Client VIRT4SERVER2016
C:\Users\J.Smith\Desktop\History rasourcas:

[l include Subfolders
[] Overwrite All

Cancel Help

5. Check the displayed paths of the two selected folders.
6. Choose to include the subfolders by selecting Include Subfolders.
7. To automatically overwrite newer versions of existing files, select Overwrite All.
8. Click OK.
9. Click Yes to confirm.
10. The Folder Synchronisation progress dialog appears.
11. Theresultis displayed in the Folder Synchronisation Results dialog.

12. Click OK.
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Distributing files

As well as enabling you to transfer files to and from individual Student's, NetSupport School also
allows you to distribute files to multiple Students simultaneously.

Note:

To improve performance when distributing files, NetSupport School's Broadcast File Distribution
facility is enabled by default. This results in the files being sent to all machines simultaneously, thus
improving the speed of transfer. If this feature is turned off, the files are sent to each Student

machine in turn.

Whilst reducing overall network traffic generated by NetSupport School, using this feature will
generate additional broadcast packets on your network. It is recommended that you consult your
network administrator before using this feature.

File Distribution can be sent to Students using multicast. The broadcast will only be sent to machines
included in the specified IP multicast address.

To distribute files to Students

1. Select the Group tab in the ribbon and click File Distribution.

Note: To distribute files to a group, select the required group from the group bar.

2. The File Distribution window appears.

All Clients - File Distribution Mute Al CJ) Lok All memet(@) (O = 7 @ _ 0O X
Home
EERA] [m]
oo L
Ea B8 BB G &2 .. Fo @ O
Set Lock Copy Create Delete Rename Imvert  Clear Print Recent
Destination  Folder File Folder  Folder Folder  [JFolders Files ~
Clients Folder Select General Favourites
« 5 1 Contents of CA\ ~ || Filter v N~ ¢ g (=] 8=
|:_| Local Computer MName Type File Description Modified Size  Attributes
[ Favourites NSS 12.60.0003 File Folder 03/04/2019 14:52:24 -
B0 Desktop: Perflogs File Folder 07/12/2019 10:14:54
j Documents: . .
H Program Files File Folder 20/06/2023 09:04:44 -r--
.. Downloads:
: . Program Files (x86) File Folder 29/06/2023 08:55:26 -r--
a2 Floppy Drive (A:) X
Lo Users File Folder 02/06/2021 16:02:32 -r--
. & Compact Disc (D7) Wi!ndnws F!\e Folder 29/06/2023 08:55:42 ---
0 Versions$ on 'nstfile004,GBR.netsupport.net’ (Z:) Windows10Upgrade File Folder 28/05/2021 12:07:50
Mame Destination Folder Description Client Platform K
@ g Emma alll @5 2\ Windows & x64
@ g Mak c Windows 2016
Windows 2016 9

@ 2 Elie =
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3. Inthe remote pane, indicate which Students you wish to copy files to (remove the check mark
next to the Student to exclude them).

4. From the Tree view, select the item(s) to be copied to the Students. To select all files, click the
Files icon on the ribbon. To select all folders, click the Folders icon. If you want to transfer all
files and folders, click the All icon.

Note: NetSupport School provides a list of files that the Tutor has recently worked with which
can be sent to a Student. Click Recent Files (the last 20 files are displayed) and select a file
from the list. The file will be copied to the current folder at the Student.

5. The location on the Student machines where the files/folders are copied to is called the
destination folder. Unless otherwise specified, the Student destination folder will be the same as
the item(s) located on the Tutor machine. If the Student does not have the same folder
available, the item(s) will be copied to the C drive by default and the folder automatically
created.

Or

To set a specific destination folder on the Student machine, right-click the Student icon in the
remote pane and choose Set Destination. Specify a destination and click OK.

Note: To set the destination folder for all Students, click the Set Destination icon on the
ribbon. You can lock the destination folder at Students by clicking Lock Folder.

6. Click Copy File.
7. A confirmation dialog is displayed. Click Yes.

8. A Copy Progress dialog appears, showing the progress of the transfer. You can choose to ignore
error messages and overwrite prompts until the operation is completed.

Note: When a file is distributed to Android Students, it will be copied across to the File Explorer for
the Students to access.
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Send work files

Two methods are available for sending pre-prepared work files to Student machines:

Quick send: Useful for one-off operations where you want to send work to all connected
Students or a defined group of Students.

Advanced send: Enables you to store the properties of an operation that will be performed
regularly and provides greater flexibility as to which Students the work is sent to.

To send work using quick send

1.

Decide which Students to send work to, all or a defined group. You cannot select individual
Students using quick send.

Select the Work Planner tab in the ribbon and click Send Work.

The Quick Send dialog appears.

Quick Send

Files to Send o
en

Lit the fie(s) to send to the Students. Fles should include a ful path and

optionaly a widcard specification. You can include mutltiple specifications by

separating them with ;' Cancel

For example: Enter 'C:\HomeWork\™.™" to include al files in the HomeWork folder
Or "C:\Study\ TEST.DOC; C:\Study\TEST.HTM' to send the TEST.DOC and
TEST.HTM files from the folder Study.

Ci\Users\testng\Documents\Resources Browse
\English_poets_assignment.pdf
[ send subfoiders
Location to Send To
Specify the folder at the Student machine to copy the files to. A new folder will be
created if necessary.
' v

List the file(s) or specify a folder to send to the Students. Files should include a full path and

optionally a wildcard specification. You can include multiple specifications by separating them
with ';".

Or

Click Browse to locate the file(s).

Or
Enter the path for the file or folder in the Add field and click Add.

If you are sending a folder to Students, you can also send any subfolders. Click Include
subfolders.

Specify the folder at the Student machine to copy the file(s) to. You can choose Desktop or
Documents from the drop-down list. A new folder will be created if necessary.
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7. Click Send.

8. The result of the operation will be displayed for you to check that the work has been sent
successfully.

9. Click OK.

To send work using advanced send
1. Selectthe Work Planner tab in the ribbon and click Send/Collect Work.

2. The Send/Collect Work dialog appears.

B Send/Collect Work %

Select an operation from the Ist and click Send Work or Collect Work. Add a new operation by clicking New, modify an
@ existing operation by selecting it and cicking Properties.

Description Last ... Last Collected Status Students
English assignment FriJu... Frilun 30 1... INVH764, VIRT4SERVER2016

Help

New... Properties Reset... Close

3. Existing send/collect work operations are listed.

4. To add a new operation, click New. The Send/Collect Work wizard appears. Follow the
instructions in the wizard.

5. Select an operation from the list and click Send Work.
6. The Select Students dialog appears.

7. You can send work to all Students or click These Clients to select the required Students
(remove the check mark next to the Student icon to remove them).

8. Click OK.

9. The result of the operation will be displayed for you to check that the work has been sent
successfully.

10. Click OK.

Once work has been sent to the Students, a Send work status pane appears in the ribbon showing the
current status.
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& Completed ;39 Andy (111)

] Remaining
Progress

Sent work status

You can show Students who have completed their work or those with items remaining by clicking the
appropriate option. The overall progress allows you to keep track of how many Students have
completed the work.

The Students can open work items from the Student Toolbar and click when a work item is complete.
This updates the status in the Send work status pane.
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Collect work files

Two methods are available for retrieving completed work files from Student machines:
* Quick collect: Remembers the last file(s) sent via quick send and provides a quick and easy
method for retrieving the work back at the end of a session.
« Advanced collect: Lets you select the file(s) to retrieve from a list of pre-defined send/collect
operations and provides greater flexibility as to which Students the work is collected from.
To collect work using quick collect

1. Selectthe Work Planner tab in the ribbon and click Collect Work.

2. The Quick Collect dialog appears.

Quick Collect o

Ready to collect files from students sent on:
Wed Jun 28 14:57.25 2023

Files to Collect S

Collect files:

Enlish poets_assignment pd | Cancel

Collect from folder at Student:

| Documents: ~ |

[] Delete files on Student's computer after collecting

Folder to Collect To on your computer

~ Browse... &)?

3. Specify the name of the file(s) to collect, e.g. *.* or Testl.txt;Test2.txt.

4. Specify the folder in which the file(s) are stored, e.g. C:\Desktop, and whether you want to
remove the file(s) from the Student machine after collecting them.

Note: The Collect files and Collect from folder at Student fields are pre-populated with the
last files sent using quick send.

5. Specify the folder on the Tutor machine to collect the file(s) in. You can choose Desktop or
Documents from the drop-down list or click Browse to specify a different folder.

6. Click Collect.

7. The result of the operation will be displayed for you to check that the work has been collected
successfully.

8. Click OK.
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To collect work using advanced collect

1. Select the Work Planner tab in the ribbon and click Send/Collect Work.

2. The Send/Collect Work dialog appears.

=3 Send/Collect Work b
Select an operation from the kst and click Send Work or Collect Work. Add a new operation by clicking New, modify an
Q existing operation by selecting it and clicking Properties.
Description Last ... Last Collected Status Students Send Work
English assignment Frilu... Frilun 30 1... INVH764, VIRT4SERVER2016 RS
Help
New... Remove... Properties Reset... Start Close
o

3. Select the required operation from the list and click Collect Work.

4. The Select Students dialog appears.

Select Students b
Select the Students to Send the fies to
Cancel
@ All Students
Help
() These Clients:
Name ’ Client Na... Description

@ g Eie  VIRT4SERV...
@ o EMM2 HPLAP-Z
@ o Mark INVH764

Removing the check mark next to a Chent excludes it from the operation.

Summary
Send 1 fies to Folder Documents: at Students.

Select the Students you want to retrieve the file(s) from.

5. Click OK.
6. The result of the operation will be displayed for you to check that the work has been collected

successfully.

7. Click OK.
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To change the properties of an operation

Manage the properties (the description, file location etc.) of a send/collect work operation.

Change the properties of an operation

1. Selectthe Work Planner tab in the ribbon and click Send/Collect Work.

2. The Send/Collect Work dialog appears.

B Send/Collect Work X
Select an operation from the kst and click Send Work or Collect Work. Add a new operation by clicking New, modify an
Q existing operation by selecting it and clicking Properties.
Description Last... LastCollected Status Students Send K
English assignment FriJu... Frilun 30 1... INVH764, VIRT4SERVER2016 e
Help
New... Remove. p Resat Start Close
o

3. Select an operation from the list and click Properties.

4. The Send/Collect Work Properties dialog appears.

Send/Collect Work X
Description: Files to Send/Collect
Yr 7 assignment Name Path
English poets C:\Users\testi Data\Roami...
Student Folder: ngish pos \Usersitesting\AppData\Roam
Documents: ~

[ Clear out the Folder before Sending work
[ ] students store work on a Network Drive

Store using sub-folders based on Student name

Store using sub-folders based on Machine name

Add
_Ccller:t Files to local Folder: ] Remove
Documents: v Browse...
["] send subfolders
Delete all files from Folder before Collecting work
["]Remove files from Student after collecting
(®) Use sub-folders based on Student name Ao

(") Use sub-folders based on Machine name
=

5. Adjust as necessary.

6. Click OK.
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Remotely launching applications and websites at
Students

This feature allows you to launch (execute) applications and websites on an individual Student
machine or a group of Student machines without the need to remote control them. For example, after
showing Students how to use an application, you might want to launch it on their machines.

Note: Applications must be installed on, or available to, the Student machines.

Launch an application or website at a Student from the Tutor Console
1. Select the required Student in the List view.
2. Select the Class tab in the ribbon and click Quick Launch.

3. The Quick Launch pane appears.

< Quick Launch

ﬁ @ q == Details Show Applications

88 Large Icons Show URLs
Add Add Send to

Application  URL Students O Logged in

s C C
s 12 L
Microsoft MSPaint  https:/fwww.; hitps:/fww...
Edge wikipedia.org;
!

4. Click Add Application or Add URL.
5. If adding an application, enter the name and path of the application to launch at the Student.
Or

Click Browse and select an executable application on the Tutor machine.

Notes:
« When adding applications on Windows machines that have the Microsoft Store, two tabs
will be displayed in the Application Properties dialog. The Desktop Application tab allows

you to add standard Windows applications as detailed above. The Windows Store
Application tab lists Windows Store applications.
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* Check that Student applications are stored in the same location as the Tutor to ensure
successful execution.

« If you want to launch a specific file with the application, you must separate the two
instructions with quotes. For example, "C:\Program Files\Microsoft Office\Excel.exe"
"C:\My Documents\Accounts.xIs".

Click OK.
If adding a website, enter the URL and click OK.

The application or website icon is displayed in the Quick Launch pane and saved for future use.

Notes:

» If you only want to launch applications or websites to Students who are logged on, select
the Logged in option.

* You can choose to display just applications or websites by clicking the Show
Applications or Show URLs option.

Select the required application or website and click Send to Students.

Launch an application at a Student from the Tech Console

1.

2.

Select the required Student in the List view.

Select the Home tab in the ribbon and click Launch Application.
Or

Right-click the Student and choose Launch Application.

The Execute Application at Client dialog appears.

Select the Execute tab.

Enter the name and path of the application to launch at the Student.
Or

Click Local Browse to browse for the application on the Tech Console machine.

Note: Check that Student applications are stored in the same location to ensure successful
execution.

Select Add to List to save the application for future use in the Saved List tab. Confirm the
description and path.

Note: The application is added to the Launch Application drop-down list in the ribbon.

If you only want to launch the application to Students that are logged on, select Execute only if
the Client is logged on.

If you don't want to view the result of the operation, click No result required.

Click Execute.
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The application will now be launched at the selected Student and if applicable, the result of the
operation is displayed in the Results pane.

If you have saved a list of applications, you can select the required application from the Launch
Application drop-down list.

Click Client must be logged on to launch the application at Students that are logged on and if
you don't want to see the results of the operation, click No result required.

The application will be launched at the Student and the Execute Application at Client dialog
appears, displaying any results.

Note: You can quickly add applications to the saved list by clicking the Launch Application icon in
the ribbon and selecting Add Application from the drop-down menu.

Launch an application on a Student machine whilst viewing

A list of applications can be saved in the View window, allowing you to quickly launch these at a
Student.

7.

Select the Home tab in the View window ribbon.

Click Add.

Enter the name and path of the application.

Or

Click the Folder = icon to browse for the application on the Tutor machine.
Click OK.

The application will be listed in the Quick Launch pane.

Note: Click Manage to edit or remove a listed application.

You can now launch the application at the Student. Select the application in the list and click
Launch or double-click the application.

The application will run at the Student.

Note: You can also remotely launch an application that has been saved in the Quick Launch pane in
the Tutor Console. Select Launch Application, select the required application (or click Add to add a
new one) and click Launch.
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To launch an application on a group of Students

1. Click the drop-down icon on the required group tab (mouse over the right-hand side of the group
tab to display this) and click Quick Launch.

2. The Launch Application dialog appears.

¥ NetSupport School X
A 0 Add
¢ >
chrome MSPaint wmplayer Remove
Properties

Execute only if the Client is logged on

Close

3. Click Add.
4. Enter the name and path of the application to launch at the Students.
Or

Click Browse and select an executable application on the Tutor machine.

Notes:

* When adding applications on Windows machines that have the Microsoft Store, two tabs
will be displayed in the Application Properties dialog. The Desktop Application tab allows
you to add standard Windows applications as detailed above. The Windows Store
Application tab lists Windows Store applications.

* Check that Student applications are stored in the same location as the Tutor to ensure
successful execution.

5. Click OK.

6. The application icon will be displayed in the Launch Application dialog and saved for future use.

Note: If you only want to execute applications to Students that are logged on select the option
Execute only if the Client is logged on.

7. Select the required application and click Launch.
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Edit a saved application or website

You can edit applications and websites that have been saved when using Quick Launch.

Edit a saved application or website
1. Select the Class tab in the ribbon and click Quick Launch.
2. Right-click the application or website to edit and select Properties.

Edit the required details and click OK.

> W

Click Close.
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Remove a saved application or website

You can remove applications and websites that have been saved when using Quick Launch.

Remove an application or website
1. Select the Class tab in the ribbon and click Quick Launch.
2. Right-click the application or website to remove and select Remove.

3. Click Close.
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User defined tools

As well as allowing you to launch applications at Student machines, you can automatically run a task
on a Tutor or Tech Console machine using a defined tool.

ﬁ @ Edge + Add

£ Edit

X Remave

Run

User Defined

To add a tool
1. From the Tutor Console, select the Administer tab in the ribbon.
Or

From the Tech Console, select the Tools tab in the ribbon.

2. Click Add.
3. The Add Tool dialog appears.
4. Enter the required information.

o

Click OK.The new tool will be listed.

6. Click Close.

To run a tool
1. From the Tutor Console, select the Administer tab in the ribbon.
Or
From the Tech Console, select the Tools tab in the ribbon.
2. Select the required tool in the User Defined pane.
3. Click Run.

4. The tool will automatically run.
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To edit a tool

1.

ol

From the Tutor Console, select the Administer tab in the ribbon.
Or

From the Tech Console, select the Tools tab in the ribbon.
Select the required tool in the User Defined pane.

Click Edit.

The Edit Tool dialog appears.

Edit the appropriate information and click OK.

To delete a tool

1.

From the Tutor Console, select the Administer tab in the ribbon.
Or

From the Tech Console, select the Tools tab in the ribbon.
Select the required tool in the User Defined pane.

Click Remove.

A confirmation dialog appears, click Yes.The tool will be removed.
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Rebooting or logging out Students

Having connected to a Student or group of Students, you can remotely log out or reboot the Student
machines at the end of a session. This is a simple way to prepare multiple machines for the next group
of Students.

To reboot or log out a Student
1. Select a Student or group of Students.
Or

To select all logged-in Students, click the Select logged in Students < icon on the status bar.
2. Select the Administer tab in the ribbon and click Reboot or Logout.

Or

Right-click a Student and click the Reboot & or Logout © icon.

3. A message appears confirming the Student(s) included in the reboot/log out.

Note: If you don't want to see this message in the future, click Don't show this again. It can
be turned back on in the Tutor User Interface settings.

4. Click Yes.

To reboot or log out a Student whilst viewing
1. Select the Home tab in the View window ribbon and click Reboot or Logout.

2. Click Yes to confirm the reboot/logout.
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Manage user account

NetSupport School allows you to manage users (reset and unlock passwords) that are part of Active
Directory, allowing you to easily reset Student passwords at the end of a lesson, if required. You can
see user accounts that have been locked, unlock the account or assign a new password.

If non-domain administrators want to use this facility, you will need to apply the appropriate rights to
them. Please contact our Support team for full instructions on how to do this.

To reset a Student password

1. Select the Student to reset the password for.

Note: You can select all or a group of Students to reset the password for.

2. Select the Administer tab in the ribbon and click Manage Account.

3. The Active Directory User Account dialog appears. The logged on user name for the selected
Student will be displayed. Click Modify.

4. The Manage Directory User Account dialog appears.

B Manage Directory User Account X
User details
Domain Username
| ECWIN10-1\testing | |testing |

Description

| User Account |

Account status

Account is unlocked Unlock

Password

MNew Password | |

Confirm Password | | Set

Force password change at next login

Back Refresh

From here, you can see the current user details, unlock the account and set a new password.
When setting a new password, you can force the user to change this when they next log in.

Note: If you selected multiple Students, you will only be able to set a new password and not unlock
accounts or force a password change.

249


http://www.netsupportsoftware.com/support

NetSupport School 15.10

Web Control module

The Web Control module is used to monitor and control the websites visited by connected Students. A
record of websites visited in a session can be stored and, if required, the Tutor can restrict or approve
the use of specific websites. In addition, the Tutor can temporarily suspend all internet access.

Note: Supported Internet Browsers for internet metering and restrictions are Microsoft Edge, Firefox
and Google Chrome. The following supports internet restrictions only: Opera 9 and higher.

Switching to Web View

1. Click the Web View @ icon on the left-hand side of the Tutor Console.

Or
Select the View tab in the ribbon, click the drop-down arrow * in the Mode section and choose
Web View.
B NetSupport School : ECWIN10-1 Mutean G Lok an memet (2) (O = = 4
'Clal Group Select Feedback &\‘\'Ellhﬂr‘g Journal Work Plannér Administer WView ~ Options
3 6 6009 &P 000 B A @ @ @ -
Student lock Urlock Blank  Show  Cuick  Studert  Chat  Anvource  Message Huelp Unrestricted Restrict  Time Limited = el
Register A ~ Laurch ~ Desktop Requests - Al Access
Chass Student Communicate Web Access Qplicrs
o 0 o) o o ® Q
0| ~e W O O O @
] - [l o) o]
9
|@
B @ 4 @+ + < @
URL Descripti URL Description
v 9 grows 2 6 st *« & 0 88

In Web mode, you can view details of approved or restricted websites and use the available icons in
the ribbon to:

» Revert back to unrestricted access if restrictions have been in place.

» Activate the Approved Websites list. The Student will only be able to view websites that are in
the Approved Websites list. All other websites are blocked. When the Student accesses the
internet, they are forced to choose an approved website rather than being able to surf at will.

250



NetSupport School 15.10

* Activate the Restricted Websites list. The Student will not be able to view websites that are in
the Restricted Websites list but will be able to view all other websites.

e Restrict access to the internet.

* Allow web access for a limited time.

Notes:

* A padlock will be displayed next to the Web View @ icon when there are central policy
restrictions in force. You can turn on/off a central policy created in the Tech Console by clicking
the Apply Policy option in the ribbon. You can override the restrictions in the Tutor
configuration.

* To temporarily block web access for all Students, select Internet on the caption bar (this can
be done from any window). If this is not showing, click the Configure Quick Access List =
icon and select Web access from the list. An indicator will appear next to the Student icons to
confirm internet usage is suspended.
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Identify websites currently running on the Student
machine

You can monitor websites that are currently running at Student machines.
Identify websites currently running on the Student machine

1. Click the Web View® icon on the left-hand side of the Tutor Console.
Or

Select the View tab in the ribbon, click the drop-down arrow * in the Mode section and choose
Web View.

In the List view, the Student icons can be viewed in two different ways, large icons or details view.
Click the Large icons @& icon or the Details == icon on the status bar.

The lower panes can be minimised to make more room for the Student icons. Click the Minimise
View EI icon.

When viewing Students in large icons view, an icon is displayed next to the Student icon if a Student
has a web browser open. This icon is either the default web browser icon or a personalised website
icon. If the List view is in details view, the current website is displayed along with a list of all other
website's running on the Student machine.

When viewing either of the two views, the order of the Student icons can also be rearranged. Right-
click in the List view and choose Arrange. The following options are available:

By Name Student icons will be arranged in alphabetical order according to their
Student name, display hame or Student register name.

By Current Website Studenticons will be arranged in alphabetical order according to the current
website the Student is viewing.

By All Websites Student icons will be arranged in alphabetical order according to the running
websites on the Student machine.

By Policy Student icons will be arranged in alphabetical order according to the current
policy set in the Tech Console. This option only appears if there is a policy in
force.

A tick identifies the selection of one of the above options.
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If this option has been selected, the Student icons will appearin
ascending order according to the option selected above. A tick identifies
selection of this option. Click this option again to clear. This will arrange
the Student icons in descending order.

This option is only available if a background image has been set to tile.
This will align the Student icons to the centre of the image.

If a new Student has been added to the list, or a new website is running
on a Student machine, this option will automatically arrange the icons
into the order selected above. A tick identifies selection of this option.
Click this option again to clear.
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Managing websites on Student machines

Not only can you identify the websites running on Student machines, you can also change, close and
launch websites at Students.

Change the current website running on a Student machine

This method allows you to change the current website running on a Student machine to another
website that the Student has open.
1. Switch to details layout by clicking the Details view == icon on the status bar.
Or
Right-click in the List view and select Details.
2. Right-click the required website icon listed in the All Web Sites column.
3. Select Activate.

4. The newly activated website now replaces the current website running on the Student machine.

Close the current/running website on a Student machine
1. Switch to details layout by clicking the Details view == icon on the status bar.
Or
Right-click in the List view and select Details.
2. Right-click a website in the Current Web Site or All Web Sites column.
3. Select Close Browser.

4. The website will be closed at the Student machine and the website icon will disappear from the
List view.

Note: You can close a website at all connected Students by clicking the Close at Students ® icon

above the Approved or Restricted Websites pane or right-clicking in the pane and choosing Close at
Students.

Launch a website on all connected Students

1. Select a website in the Approved Websites list.

2. Click the Send to Students °<g icon above the list.

Or
Right-click and select Send to Students.

3. The website will be launched on all connected Student machines.
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In the List view, the launched website icon will appear in the Current Web Site column or on the
Student icon.

Highlight a website in the Approved or Restricted Websites list.
Drag and drop the highlighted website in the List view.
The website will be launched on all connected Student machines.

In the List view, the launched website icon will appear in the Current Web Site column or on the
Student icon.
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Setting up an Approved or Restricted Websites list

Approved websites: When activated, Students can only view the websites specified in this list. The
list of approved websites is displayed on the Student Toolbar. If this is disabled, a page is displayed at
Student machines.

Restricted websites: When activated, the Student is unable to view the websites specified in this
list. However, all other websites can be viewed.

Notes:

 To ensure Students are only viewing the appropriate pages in a website you can
approve/restrict sub-URLs, specific web pages and have different parts of the same website
approved/restricted, i.e. www.bbc.co.uk/learning can be restricted but
www.bbc.co.uk/learning/history can be approved. Students will only be able to view pages
relating to history and not view pages relating to Science or English.

+ Web restrictions can be applied at startup. Click Options in the Tutor Console, select Network
Settings from the drop-down menu and choose Start Options - Restrictions.
Add a website to the Approved or Restricted Websites list
1. Click the Add ~+ icon.
Or

Right-click in the Approved Websites or Restricted Websites pane and select Add Website.

2. The Website Properties dialog appears.

Website Properties *

Website Properties
URL:

|| View Cancel

Description:
| Help

oK

Visible at Student

Advanced Properties

Keywaords:

Keywaords are used to identify the website when blocking
or redirecting it

3. Type in the website address under URL.

4. Type in the description, e.g. Google (this is optional).
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Note: By default, keywords are entered to prevent/allow a Student to view a URL that includes
these keywords. This can be used to deal with websites that are re-directed.

By default, websites added to the Approved Websites list appear in the Student Toolbar. If you
don't want Students to see this website, you can hide it by clearing the Visible at Student
option.

Click OK.

The website and description will appear in the Approved Websites or Restricted Websites pane.

Switch the List view to details view by clicking the Details view =z icon on the status bar.
Right-click on a website icon in the List view in the Current Web Site or All Web Sites column.
Choose Add to Approved List.

Or

Choose Add to Restricted List.

The Website Properties dialog appears with the website details pre-populated.

Click OK.

The website and description will appear in the Approved or Restricted Websites list.

Remove a website from the Approved or Restricted Websites list

1.

Highlight the chosen website and click the Remove X icon.

Or

Right-click the website and select Remove Website.

Create a new Website list

You may need to create more than one Website list, for example, if you want different websites
approved or restricted for different classes. The default Website list is saved as NetSupport

School.web
1. Select the Class tab in the ribbon and from the Website list drop-down menu, click Create
New Website List.
2. Enter a file name and click Create.
3. A new blank Website list will appear.
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Open an existing Website list

1. Select the Class tab in the ribbon and from the Website list drop-down menu, click Load
Existing Website List.

2. Highlight the relevant file and click Open.

3. The existing Website list will appear.

Save a new Website list

1. Select the Class tab in the ribbon and from the Website list drop-down menu, click Save
Website List As.

2. Enter a file name and click Save.

3. The current Website list will be saved.

Notes:

*« Any changes made to a new or existing Website list are automatically saved when a new
Website list is created, or when you exit out of the Tutor Console.

* The approved Website list can be added to the Student Journal by clicking the Journal =l icon
above the Approved Websites pane.
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Blocking/restricting internet access

NetSupport School allows you to control what websites Students are able to access. This is done by
creating Approved or Restricted Websites lists which can then be applied to individual or all connected
Students. Students can view the current restrictions in the Student Toolbar. You can also block all web
access for all Students if required.

Notes:

 Web restrictions can be applied at start-up. Click Options in the Tutor Console, select
Network Settings from the drop-down menu and choose Start Options - Restrictions.

* You can set the web access from the Class tab in the ribbon in all view modes.

Apply approved or restricted websites
1. If you want to apply restrictions to individual Student's, select their icons in the List view.
2. Select the Class tab in the ribbon and click Approved Only or Block Restricted.

3. To acknowledge which restriction has been activated, an appropriate indicator will appear next
to the Student icons. Red for restricted, green for approved.

4, If a Studentis currently viewing a website included in the activated restriction list, they will be
redirected to a message stating that the website has been blocked by the Tutor.

Notes:

* You can amend the URL that restricted websites will be redirected to. Click Options in the
Tutor Console, select Network Settings from the drop-down menu, choose Administration
- Security and enter the required URL in the URL that restricted websites will be
redirected to field.

* Full internet redirection is supported on Edge, Firefox and Chrome. For other browsers, the
browser window will close.

* You can specify a time limit that certain internet permissions apply for. Select the Class tab in
the ribbon and click Time Limited Access.

End approved or restricted websites
1. Toremove the restrictions for individual Student's, select their icons in the List view.
2. Select the Class tab in the ribbon and click Unrestricted.

3. The green or red indicator will be removed from the selected Student icons.

Note: Because internet browsers often hold the results of recent web access attempts in cache
memory, lifting an internet restriction may not appear to take effect immediately. If this happens, you
may have to restart the browser. The same situation may arise if you are using an application which
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requires internet access to a site that has been blocked. Once the restriction has been lifted, you may
need to restart the application for it to recognise the change.

Block all web access

Allows you to block all access to the internet for Students. An indicator will appear next to the Student
icons to confirm internet usage is suspended.

1. If you want to block web access for individual Student's, select their icons in the List view.

2. Select the Class tab in the ribbon and click Restrict All.

3. All web access will be blocked for the selected Students.

Notes:

* You can instantly block all web access for all Students by clicking Internet on the caption bar
(this can be done from any window). This changes to Blocked to show web access is now

blocked. If this is not displayed, you can add it by clicking the Configure Quick Access List
= icon and selecting Web access from the list.

e You can also block web access for all connected Students from the Tutor Toolbar.
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View web history

This feature of the Web Control module enables you to monitor the websites being visited by
connected Students and, if required, store or print a permanent record.

Note: Students' web history can be automatically saved to the Tutor Journal when the Tutor Console
is shut down. To enable this setting, click Options in the Tutor Console, select Settings from the
drop-down menu, choose User Interface - Tutor and click the Save Student Web history to
Tutor Journal option.

View web history
1. In Web View, select the Class tab in the ribbon and click History.

2. The Web History dialog appears.

&b Web History O *
Show History for: s Al Students v
Student Name Login Name Computer Name Page URL
; Mark Administrator  INVH764 itv - Google Search https:/www.google.com/search?q=it
; Mark Administrator  INVH764 NetSupport School - Platforms https:/fwww.netsupportschool.com/p
6 Mark Administrator  INVH764 NetSupport School - Classroom Management Software https:/fwww.netsupportschool.com/
; Chris testing HPLAP-2 Explore / Twitter https:/ftwitter.com/
; Mark Administrator  INVH764 NetSupport School - Clzssroom Management Software https://netsupportschool.comy/
; Chris testing HPLAP-2 Facebook — lng in or sign up https://en-gb.facebook.com/
; Chris testing HRLAP-2 facebook - Google Search https:/{www.google.com/search?q=fz
; Mark Administrator  INVH764 Mew Tab https://{/
; Mark Administrator  INVH764 Qverview | Our Solar System — MASA Solar System Exploration  https://solarsystem.nasa.gov/solar-syst
; Mark Administrator  INVH764 solar system - Google Search https:/www.google.com/search?q=s
; Mark Administrator  INVH764 Sky Sports - Sports Mews, Transfers, Scores | Watch Live Sport  https://skysports.com/
; Mark Administrator  INVH764 sky sports - Google Search https:/fwww.google.com/search?g=sh
; Mark Administrator  INVH764 New Tab https:///
; Chris testing HPLAP-2 Home - BBC Bitesize https:/fwww.bbc.co.uk/bitesize
; Chris testing HPLAP-2 Home - BBC Bitesize https:/fwww.bbc.co.uk/
; Chris testing HPLAP-2 KS3 English - BBC Bitesize https:/fwww.bbc.co.uk/bitesize/subje
< >
Save... Export... Print... Help Close

©

This provides details of the sites visited by the Student(s) during the currently connected session.
The available options are:

Show History for

You can view the history for all Students, the currently selected Students or you can select the
required Student from the list.

Refresh
While viewing the list, click Refresh at any time to update the display.
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Save

To keep a permanent record of the displayed items, you can save the details to a text file before
disconnecting.

Export
Exports data to a CSV file allowing the data to be imported if needed.

Print

Prints details of the currently displayed items.

Close

Closes the History dialog but details will continue to be recorded while the Tutor is connected.
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Application Control module

The Application Control module is used to monitor and control the applications used by connected
Students. A record of applications used in a session can be stored and, if required, the Tutor can
restrict or approve the use of applications.

Switching to Application View

1. Click the Application View @ icon on the left-hand side of the Tutor Console.

Or

Select the View tab in the ribbon, click the drop-down arrow ** in the Mode section and choose
Application View.
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In Application mode, you can view details of approved or restricted applications and use the available
icons in the ribbon to:

* Revert back to unrestricted access if restrictions have been in place.

* Activate the Approved Applications list. Students can only run applications that are in the
approved list. All other applications are blocked.

» Activate the Restricted Applications list. Students can't run applications that are in the restricted
list but will be able to run all other applications.
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Note: A padlock will be displayed next to the Application View F icon when there are central

policy restrictions in force. You can turn on/off a central policy created in the Tech Console by clicking
the Apply Policy option in the ribbon. You can override the restrictions in the Tutor configuration.
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Identify applications currently running on the Student
machine

You can monitor applications that are currently running on Student machines.

Identify applications currently running on the Student machine

1. Click the Application View @ icon on the left-hand side of the Tutor Console.
Or

Select the View tab in the ribbon, click the drop-down arrow ** in the Mode section and choose
Application View.

In the List view, the Student icons can be viewed in two different ways, large icons or details view.
Click the Large icons &t icon or the Details == icon on the status bar.

The lower panes can be minimised to make more room for the Student icons. Click the Minimise
View 3] icon.

When viewing Students in large icons, an icon is displayed next to the Student icon, showing the
current application in use. If the List view is in details view, the current application, along with a list of
all other applications running on the Student machine is also displayed.

When viewing either of the two views, the order of the Student and application icons can also be
rearranged. Right-click in the List view and choose Arrange. The following options are available:

By Name Student icons will be arranged in alphabetical order according to
their Student name, display name or Student register name.

By Current Application Student icons will be arranged in alphabetical order according to
the current application.

By Running Applications Student icons will be arranged in alphabetical order according to
the running applications on the Student machine.

By Policy Student icons will be arranged in alphabetical order according to
the current policy set in the Tech Console. This option will only be
displayed if there is a policy in force.

A tick identifies the selection of one of the above options.
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If this option has been selected, the Student icons will
appear in ascending order according to the option
selected above. A tick identifies that this option is
selected. Click this option again to clear. This will
arrange the Student icons in descending order.

This option is only available if a background image
has been set to tile. This will align the Student icons
to the centre of the image.

If a new Student has been added to the list or a new
application is running on a Student machine, this
option will automatically arrange the icons into the
order selected above. A tick identifies that this option
is selected. Click this option again to clear.
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Managing applications on Student machines

Not only can you identify what applications are running on Student machines, you can also change,
close and launch applications at Students.

Change the current application running on a Student machine

This method allows you to change the current application running on a Student machine to another
application that the Student has open.
1. Switch to details layout by clicking the Details view == icon on the status bar.
Or
Right-click in the List view and select Details.
2. Right-click on an application icon listed in the Running Applications column.
3. Select Activate.

4. The newly activated application now replaces the current application running on the Student
machine.

Note: You can minimise all applications at Student machines. Select the Class tab in the ribbon, click
the Student Desktop icon and choose Show Desktop.

Close current/running applications on a Student machine

There are two options when closing an application on a Student machine:

Close Application: Close down an application but respect any applications requests at the Student,
e.g. to save file before closing.

Kill Process: Force the application to close, without any application prompts.

To close an application running on a Student machine
1. Switch to details layout by clicking the Details view == icon on the status bar.
Or
Right-click in the List view and select Details.

2. Right-click on an application icon listed in the Current Application or Running Application
column.

3. Select Close Application or Kill Process.

4. The application will be closed at the Student machine and the icon will disappear from the List
view.
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Note: You can close an application at all connected Students by clicking the Close at Students @
icon above the Approved or Restricted Applications pane or right-clicking in the pane and choosing
Close at Students.

To close all applications at the Student

All running applications at the Student will be forced to close.

Note: This feature is not supported for Windows Store applications. Only standard Windows desktop
applications will be closed.

1. Select the Students you wish to close applications at.
2. Select the Class tab in the ribbon, click the Student Desktop icon and click Clear Desktop.
Or

Right-click on an application icon listed in the Current Application or Running Application column
and select Close All Applications.

Note: You can switch Windows 8 Students to either the desktop or Start screen by selecting the Class
tab in the ribbon, clicking the Student Desktop icon and choosing Switch to Desktop or Switch to
Start screen.

Launch an application on all connected Students

1. Select an application in the Approved Applications list.

2. Click the Send to Students °<g icon above the list.

Or

Right-click on an application icon in the Approved or Restricted Applications list and choose
Send to Students.

3. The application will be launched on all connected Student machines.
4. Inthe List view, the launched application icon will appear in the Current Application column or
on the Student icon.

Or

1. Highlight an application in the Approved or Restricted Applications list.
2. Drag and drop the highlighted application into the List view.
3. The application will be launched on all connected Student machines.

4. Inthe List view, the launched application icon will appear in the Current Application column or
on the Student icon.
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Setting up approved or restricted application lists

Approved Applications: The Student is only able to run the applications specified in this list.
Restricted Applications: The Student is unable to run the applications specified in this list.

Note: Application restrictions can be applied at startup. Click Options in the Tutor Console, select
Network Settings from the drop-down menu and choose Start Options - Restrictions.

Add an application to your Approved or Restricted Applications list
1. Click the Add T icon.
Or
Right-click in the Approved or Restricted Applications List pane and select Add Application.
Or

Drag and drop applications from your desktop or Start menu into the Approved or Restricted
Applications List pane.

2. The Application Properties dialog appears.

Application Properties X

Desktop Application  Windows Store Application

Filename: Cancel

|| Browse. ..

Description:

3. Typein the .exe file name (e.g. winword.exe) under Filename or browse for your chosen
application.

4. Type in the description, e.g. Microsoft Word.

Note: When adding applications on Windows machines that have the Microsoft Store, two tabs
will be displayed. The Desktop Application tab allows you to add standard Windows applications
as detailed above. The Windows Store Application tab lists Windows Store applications, allowing
you to select the required application.

5. Click OK.

6. The application icon, name and description will appear in your Approved or Restricted
Applications pane.
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Or

1. Switch the List view to details layout by clicking the Details view == icon on the status bar.

2. Right-click on an application icon in the List view in the Current Application or Running
Applications column.

3. Choose Add to Approved List.
Or
Choose Add to Restricted List.

4. The application icon and description will appear in the Approved or Restricted Applications pane.

Remove an application from your Approved or Restricted Applications list
1. Highlight the chosen application and click the Remove X icon.

Or

Right-click the application and select Remove Application.

Apply approved or restricted applications

Restrictions can be applied to individual Students or all connected Students. Students can view the
current restrictions in the Student Toolbar.
1. If you want to apply restrictions to individual Students, select their icons in the List view.

2. To apply these restrictions, select the Class tab in the ribbon and click Approved Only or Block
Restricted.

3. To acknowledge which restriction has been activated, an appropriate indicator will appear next
to the Student icons. Red for restricted, green for approved.

4, If a Studentis currently running an application included in your activated restriction list, an
Application Blocked dialog appears on their screen, stating the application that has been blocked
by the Tutor. This will also appear if a Student attempts to run any of the applications included
on the restriction list.

End approved or restricted applications
1. Toremove the restrictions for individual Students, select their icons in the List view.
2. Select the Class tab in the ribbon and click Allow All.

3. The green or red indicator will be removed from the selected Student icons.

Note: Removing a restriction may not appear to take effect immediately. You may need to restart the
application for it to recognise the change.
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Create a new application list

You may need to create more than one application list, for example, if you want different approved or
restricted for different classes. The default application list is NetSupport School.app.

1. To create a new Application list, select the Class tab in the ribbon and from the Application list
drop-down menu, click Create New Application List.
2. Enter afile name and click Save.

3. A new blank Application list will appear.

Note: Application lists can be assigned to different Tutor users by setting up a Tutor Profile.

Open an existing application list

1. To open an existing application list, select the Class tab in the ribbon and from the Application
list drop-down menu, click Load Existing Application List.

2. Highlight the relevant file and click Open.

3. The existing application list will appear.

Save an application list

1. To save the current application list, select the Class tab in the ribbon and from the Application
list drop-down menu, click Save Application List As.

2. Enter a file name and click Save.

3. The current application list will be saved.

Note: Any changes that have been made to the new or existing applications lists will be automatically
saved when a new applications list is created, or when you exit the NetSupport School program.
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View application history

This feature of the Application Control module enables you to monitor the applications being used by
connected Students and, if required, store or print a permanent record.
View application history

1. In Application View, select the Class tab in the ribbon and click History.

2. The Application History dialog appears.

3 Application History ] X

Show History for: > Al students v
Student Name Login Name Computer Name  Application Started 2
; Elie Administrator  INVH764 Snipping Tool 06/29/23 15:19:54
; Mo testing HPLAP-2 Untitled - Paint 06/29/23 15:19:09
‘ Mo testing HPLAP-2 paint 06/29/23 15:19:01
; Elie Administrator  INVH764 This PC 06/29/23 15:18:23
‘ Elie Administrator  INVH764 itv - Google Search - Google Chrome 06/29/23 15:12:47
; Elie Administrator  INVH764 Overview | Our Solar System — MASA Solar System Exploration - Google Chrome  06/29/23 14:52:45
; Mo testing HPLAP-2 Document: - WordPad 06/25/23 14:50:28
; Mo testing HPLAP-2 Task Manager 06/29/23 14:50:22
‘ Mo testing HPLAP-2 Libraries 06/29/23 14:50:12
; Elie Administrator  INVH764 Document - WordPad 06/29/23 14:46:17
; Elie Administrator  INVH764 Search 06/29/23 14:46:13
; Mo testing HPLAP-2 Start Menu 06/29/23 14:45:35
; Mo testing HPLAP-2 Explore / Twitter - Google Chrome 06/29/23 14:45:35
; Mo testing HPLAP-2 classroom. cloud 06/29/23 14:45:35
‘ Mo testing HPLAP-2 AMD:CCC-AEMCapturingWindow 06/29/23 14:45:35
; Elie Administrator  INVH764 Downloads 06/29/23 14:45:35
; Elie Administrator  INVH764 Start Menu 06/25/23 14:45:35
< >
Save... Export... Print... Help Close

o

This provides details of any application used by the Student(s) during the currently connected
session.

The available options are:

Show History for

You can view the history for all Students, the currently selected Students or you can select the
required Student from the list.

Refresh
While viewing the list, click Refresh at any time to update the display.

Save

To keep a permanent record of the displayed items, you can save the details to a text file before
disconnecting.
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Export
Exports data to a CSV file allowing the data to be imported if needed.

Print

Prints details of the currently displayed items.

Close

Closes the History dialog but details will continue to be recorded while the Tutor is connected.
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Student Surveys

The Student Survey tool enables the Tutor to get instant feedback from Students during or at the end
of a session. The Tutor sends connected Students a question, together with a selection of pre-defined
responses. Student responses are gathered at the Tutor with the results shown as an overall
percentage and by individual Student. Results can be shown to Students in the form of a pie chart,
Students must respond before they can view the results.

Students can also be temporarily 'grouped' by response enabling you to see in an instant who selected
the same answer. This could be useful if you felt a quick follow-up question or message to particular
Students was required.

Sending a survey to Students

1. Select the Survey View @ icon on the left-hand side of the Tutor Console.
Or

Select the View tab in the ribbon, click the drop-down arrow * in the Mode section and choose
Survey View.
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2. Select the Students to include in the survey. This can be all Students in the List view, the
currently selected Students or a defined group of Students.

3. Enter a question in the Survey pane Question field.
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4. Select the responses/answers to the question. These can either be chosen from the Response
drop-down list of defaults or you can enter your own options, using a comma to separate each
one. Up to six choices can be entered.

Note: You can select a pre-defined survey from the Survey list by selecting the Class tab in the
ribbon, clicking the Question icon and selecting the required survey. Pre-defined surveys can
be selected from the Question drop-down arrow in the ribbon.

5. Send the survey to Students by clicking Send in the Survey pane or selecting the Class tab in
the ribbon and clicking Send.

6. Adialog appears at the Student machines displaying the question and responses. Students
choose the appropriate response to submit their answer.

7. As Students submit their answers, the Survey Results pane will display the percentage response
for each option. The Student icon will also flag how the individual Student answered. By
switching the List view to details view (click the Details == icon on the status bar), you can sort
the Students by result. Alternatively, you can sort the Students into temporary groups by
response. From the Class tab in the ribbon, click Auto group.

8. When the survey is complete, remove it from the screen by clicking Cancel Survey in the
ribbon.

Notes:
» The survey will be cleared from all machines whether the Student has responded or not.

* Once the question has been sent to Students, it will be added to the Survey list, allowing you to
re-use this.

Show survey results to Students
1. Select the Class tab in the ribbon and click Show Results.

2. The results will be displayed as a pie chart on Students screens'.

Note: Survey results will only be displayed if the Student Toolbar is running and the Student has
submitted their answer.

Save survey results

The survey can be saved to a .CSV file.

1. Select the Class tab in the ribbon, click Survey list and choose Save from the drop-down menu.

Print survey results

Before clearing the survey, you can print a permanent record of the results.

1. Select the Class tab in the ribbon and click Print.
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Note: The Student results can be added to the Student Journal. Select the Class tab in the ribbon and
click Journal.
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Survey lists

Surveys can be re-used by adding them to a Survey list. NetSupport School provides a default list,
NetSupport School.sul, into which questions and responses are automatically stored, but you can
create custom lists if you want to categorise different types of question.

Create a Survey list

1. In Survey view, select the Class tab in the ribbon, click Survey list and choose New from the
drop-down menu.

2. Enter a name for the file and click Create.

3. Any new surveys you enter will be added to the list.

Load a Survey list

1. In Survey view, select the Class tab in the ribbon, click Survey list and choose Load from the
drop-down menu.

2. Select the required list and click Open.

Using Survey lists

With the required Survey list loaded, you can enter new questions or use and manage previously
stored questions and responses.

To add a new question to a Survey list

1. Inthe Survey pane, enter the question and choose the required responses from the Response
drop-down list (or add new options if the defaults aren't appropriate).

2. Click Send. The survey will automatically be stored in the current list.

Note: You can also add a question in the Select Survey dialog.

To use an existing survey
1. Selectthe Class tab in the ribbon and click Question.

2. The Select Survey dialog appears.
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Select Survey x|
Question Response
How many planets ane in our solar system? one, seven, eight, nine, two c

Help

Add new Survey to the list
Cuestion:

Response:
V| Manage...

Select a question from the list and click OK.

The question will be displayed in the Survey pane ready to be sent to Students.

Note: Recent questions can also be selected by clicking the Question icon drop-down arrow in the

ribbon. You can send the question directly to Students by clicking the Send icon.

Manage questions and responses

As well as enabling you to choose an existing survey, the Select Survey dialog can be used to add new
questions/responses and edit questions/responses if the current examples are not appropriate.

4,

5.

Select the Class tab in the ribbon and click Question.
The Select Survey dialog appears.

If the Survey list does not currently include the required question, enter the new question along
with the responses, in the fields provided and click Add.

Or

To edit an existing question, select it from the list, change the question and/or the responses
and click Add.

Note: If you change the question, it will be added to the list in addition to the original. If you
only change the responses, the original will be overwritten.

To use the question in a survey, select it from the list and click OK.

The question will be displayed in the Survey pane ready to be sent to Students.

Note: When you use customised responses in a survey, they will be attached to that question only. If
you want to make the responses available to other surveys, they need to be added to the default
drop-down list. Click Manage, enter the required responses and click Add.
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Question and Answer module

NetSupport School's Question and Answer module is a unique collaborative tool that enables teachers
to reinforce key learning points and instantly gauge student understanding during a lesson. You can
verbally ask questions to the whole class, gauge student answers and understanding, bounce
questions around the classroom, develop peer assessment opportunities as well as track rewards
against both the individual and, where appropriate, teams.
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Clams Student Web Access Communicate Qand & Options
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Note: The Student Toolbar will be enabled and displayed at the Student, even if the toolbar is turned
off at the Tutor.

1. Click the Q&A View @ icon on the left-hand side of the Tutor Console.

Or

Select the View tab in the ribbon, click the drop-down arrow * in the Mode section and choose
Q&A View.

2. The Tutor displays the Student thumbnails. Once a question and answer session has begun, you
can see who has responded and mark their answers.

Starting a question and answer session
1. Select the Class tab in the ribbon and click Question Types.

2. There are five types of questions to choose from:
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First to answer
Enter an answer

Pot luck

Team first to answer

Team enter an answer

Select a question type to continue.

Set the required properties for the question and click OK.

Click Go to start the question and answer session.

A dialog appears at the Student, allowing them to answer the question.

The Student thumbnails show who has responded and you can mark their answers.

A Question and Answer dialog at the Student shows the current question type and any awards
the Student has received. Students can see the current state of all Students for each question.
You can also choose to show the results to Students. This can be set in the Question & Answer

Options dialog.
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Question and Answer module - first to answer question
type
The teacher asks a verbal question and the Students click to answer. The 'top x' fastest responders will

be displayed and the quickest Student is asked for their answer. You then decide whether this is
correct or not and rewards can be awarded or deducted.

Ask the question >
Question Options
. [] Thinking Time:
- [] Time Limit:

Bounce Options

] Automatically bounce to next Student

Options Help Cancel

A thinking time limit can be applied, the Answer button is disabled during this period, giving Students
a chance to think about their answer before they click. A time limit for answering the question can also
be set.

Note: Questions can be bounced to the next quickest Student when more than one Student has been
selected. This can be done automatically by selecting the Automatically bounce to next Student

option in the Ask the question dialog or manually by selecting the Class tab in the ribbon and clicking

Bounce.

You can choose to exclude a Student from the next round if they have already answered a question by
clicking Options, ensuring all Students have a fair chance to answer a question.
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Question and Answer mode - enter an answer question
type

The teacher enters the answer to the next question in advance and then verbally asks the question.
Students are prompted to enter their answer. Results are instantly displayed to the class and rewards
can be awarded or deducted.

Note: You can determine whether the answer is case sensitive or not.

Ask the question X
Question Options
I I [/ Thinking Time: ]
_-. 15 seconds
— [ Time Limit: |
15 seconds
Options Help Cancel

A thinking time limit can be applied, the Answer button is disabled during this period, giving Students
a chance to think about their answer before they click. A time limit for answering the question can also
be set.

You can choose to exclude a Student from the next round if they have already answered a question by
clicking Options, ensuring all Students have a fair chance to answer a question.
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Question and Answer mode - pot luck question type

The teacher decides how many Students to select randomly, NetSupport School will pick and order
them. A Student is then randomly selected and you verbally ask a question and the Student answers.
You then decide whether this is correct or not and have the option to 'bounce' the question to another
random Student. Rewards can be awarded or deducted.

Random Select x|

Student randomly selected, question then asked and next

person selected

How many students to select?

Automatically bounce to next Student

[/] Only select students once

nd 1

Options Help Cancel

Note: Questions can be bounced when more than one Student has been selected. This can be done
automatically by selecting the Automatically bounce to next Student option in the Ask the
question dialog or manually by selecting the Class tab in the ribbon and clicking Bounce.

If a Student has answered correctly, you can allow them to select the next random Student.

Note: If a Student has answered, they will not be randomly selected again during this session, unless
the Only Select Students Once option is unselected.

You can also select a Student randomly by selecting the Select tab in the ribbon and clicking Random
Student.
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Question and Answer mode Tutor display

Once the question type has been selected and the options chosen, Student thumbnails are displayed
at the Tutor. The thumbnails allow you to see who has responded and mark their answers more easily.

Customise thumbnail size

Student thumbnails can be resized to suit personal preferences.

1. Use the slider on the status bar to select the required size.

Auto-fit size of Student thumbnail

This option will automatically adjust the size of the displayed thumbnails to fit the window.
1. Click Auto on the status bar.

The following icons can be displayed at the Tutor:

Student has not yet answered.

The Student has answered. You can mark their answer correct or incorrect
by clicking on the tick or cross. Clicking the thumbs up/down button
allows the rest of the class to peer assess the answer. The yellow number
indicates which position the Student has answered in.

Student has been marked correct. The number of rewards the Student
currently has is also displayed.

Student has been marked incorrect. The number of rewards the Student
currently has is also displayed.

Student is excluded from the round.

4s

The time ran out before the Student answered.

A Student is being peer assessed. The green and red area will fill in a bar

a chart style as the Students respond.
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Student thought the answer was correct in peer assess mode.

Student thought the answer was incorrect in peer assess mode.

During a pot luck question Student icons flash in this state to indicate they
might be selected. A corresponding large '?' is also shown at Student
screens.
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Using Question and Answer mode

Once a Question and Answer session has begun, you can see who has responded and mark Student
answers by clicking the tick or cross on the Student's thumbnail. Awards can be given for a correct
answer and deducted for an incorrect answer and you can configure these options in the Question &
Answer Options dialog. The number of rewards a Student has is shown on their thumbnail and
Students can see their current awards in the Question and Answer Mode window displayed on their
screen.

Note: Rewards can be allocated/deducted outside of a Question and Answer session by selecting the
Feedback & Wellbeing tab in the ribbon.

Questions can be bounced around the class, encouraging discussion. You can also ask Students to
peer assess an answer to find out if they thought it was correct or not.

You can move on to the next round by selecting the Class tab in the ribbon and clicking Next Round.
You can stop the current question type and clear the Question and Answer Mode window on the
Student machines by clicking Stop in the ribbon.

Excluding Students

To ensure all Students are involved equally in the process, you can exclude specific students, those
that have already answered a question, from the next round of questioning.

Students are automatically excluded from a round if either of the Exclude options in the Question &
Answer Options dialog have been selected. Students can be manually excluded, right-click the Student
and select Exclude Student from round.

Sound effects
Sound effects can be played at the Tutor and Students. A sound is played at the Tutor when a Student
answers, at the Student when the Answer dialog is displayed and at both when randomly selecting a
Student and when the thinking time or time limit is at 5 and 2.5 seconds. Sounds effects are turned on
by default.

1. Select the Class tab in the ribbon and click Volume.

2. Select the relevant option to turn sound effects on/off at the Tutor or Student.

3. Use the slider bar to adjust the volume.
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Bouncing questions

To encourage discussion across the class, you can bounce a question to the next Student asking if they
have an answer or what they thought of the previous answer.

Note: You can only bounce a question for first to answer and pot luck question types when more than
one Student has been selected.

Questions can be automatically bounced to the next Student who has responded as soon as you click
the tick or cross. Select the Automatically bounce to next Student option in the Ask the question
dialog. The question will be bounced around the Students for the number of times specified.

Manually bounce questions

If you haven't selected the automatically bounce option, you can still bounce questions to the next
available Student.
1. Select the Class tab in the ribbon and click Bounce.
Or
Right-click the Student and select Bounce Question.
When a question has been bounced, the display changes to show who now has the question and where

it came from. The next Student can answer and this can continue around the whole class until all
Students who have answered have been included.
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Peer assessment

Peer assessment allows Students to give feedback in response to an answer given by one of their
classmates. After a question has been answered, you can ask the rest of the class to assess the
answer by clicking on the Ca* putton. A dialog appears at Student screens asking them to decide if
the answer was correct or not. As the Students answer the Student thumbnail at the Tutor will change
to reflect the number of Students who think their answer is right or wrong.
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Question and Answer team mode

Students can be placed in teams allowing them to compete for rewards as a group. You can use team
mode when selecting Team first to answer or Team enter an answer question types. Teams can be
created randomly or Students can pick a team to join. Custom team names can be created and you
can customise the colour allocated to the team.

Using team mode

1.

Select the Class tab in the ribbon, click Question Types and choose Team first to answer or
Team enter an answer from the menu.

Select the required properties for the question in the Ask the question dialog. Click OK.

The Create Teams dialog appears.

Create Teams x

Create teams randomly, allow student to choose their team or use cument groups as @
teams

() Assign Randomly

L3

Mumber of teams: 2 =

(®) Allow student to choose their team

Team names: |Team 1, Team 2, Team 3

Students select from this list, separate names with

Use cument groups as teams

Help Cancel

Select how to group the teams. If randomly, enter the number of teams. If you allow the
Student to choose a team, enter the team names; the Student can then pick a team from a
drop-down list. Click OK.

The Team Summary dialog appears showing how many Students are in each team. NetSupport
School randomly allocates colours to teams; you can change this by clicking the colour and
selecting a new colour.

Click OK. The question and answer session will start as normal.

The Tutor Console shows which team each Student is in. The teams are displayed in the group bar.
You can hide/show these by clicking the Teams icon on the group bar. The team statistics will be
displayed to students in the Question and Answer dialog. Rewards are awarded to both the individual
Student and the team.
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Note: To delete the teams that have been set up, select the Class tab in the ribbon, click the
Question Types icon and select Delete Teams.
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Printer Management

Print Management gives the Tutor total control over printer usage within the classroom, the Tutor can
monitor and control all printing activity by connected Students or printer. Students can be prevented
from printing, be assigned page limits per lesson or require Tutor authorisation to print.

The print management feature supports multiple printers within a classroom, prevents the addition,
deletion or modification of existing printers and provides printing usage summaries as part of the
Student Register.

Notes:

e Printers must be added to Student machines before the Tutor connects.

* A padlock will be displayed next to the Print View@ icon when there are central policy
restrictions in force. You can override the restrictions in the Tutor configuration.

Switching to Print View

1. Click the Print View @ icon on the left-hand side of the Tutor Console.

Or

Select the View tab in the ribbon, click the drop-down arrow * in the Mode section and choose
Print View.

By NetSupport School : ECWIN10-1 Mute all €} Lockan internet () (D) = - 3 X
Class Group Select Feedback & Wellbeing Journal Work Planner Administer View ~ Options
Histary
E3 6 6009 ¢ &@ 00 B O & o 6 g2
— - Kgg Set Print Thresholds
Student Lock  Unlock  Blank  Show Quick Student Unrestricted Chat Announce  Message Help Tutor Unrestricted Block Pause Show
Register Al bt Launch ~ Desktop~ = = Requests~  Assistant~ printing  printing Printers O Delete Duplicates
Class Stucient Web Access Communicate Tabiet Printing Options
@ a3 =
Emma HF2A9130 HP HP ePrint Microsoft Print Microsoft XPS
esklet 2700 5. o PDF (redirec.| Yocument Wr
9
6 Microsoft Print
to POF
User : Status Document Pages Printer Printer Total Pages Total Print Jobs
; Mark Printing MNetSupport Sch.. 037 Microsoft Print to PDF @S Microseft XPS Docurment W...
@ (@5 HP2ZAZ120 (HP Desklet 2700...
@) HP ePrint
@ @S Micrasoft Print to PDF (redi...
(®) S Microseft Print to POF 37 1
WiClass 1 ~ 3% 3 Students e & 0O = 58
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In the List view, the Student icons can be viewed in two different ways, large icons or details view.
Click the Large icons @@ icon or the Details == icon on the status bar.

When viewing in large icons view, an icon is displayed next to the Student icon, informing the Tutor of
the current print activity. If the List view is in details view, a summary of the print activity for each
Student is displayed.

The lower panes can be minimised to make more room for the Student icons. Click the Minimise
View 3] icon.

To keep track of print usage while in other areas of the Tutor Console, select the Class tab in the ribbon
and click Show Printers. The printer icon will be displayed in all other views allowing you to see jobs
as they happen, pause, delete and resume printing.

Notes:

» All printers are displayed when you select Show Printers. You can remove printers by
deselecting the printer in the Printer List pane.

« When a Student is printing, a connection bar will be displayed from the printer to the Student
who is printing. The connection bar will only be displayed for local printers.
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Using Printer management

Printers must be added to the Student machine before the Tutor connects, once connected to
Students, printers cannot be added, removed or modified. All printers that are attached to Student
machines will appear in the Printer List pane. Student print jobs will be displayed in the Print Queue
pane, giving you an overview of who is printing, what is being printed, how many pages are printing
and the current print status. From here, you can delete or resume printing for Students.

Notes:

» If'Show printers' is enabled, you can pause, delete and resume jobs via the printericon in any
view.

e Print restrictions can be applied at startup. Click Options in the Tutor Console, select Network
Settings from the drop-down menu and choose Start Options - Restrictions.

If the Student Toolbar is enabled, Students will be notified of the current print status.

Setting print thresholds

Print thresholds can be applied for an individual print job, allowing the Tutor to specify the maximum
number of pages Students can print. If the Student exceeds this limit, the print job will be
automatically paused or deleted.

1. Selectthe Class tab in the ribbon and click Set Print Thresholds.

2. The Print Thresholds dialog will appear, allowing you to apply the relevant settings.

Pause printing
1. Select the required Students in the List view.
2. Select the Class tab in the ribbon and click Pause printing.

3. The print status for the selected Student(s) will now show as paused.
Or

1. Select the required printer in the Printer List pane.
2. Right-click and choose Pause.

3. Printing will be paused for the selected printer.

Block all printing
1. Select the required Students in the List view.

2. Select the Class tab in the ribbon and click Block printing.
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3. The print status for the selected Student(s) will now show as blocked.

1. Select the required printer in the Printer list.
2. Right-click and choose Block.

3. Printing will be blocked for the selected printer.

Delete print jobs

You can delete all print jobs, selected print jobs or all print jobs for a Student.

1. Select the required print job(s) in the Print Queue pane.
2. Click the Delete X icon above the Print Queues pane.
Or
Right-click and choose Delete/Delete All/Delete All jobs for xxx.

3. The selected print job(s) will be deleted.

Deleting duplicate print jobs
1. Select the Class tab in the ribbon and click the Delete Duplicates option.

2. Duplicate print jobs will now be deleted.

Resume printing

Allows you to restart printing after it has been paused or blocked.

1. Select the required Students in the List view.

2. Click the Resume [> icon above the Print Queues pane.
Or
Select the Class tab in the ribbon and click Unrestricted.

3. Printing will now be resumed.

1. Select the required printer in the Printer List pane.
2. Right-click and choose Resume.

3. Printing will be resumed for the selected printer.

Note: You can also resume printing for Student(s) in the Print Queue pane. Select the required print
job, right-click and choose Resume.
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Printer properties

Allows you to change the image, display name of the printer and reset the total page and job count.

1. Select the printericon in the List view.

Or

Select the required printer in the Printer List pane.
2. Right-click and choose Properties.
3. Amend the required properties.

4. Click OK.
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View print history

This feature of Print Management enables you to monitor the print usage of connected Students and if
required, store or print a permanent record.
View print history

1. In Print View, select the Class tab in the ribbon and click History.

2. The Print History dialog appears.

= Print History [m] x
Show History for: 3 All Students v
Student Name Login Name Computer Name Printer Document Pages Printed On
; Mo Mo HPLAP-2 Microsoft XPS Document Writer Document 1 15:23:57 29/06/2023
; Eliie Elie VIRT4SERVER2016 Microsoft Print to PDF NetSupport School37 15:23:17 29/06/2023
Save... Export... Print... Help Close
[*]

This provides details of the Students print activity during the currently connected session.
The available options are:

Show History for

You can view the history for all Students, the currently selected Students or you can select the
required Student from the list.

Refresh
While viewing the list, click Refresh at any time to update the display.

Save

To keep a permanent record of the displayed items, you can save the details to a text file before
disconnecting.

Export
Exports data to a CSV file allowing the data to be imported if needed.
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Print

Prints details of the currently displayed items.

Close

Closes the History dialog but details will continue to be recorded while the Tutor is connected.
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Device Control

The Device control feature allows the Tutor to protect against external sources during a lesson. The
Tutor can prevent data from being copied to or from USB devices and CD/DVD drives. In addition, the
Tutor can provide read-only access, allowing Students to view files from devices but prevents them
from copying files to them. The Tutor can also prevent Students from using the webcam on their
device.

1. Selectthe Device View B icon on the left-hand side of the Tutor Console.

Or

Select the View tab in the ribbon, click the drop-down arrow * in the Mode section and choose
Device View.

A NetSupport School : ECWIN10-1 Mute All Lock All Internet = _
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; Mark Full Access Read Only Access Full Access
\Q} ; Sarah Mo Access Full Access Full Access
| B
WClass1 ~ 5% 3 Students & & 0O 58 53

Note: A padlock will be displayed next to the Device ViewEll icon when there are central policy
restrictions in force. You can override the restrictions in the Tutor configuration.

In the List view, the Student icons can be viewed in two different ways, large icons or details view.
Click the Large icons &5 icon or the Details == icon on the status bar.

When viewing in large icons view, an icon is displayed next to the Student icon, informing the Tutor of
the current device restrictions. If the List view is in details view, a summary of device restrictions for
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each Student is displayed.

Note: Device restrictions can be applied at startup. Click Options in the Tutor Console, select
Network Settings from the drop-down menu and choose Start Options - Restrictions.

Block access to CD/DVD or USB devices
1. Select the required Students in the List view.

2. Select the Class tab in the ribbon, click the USB or CD/DVD icon and choose Block Access
from the drop-down menu.

Read-only access to CD/DVD or USB devices
Provide Students with read-only access to CD/DVD or USB devices.

1. Select the required Students in the List view.

2. Select the Class tab in the ribbon, click the USB or CD/DVD icon and choose Read Only from
the drop-down menu.

Unrestricted access
Provide Students with full access to CD/DVD or USB devices.

1. Select the required Students in the List view.

2. Select the Class tab in the ribbon, click the USB or CD/DVD icon and choose Unrestricted
from the drop-down menu.

Mute sound on Student machines
1. Selectthe Class tab in the ribbon and click Mute Sound.
2. Sound will be muted on the Student machines.

3. To enable sound at the Students, click Unmute Sound.

Disable the webcam on Student machines

Prevent Students from using the webcam.

1. Select the required Students in the List view.
2. Select the Class tab in the ribbon and click Disable Webcam.

3. The webcam at the selected Students will be disabled.

Note: To allow access to webcams, click Enable Webcam in the ribbon.
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Tutor profiles

NetSupport School allows you to set up multiple Tutor profiles for different Tutor users, each with a
pre-defined set of options. On starting the Tutor Console, if multiple profiles have been created, a
dialog is displayed that allows the user to select which profile to use.

The main benefit of creating a profile is to be able to store ready-made lists of approved/restricted
applications, websites and keywords rather than have the user create these at the start of each lesson.

Having created your Application, Website or Word lists, as detailed in the Web Control, Application
Control and Keyboard monitoring sections, the files can then be added to a Tutor Profile.

Note: As well as Website, Application and keyword lists, other areas of the program that can be
profiled are Layouts, Student Surveys, Client lists, Group lists, the location for storing test results,
exams and Class lists.

To create a Tutor profile

1. Create the files containing details of approved/restricted websites, applications etc that are to
be included in the profile.

2. Click Options in the Tutor Console, select Network Settings from the drop-down menu and
choose Administration - Profile.

Settings for Configuration: NetSupport School *
|_ sattings | Profies
NetSuppod School
b @‘?’ Start Options Add
153 Start Options Delele
Q Restrictions
@? Hatwork and Wireless Settings EES
@'e Performance
& Student Selection
e @G Administration
@ Securty
fo3 Profie
oK Cancel Halp

A list of existing Tutor Profiles will appear, NetSupport School is the default.

3. To create a new profile, select Add. The Create New Configuration dialog appears.
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4. Enter a name for the profile. Functionality for the profile can be 'copied from' an existing Tutor
configuration, the default NetSupport School or a user defined profile. Click OK. The name will
be added to the profile list.

5. To change the content of the profile, click Edit. The File Locations dialog appears.

6. Ineach category, select the file to be used in the profile. The Folder Locations dialog allows you
to change where items are located.

7. Click OK.

Each time the Tutor Console is started, the user will be presented with a list of locally stored profiles to
choose from. Should you wish to share profiles across a network, the /R command line instruction can
be used to launch the Tutor program with a centrally available profile.

For example, from the NetSupport School program folder run the command; pcinssui
/rN:\SampleProfile.cfg. If the profile, in this example SampleProfile.cfg, does not currently exist a
default will be loaded, enabling you to add your own values. Once you exit the Tutor Console, the
profile will be stored in the specified location.
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Manage Student resources

Students can easily access any resources required during a lesson. The Tutor can create a resource list
and add links to websites, applications and documents, this list is then displayed in the Student
Toolbar providing Students with a quick and easy way to access the required resources.

To create a resource list

1. Selectthe Work Planner tab in the ribbon and click Student Resources.

2. The Resources List dialog appears.

B Resources List - [untitled *] m] X
=
B +/ X A
New Open Save Add Edit Delete Move
Up

Avadable Trems: Resources List:

@ Wabshe i English_poets_assignment.pdf

ChUserstesting\ Documents Resou rces Englsh_poests_astignment pdf
B Application
2 Website *
@ Document hittpsy/wwvwbbe oouk/bitesize/courses/zhasglp
e
o

3. Select the resource from the Available Items list and either drag and drop to the Resource List or
click the Add icon. You will be prompted to enter a description and location for the resource.

4. The order of the list can be sorted using the appropriate arrows.

5. Click Save and specify a file name for the list, once saved the resources will be displayed in the

Student Toolbar.
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Student Journal

NetSupport School provides a Journal feature, allowing key lesson resources to be captured and
automatically included in a PDF file for post-lesson review by each student and as a record of content
covered for teachers. Not only can teachers add notes and resources used during the lesson directly to
each Student Journal, the Students can add their own notes making this a truly personalised
document.

Tutor

E]i Lesson Details: 30/06/2023 16:19
Teacher: Mrs Smith
Lesson.  English - Postry
Room:  ICT2

(£ Aproved Websites 30/06/2023 16:21
Approved websites for year 7

URL Description
[ .1 hist: i

L X bbe.co. ICSy;
hitps:/fwww.poetryfoundation.org/poat

E] Notes from Tutor 30/06/2023 16:23

Please research the following poets:
Edgar Allen Poe

William Shakespeara

Maya Angelou

Emily Dickinson

@ Screenshot from Tutor 30/06/2023 16:25

Who are your muses?

Sebect up to 3 poets to Inspire you

®©0 00

WWlian Callin Bepant Emily Dickinscn Pouil Laurence Dunbar  Raiph Waldo Emerson

O L @ @

PRlip Fresss Robert Frost Frances Blen Wathins  Giiver Wendel Holmes.
Harper 2

Tuier 11 NetSuppar Schoal

Note: A PDF reader will be required to view the Journal.

By default, the Journal is located in:

C:\Users\"Logged on User"\Documents\Journals

Configuring the Journal

You can customise the settings for the Journal (at both the Student and Tutor) and change the location
of where the Journal is stored.

Tutor Journal

1. Click Options in the Tutor Console, select Settings from the drop-down menu and choose
Journal.
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Student Journal

1. Inthe Student Configurator, select Journal.
Items that can be included within the Journal are:

* Lesson details and objectives

¢ Student register

e« The Approved Websites list

+ Copies of any class chat transcripts
¢ Class or group survey results

e Individual Student test results

e Virtual whiteboard screens

* Screenshots (and supporting explanation)
* Target keywords

e Teacher notes

¢ Individual Student notes.

e Student rewards.

e Student stickers.

Notes:

» Students' web history can be automatically saved to the Tutor Journal when the Tutor Console
is shut down. To enable this setting, click Options in the Tutor Console, select Settings from
the drop-down menu, choose User Interface - Tutor and select the Save Student Web
history to Tutor Journal option.

* Student rewards and stickers are automatically added to the Journal when they are given to
Students.

Starting a Journal

The Journal will automatically start when any of the 'Send to Journal' options are selected. You can
also start a Journal in the Class wizard.

1. Selectthe Journal tab in the ribbon and click Start.

Note: If the Tutor Console is closed or the Student is restarted, the current Journal will be closed. You
can open an existing Journal. Select the Journal tab in the ribbon, click the Start icon drop-down
arrow and choose the previous Journal from the list.
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Add Tutor notes to the Journal
1. Select the required Students in the List view.
2. Select the Journal tab in the ribbon and click Notes.
3. The Add Notes to Journal dialog appears.

4. Enter the required note and choose which Student Journals to send the note to from the Send
To drop-down list (all connected Students or the currently selected Students).

5. Click OK.

Note: You can also add a note to all Student Journals. Select the Journal tab in the ribbon, enter the
required note in the Note section and click Add. Or, click the Add notes to the journal = icon on the

caption bar, enter the required note and click Add. If this is not displayed, you can add by clicking the
Configure Quick Access List = icon and selecting Add notes to the student journal from the

list.

Add a screenshot to the Journal
1. Select the required Students in the List view.
2. Select the Journal tab in the ribbon and click Screenshot.
3. Click Desktop to add a screenshot of your desktop.

4. Click Application and select the required application from the list to add a screenshot of the
selected application.

5. Click Paste to add an image you have copied to your clipboard.
6. You can enter a note to accompany the screenshot if required.

7. Choose which Student Journals to send the screenshot to from the Send To drop-down list (all
connected Students or the currently selected Students).

8. Click OK.

Add Student notes or screenshots to the Journal

Students can add their own notes and screenshots to their Journal.

1. Click the Journal @5 icon on the Student Toolbar and select Add notes to Journal.

Or

Right-click the NetSupport School Student icon on the system tray and select Add Notes to
Journal.

Or
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Click the NetSupport School Student icon on the system tray and choose {Commands}{Add
Notes to Journal} from the drop-down menu.

2. Enter the required note and/or screenshot, following steps 3-5 above.
3. Click OK.

4. The note and/or image will be added to the Student Journal.

Note: Students cannot add notes if the Student Toolbar and Student icon are not visible.

Add the student register to the Journal

The student register can be added to the Tutor's Journal.

1. Select the Journal tab in the ribbon and click Student Register.
Or

Select the Class tab in the ribbon, click the Student Register icon and choose Student
Register.

Add the Approved Websites list to the Journal
1. Select the required Students in the List view.
2. Select the Journal tab in the ribbon and click Websites.

3. Enter a note if required, and choose whether to send to all connected or the currently selected
Students.

4. Click OK.

Note: If you haven't set up an Approved Websites list in the Web Control module, the Website
Properties dialog appears, allowing you to add a website to the list.

Add the target word list to the Journal

You can add a target word list to the Journal.

1. Select the required Students in the List view.
2. Select the Journal tab in the ribbon and click Word List.

3. Enter a note if required and choose whether to send to all or the currently selected Students.

Note: If you haven't already created a word list in Keyboard Monitoring, you are prompted to
add the target words. Click OK.

4. Click OK.

Add the survey results to the Journal

If you have conducted a Student survey, you can add the results to the Journal.
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1. Select the Journal tab in the ribbon and click Survey.
2. A message will appear advising that the results have been added.

3. Click OK.

Add the contents of the interactive whiteboard to the Journal

1. Selectthe Journal tab in the ribbon and click Whiteboard.

Note: This option is only active if the whiteboard is being shown to Students.

2. Enter a note to be added with the whiteboard image if required.

3. Click OK.

Add a chapter to the Journal

Chapters can be added, allowing the Journal to be organised into sections. Each chapter starts on a
new page.

1. Select the Journal tab in the ribbon.
2. Inthe Chapter section, enter a name for the chapter and click Add.

3. Items are now added to the new chapter.

Remove an item from the Journal

You can remove the last item added to the Journal.
1. Atthe Tutor, select the Journal tab in the ribbon and click Undo last add.

Or

1. Atthe Student, right-click the NetSupport School Student icon on the system tray and select
Delete Last Journal Item.

Or
Click the NetSupport School Student icon on the system tray and choose {Commands}{Delete
Last Journal Item?} from the drop-down menu.
View a Journal
1. Select the Journal tab in the ribbon and click View Journal.

Note: Student's can view a copy of their Journal by clicking the Journal @ icon in the Student
Toolbar and selecting View Journal.
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Print the Journal

You can print a copy of the current Journal.

1. Select the Journal tab in the ribbon and click Print.

Synchronise Journals

You can synchronise the Tutor Journal with the Students to ensure the Student Journals are up-to-
date. Any missing items are added to the Student Journals. This will not affect any information that the
Student has added.

1. Select the Journal tab in the ribbon and click Synchronise.

End the current Journal

1. Select the Journal tab in the ribbon and click Stop.
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Lesson planner

A NetSupport School lesson plan enables a Tutor to structure a session around a pre-defined set of
tasks with appropriate timings and prompts allocated to each part of the plan.

Common NetSupport School functionality can be built into the plan, such as run test, send/collect
work, scan and show.
To create a lesson plan

1. Select the Work Planner tab in the ribbon and click Manage Plans.

Or
If displayed, click the Show the Lesson Planner I icon on the Lesson Plan bar.

2. The Lesson Plan window appears.

E Lesson Plan - [C\ProgramDatat MNetSupport\MetSupport School\example.nlp] [m| X
0 S X A
Mew Open Edit Delete Move
Plan  Plan Item Item Up
This Lesson Plan: Total Lesson Time (hh:mmy) : 00:04  Availsble Trems:
4 Message o o? A
Select G
Display a message at Tutor, Student or both -' elect Graup
And now unlock them.
5 Unlock % T srew
Unlock Clients Keyboard and Mouse
6 Message * @ Frae Tims
Display a message at Tutor, Student or both
Mext we will Scan the students PCs for the next minute @ Test
7 = Scan b4 -
[y
0 sc=n through the currenty connected Clients @ om0
@ Current View
8 Message b4
Display a message at Tutor, Studant or both
Nt we will lsunch =n applicstion on esch BC lets uss Notspad Messzge
9 Execute ®
Execute an Application at the Students v frc\ Scan v
Author: | NSL |
y
Description: Example Lesson Plan
Cancel
o

3. Tocreate a new lesson plan, click New Plan on the toolbar or click Open Plan to load a saved
lesson plan.

4. From the Available Items list, drag the required task and drop it into the This Lesson Plan pane.
Enter any additional properties that are required. You can edit and move tasks in the lesson plan
using the appropriate icons on the toolbar.

5. Ifrequired, enter the lesson plan's author and description.
6. Click Save Plan and enter a name for the plan.
7. Click Save.

8. The Lesson Plan window displays the lesson content, total time, author and description of the
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lesson.

9. To start the currently loaded lesson, click OK and then Yes or click Cancel to close the window.

Running a lesson plan
1. Select the Work Planner tab in the ribbon and click Execute Plan.
2. Select the required lesson plan and click Open.
3. Acut-down version of the Lesson Plan window appears, showing the tasks included in the plan.

Note: You cannot edit the tasks in a lesson plan from here.

4, Click OK.

Managing a lesson plan

When a lesson plan is activated, a progress bar appears in the lesson plan bar. You are prompted
before each task is due to begin and can choose whether to continue or abort. At any point during a
task, you can use the tools in the ribbon or on the lesson plan bar to pause, skip to the next item or
abort the lesson.

Lesson timer

You can have a timed session without running a pre-defined lesson plan.

Notes:
e Students running pre-version 15.00 won't show the lesson timer.
¢ You can also set the time that the lesson ends in the Class wizard.
1. Select the Work Planner tab in the ribbon and click Set Class Time.

2. The Set Class Time dialog appears.

Set Class Time *

® Set the duration of this lesson or when it should end

Cancel
(@ End at this time 12 = (00 =
() Duration {minutes)
When the lesson ends |Lock the mouse and keyboard ~

3. Select the end time for the class or enter a duration.
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4. Decide what happens when the lesson ends. You can do nothing, send a message or lock the
Students' mice and keyboards.

5. Click OK.
6. Atimer appears on the caption bar and the Student Toolbar.

7. Click the timer to add an extra ten minutes, pause or stop. You can also stop the timed session
by clicking Remove in the Set Class Time dialog.

Note: You can quickly start a timed session by clicking the Lesson Timer ® icon on the caption bar
(if this is not displayed, you can add it by clicking the Configure Quick Access List = icon and
selecting Show the lesson timer). Select the lesson duration (15, 30 or 45 minutes), or you can
enter your own time in the field. Click Start.
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Student Toolbar

The Student Toolbar provides feedback to the Student on the current lesson, time remaining, current
websites and applications that are available, the status of print, audio and keyboard monitoring and
quick access to initiate a Chat session and request help. Students can also access their USB memory
stick, Student Journal, work items that have been sent and any resources from the toolbar. It can be
set to be always visible at the top of the Student screen or to auto-hide.

All features included on the toolbar can be customised by the Tutor. To select the features available on
the toolbar, click Options in the Tutor Console, select Settings from the drop-down menu and choose
Student Toolbar.

The toolbar is enabled by default and set to always visible. Alternatively, if the toolbar is not always set
to be visible, the Student can mouse over the top of their screen to make it appear. If the Tutor
changes a setting that affects a toolbar option, a message will appear. For example, enabling internet
restrictions.

Note: You can quickly show/hide the Student Toolbar by selecting the View tab in the ribbon and
selecting the Student Toolbar option.

Settings for Configuration: NetSuppert School x

|5"a'“‘ settngs a I The Student Toolbar is displayed on the Student's desktop. R can show detals sbout

tihe class, cusment lesson as well as Intemet. Applcation and print status

b Remote Control

& Tutor Assistant
Group Leaders
@? Student Toolbar
@ﬁ} Journal

@ﬁ} Show

£o3 View
Q Keyboard/Mouse
] Enable Student Toolbar
i:i Replay Files .
£63 Audio [4] Make the toolbar ahways visible
@F‘ Chat Toolbar options
3
File Transfer 4] Show the Image associated with this Student A
¥ User Interface 7] Shaws the logged on user name or name entered on the Student Regl
@ Tutor (4 Class and Teacher Infomation
ﬁ Student ] Show amount of time left in the Lesson

E Indicate when typing is being monitored

£ Show Printer status (Blocked. Paused etc)

[ Show Application Monitoring status and give access to approved Appl
E4] Show Intemet Monitoring status and give access to approved Web si
B Allow the Student to intiate a Chat

] Allow the Studert ta send & request for hels

Show Cock

B4 Show Rewards

(1 Show Objectives

FA Shaw CIVNIVTIA ISR davies rmariction statim and nmvids shoteg ta Y
< »

0K Cancel Help

The following toolbar options can be turned on or off as required:

Shows the image associated with this Student. Displays the Student Icon image.
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Shows the Student's logged on user
name or the name entered on the
Student Register.

Shows the Student's logged on user name or the name entered
on the Student Register.

Displays details of the current class,
teacher name, subject and room.

Class and teacher information.

If a timed lesson is in progress,
indicates the time remaining.

Show amount of time left in the lesson.

Advises the Student when keyboard
monitoring is active.

Indicate when typing is being monitored.

The Students will see the current
printer status.

Shows the current printer status (blocked, paused etc).

Indicates to Students the current
status of Application Monitoring,
Show Application Monitoring status and give access to restricted or unrestricted access. If
approved applications. restrictions apply, the list of approved
applications will be displayed when
Students click the Toolbar icon.
Indicates to Students the current
status of Internet Monitoring,
Show Internet Monitoring status and give access to approved restricted or unrestricted access. If
websites. restrictions apply, the list of approved
websites will be displayed when
Students click the Toolbar icon.
Enables the Student to initiate a Chat
session.

Allow the Student to initiate a Chat.

Enables the Student to send a help
request to the Tutor.

Show clock. Displays the time and date.

Allow the Student to send a request for help.

Shows any rewards that have been
given to the Student.

Show rewards.

If lesson objectives have been set,

Show objectives.
they will be displayed.

Allows Students to access their USB
memory stick from the Toolbar and
see any device restrictions.

Show CD/DVD/USB device restrictions status and provide
shortcut to USB memory stick.

Allows Students to view and add notes
Allow Students to access their Journal. to their Journal from the Student

Toolbar.

Allows Student to access any
resources you have defined from the
toolbar.

Allow Students to access resources (applications, websites,
documents or folders) that you define.
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Show when you are listening to or recording the audio at the ~ ~dVises Students when they are being
Student listened to or if you are recording their

audio.

Displays the files that have been sent
via the Send/Collect work feature. The
Student can work through these and
indicate when they have been
completed.

Show list of files sent to work on.

Note: A Tutor Toolbar is also available, this provides access to key NetSupport School features when
the Tutor program is minimised.
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Student rewards

NetSupport School allows the Tutor to 'reward' Students for good behaviour. During a lesson, a Tutor
can reward individual Students by giving them a star, which is reflected on the Student Toolbar. The
number of rewards a Student has can be viewed by mousing over the Student icon.

Note: The Student Toolbar must be switched on to use this feature.

Giving rewards to Students
1. Select the required Student in the List view.
2. Select the Feedback & Wellbeing tab in the ribbon and click Give Reward.
Or
Right-click on an individual Student and select Give Reward.

3. A star appears on the Student Toolbar.

Note: If a Student Journal is active, the reward is automatically added to it.

Removing rewards
1. Select the required Student in the List view.
2. Select the Feedback & Wellbeing tab in the ribbon and click Remove.
Or
Right-click on an individual Student and select Remove.

3. A staris removed from the Student Toolbar.

Notes:
» If a Student Journal is active, an entry is added to show that the reward has been removed.

» All rewards can be removed from a Student by selecting the Feedback & Wellbeing tab in the
ribbon and clicking Remove All.
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Student stickers

NetSupport School allows you to send animated stickers to Students recognising students' good
behaviour. During a lesson, you can send a sticker to individual Students, which is reflected on the
Student Toolbar.

Notes:
e The Student Toolbar must be switched on to use this feature.

» This feature is only available for Windows Students running v15.00 or higher.

Sending a sticker
1. Select the Student(s) in the List view.
2. Select the Feedback & Wellbeing tab in the ribbon.

3. A selection of stickers is available to choose from.

{

Send 1 2 g 4 5 6 .
Sticker =

Stickers

Select the required sticker from the gallery (click the Show drop-down < icon to see all
stickers in the gallery) and click Send Sticker.

4. Alarge version of the sticker appears on the Student screen before animating to the Student
Toolbar.

Note: If a Student Journal is active, the sticker is automatically added to it.
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Configuring the Student

Students are configured using the NetSupport School Student (Client) Configurator launched from the
NetSupport School Program Group.

Note: A search bar is provided at the top of the window, allowing you to locate the settings you're
looking for. Type in the search bar (you can enter a full or partial term) and click the Search -~ icon.
Any sections containing the search term will be highlighted. Click the Close < icon to close the search.

MetSupport School Client Configurator *

| Search settings ( | TCRAP
Network Settings
&
{5 Room 4] Send Keepalive Packets

Port: [5405

& .
55" Security [JUse Name & Connectivity Server
@9 Audio e

@g User Interface
@ Advanced Muiticast address

& Journal 225.16.8.68
@g Terminal Services ' Test

Name and connectivity server

e oo

The Student Configurator has the following options:

Network Settings

Set the network transport that the Student will use for communicating with the Tutor program. It must
be the same as that set at the Tutor.

Room

Specify where to connect the Student when using Room mode.

Security

Set passwords to protect the configuration and prevent unauthorised access to the Student machine.

Audio

Set the audio settings for the Student. Both the Student and the Tutor machines must have audio
hardware installed in order to use NetSupport School's audio features.
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User Interface

Customise the interface between the Student and Tutor.

Advanced

Set a personalised Student name and the behaviour of certain remote control features.

Journal

Customise the settings for the Student Journal.

Terminal Services

Allows you to configure the Terminal Server settings for the Student.
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Student Network settings

Allows you to set up the network transport for a Student. It must be the same as set at the Tutor.

MetSupport Scheel Client Cenfigurator 'Y

| Search settings { | TCPAP
Network Settings .

Reom [ Send Keepalive Packets
@ Security [[J Use Name & Connectivty Server
@G.ﬁudn e e

@9 User Interface

i Advanced Muticast address

o)
@@ Journal 225.16.8.68
s Terminal Services ) Test

Post- |5405

Name and connectivity server

cnc e

TCP/IP

Port: The TCP/IP protocol requires that a port number be allocated for applications to communicate
through. The default registered port for NetSupport School is 5405.

Send Keep Alive Packets: Some TCP stacks send Keep Alive Packets. In some circumstances, it
may be desirable to disable this. For example, on an ISDN line where a TCP/IP client is loaded, a
symptom may occur where the ISDN line is brought up unintentionally.

Use Name & Connectivity Server (Gateway): Enable this option if you want the Student's current
IP address to register with a designated 'NetSupport Connectivity Server/Gateway' on start up. Click
Configure and enter the IP address of the Connectivity Server along with the matching security key.

Multicast address: This is the IP multicast address that the Student is listening on.

Click Test to check that the protocol is correctly installed on this machine.
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Student Room settings

Allows you to specify the room settings for Students when connecting via Room mode.

MetSupport Schoel Client Configurator *

Search
Sea

SLongs Room

Network Settings . (®) This computer is always located in the folowing room:

Room [Rogem 1

@9 Security :

@g Audio () This is a mobie computer and may be in one of the following rmoms
@g User Interface

& Advanced

@9 Journal
@G‘ Terminal Services () This is a mobile computer and &s room will be entered manually

= e

Room

This computer is always located in the following room: If the computer is always located in the
same room, select this option and enter the required room.

This is a mobile computer and may be in one of the following rooms: Select this option if the
computer could be located in different rooms, enter the required rooms and separate each value with a
comma.

This is a mobile computer and its room will be entered manually: Select this option if the
computer is a mobile computer. The Student will then have an option from the Student icon in the
taskbar to manually enter the room.

+ Display available rooms: A list of available rooms will be displayed, allowing Students to
choose which one to connect to.

Note: If the Student icon is hidden in the taskbar, the Student can still manually enter the room by

running the setroom.exe. This file is located in the NetSupport School Program folder on the Student
machine.
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Student Security settings

From here, you can set the security settings at the Student.

MetSupport School Client Configurator W
| Search settings l
Search settings ( 5 s 5
Metwork Settings Security Key:
Room ] Kay..
i L SEGJ“Y
Security
Enable user Acknowledgement
& Audio 0
" User Interface Display Customizable Test
& Advanced When Connected:
@g Journal I

& Terminal Services -
When Viewed

Configurator Securlty Seftings
Configurator Passwond:

[[] Enable user Acknowledgement for Tech Console connections
{Apples to Tutor only instalis)

[[] Dont apply central policies to this computer

e et

Student Security

Security Key: This sets a security key that must be the same as that set at the Tutor before the Tutor
will be allowed to connect. This setting is optional. If there is no security key set here any Tutor may
connect, regardless of the security key set at the Tutor.

Enable User Acknowledgement: If enabled, a remote control session cannot take place until the
Student has confirmed that they accept the link being made.

Display Customisable Text

When Connected: The message entered here is displayed at the Student machine when a Tutor or
Tech Console connects to it.

When Viewed: The message entered here is displayed at the Student machine when it is being
viewed by the Tutor or Tech Console.

Configurator Security Settings

Configurator Password: As an extra level of security, you can associate a password with a
Configuration file. This prevents unauthorised amendment of this Student's configuration. When the
Configurator is next started, the user must enter the required password before being able to change
any Student parameters in this Configuration file. Choose Set, to set your password.
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Enable user acknowledgement for Tech Console connections (applies to Tutor only
installs)

If enabled, the Tech Console will not be able to connect to a Tutor machine until the Tutor has
confirmed that they accept the link being made.

Don't apply central policies to this computer
Any policy restrictions set in the Tech Console will not be applied at this Student machine.
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Student Audio settings

Set the audio settings for the Student. Both the Student and Tutor machines must have audio
hardware installed in order to use NetSupport School's audio features.

MNetSupport Schoel Client Configurator Y

| Search settings Viokume

Threshold [ ]

Network Settings
Room I

Security

i Audio Speaker |
& User Interface Guiet Loud
& Advanced [ Test [

@ﬂ Journal

& Terminal Services

Compatibilky
[ Enable Audio Hooking
Hook sudio scceleration Aways w

== e

Volume

Threshold: Microphone sensitivity.
Microphone: Volume of microphone.
Speaker: Volume of speakers.

Test: Tests all of the above settings.

Compatibility
Enable Audio Hooking: Allows you to set the hardware acceleration level for the Students.
Hook audio acceleration: The following levels are available:

* Never: Leaves the acceleration level at full.

« While Connected: The acceleration level will be moved to basic while connected.

+ Always: The acceleration level will be moved to basic.
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Student User Interface settings

Here, you can customise the interface between the Student and Tutor.

MetSupport School Client Configurator %
Search settings
Search settngs - Student loon
o ] M T
Network Settings [[] Guiet Made (client not visible on Taskbar)
Room
@@ Security STETILIE
&P Audo [ Disable Request Help
&I User Interface eoRsEy
& Advanced B A [OJContral [ Left Shift | Right Shift
@:gﬂ Journal
@@ Terminal Services
Meru Rems
[] Digable Join Qlass
[] Disable Chat
[ Disable Replay
[] Digable Joumal

cnc e

Student Icon

Quiet Mode: If this box is checked, there will be no indication at the Student machine, that the
Student program is loaded. This is useful for preventing Students from manually unloading or
otherwise misusing the Student program.

Request Help

Disable Request Help: Prevents the Student user from being able to use the request help function.

Hotkeys: These are the keys that the user at the Student will need to press to obtain access to the
request help function. The default is ALT + Left Shift + Right Shift. Note that some keyboards do not
recognise a three key combination so if you experience problems try changing to a two-key
combination.

Menu items

Disable Join Class: Prevents the Student from being able to use the Join Class function.
Disable Chat: Prevents the Student from being able to use the Chat function.

Disable Replay: Prevents the Student from being able to open Replay Files.
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Disable Journal: Disables the Journal options in the NetSupport School Student icon on the taskbar.
Students will still be able to access the Journal from the Student Toolbar.
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Student Advanced settings

Allows further personalisation of the Student's configuration. A meaningful Student name can be used
rather than the machine name, or you can specify a particular image to load when the Student's
keyboard and mouse are locked rather than use NetSupport School's default.

NetSupport School Client Configurator X

Search settings

Student Kentification
Student Name (* = machine name, ECWIN10-1):

MNetwork Settings

@‘b Room
& s
@ Securty While Viewed
& Audio )
{9 [[] Silent Mode fno refresh when Viewing)
&3 User Interface [] Send Physical Fonts
&I Advanced [ Enable Screen Scrape
@G‘ Journal
&F Teminal Services s
Cache Size: 16 MB w
Image Option
Image File:
[nss_lock_mage jog | | Browse

Enable DVD Playback and Dirsct 3D support

[(] Except while viewed Except while connected
Keyboard Fiter Driver
[Defatt v|
canc =

Student Identification

Student Name: This is the name that the Student will be known as on the network for NetSupport
School purposes. It must be a unique name of up to 15 characters. You should try to use a sensible
naming convention to help you identify which machine is which. It is also important to prefix each
name in a group of related Students with the same few characters, as this will be used when the Tutor
connects to establish the workgroup. For example, you might start the name of each machine in the
same room with the prefix CLASS1_. Then configure the Tutor to connect to all Students starting with
CLASS1_ will avoid Student machines outside of this room being inadvertently connected and
receiving a show. You can use an asterisk (*) to cause the Student name to default to the machine
name (also known as the computer name).

Note: Although internally the Tutor connects to Students by referring to their Student name, the user
at the Tutor can configure the Tutor program to display a different name.

While Viewed

Silent Mode: Allows the Tutor to connect and view a Student without the Student's knowledge. If
Silent mode is not selected the Student's screen and mouse icon will flicker notifying the Student that
a connection has been made and their screen is being viewed.
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Send Physical Fonts: When a Windows Student is sending its screen to a Tutor, it passes the font
information by reference to reduce the volume of data sent. The Tutor refers to its own internal font
mappings and uses the closest matching that it has to the one being displayed at the Student. In most
cases, the same fonts will be available at both the Student and the Tutor and so what is displayed on
the screen will appear identical. However, there may be occasions when a close match cannot be
found. In these cases, it is desirable that the Student sends the Tutor the full information that it
requires to display the data in the same font. Setting this option forces TrueType text to be sent as
glyphs (i.e. character shapes), rather than character codes. This guarantees that they will be
displayed correctly at the Tutor.

This will, however, impact on performance and is not usually required.

Enable Screen Scrape: NetSupport School's favoured, and the most efficient, method for capturing
screen data is to hook into the Video Driver of the machine being viewed. However, there may be
occasions when this method will not work because certain applications bypass the driver. In these
circumstances, you can enable 'screen scrape' mode in order to take a snapshot of the screen.
Although this will have a greater impact on the network, it will at least provide an accurate
representation of the Student's screen.

Performance

Cache size: Screen data that has been recently sent to the Tutor by the Student is cached to improve
performance. A larger cache improves performance, at the expense of using more memory at both the
Student and the Tutor. Setting this option enables you to tailor the cache size in order to achieve
maximum performance. The Student and the Tutor use the same size cache, the lowest cache value
will be used so you must ensure that you set this at both the Student and the Tutor for this to be
effective.

Image Option

Image File: When a Student's keyboard and mouse have been locked, a default image appears on
their screen. Alternatively, you may prefer to specify an image personal to your organisation.

Enable DVD Playback and Direct 3D support

NetSupport School uses the Microsoft Mirror Driver to capture screen data for view sessions. However,
while hooked into the Mirror Driver it is not possible to play DVD's. Therefore, if you do need the
capability to play DVD's, NetSupport School provides options which load and unload the Mirror Driver
as required.

Except While Viewed: If checked, DVD support is enabled but will be disabled for the duration of a
view session while the Mirror Driver is loaded.

Except While Connected: If checked, DVD support is suspended while a connection to the Student
is in place.
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Keyboard Filter Driver

Should you encounter any issues with your keyboard filter driver, we provide a choice of drivers to
switch between. Select the required driver from the drop-down menu.

328



NetSupport School 15.10

Student Journal settings

A Student Journal is provided allowing key information from the lesson to be stored in a portable PDF
file. You can use these options to customise the settings for the Student Journal.

MetSupport Scheel Client Configurator W

Search settings 9
| Se s 03 Margins fmm} Page size
[ 2 ] 1
Network Settings Top | 5 | Defaul o
Room Baottom )
s - - Fork size (points)
Security Left 15 Mm 1
Audio ' : -
@G’ User Interface I
&? advanced

@? Journal

& Terminal services
JPEG Quaity (1-100) 75

Joumnal Folder
Joumals

Nete : F specfying & network path the Student must have access to
this folderin order for the Tutor to create a Joumal

e e

Margins (mm)

If required, you can adjust the top, bottom, left and right margins for the Journal.

Page Size

Select the required page size for the Student Journal.

Font Size (points)

Set the font size to be used in the Journal.

Jpeg Quality (0-100)

Allows you to set the quality of images in the Journal, this is set to 75 by default.

Journal Folder

Specify where you want the Student Journal to be stored.
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Student Terminal Services settings

You can configure the settings for the Student Terminal Server here.

MetSupport Schoel Client Cenfigurator w
| Search settings ' | Teminal Services Settings
MNetwork Settings A Run Student in Conscle session
@ﬁ Room A Run Student in remote sessions
@‘9 Security . )
& Audio Base Port [25405 |
@9 User Interface Student Name: [
@3 Advanced
@ﬂ Journal

i
@@Termalsemes [ Use lockup file to set room

== oo

Note: Terminal Server and other thin clients may not be configured to use the NetSupport
Connectivity Server.

Terminal Services Settings

Run Student in Console Session: Unchecking this option will stop the Student from running in a
Console session.

Run Student in remote sessions: Unchecking this option will stop the Student from running in
remote sessions.

Base Port: Enter the required base port number, the default value is 25405.

Student Name: Enter the required name for the Student, if left blank a unique ID will be displayed
(defaults to % CLIENTNAME%). When entering a Student name, you must include at least one
environment variable, e.g. Y%ocomputername%.

Use lookup file to set room: Checking this option allows you to allocate Students to different rooms
when connecting via Room mode, a 'lookup file' containing the Student name and required room must
be used. The 'lookup file' should be saved with a .csv extension and should be in the format 'Student
Identifier', 'Room value'.

330



NetSupport School 15.10

Note: For further information regarding Terminal Server support, please visit our Knowledge Base
and refer to product article Setting up NetSupport School to run in a Microsoft Terminal Server
environment.
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Configuring the Tutor

The NetSupport School Tutor is configured by clicking Options in the Tutor Console and selecting
Network Settings from the drop-down menu.

Note: A search bar is provided at the top of the window, allowing you to locate the settings you're

looking for. Type in the search bar (you can enter a full or partial term) and click the Search -~ icon.
Any sections containing the search term will be highlighted. Click the Close < icon to close the search.

Settings for Configuration: NetSuppert Schoel X
Search settings { At Startup
~ ¢ start options U start Viewng
£93 Start Options L
# Restrictions Share
@G“ Network and Wireless Settings
@f‘ Performance
& Student Selection [ start showing
w (éf‘ Administration
£03 Security [J'start Scanning at interval of:
=
£63 Profie
kA Display Class Wizard

What best describes your envranment?

[C] Al your students are within 3 MultiSeat thin chent environment
[C] Al your students are using Tablets

] All your students are using Chromebooks

[C] Al your students are using Windows 105

Changes to these options wil require a restart of the Tutor

cancel b

The Tutor Configurator has the following options:

Start Options

Allows you to specify the start-up options for the Tutor and also set the level of access for the various
modes.

Network and Wireless Settings

This is used for setting the network transport that the Tutor will use for communicating with the
Student program. It must be the same as that set at the Student. You can also set the name and
description for the Tutor.

Performance

Allows you to set low bandwidth and colour reduction settings to lower data sent across the
networking when performing a View or Show.
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Student Selection

This is used to specify the mode to connect to Students when the Tutor program starts.

Administration

Enables you to set an additional password if the configuration options are to be protected and to create
pre-defined Tutor profiles.

Adjusting Student settings for a Tutor session

During any Tutor session where you may be working with more than one Student, you can customise
how each Student interacts with the Tutor. Changes can be made on an individual Student basis, while
they are being viewed, or globally.
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Tutor Start Options

Use these options to specify the startup options for the Tutor.

Settings for Configuration: NetSupport School %
Search settings ( AL Startup
~ (;f Start Options O start viewng
£93 Start Options Watch
@ Restrictions Share
(a:}s" Network and \Wireless Settngs Contro
@f’ Performance
& Student Selection [start Showing
hd (g‘: Adminstration
@ Security [Jstart Scanning at interval of:
o
503 Profie
[ Display Ctass Wizard

what best describes your environment?

] All your students are within a MultiSeat thin chent environment
[C] All your students are using Tablets

[ All your students are using Chromebooks

[C] All your students are using Windows 105

Changes to these options will require a restart of the Tutor

Ganc =

At Startup

Start Viewing: If this option is selected, when the Tutor initialises, it will connect to all Students and
immediately start viewing them. You can choose which mode to view the Students in: Share, Watch or
Control.

Start Showing: If this option is selected, when the Tutor initialises, it will connect to all Students and
immediately start showing the Tutor's screen to them.

Start Scanning at interval of: If this option is selected, when the Tutor initialises, it will connect to
all Students and immediately start scanning them. The scan interval time will be set to ten seconds.
This can be amended if required.

Display Class Wizard

If this option is selected, the Class wizard will appear at startup.

What best describes your environment?

All your students are within a MultiSeat thin client environment: If you are connecting to
students within a MultiSeat thin client environment, you may want the NetSupport School Tutor to
display only the features that apply to these students.
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All your students are using Tablets: If you are connecting to students using tablets, you may want
the NetSupport School Tutor to display only the features that apply to these students.

All your students are using Chromebooks: If you are connecting to students using Chromebooks,
you may want the NetSupport School Tutor to display only the features that apply to these students.

All your students are using Windows 10S: If all your students are using Windows 10S, you many
want the NetSupport School Tutor to display only the features that apply to Windows 10S students.

Selecting one of these options will provide you with a cut-down version of the NetSupport School
Tutor.

Note: A restart of the NetSupport School Tutor will be required each time a change to these options is
made.
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Tutor Startup Restrictions

Access levels and restrictions for NetSupport School features can now be defined at start-up, ensuring
they come into force as soon as the Tutor is started.

Settings for Configuration: NetSupport School x
Search settings [ Startup mode
Web
t
~ (f‘ Start Options od o [ Aoply central policy
10% start Options
fo3 Restrictions Applcations
@ﬁ“ Network and Wireless Settings Unrestricted Aocess. v [ Aeply central policy
@f‘ Performance
(f Student Selection Print
v (@f‘ Administration Unrestricted Access w [ Use central policy
163 Securty
i1 Profie Devices {L0/DVD/USE)
Unrestricted Access v [JUse central poley
Webcam
Usvestricted Access w
Typing
Net manitored ol
Pudio
On w
ance Heb

Startup mode

Web: Set the level of access for the Web Control Module.

+ Apply central policy: Applies the central policy restrictions that have been created in the Tech
Console.

Applications: Set the level of access for the Application Control Module.

« Apply central policy: Applies the central policy restrictions that have been created in the Tech
Console

Print: Choose the level of access for the Printer Management mode.

+ Use central policy: Applies the central policy restrictions that have been created in the Tech
Console

Devices (CD/DVD/USB): Choose the level of access for the Device Control mode.
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+ Use central policy: Applies the central policy restrictions that have been created in the Tech
Console

Webcam: Choose whether to allow or block access to webcams at Student machines.

Typing: Choose whether or not to monitor Students keyboard usage in Keyboard Monitoring mode.

Audio: Enable Audio monitoring or mute audio at the Students machines.
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Tutor Network and Wireless settings

This is primarily used for setting the network transport that the Tutor will use for communicating with
the Students. It must be the same as that set at the Students. You can also set the name and
description for the Tutor.

Settings for Configuration: NetSupport Schoel X

Search settings ( Tutor kertfication
Name

v 4f* Start Options

@ Start Options Description
f03 Restrictions
@F Network and Wireless Settings TCPAIP Settings
erforman -
@f Performance [[] Conmect By Hostname [DHCP/WINS) Port: |5406

@'f“' Student Selection
b @F Administration
t? Security
103 Profie

[ inchude Chromebacks
[J Use Name & Connectivity Seever

Bronwaing
Subnets used when browsing for studerts Settings

[ Accelerate Browse

Broadcast Settings

Ensble Broadcast Show and File Distribution Settings...
() Use Mulicast
(®) Use Broadcast

[] Wirsless Netwark

& Deploy

0K Cancel Help

Tutor Identification
Name: This is the name by which the Tutor will be known on the network. Setting it to an asterisk

defaults to the machine or computer name.

Description: This is used to provide a description for the Tutor program itself. This is displayed in the
Title bar of the Student program.

TCP/IP Settings

Connect by Hosthame (DHCP/WINS networks): Normally, the Tutor connects to a Student by IP
address rather than by name. In an environment that uses DHCP (Dynamic Host Configuration
Protocol), this may be undesirable as the address may change when the Student machine is restarted.
Checking this option forces the Tutor to connect by hostname.

Port: The TCP/IP protocol requires that a port number be allocated for applications to communicate
through. The default registered port for NetSupport School is 5405.

Note: If you are using routers, you must ensure that they are configured to pass through data using
this port.
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Include Chromebooks: NetSupport School provides support for Google Chromebooks. This option
includes Google Chromebooks when performing a search.

Note: The IP address of the NetSupport Connectivity Server/Gateway along with the matching
security key needs to be entered - click Settings.

Use Name & Connectivity Server (Gateway): Enable this option if you want to search for
Students whose IP addresses are registered with a defined NetSupport Connectivity Server. The
currently configured browse at Start-up option will still apply, but rather than perform a UDP browse of
the network, the NetSupport School program will search the Connectivity Server for Students
matching the specified criteria. Click Settings and enter the IP address of the Connectivity Server
along with the matching security key.

Note: When using the Name & Connectivity Server, please ensure Connect By Hostname
(DHCP/WINS) is disabled to avoid conflicts.

Browsing

Subnets used when browsing for students: When you are running on a network with multiple
subnets or addresses, you need to configure the broadcast addresses for each effective network.
When a browse is performed, the broadcast messages are sent to these addresses.

Accelerate Browse: Increases the browse and connection speed to Students. This is set by default.

Note: A warning icon will highlight machines you have been unable to connect to. Mouse over the icon
to display the reason why the connection failed.

Broadcast Settings

Enable Broadcast Show and File Distribution: When performing a Show or distributing files to
Students, the screen information/files are sent to each Student machine in turn. Enabling Broadcast
Show and File Distribution results in the screen information and files being sent to all machines
simultaneously. In some network environments, where there is limited network bandwidth available
or when broadcasting to larger numbers of machines, this will provide significant performance
benefits.

Whilst reducing overall network traffic generated by NetSupport School, using this feature will
generate additional broadcast packets on your network. It is recommended that you consult your
network administrator before using this feature.

Note: Show and File Distribution can be sent using multicast instead of UDP/broadcast. This means

that the multicast packet will only be sent to machines included in the specified IP multicast address.
Select Use Multicast to switch to this method.
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Settings: If the Broadcast Show and File Distribution option is enabled, select this option to set the
multicast or broadcast address. The Broadcast Settings dialog will appear. If multiple Tutors are
attempting to use UDP/Broadcast Show simultaneously on the same subnet, it is recommended that
each uses a unique port to avoid conflict.

Wireless Network: Check this option in order to optimise Show performance across a wireless
network.

Note: NetSupport School will automatically detect any wireless Students and enable this option to
improve performance.

« Maximum Throughput: Controls the level of data sent across the network to your wireless
access point. The default data rate is 8 Mbps. If required, this can be altered to reflect the speed
of the router.

Note: When a Tutor detects wireless Students, or is itself wirelessly connected, it will
automatically reduce the maximum data output to whatever has been configured in the
Maximum throughput settings, regardless of whether the wireless network checkbox has been
selected. This behaviour cannot be turned off.

Deploy
Opens the NetSupport School Basic Deploy dialog, allowing you to deploy Student software to PCs in a
particular room.
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Tutor Performance settings

Allows you to set low bandwidth and colour reduction settings to lower the amount of data sent across
the network.

Settings for Configuration: NetSupport Schoel x
Search settings (
Pedomance Sattings
~ —f* start options Low bandwidth mode Wireless v
# Start Options
0 This mode is designed for netwodk environments where low data usage is a pricety
23 Restrictions When enabled video perfornance and quaity willbe reduced and lmi network activity
@ﬂ Network and Wireless Settings
@f‘ Parformance
(‘_:f‘" Student Selection
v (éfa‘ Administration Cobour Focuclion
108 Securty
fo1 Profile View
Max Colour Depth: 256 colours (high quality) Y
Show
Max; Colour Depth: 256 colours (high quaiky) 7
OK Cancel Help

Performance Settings

Low bandwidth mode: This mode is designed for network environments where low data usage is a
priority. When enabled, video performance will be reduced to limit network activity.

Select the mode from the drop-down list: Never, Always or Wireless. The Wireless option will
automatically turn on low bandwidth mode when wireless students have been detected.

Colour reduction
View: Allows you to select the maximum colour depth when viewing Students. By default, this will be

set to 256 (high) colours.

Show: Allows you to select the maximum colour depth when showing to Students. By default, this will
be set to 256 (high) colours.

Note: These options will have negligible visual impact when remotely viewing or showing

applications, but may be seen when viewing or showing multimedia. Typically, these options should
be applied only when network utilisation is a priority.
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Tutor Student Selection settings

Use these options to pre-determine the Students to connect to when the Tutor program starts and in
what mode.

Settings for Configuration: NetSupport School X
Search settings Room Noda
- @'E‘ Start Options: i connect to Students in Roomi(s):
Start Options [1cT2
Restrictions -
@F“ :work and Wirelass Sattings CJselect from ket of rooms
@f‘ Performance
& Student Selection ] Promet at startup
v (§f“ Administration A Acknowledge Roaming Students
$0% Security
Profie Browse Mode

[JBrowse and connect to Students starting with:

Foeed List Mode
[Jconnect to a st of Students

SIS Mode
Oconnect to SIS
School name:

OK Cancel Help

Note: If a 'NetSupport Connectivity Server/Gateway' has been configured, the Tutor program will use
the details registered here rather than perform a browse across the network.

Room Mode

Connect to Students in Room(s): Allows you to connect to the machines in a given room. Specify
the room you wish to connect to.

Note: You can connect to multiple rooms in the Class wizard.

Select from a list of rooms: Allows you to choose from a list of rooms to connect to at startup.
Enter the required rooms and separate each value with a comma.

Prompt at startup: Allows you to specify an ad-hoc room to connect to in the Class wizard.

Acknowledge Roaming Students: Allows roaming Students to connect to your room.

Note: The Room settings can be configured at the Student in the NetSupport School Student
Configurator.
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Browse Mode

Browse and connect to Students starting with: If this option is selected, NetSupport School will
browse and immediately connect to all Students starting with the prefix set in the text box.

Fixed List Mode

Connect to a list of Students: Allows you to connect to a fixed list of Student computers by
machine name.

* This is a list of student user names: Select this option if you are connecting to a list of
Student logged on user names.

Note: You can set the list of Student machine/user namesin the Class wizard.

SIS Mode

Connect to SIS: Allows you to connect to your SIS data. The NetSupport Connectivity Server needs
to be synced with OneRoster/Google Classroom to use this connection method. Once connected,
select the required school name from the drop-down list.

Notes:

« If the expected Students are not found, it may be because NetSupport School has not been
configured to browse the required networks. See Configuring NetSupport School for subnet
browsing for more information.

« If connecting to Students via the NetSupport Connectivity Server in Room mode, it is
necessary to set the Connectivity Server settings at the Tutor in both the Tutor Configurator
and the Student Configurator.
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Tutor Administration - Security settings

Settings for Configuration: NetSupport School x
] Profeet the Configuration
. Protecting the Configuration will hide the Transpor and Stadup options
- @13 Start Options These options can then only be changed by entering a passwond
{93 Start Options
Restrictions [ Protect
Network and Wreless Settings S
({F Performance
Student Selection
A Administration
Securty S
= Profie Passwond
Set..
Securty Key
URL that resiricted websites will be redirected to
oK Cancel Help

Protect the Configuration

The Tutor Configuration can be protected by setting a password. This acts independently of the Tutor
password if set.

Select Protect to set the password.

Each time a Tutor user subsequently wants to make changes to the configuration, they will be
prompted to enter the password.

Options

Password: Setting a password will mean that the next time the Tutor program is started the user will
be prompted to enter a password. If they do not enter the correct password, they will not be able to
start the Tutor.

Security Key: You can set a security key that will ensure that only Tutors and Students with matching
keys are able to connect. Setting an asterisk * defaults the security key to be the same as the serial
number. Note that this must set at both the Tutor and the Student. If a security key is set here, this
Tutor will only connect to Students with the same, or no, security key.

URL that restricted websites will be redirected to

Allows you to specify the URL that Students are redirected to if they try to access restricted websites.

344



NetSupport School 15.10

Shared Data

Checking this option allows you to share data files with other users.
By default, on a new install, this option will be disabled.

By default, on an upgrade, this option will be enabled.
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Tutor Administration - Profiles

After creating, for example, an approved or restricted list of websites and applications, you can add
the files containing this information to a Tutor Profile. On entering the Tutor Console, you select the
required profile to load the pre-defined settings.

Settings for Configuration: NetSupport School *
| Search sattings { Profies
- @3 Start Options = Aad
193 Start Options Delete
@ Restrictions
Hetwork and Wreless Settings B2
performance
Student Selection
b @@ Administration
193 Securtty
f03 Profie
oK Cancel Help

From here, you can add, edit or delete Tutor Profiles.

* Click Add to create a new Tutor Profile.
* Toremove a profile, select the profile name and click Delete.

* To choose the files to include in a new or existing profile, select the profile name and click Edit.
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Tutor Profiles - file locations

Settings for Configuration: NetSupport Scheel x
[ search settin gs L ' Apphcations Fie
[ - 7 [ NetSuppont Seheal. || change
b File Locations L pood i J 2
: File Locations \Web Ste Fie
:03 Folder Locations [p— - .
fo3 Advanced . - Sitiiie
Survey Fle
[Met Support Schoolsul Change...
Layout File
[C:\Users teating\AppData’ Raaming \NetSuppartNet!| | Change...
Word List File
[Met Suppost Sehool wdl | ["change...
== oo

Click Change for the appropriate files to include in the Tutor Profile.

Applications File

Contains details of approved and restricted application packages. The default file name is NetSupport
School.app. See Application Control module for more information about creating pre-defined lists of
approved or restricted applications.

Web Site File

Contains details of approved and restricted websites. The default file name is NetSupport School.web.
See Web Control module for more information about creating pre-defined lists of approved or
restricted websites.

Survey File

Identifies the location of stored Student Surveys. The default file name is NetSupport School.sul. See
Student Surveys for more information.

Layout File

Stores the position of the Student machines as they appear in the Tutor Console and, if specified, a
background image. See Working with classroom layouts for more information.
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Word List File

Contains details of target and Inappropriate keywords. The default file name is NetSupport
School.wdl. See Keyboard Monitoring for further information.
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Tutor Profiles - folder locations

Search settings

- Testing Console Report Folder
v File Locations [
@ Fie Locations
23 Folder Locations Testing Console Exam Folder
Q Advanced
(lass Lists Folder
Joumal Folder
[Joumals
Audio Recondings Folder
oK Cancel Help
Click the Browse -~ icon to specify locations for the following items in the Tutor Profile.

Testing Console Report Folder

Specify a location for storing test results.

Testing Console Exam Folder

Specify a location for storing exams.

Class List Folder

Specify a location for storing Class Lists.

Journal Folder

Specify the location for storing Student Journals.

Audio Recordings Folder

Specify the location for storing audio recordings.
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Tutor Profiles - file locations advanced

Pre-defined Student and Group lists can also be included in a Tutor Profile, but these aren't enabled by
default. Before deciding to apply these to a profile, consider the current method of browsing for
Students on start-up as you may not want to override this.

Settings for Configuration: NetSupport Schoel X
| Search settings
[[] Enable Advanced Options
1}
W "' File Locations - Fie
fo2 Fle Locations
503 Folder Locations et i
$63 Advanced
Group File
[[] Use shared data fies
R

Click Change and browse for the appropriate files to include in the Tutor Profile.

Enable Advanced Options

Client File: Contains a list of Known Client machines that the Tutor program attempts to connect to
when loading. The default file name is, CLIENT.NSS. See Class Lists for more information.

Group File: Contains the details of any Student groups that have been created. The default file name
is GROUP.NSS. See Working with groups for more information.

Use shared data files

Checking this option allows you to share data with other users.
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Adjusting configuration settings

NetSupport School provides a range of customisable options enabling you to tailor each Remote
Control session to suit specific requirements and conditions.

The Tutor has the option of applying settings globally or, in some instances, at individual Student
level.

To adjust global configuration settings

1. Click Options in the Tutor Console and select Settings from the drop-down menu.

Settings for Configuration: NetSupport Scheol x
Search settngs . Options
v i Remote Control [Je10s Keyboard A sarolbars
ﬁ View B4 Confirm Switch to Full Screen EAuse Compression
o [CJFul Screen [ walpaper
Keyboard/Mouse
g Replay Files Clscale to Fr [Beank Clent Screen
ﬁ ? [JDisconnect when Closed [ video Skipping
Audo [Oscreen Serape [ Auto Cipboard
& cnat
File Transfer
v User Interface Defauk Mode: Share -
@ Tutor Cache Size: 4 MB w
£03 student
@}a Tutor Assistant Max Colour Depth: 256 colours (high qualty) ~
Group Leaders
Student Toolbar
F Joumal Change DOS Font... Change Japanese Font...

ﬁ‘;@ show

Jpdate Configuration: NetSupport Schog

e 3

2. The following options are available:

Remote Control
View
Keyboard/Mouse
Replay Files
Audio

Chat

File Transfer

User Interface
Tutor
Student

Tutor Assistant
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Group Leaders
Student Toolbar
Journal
Show
3. Configure the required options.

Note: A search bar is provided at the top of the window, allowing you to locate the settings
you're looking for. Type in the search bar (you can enter a full or partial term) and click the

Search icon. Any sections containing the search term will be highlighted. Click the Close
icon to close the search.

4. Click OK. The selected settings will apply to all Students and will automatically be saved for

future Tutor sessions.

To adjust settings for individual Students

The View, Keyboard/Mouse, Replay Files and Audio settings can be customised for individual Students.

1. View the required Student.
2. Click the Settings & icon on the caption bar.

3. The settings for the selected Student appears, select the relevant option View, Keyboard/Mouse,
Replay Files or Audio.

4. Configure the options to be enabled or disabled during the session.

Note: If you want to change the settings permanently, select Update Configuration
NetSupport School.

5. Click OK.
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Tutor View settings

This option provides configuration options for the viewing of Student machines.

Settings for Configuration: MetSupport Scheol >
| Search setngs Options
v @E‘ Remote Control [ B10S Keyboard A Serolbars
£o3 View EA Confirm Switch to Ful Screen (4 use Compression
£o3 Keyboard/Mouse L] Full Screen O walpaper
& Replay Fies O scale to Fit [ stank Clent Screen
é ° ] Disconnect when Closed [Jvideo Skipping
337 Audio [Jscreen Scrape [ Auto Cipboard
& chat
File Transfer
bd User Interface Default Mode: Share w
{8 Tutor Cache Size: 4mB v
£03 Student
@\3‘. Tutor Assictant Max Colour Depth: 256 colours (high quality) =

Group Leaders
Student Toolbar
& Joumnal

o]
@ Show

Change DOS Font... Change Japanese Font...

e o

The View settings can be configured in two ways:
1. To apply the settings for all Student View sessions, click Options in the Tutor Console, select
Settings from the drop-down menu and choose View.

2. To apply the settings for an individual Student View session, click the Settings & icon on the
View window caption bar and select View.

A brief description of the available options follows:

Options

BIOS Keyboard: Checking this option causes the Tutor to emulate keystrokes on the Student, at the
BIOS level rather than the hardware level. Use this if an application at the Student does not appear to
be correctly accepting keystrokes from the Tutor. Only use this option if you are experiencing
problems with the default low-level keyboard option.

Confirm Switch to Full Screen: When this box is checked, you will be prompted to confirm
switching to full screen mode.

Full Screen: Checking this option will force the Tutor to view a Student in full screen mode rather
than in a windowed mode.
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Scale to Fit: Check this option if you want the contents of the View window to be automatically
shrunk to fit the sizeable frame.

Disconnect when closed: Check this option to disconnect from a Student when a View window is
closed.

Screen Scrape: NetSupport School's favoured, and the most efficient, method for capturing screen
data is to hook into the Video Driver of the machine being viewed. However, there may be occasions
when this method will not work because certain applications bypass the driver. In these
circumstances, you can enable 'screen scrape' mode in order to take a snapshot of the screen.
Although this will have a greater impact on the network, it will at least provide an accurate
representation of the Student's screen.

Scrollbars: You can turn off scrollbars on the View window by checking this option. This is useful
when using auto-scroll, as you gain a little extra workspace.

Use Compression: Select this option to enable compression when viewing a Student's screen. The
state of this checkbox is also reflected in the Client Properties.

Wallpaper: Select this option if you want the Student's wallpaper to be visible when viewing.
Normally this is turned off to improve performance, so expect the screen update speed to be impacted
by selecting this option.

Blank Client screen: This enables the Tutor to blank the Student screen in any of the View modes.

Note: This feature is only available on Students running Windows 10 v2004 and above (legacy
support is provided for Students running Windows 8 and below).

Video Skipping: A Tutor's viewing performance can be configured using video skipping. The Tutor
program will not display Student screen updates if a subsequent update to the area of the screen is
made. Unticking the box will result in all Student screen updates being displayed at the Tutor.

Auto Clipboard: When enabled, provides the quickest method for copying data. Use the short cut
keys (Ctrl+C and Ctrl+V) to automatically copy to and from the clipboard at both the Tutor and
Student machines.

Default Mode: When you view a Student, by default, you start viewing in Share mode. If you prefer
to start viewing in a different way, change the style from the list provided.

Cache Size: The NetSupport School Tutor contains a cache to help improve overall performance. The
cache sizes range from 256KB to 16Mb and a separate cache is allocated to each Student connection.
If you are running applications on the Student that use lots of or large bitmaps, increase the cache size
to improve the performance.
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Max Colour Depth: When you connect to a Student, you can restrict the colour depth that is sent.
This is done to reduce the amount of traffic between the Student and Tutor.

Change DOS Font

Use this dialog to select the font to use when displaying DOS screens. This will be from Windows
Students running full screen DOS boxes. Windows uses a graphic character set for displaying DOS
screens. The higher the resolution that you are running Windows in the larger the font size you will
need to set to get an accurate representation of a DOS screen.

Change Japanese Font

Use this dialog to select the font to use when displaying Japanese DOS screens.
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Tutor Keyboard/Mouse settings

Settings for Configuration: NetSupport Schoel »
|§e-d'c"»-'.'.'f._j» { I Keyboard Layout
el @f‘ Remote Control . £2] intemational Keyboard
View Unmapped Heyboard
Q Keyboard/Mousa
@ Replay Files Hatkeys
Audio Oa [ Left Shift
& chat Conirol 1 Right Shift
File Transfer o et
v (@ User Interface e '*P*d | ay M-M' Delay
ﬁ Tutor
Student Off Fastest  Min Max M Ifine
¥ Tutor Assistant
Group Leaders [[] Disable: Mum lock synchronisation
Student Toolbar
@ﬁ} Journal
@ﬁ} Show
Cance Heb

Keyboard Layout

International keyboard: An international keyboard layout will be used at the Tutor during a view
session.

To specify a different keyboard layout to be used at the Tutor while viewing, select the required layout
from the drop-down list. These layouts map keys on the Tutor to keys on the Student machine. If both
Student and Tutor are using the same keyboard layout, you should select Unmapped Keyboard from
the list.

Hotkeys

When you are viewing a Student in full screen mode, hotkeys provide a way of returning to the
possibly hidden user interface. If the screen resolution at the Student is smaller than the resolution of
the Tutor, you can simply click your mouse button outside the View window to stop viewing and
display the view window again. Check the boxes in this group to determine the keys that are used as
hotkeys.

Autoscroll Speed

When you are viewing a Student's screen, the Tutor can automatically scroll the contents when the
mouse moves close to the edges of the window. Adjusting the sliding control sets the speed at which
the view scrolls, from not at all to very fast.
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Scroll Delay

When auto-scroll is enabled, you can change the delay before the scroll is activated. If you want the
view to scroll as soon as the mouse is at an edge of the screen, move the slider towards Min. If you
prefer a longer delay before the auto-scroll takes effect, move the slider towards Max.

Mouse Delay

Adjusting the mouse delay allows you to reduce the rate at which mouse updates are sent from the
Tutor to the Student when controlling or sharing. Move the slider control towards Infinite to reduce
the rate and conserve bandwidth, or towards Min for the best mouse response. This is useful on dial-
up or very slow networks.

Disable Num Lock Synchronisation

Check this option if using a laptop as the Tutor machine to ensure that the keyboard's behaviour
corresponds with that of a standard desktop machine.
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Replay file settings

The replay files feature enables the Tutor to record and play back the screen activity that takes place
at a Student machine while it is being remote controlled/viewed.

|.C»:-‘- settings [ I Replay Fles
| 5 Files
[N @‘:‘ Remaote Control £ Recond Replay Fie

ﬁ View [ include Audio
? Keyboard/Mouse [ Prefix Files With Client Name

23 Replay Fies
£63 Audio
o chat
@P File Transfer
v @@ User Interface
Q Tutor
£03 Student
& Tutor Assietant
& Group Leaders
Student Toolbar
@ﬂ Journal
&® show

In Directony

0K Cancel Help

Replay Files
Record Replay Files: Check this option to enable the recording of replay files. A replay file will be
created each time the Tutor opens a view session at any Student machine.

Include Audio: In addition to the screen, mouse and keyboard activity, if the machine is configured
for audio, you can record any microphone narration from the Tutor.

Note: Desktop sounds, music, etc, are unable to be recorded.
Prefix Files With Client Name: In order to identify each replay file, file names are prefixed with the
Client name and the date/time of the recording. Alternatively, by clearing this checkbox the files will

be named sequentially in the format 00000001.rpf etc.

In Directory: Specify where the replay files should be stored.
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Audio settings

Provides the configuration options for using audio support.

Settings for Configuration: NetSuppert School %
|F-.-A'c:‘t-'.‘.'-:_;» ( Volume
[v {gf‘ Remote Control | Threshold '
‘f: View
? Keyboard/Mouse
*E'F Replay Files Speaker '
502 Audio G s
&f? chat OTes B
File Transfer —
v r Interface @ ok O Takorly
Tutor - -
$03 Student o i
@G‘ Tutor Asststant Change Transmission Fomat..
Group Leaders
Student Toolbar
@ﬁ} Journal
@G} show
oK Cancel Help

The audio settings can be configured in two ways:
1. To apply the settings for all Student sessions, click Options in the Tutor Console, select
Settings from the drop-down menu and choose Remote Control - Audio.

2. To apply the settings for an individual Student session, go to the Audio tab in the View window
ribbon and click Audio Settings = .

Volume

Threshold: Microphone sensitivity.
Microphone: Volume of microphone.
Speaker: Volume of speakers.

Test: Tests all of the above settings (this is only available when applying settings to all Student
sessions).

Enable
Off: Turn audio off.
On: Turn audio on.

Talk only: Turn the Tutor audio to talk function only.
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Listen only: Turn the Tutor audio to listen function only.

Selecting Change Transmission Format allows you to change the transmission format. Use only the
level you need for acceptable quality. High-quality settings can affect screen update performance.
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Tutor Chat settings

A copy of all chat history can be saved to a .txt file.

Settings for Configuration: NetSupport School b4

| Search settings I

- = ki
v Remote Control Dl uto save chat history

? View Chat History Folder:
t:ﬁ Keyboard/Mouse [

£93 Replay Fiies

ﬁ Audio

that As User:

File Transfer
v User Interface

£03 Tutor
Student Oinclude teacher name in path
Tutor Assistant
Group Leaders
Student Toolbar
:_;)ﬂ Joumal
&P show

cnc e

Auto save chat history

Select to save all chat history automatically.

Chat History Folder

Click the Browse -+ icon to specify the folder to store the chat history.

As User

If the path specified above is a UNC path, enter the user name and password.

Include teacher name in path

Allows you to include the teacher name in the path name.
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Tutor File Transfer settings

You can configure the File Transfer settings in NetSupport School. Click Options in the Tutor Console,

select Settings from the drop-down menu and choose File Transfer. Here you can alter the way in
which information is displayed and set safety features such as confirmation before performing a

damaging operation.

Settings for Configuration: NetSuppert School
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Re| Files

& Py 4 Folder copy EAFle overwrite
® o Audo [ Folder delete A File delete
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0K Cancel Help

Display Options
Show System/Hidden files: Check this box to display all files with system and hidden attributes. By

default, this option is unchecked.

Confirm

When you perform potentially dangerous file operations, such as deleting a folder or file, you can
make the Tutor display a Confirmation dialog box. This helps prevent accidental loss of data. If you are
familiar with the User Interface, you can turn these options off as required. By default, all the
confirmation settings are turned on.

Folder copy: Make the user confirm before copying a folder structure.
Folder delete: Make the user confirm before deleting a folder structure.
File overwrite: If checked, displays a confirmation dialog before overwriting an existing file.

However, if unchecked the confirmation message will still appear if system/hidden files are about to be
overwritten.
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File delete: Display a confirmation dialog before deleting one or more files.

Use Recycle Bin for local deletions (when available)

All files deleted from the local pane will be sent to the recycle bin, this is enabled by default.

Use Compression

Check this box to enable the use of compression. When you are communicating with a Student,
whether it is a File Transfer, View or Chat session, the data being sent and received will be
compressed. This also provides a means of security, as the data will also be encrypted.

Delta File Transfer

Delta File Transfer improves performance by skipping the transfer of information that is unchanged. If
the file being transferred already exists in the destination folder, only the changed parts of the file will
be updated.

Delta File Transfer is enabled by default.

Priority (when also viewing)

When you are transferring files and viewing a Students' screen at the same time, each operation
impacts the performance of the other. You can reduce the priority of a File Transfer operation to make
the viewing more responsive and vice-versa. Slide the control to the left to give the File Transfer
higher priority, or to the right to give Student views higher priority. If you are not viewing a Student,
this setting is ignored.

Automatically close progress when copy finished

Closes the File Transfer progress dialog automatically on completion. Un-tick this option if you want to
see the File Transfer results.
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Tutor User Interface settings

Settings for Configuration: NetSuppert Schoel X
| Search settngs ( I Tutor
v = Remote Control | EADisplay Student User Names
£03 View [Jremember Student User/Login names
? Keyboard/Mouse [ Display Student photos from Google Classroom
Q Replay Files [ silent Disconnect
a Audio [ Automatically Reconnect Students
& chat
File Transfer Ll
- User Interface [ 5ave Student history
ﬁ Tutor [[] save Student Web history to Tutor Journal
o
593 Student
@E‘- Tutor Assistant [A Show icons for restricted websites
Group Leaders EAshow Tutor Toobar on minimizing
Student Toobar [ show active Print Jobs
& Joumal
&P show EAshow student alert level
[use context colours in user interface
Show wireless and battery status Show when battery islow  ~
Massage Prompts
Reset ‘Don't show this again’ prompts so you see them again Reset
oK Cancel Help
Tutor

Display Student User Names: Check this option to retrieve and display the login name of the
Student on the Tutor Console when you perform a Student Register.

Remember Student User/Login names: Check this option to save the Student user/login names in
the Known Client list.

Display Student photos from Google Classroom: If you are integrating with Google Classroom
and a photo is associated with the student account, you can choose to display the photo as the
Student icon in the Tutor Console.

Silent Disconnect: Should a Student inadvertently disconnect from the Tutor during a session, a
prompt appears at the Tutor machine. Check this option to disable this warning.

Automatically Reconnect Students: Ensures that Student machines automatically rejoin a live
remote control session should they inadvertently disconnect.
On Exit

+« Save Student history: Check this option to automatically save Internet, Application, Print and
Typing history to a CSV file when the Tutor is shut down.

+ Save Student Web history to Tutor Journal: This option will automatically save Students'
web history to the Tutor Journal when the Tutor is closed down.
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Show icons for restricted websites: By default, the website icon for restricted websites is
displayed. If you have numerous restricted websites, you may want to disable these icons so you are
not using excessive Windows resources.

Show Tutor Toolbar on minimizing: When the Tutor program is minimised, the Tutor Toolbar will
be displayed, providing access to key NetSupport School features. Uncheck this option to disable this.

Show active Print Jobs: Displays any active print jobs in all views.

Show Student alert level: Students can raise an alert from the Student Toolbar, the Student icon
will change colour at the Tutor depending on the type of alert raised. This option enables you to show
or hide these alerts.

Use context colour in user interface: By default, the colour used in the Tutor user interface
changes to match the current view mode. Disabling this option allows you to turn this off and use the
same colour throughout the user interface instead.

Show wireless and battery status: You can choose to display both the wireless and battery status
on the Student thumbnails, just show the battery level when it drops below 10% or show neither.
Message Prompts

Reset 'Don't show this again’' prompts so you see them again: If you have turned off the 'Don't
show this again' message prompts for certain features such as power off, restart, log out or when
exiting the Tutor Console, you can enable them again here. Click Reset.
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Student User Interface settings

Settings for Configuration: MetSupport Scheol >

\Sz-a-cl‘. settings Student

Remote Control | [ Mute sound when locking mouse/keyboard or blanking screen

Chat
File Transfer
v @i User Interface [Jstudent to Student Chat

Q Tutor
§o2 Student

Tutor Assistant

Group Leaders

& student Toobar

@)‘9 Journal

{,}F Show

e o

Student

Mute sound when locking mouse/keyboard or blanking screen: Sound will be muted at
Students when locking the mouse/keyboard or blanking the screen.

Student to Student Chat: Check this option to enable Students to initiate a group Chat session with
other connected Students.
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Tutor Assistant settings

Configure the settings for the NetSupport School Tutor Assistant.

Settings for Configuration: NetSupport Scheol X
Search settings Tutor Assistant System Configuration
™ :’f Remote Control ] Tutor Name/1D _Cu:tom Sgum Status
753 View |ECWIN1D-1 | opped
o Stast
E Keyboard/Mouse G Metwork A
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g‘,‘f’ Tutor Assistant Delete
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Student Toolbar b L
@ﬂ Journal Assistants Waiting For Authorisation _
ﬁ)ﬂ Show Autherise
Dedete
< >
[ Automatic Authorsation
[ interactive Authorisation
0K Cancel Help

Tutor Name/ID

The name that appears at the Tutor Assistant. Selecting Custom allows you to enter your own name
for the Tutor.

System Status

Shows the current system status. You can start and stop the system from here.
Start System when Tutor Starts: The system will automatically start when the Tutor starts.

Current Network Address

The network address for the Tutor.

Connection Port
Enter the port number. The default port is 37777.

Connection Password

Enter the password that Tutor Assistants will use to connect to the Tutor.

Show Password: Displays the connection password.

367



NetSupport School 15.10

Authorised Assistants
Lists the Tutor Assistants that have been authorised to connect to the Tutor. You can remove or
unauthorise the Tutor Assistants from here.

Assistants waiting for Authorisation
Lists the Tutor Assistants waiting for authorisation to connect to the Tutor. Click Authorise to approve
the Tutor Assistant.

Automatic Authorisation
Tutor Assistants will be automatically authorised once they have entered the correct password.

Interactive Authorisation

Tutor Assistants will require manual authorisation to connect to the Tutor.
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Group leader settings

When working with defined groups of Students, the Tutor can assign 'group leader' status to a selected
group member. The designated leader can then take control of the group, performing many tasks that
the main Tutor can. However, the main Tutor retains overall responsibility while a group leader is in
place and can remove the status at any time.

To select the features available to a group leader, select the Group tab in the ribbon and click
Configure.

Visual group leader connections are displayed by default, allowing you easily see the link between a
group leader and their Students in all views. If you don't want to see these, clear the Show Visual
Group Leader Connections option.

All group leader features are enabled by default but can be removed by clearing the appropriate box.

Settings for Configuration: MetSupport School x
|S-.-e'c:‘&-'.'.'f._n { I =B - i
W Remote Control [+ Show wisual Group Leader connections
@ View Select the functions a group leader can pedom within their group
Q Keyboard/Mouse FRmciona.
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File Transfer [ Chat
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2 Audio (Show, Announce and View)
$03 Student 0
& Tutor Assistant
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Student Toolbar Bc e
@ﬂ Journal A Watch

@ﬂ Show

0K Cancel Help

The following functions are available to a group leader:

Show
Scan
Message
Chat

Execute
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Send/collect work
Audio (Show, Announce and view)
Student Journal

View (Share, Control and Watch modes)

Click OK to accept the settings. You are now ready to assign group leader status to selected Students.
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Student Toolbar settings

From here, you can enable/disable and configure the settings for the Student Toolbar.

Settings for Configuration: NetSuppert Schoel x

|5ea1h settngs II The Student Toolbar is displayed on the Sudent’s deskiop, k can show detals about
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B4 Indicate when typing is being montored
] Show Printer status (Blocked. Paused etc)
4] Show Application Monitoring status and give sccess to approved Appl

ﬁ? Tutor Assistant
Group Leaders
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Enable Student Toolbar
Enables the Student Toolbar.

Make the toolbar always visible

By default, the toolbar is set to always visible at the top of the Student screen. Clearing this option will
auto-hide the toolbar and it's only visible if the Student mouses over the top of their screen.

Toolbar options

Select the options that are displayed on the Student Toolbar.
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Tutor Journal settings

A Journal is provided, allowing key information from the lesson to be stored in a portable PDF file. You
can use these options to customise the settings for the Journal stored at the Tutor. To customise the
settings for the Student Journal, choose {Start}{Programs}{NetSupport School}{NetSupport School
Student Configurator - Journal}. On Windows 8 machines, right-click in the Start screen and choose
All Apps at the bottom of the screen. Click the NetSupport School Student Configurator icon.

Settings for Configuration: NetSuppert Schoel x
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Enable Student Journal

Activates the Journal for the Students.

Enable Tutor Journal

If enabled, a copy of the Journal will be stored for the Tutor to view.

Tutor Settings

Margins (mm): If required, you can adjust the top, bottom, left and right margins for the Journal.
Page size: Select the required page size for the Student Journal.
Font size (points): Set the font size to be used in the Journal.

Jpeg Quality (0-100): Allows you to set the quality of images in the Journal, this is set to 75 by
default.
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Journal Folder

Specify where you want the Student Journal to be stored.

Journal Logo

Allows you to add an image that will appear at the top of the Journal.
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Show settings

The Show feature allows you to display the Tutor screen on all, some or one of the Student's screens.
From here, you can configure the settings for a Show.

Settings for Configuration: MetSuppert School x

| Search settngs [ I Show
[]Sereen Scrape
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& chat :
@;P File Transfer
v @f’ User Interface * component et installed
i? Tutor
£03 Student

& Tutor Assistant
@& Group Leaders
@a Student Toolbar
@ Joumal

& show

0K Cancel Help

Show

Screen Scrape: NetSupport School's favoured, and the most efficient, method for capturing screen
data is to hook into the Video Driver of the machine being viewed. However, there may be occasions
when this method will not work because certain applications bypass the driver. In these
circumstances, you can enable 'screen scrape' mode in order to take a snapshot of the screen.
Although this will have a greater impact on the network, it will at least provide an accurate
representation of the Student's screen.

Max Colour Depth: Allows you to select the maximum colour depth when showing to Students. By
default, this will be set to 256 (high) colours.

Show Hotkeys: To ensure that all actions performed by the Tutor are visible to Students during a
Show, you can enable the use of hotkeys. Any key combinations that the Tutor uses, e.g. CTRL+V, will
be displayed in a balloon at both the Tutor and Student screens.

Send Physical Fonts: In order to reduce the volume of data being sent when sharing information of
this nature, NetSupport School passes the font information by reference. The target machine will refer
to its own internal font mappings to find an appropriate match to the one that has been sent. In most
cases, the same fonts will be available, but if there are instances where this isn't the case, you can
send the full information. Check this box to enable.
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Disable Touch Support at Student during Show: If the Students are using touch-enabled
devices, you may wish to disable touch support whilst performing a Show.

Restrict Internet access to approved sites only during a Show: Allows the Tutor to only access
websites that are in the Approved Website list, preventing inappropriate websites being displayed to
Students during a Show.
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Tech Console

A classroom management solution is not simply about providing the right tools for each teacher;
equally important are tools to ensure all computers in the school can be managed and maintained, so
they are always available for teaching. With this in mind, NetSupport School also provides a unique
"Tech Console" specifically for technicians.

The Tech Console provides a single view of all computers across the school, allowing technicians to
review hardware and software inventory, monitor internet and application usage, apply 'always on'
internet, application and printing policies and define security policies which all PCs across the school
will be checked against to determine whether they are secure.

Note: The Tech Console can be installed with other NetSupport School components or as a standalone
component.

To start the Tech Console, click the NetSupport School Tech Console icon in the Start screen or
click the desktop icon, if the option was selected during installation.
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376



NetSupport School 15.10

When the Tech Console loads for the first time, the Configuration dialog appears. This enables you to
specify the Students to connect to at start-up. This dialog will not appear in future sessions but can be
accessed by clicking Options on the right-hand side of the Tech Console and selecting Settings from
the drop-down menu.

Note: If required, a message can be displayed at a Tutor machine when a connection is made. See
Student Security settings for further details.

In the List view, the connected Students can be viewed in two different ways. Thumbnail view displays
a thumbnail of the Student screen, providing a quick and easy method for monitoring activity. Details
view displays details of the Student machines, such as name, IP address, user name, Client platform,
Client version, current security state, policy settings, room, running application and all websites.

The icon displayed next to the Student name in details view will change depending on the status of the
Student. The available icons are:

Grey PC = the machine is off.

Colour PC = the machine on, no Tutor connected.

Green user = the Tutor is connected (Student is in a class).

Brown user = the Student is a teacher.

To toggle between views, select the View tab in the ribbon and click Details or Thumbnail, or click
the Details == or Thumbnail I icon on the status bar.

If you are in details view, you can hide the Running Applications, All Websites and Client Version
columns by clearing the required checkboxes in the View tab of the ribbon.

Note: From details view, you can activate and close applications and websites on a Student by right-
clicking the required icon.

From the status bar, you can resize the Student thumbnails using a convenient 'slider' bar, change the
thumbnail refresh rate and automatically adjust the size of the displayed thumbnails to fit the window.

To allow you to differentiate between a Student and a Tutor, a Tutor & icon is displayed next to the
Tutor thumbnail. A connection bar showing the link from the Tutor to the Students is also displayed.
You can manually set a machine to show as a Tutor machine; right-click the required Student and click

the Properties & icon. In the General tab, select This is a teacher's computer.

With the Tech Console, you can:
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« Monitor all computers across the school network in a single view.

» Monitor application and internet usage on each Student PC.

* Transfer files and folders to selected or all computers.

¢ Group all computers by classroom/physical location.

» Perform a hardware/software inventory.

* Use the Task Manager to view and manage applications, processes and services on the Student.
* Provide direct technical assistance to any classroom teacher.

* Power on/off classroom computers remotely.

¢ Reboot/logout classroom computers remotely.

* Automatically login computers.

» Display all Students and Tutors by active class.

* Review individual NetSupport School Student security settings remotely.

¢ Conduct Chat with one or multiple Students or Tutors.

* Broadcast messages to groups or all network users in seconds.

* Perform powerful 1:1 PC Remote Control on any selected computer.

* See real-time USB memory stick status on all Student PCs.

¢ Lock/unlock Students' keyboards and mice.

e Launch applications on Student PCs.

* View/set power management, Windows update and security settings.

* Edit the registry of a remote and local system.

* Launch a local command prompt from the remote system on your PC.

* Launch a PowerShell window at the selected Student.

* Automatically connect to Students/Tutors using Room mode.

* Apply a school-wide set of internet, application, USB, CD/DVD and print restrictions.
» Easily find Student and Tutor machines using the search feature.

* Stop the NetSupport School Student running at the student machine.

* Create user-defined tools that can automatically run a task on a Tech Console machine.

* Manage files on a Tech Console using the File Manager.

NetSupport School allows teachers to request help from technicians. The Teacher Support feature is

enabled by default and can be turned on and off by toggling the Teacher Support ® toggle on the
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caption bar. A Support B suweeart jcon is displayed on the Tutor Console caption bar. Clicking the icon
allows the Tutor to either chat or send a message directly to the technician.
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Searching for Students

You can easily find Student and Tutor machines using the search feature in the Tech Console. You can
search by logged-on user name, machine name, IP address, running application or the active website.

3.
4.

Select the View tab in the Tech Console ribbon and enter the search term in the Search Text
field.

Search Text : -teacher] | F_m
Search For: S O = 6 & -

Search
Options : Aa

Search

Click the required Search For icon:
=
Search by logged-on username.

[Logged-on user icon]

L

Search by PC name.
[PC name icon - monitor]
=

Search by IP address.
[IP address icon]
|

Search by the running application.
[Running application icon]

iz

[Active website icon]

Search by the active website.

To make the search case-sensitive, click the Case sensitive search 2z icon.
Click Search.

The search results appear in a new group on the group bar.

Note: You can remove the search results (and the group) by clicking the Close Search icon on the
ribbon.
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Stopping the Student service

There may be occasions when you need to stop the NetSupport School Student running at a student
machine. You can stop the Student service from the Tech Console. Once this has been stopped, no
further use of NetSupport School is available. You can stop the Student until the machine is restarted,
specify how long the Student is stopped for before it's restarted or stop the Student until a specified
time.

Note: If you have suspended the service for a set period or a specified time, restarting the machine
does not cause the Student service to start unless the specified time has expired.

To stop the Student service

1. Inthe Tech Console, select the Student(s) or group to stop the Student service for.

Note: Please ensure the correct machines are selected, as this can't be undone.

2. Select the Home tab in the ribbon and click Stop Student.

Stop Student »

You can stop the remote student service in case the machine needs to be unavadable for
@ connection. This might be during an exam for example.

You should be certain which machines this applies to, it cannot be undone
() Student is stopped now and won't be avaiable until the machine is restarted

() Student is stopped now and restarted after the spedfied number of minutes

80l || minutes
() Student is stopped now and restarted at the spedified time

Concel | | Next |

3. Choose the required option:

Student is stopped now and won't be available until the machine is restarted: The
Student service is stopped and won't be available until the machine is restarted.

Student is stopped now and restarted after the specified number of minutes:
Suspends the Student service for a specified time. Enter the amount of time in minutes before
the Student is restarted.
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Student is stopped now and restarted at the specified time: Stops the Student service
until the specified time. Enter the time the Student is restarted.

4. Click Next.

5. A summary of the option you have selected and the Student(s) this applies to is displayed.

6. Click OK.

7. Afinal confirmation appears. Click Yes to proceed.

Limitations:
e This is only available for Windows Students.

* The maximum time you can stop the Student service for is 24 hours. If you need to stop the
service for longer, the setting must be applied daily.

« Interminal server environments, it is not possible to stop the Student service for individual user
sessions.
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Remote inventory and system information

For many support teams an important part of the problem resolution process is knowing not only what
platform the machine is running, but its hardware specifications and the applications installed on the
machine. For this reason, NetSupport School provides the tools to supply a full inventory of the remote
machine.

In addition to its sophisticated hardware/software reporting, where a wealth of information is collected
specifically about the hardware or environment of the Student PC, you can obtain details of installed
hotfixes and use the Task Manager to view and manage applications, processes and services that are
currently running.

As well as the real-time reporting, NetSupport School also provides the tools, security permitting, to
allow you to remotely stop and start services, end applications and processes.

Note: The inventory is only available from the Tech Console.

To retrieve a Student inventory
1. Select the required Studenticon in the Tech Console List view.
2. Select the Home tab in the ribbon and click Inventory.
Or
Select the tab displaying the Student's name in the ribbon and click Inventory.
Or
Right-click and select Inventory.

3. The Inventory window for the selected Student appears.

Note: Once collected, the various Student inventories are stored locally in the NetSupport School
program folder, meaning that you do not need to be connected to the target PC to be able to view the
information at a later date. Simply select the required Student from the List view and choose the
Inventory option. However, if you subsequently want to refresh the inventory, you do need to
connect to the target PC.

Running the Task Manager
1. Select the required Studenticon in the Tech Console List view.
2. Select the Home tab in the ribbon and click Task Manager.
Or
Select the tab displaying the Student's name in the ribbon and click Task Manager.

Or
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Right-click and select Task Manager.

Or
While viewing the Student screen, select the Tools tab in the View window ribbon and click the

Task Manager icon.

The Task Manager window for the selected Student appears.
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The Inventory window

The Inventory window is the primary interface for accessing the wealth of information that NetSupport

School's inventory feature provides.

3 Inventory 2 ? _ O X
Home
=) 5 C @ &
a7 =
= .
Hardware Software Hot Refresh Print Export
Fixes
View Hardware
~

Hardware Inventory Summary HPLAP-2

System Overview Name:
Manufacturer:

Operating System:

1]

Service Pack:

Version:

Registered User:

(o} Physical Memory:
— Domain / Workgroup:
Model:

Serial Number:
Organisation:
System Language:
System Time Zone:
Logged on User:
Direct X version:

System Enclosure:

Motherboard Processor:
Clock Speed:
111n1 Processor Manufacturer:

- -
_I_I_ BIOS Asset Tag:

O Connections:3 ~

The window is organised as follows:

The caption bar

Last Updated : 28 Jun 2023 16:26:44

HELAP-2
Hevdett-Packard

Windove 8 x64

<MNot Available>

5.2.9200

testing

4096 MB

WORKGROUP

HP Pavilion dm1 Notebook PC
00179-50291-10235-AA0EM
Hewlett-Packard

English (United Kingdom)
(GMT) GMT Summer Time
testing

11.0

Notebook

AMD E2-1800 APU with Radeon(tm) HD Graphics
1700 MHz
AMD

<Not Available>

The caption bar displays the name of the remote Student PC whose system inventory is being viewed.
The following options are available on the right-hand side:

2
[Multiple windows icon]

B

[Online help icon - question mark]

[Minimise window icon]
|

[Maximise window icon]
bt

[Close window icon]

Shows how many windows are open. From here, you can
access the Window menu.

Access the online help and version number, licensee, Technical
Support and compression information.

Minimise the window.

Maximise the window.

Close the window.
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The ribbon

The ribbon provides access to the inventory components and from here, you can refresh, print and
export the current view.

The following inventory views are available:

Hardware: NetSupport School collects a range of information specifically about the hardware or
environment of the Student PC, providing all the key information needed to assist in speedy problem
resolution.

Software: Provides a full software inventory report for any selected Student PC. Includes the name of
each installed product, the manufacturer, product icon, version number and even the associated .exe
file.

Hot Fixes: NetSupport School scans for and checks the status of any hotfixes that have been installed
on the selected Student machine. The hotfix ID is listed along with its status. The hotfix ID links to the
appropriate Microsoft support page, where details of the fix can be found.

When verifying the status of each fix, NetSupport School returns one of three indicators:

Verifies that the fix is present on the target PC and is current.

(%) An expected file may not be present or is not the correct version. It would be
advisable to install the fix again.

(7] NetSupport School was unable to gather the required information for it to be
able to verify the status.

Note: Once collected, the various Student inventories are stored locally in the NetSupport School
program folder, meaning that you do not need to be connected to the target PC to be able to view the
information at a later date. Simply select the required Student from the List view and choose the
Inventory option. However, if you subsequently want to refresh the inventory, you do need to connect
to the target PC.

The status bar

The status bar shows the number of connected Students. You can see a list of all connected Students
by clicking Connections (clicking a Student name opens an Inventory window for them).

386



NetSupport School 15.10

The Task Manager window

NetSupport School allows you to remotely open the Task Manager and manage applications, processes

and services on the Student.

Task Manager

Home

E@@""

Applications  Processes  Services

View

C o &

Export

Applications

150 ? _ O X

~
MName

E’AMD:CCC-AEMCapturingWindow
Eclassroom.cloud
E Document - WordPad

<

G K53 English - BEC Bitesize - Google Chro...

PID
4584
2980
1320
5040

State

Running
Running
Running

Running

O Connections: 3 ~

The window is organised as follows:

The caption bar

The caption bar displays the name of the Student you are running the Task Manager for. The following
options are available on the right-hand side:

2

[Multiple windows icon]

B

[Online help icon - question mark]

[Minimise window icon]

-

[Maximise window icon]

Shows how many windows are open. From here, you can
access the Window menu.

Access the online help and version number, licensee, Technical
Support and compression information.

Minimise the window.

Maximise the window.
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®
Close the window.
[Close window icon]

The ribbon

The ribbon provides access to the Task Manager tasks and tools. The available options change
depending on what view is selected. You can refresh, print and export the data from all views.

The following views are available:

Applications: Shows a list of applications currently running on the Student machine. You can close a
selected application from the list by clicking the Close Application icon.

Processes: Provides a list of processes currently running on the Student machine. You can close a
selected process from the list by clicking the Kill Process icon.

Note: Click Monitor Resources to see the usage differences (+/-) for the running processes.

Services: Provides a list of services currently running on the Student machine. You can stop, start,
pause and restart services by clicking the required Services icon.

The status bar

The status bar shows the number of connected Students. You can see a list of all connected Students
by clicking Connections (clicking a Student name opens a Task Manager window for them).
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Policy management

The Tech Console allows you to create a set of policy restrictions that can be applied across the whole
school permanently. Once the policy is applied, it will remain in force 24 hours a day. The policy
restrictions can include internet and application usage, access to USB and CD/DVD drives, printing and
webcams.

Note: The Tutor can override central policies for their Students in the NetSupport School Tutor - Start
Option settings.

In details view, you can view the current policy restrictions for Students. Hovering over the icons in
the Policy column displays further information about the current policy.

The NetSupport School Tutor is notified of any policy restrictions that are in force. A lock icon will be
displayed next to the relevant feature advising that a central policy has been applied.

Creating a policy
1. Select the Security tab in the ribbon and click Group.

Or

Click the Details == icon on the status bar, right-click in the Policy column and select Policy

Management.

2. The Policy Management dialog appears.

Policy Management X

Intemet
Mode | Restricted ~

=
URL Description Add
“www.facebook.com
W www twitter.com
www youtube com Ed

Applications

Mode | Unrestricted ~
=

Name Description | Add |

[#5] Microsoft Edge Remove

B usFaint

Edit
Impart
USB CD/DVD
() Unrestricted (O Unrestricted
() Block access () Block access
(®) Read only (®) Read only
Printer Unrestricted ~ Webcam Blocked v
Help OK Cancel
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3. Set the required restrictions.
4. Click OK.
5. Click Yes to apply the policy changes to all Students.

Applying a policy

You can apply the policy to all connected machines.

Note: Teacher machines can be excluded from a policy. Select the Don't apply policies to teacher
computers option in the Tech Console - General settings dialog.

1. Select the Security tab in the ribbon and click Apply.

Clear a policy

Clears the current policy from the selected Student(s).

1. Click the Details == icon on the status bar.
2. Select the required Student(s).

3. Right-click in the Policy column and select Clear Policy.
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Define and view Student security settings

The Tech Console allows you to view the current security status for Students, modify the security
settings such as the firewall, Windows updates etc, for Students and configure the settings that
determine whether a PC is secure. If a Student meets the conditions that define a secure PC, a green

shield is displayed in details view. This will turn red if the Student fails to meet even one of these
conditions.

Note: These settings are only available in the Tech Console.

Define a secure PC

Define what options determine whether a PC is classed as secure.

1. Select the Security tab in the ribbon and click Define.

2. The Define Secure PC dialog appears.

Drefine Secure PC e
Check the options which should be used to determine if a PC is secure. @
Options
Firewvall: on
Anti Virus: Active
Anti Spyware: Active
UAC: on
Windows Updates: [ notify Only
[~ Download and Notify
Automatic
Help Cancel

3. Select the required options.

4. Click OK.

View current security settings

In details view, the current security status for Students is displayed in the Security column. Hovering
over the shield will display the current status of all items for a Student.

1. Right-click the Student icon and select Properties =.

2. The Client Properties dialog appears.
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2l Client Properties x
General Details Secunly About Compression
ltem Status
) Firewall On
Anti Virus Unknown
Anti Spyware Unknown
@ UAC on
Windows Update Unknewn
) Power Scheme Balanced
(%) User Acknowledgement Not set
® Security Key Mot set
Details
Refresh Change
co

3. Select the Security tab.

4. The current security status for the Student is displayed.

Change the security settings
1. Select the Studenticon.
2. Select the Security tab in the ribbon and click Security Settings.
Or

In details view, right-click the shield in the Security column and select Modify Security
Settings.

3. The Modify Settings dialog appears.

Maodify Settings *
Settings
Firewall: On =
UAC: On >
Windows Updates: Notify Only v @
Power Scheme: Balanced v
%) These items are currently indicating this PC is not secure
Help Apply Cancel

4. Alter the settings as required.

5. Click Apply.
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Or

1. Right-click the Student icon and choose Properties =.

2. The Client Properties dialog appears. Select the Security tab.

3. Click Change and alter the settings as required.
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Remote Command Prompt window

By launching the Remote Command Prompt window, you can remotely execute command line
instructions at a connected Student.

Note: This feature is only available in the Tech Console.
1. Connect to the required Student.
2. Select the Home tab in the Tech Console ribbon and click Remote Command.
Or

Right-click on the Student icon and select Remote Command Prompt.

Or

Select the tab displaying the Student's name in the ribbon and click Remote Command.

3. The Remote Command Prompt window appears.

B Remote Command Prompt 2 7
Home
@ B [ Paste
Stop Clear . Font
Output
Remote Output View

_ 0O

Microseft Windows [Version 10.0.19042.1288]
{c) Microsoft Corporation. Rl1l rights reserwved.

C:\WINDOWS\system32>

[O Connections : 2~

The window is divided into the following sections:

The caption bar

The caption bar shows the name of the Student the Remote Command Prompt window is open

for. The following options are available on the right-hand side:

29! Shows how many windows are open. From here, you can

[Multiple windows icon] access the Window menu.
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Access the online help and version number, licensee,

. . ] Technical Support and compression information.
[Online help icon - question mark]

Minimise the window.
[Minimise window icon]

-

Maximise the window.
[Maximise window icon]

x
Close the window.
[Close window icon]

The ribbon

A range of tools is available via the ribbon, enabling you, for example, to clear the output
window and change the displayed font.

Output/results pane

Shows the results of the command that has been run at the Student.

Input pane

This is where you enter the commands to run at the Student. It can be resized if required. While
the window is open, each command is stored by the Tech Console - enabling you to recall
previous instructions that you may wish to run again. Either scroll through the entries using the
up and down arrow keys and press Enter when the required command is displayed or press F7
to show all commands in a window. Click on the required command and press Enter.

A maximum of fifty commands are stored. To clear the history, press F8. Once you close the
Remote Command Prompt window, the history is cleared automatically.

The status bar

The status bar shows the number of connected Students. You can see a list of all connected
Students by clicking Connections (clicking a Student name opens a Remote Command Prompt
window for them).
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PowerShell window

A PowerShell window can be launched, allowing you to execute PowerShell commands at Students.

Note: This feature is only available in the Tech Console.
1. Connect to the required Students.
2. Select the Home tab in the Tech Console ribbon and click PowerShell.
Or
Right-click the Student icon and select PowerShell.
Or
Select the tab displaying the Student's name in the ribbon and click PowerShell.

3. The PowerShell window appears.

Multiple PowerShell (Administrator) 240 ? _ O x
Home
— MNext [ clear [E Copy Al AC\
€ Previous — Next
Font
“— Previous
Clients Errars Edit View

windows Powershell
Copyright (C) Microsoft Corporation. All rights reserved.

ss—platform Powershell http

ting> o

O Connections:2 ~ | [J Errors:0 [l Differences : 1

The window is divided into the following sections:

The caption bar

The caption bar shows the name of the Student the PowerShell window is open for (or the
currently selected Student if the PowerShell is for multiple Students). The following options are
available on the right-hand side:
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2 ¢ Shows how many windows are open. From here, you can

[Multiple windows icon] access the Window menu.

? Access the online help and version number, licensee,

. . . Technical Support and compression information.
[Online help icon - question mark]

Minimise the window.
[Minimise window icon]

8

Maximise the window.
[Maximise window icon]

*
Close the window.
[Close window icon]

The ribbon

A range of tools is available via the ribbon, enabling you, for example, to change the displayed
font. If the PowerShell is launched at multiple Students, they will be listed in the Students pane,
allowing you to easily access the required Student session.

When a PowerShell is launched at multiple Students, if any sessions report an error or there are
any differences between them, you will be notified in the Errors and Differences sections in the
ribbon. An indicator will appear advising how many errors or differences there are and you can
scroll through these and clear them when required.

Input output pane

This is where you enter the commands to run at the Student(s) and the results are displayed.

While the window is open, each command is stored by the Tech Console - enabling you to recall
previous instructions that you may wish to run again. Either scroll through the entries using the
up and down arrow keys and press Enter when the required command is displayed or press F7
to show all commands in a window. Click on the required command and press Enter.

The status bar

The status bar shows the number of connected Students and any errors or differences between
multiple Student sessions. You can see a list of all connected Students by clicking Connections
(clicking a Student name opens a PowerShell window for them).
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About NetSupport School Testing module

NetSupport School's Testing module is a powerful utility that enables you to design tests and
examinations with the minimum of effort. Incorporating an intuitive Test Designer allowing you to set
customised tests including text, picture, audio and video questions, once the specified Students have
completed the test in the pre-set time, the results are automatically collated, marked and made
available.

MetSupport School Test Designer

= Home Resources

lj 1 Delete I} lz] ¥=] fo=l [ox @ Q D [l By Author ) By Subject | (7 Question tree
53 Rename : o] oz [oT Q. Opyoificuy DeyType | & Bxamtree
New ew Create d Create  Edit Delete Grades Publish Preview
Subjects Topics Questions Exams Preview
- A
Questions - %
-5 General
-5 Geography
-5 History
@3 Literature

-3 Science

NetSupport School Test Designer

Select a gquestion from the Question list to preview it or select an Exam for
exam details

Exams v %
@-E] Example Test

For Help, press F1 NUM

The following components are available within the Testing module:

The Test Designer

The Test Designer is used to create questions and tests.

The Testing Console

Run from within the NetSupport School Tutor program, the Testing Console is used to launch the
required test at selected Student machines, monitor progress and collate results.

The Test Player

This component runs the test at the Student machine, it loads automatically when the Tutor launches
a test.
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The Test Designer

The Test Designer is where you view and create questions and exams.

NetSuppart Sehool Test Designer

= Home Resources
lj 17 Delete I] ‘3 |j F F @ Q E‘ [ By Author By Subject Question tree
[ Rename = o=] oz leT Q o By Difficulty | [ By Type Exam tree
New New Create J Create Edit Delete Grades Publish Preview
Subjects Topics Questions Exams Preview
. ~
QUESUOHS v X General Information Optional details
-5 General Title Example Test Age range ALL
T Geography
§ History Description An example to show the capabilities of Class Group ALL
#-3 Litersture Testing modules.
T Science
Notes
Timed Exam
Time Limit 00:10 ~ | Hours : Minutes
Exams v X
P Ei ] Grading Schema
Default scoring system
Question Topic Subject Level &
In these statements highlight the word that is a verb General other Easy
Identify the countries by dragging the correct name to the map ... Geography Countries Easy
Using the picture provided, answer these questions on Italy. Geography Countries Hard
Identffy the flags for each of these African nations. Geography Countries Medium
Put these oceans in order of size (Largest to Smallest). Geography Oceans Easy
Listen to the music and identify which country this is the national... Geography Countries Hard
Choose the correct year that these countries hosted the Summ... History Dates Medium
Which of the Seven Wonders of the World is still standing? Geography Countries Easy
Comnlate the falawing sentences. Genaranhv Countries Fasy e
For Help, press F1 HUM

The window is divided into the following areas:

The ribbon

The ribbon provides access to all the tools needed to use and manage the Test Designer. The ribbon is
organised into the following tabs:

Options =~

Enables you to import and export data, manage users and configure the Test Designer options.

Home

Here, you can create and manage subjects, topics, questions and exams.

Resources

Displays the resources available to add to questions. From here, you can add, edit and remove
resources.
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Left-hand pane

Questions tree view

Shows the available questions. These are grouped by subject.

Exams tree view

Shows the exams. Expanding the exam name shows the questions that are included.

Right-hand pane
Shows a preview of the currently selected question or exam or the list of resources if the Resources
tab is selected.
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Starting the Test Designer

The NetSupport School Test Designer is the primary interface for:

¢ Creating questions.
* Creating tests/examinations.
* Maintaining stored questions and tests.

¢ Providing user access to the designer.

Note: Selecting participants, running the test at student machines and recording the results of tests
is managed in the Tutor Console.

Starting the Test Designer

1. Choose {Start}{Programs}{NetSupport School}{NetSupport School Test Designer}. On
Windows 8 machines right-click in the Start screen and choose All Apps at the bottom of the
screen. Click the NetSupport School Test Designer icon.

Or
Select the Feedback & Wellbeing tab in the Tutor Console ribbon and click Test Designer.

2. Alogin screen appears.

MetSupport School Test Designer

Password Cancel

Enter your user name and password.

Note: By default, the admin account has no password set. You are prompted to set one when
you create additional user accounts or exit the Test Designer.

3. The Test Designer window opens.
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The Questions interface

You can create questions in a variety of formats and these can be enhanced by the use of imported
pictures, videos and sound clips.

1. Select the required question from the Questions pane tree view.

2. A preview of the question appears in the right-hand pane.

Netsupport School Test Designer

=~  Home  Resources
@ E].; [_—],, [_—1,\ “= foml o ® Q E] [ By Author By Subject Question tree
: 7z W LW o] o7 1T Q. Oeyomeuty O oy Type Exam tree
Create  Edit Delete Duplicate Create Edit Delete Grades Publish Preview
Subjects Topics Questions Exams Preview

Questions v x

& General - Complete the following sentences.

-3 Geography

Capital Cities
Countries

A: Complete the following sentences.

& Correctly assign the national flags to each country.
How many countries are in each of these continents? Please place the text in the right place
57 Identify the countries by dragging the correct name to tt
L+ Identify the flags for each of these African nations. __isacityin the United Kingdom.
Listen to the music and identify which country this is the
ing the picture provided, answer these questions on It
Which of the Seven Wonders of the World is still standin

Oceans is a region in Germany.
= e
4 13

Exams v X
-] Example Test

The capital of Western is Perth,

Australia
Bavaria
London

For Help, press F1

The icons available in the Questions section of the ribbon, enable you to:

¢ Create questions

» Edit a selected item

e Delete a selected item

¢ Duplicate a selected item

+« Change the way questions are arranged in the tree view. This can be by author, question type,

subject or level of difficulty.

Subjects and topics can be added to the tree view at any time or, if you are not sure which subject
groups your questions will belong to, you can add them when creating a question.

To add subjects directly to the tree view, select the Home tab and click New in the Subjects section of
the ribbon or right-click in the Questions pane and select New Subject.
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Multiple topics can then be added beneath a subject by right-clicking on the subject name and
selecting New Topic or clicking New in the Topics section of the ribbon.
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Create questions

A choice of nine question styles are available, each with a Question wizard which steps you through
the required process.

To create a question
1. Select the Home tab and click Create in the Questions section of the ribbon.
Or
Right-click on an existing question and click Create Question.

2. Select the required question type and click Create.
Or

1. Select the Home tab in the ribbon, click the Create icon drop-down arrow and choose the
required question from the list.

Create a Question

9 8 & @ ©

Multi Cheice Drag & Drop Text Drag & Drop Image Combo List Label Image True or false

S = 6

Multi True or false Order ltems Highlight Text

Standard question where the student is required to select the correct answer from up to four possible
options
Create

Help

Close

Note: Questions can also be created in the Exam Editor when you compile a test.
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The available question types are:

Multi choice

The Student is required to pick the correct answer from up to four possible options.

Drag and drop text

Students must try to complete a statement by adding a word or phrase from the alternatives provided.

Drag and drop image

Students must match an image with the appropriate statement.

Combo list

Students are presented with up to four questions and need to select the correct answer from the drop-
down list. You can insert additional 'decoy' answers into the list.

Label image

You provide students with a picture that has various areas marked. The Student needs to label each
area correctly.

True or false

The Students are provided with a statement and they must decide whether this is true or false.

Multi true or false

Students are presented with up to four statements and must decide whether they are true or false.

Order items

The Students are required to place the items in the correct order.

Highlight text

Students must highlight a word or phrase to answer the question.
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Multiple choice question

Students select the correct answer from up to four possibilities.

Multi Choice Wizard i

Question and Correct Answer

=i Which of the Seven Wonders of the Ancient World is still standing?

Answer

The Great Pyramid of Giza.

Incorrect Answers

Answer 1

The Lighthouse of Alexandria.|

Answer 2 The Hanging Gardens of Babylon|

Ansverd The Colossus of Rhodes

) Information

Enter your question in the dialog at the top of the screen. You can enter the correct answer and up to three other answers to
complete the multiple choice question. When done dick next to continue

< pack ol Hep

The first stage of three is to set the question followed by the correct answer and up to three incorrect
answers. When the question is run at Student machines, the answers are randomly arranged.

Once you have completed part one of the wizard, click Next.
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Drag and drop text question

The Student is presented with four partially completed statements. They must complete the statement
by dragging and dropping the appropriate word or phrase from a list.

Drag & Drop Text Wizard %

|ETTELTTS Identify the correct capital cities for the countries listed below,

Statement 1 m is the capital city of England. Set Answer

Statement 2 m is the capital city of France. Set Answer

Statement3  The capital city of Italy is [TY. Set Answer

Statement 4 M is the capital city of Spain. Set Answer
Fake answers Barcelona Berlin

Ay Information

Enter the instructions for the question along with up to four statements. Within each statement highlight with your mouse
the word or phrase that you want the Student to drag and drop. Click 'Set Answer’ when you are happy that you have
selected the appropriate text.

< Back Next > Cancel Help

The first stage of three is to enter the instructions for the question along with the four statements.
Within each statement, highlight the word or phrase that you want the Students to drag and drop and
click Set Answer. You can add two fake (incorrect) answers, so the Students have to identify the
correct answer before dragging it into the statement. When the question is run at Student machines,
the four highlighted items are removed from the statements and randomly arranged with any fake
answers you have entered.

Once you have completed part one of the wizard, click Next.
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Drag and drop image question

The Student is presented with up to four statements or questions, and a selection of images. They
must match the image with the correct statement.

Drag & Drop Image Wizard X

Instructions Correctly assign the national flags to each coumry.|

Option 1 E t
ayp = —
Option 2 Canada
* Browse
Option 3 Ghana
Pntonl Brazil o
@ Browse

& Information

Enter your instructions in the box at the top of the screen. Then enter up to four labels in each of the option boxes.
Then select the Browse button to the right of each option and select the image that matches the statement, When the
question is published the Student will need to choose which image matches each statement

The first stage of three is to enter the instructions along with up to four statements or phrases.
Alongside each statement, you add the appropriate image. Click Browse to search for the images.
The list of pictures currently stored in the images database appears. Either select an existing image or
import a new one. Click Use to apply the image to the question.

When the question is run at Student machines, the pictures are randomly arranged at the bottom of
the screen and the Students drag and drop the images next to the appropriate statement.

Once you have completed part one of the wizard, click Next.
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Create question - combo list

The Student is presented with up to four statements, alongside each statement is a drop-down list
containing a choice of possible answers. They must select the correct answer from the list.

Combo List Wizard X

Instructions

How many countries are in each of these continents?

Question Text

Text 1

Africa 54
Tet2  psia 48 .
Tet3  Australia & Oceania 14
Text4  Antarctica d

|

Fake Answers

68 100

(2 Information

Enter up to four different statements, for each staternent enter the correct answer in the text box provided. In addition add two incorrect answers in the
boxes marked Fake 1 and 2. The student will be shown all possible answers to choose from

Cance Help

The first stage of three is to enter the instructions along with up to four statements or phrases.
Alongside each statement, enter the correct answer text. You can then add two further fake answers,
meaning that when the question is run at Student machines, the Student will be shown all possible
answers to choose from.

Once you have completed part one of the wizard, click Next.
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Create question - label image

Students are presented with a picture that has up to four areas marked, each with an adjacent blank
text box. At the bottom of their screen will be up to four text labels which they must drag and drop into
the correct text box.

Label Image Wizard >

Instructions

=i Identify the countries by dragging the correct name to the map Iabelj

Label 1 Brazil
Label 2 Canada
Label 3 France
Label 4 India
Image to label
Image File Map of World Browse

&0 Information

Enter the instructions at the top of the page, then specify up to four labels that will need to be correctly located on the image. Select the image by using the
Brawse button. When done click Next to proceed

MNext > Cancel Help |

The first stage of five is to enter the question along with up to four text labels. You then select the
image that the Students need to label. Click Browse to search for the image. The list of pictures
currently stored in the Images database appears. Either select an existing image or import a new one.
Click Use to apply the image to the question.

Once you have completed part one of the wizard, click Next.
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Adjust image

If the image you have chosen for the label image question is too large for the viewable area, you can
resize it.

e plarver then serel the image i the view that you wish 1o see, O seiect &

I!!'!n? Vo thar the
secen of the image by draggeng 8 bax over Tt area

o (] [ | [ e

Use the scroll-bars to position the image within the viewable area. To select the required section, use
your mouse to draw around the area you require. When ready, press Enter or click Next to continue.
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Label image

Use this preview window to position the answers on the image and choose an appropriate colour
scheme for the 'pointer’ lines and background.

Label the image

Drag & Drop Labels on to image

rance

Label line colour B red +| Background colour B e v

Arrow Type = D ounid w

51 Information
Move the answers to a location that does not cover an important section of the image. Then move the pointer of each answer to the correct location on
the image

< Back Cancel Help

1. Drag the end of each pointer to the correct region of the image.
2. Drag the associated text box to an appropriate area.

3. Select the pointer (arrow) style you wish to use and choose a colour for the label line and
background.

4. Click Next.
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True or false question

Students are provided with a statement and they must decide whether it is true or false.

True or false Wizard *

Instructions Is the following statement true or false

Answer TRUE or FALSE

ERENE The deepest point in the ocean is the Marianas Trench, which is

located in the Pacific Dceanj L TRUE O

&> Information

Enter the instructions for the question along with the statement that is true or false.

< Back Cancel Help

The first stage of three is to provide instructions for the question, then enter the statement you want
the students to answer and specify whether the statement is true or false.

Once you have completed part one of the wizard, click Next.
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Multi true or false question

Students are provided with up to four statements and they must decide whether they are true or false.

Multi True or false Wizard x

Instructions .
ue Are the following statements true or false?

Answer TRUE or FALSE

Statement There are 86,400 seconds in a day.|

Statement There are 1,540 seconds in a day.

Statement

Statement

=

& Information

Enter the question instructions. Then add a statement and select whether the correct answer is true or false.

< ook Concel Hep

The first stage of three is to enter instructions for the questions, along with up to four statements.
Alongside each of the statements choose whether they are true or false, by using the toggle.

Once you have completed part one of the wizard, click Next.
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Order items question

Students are required to correctly place in order up to four answers to the question.

Order Items Wizard *

Cnestion Using the picture to help you, order the planets below by their distance from the Sun

(nearest to furthest) |

Answer correct order
Text 1 Mercury
Ted 2 Venus
Text3 Earth
Text 4 Mars

i= Information

Enter the instructions for the question along with up to four items to order.

< Badk Next = Cancel Help

The first stage of three is to set the question, with up to four answers in the correct order. When the
question is run at the Student machines, the answers will be randomly arranged and the Students will
drag and drop each item to the correct place.

Once you have completed part one of the wizard, click Next.
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Highlight text question

Students are presented with up to four statements. They have to highlight the correct section of the
statement(s).

Note: This question type was introduced in version 15.00 and previous versions cannot import or use
this question. This question type should not be used if you have Tutor Consoles or Students running
earlier versions, as it will not work and, if included in a test, the test will not start for any Students.

Highlight Text Wizard .
|

Instructions 1, these statements highlight the word that is a verb

Select student highlight error margin:

Number of characters before start of answer: 1 = MNumber of characters after end of answer: 2

Statement 1 John m Buckingham Palace with his friends.
Statemnent 2 The boym the piano at the concert.
Statement 3 Sarah her new toys. Hiahliaht |

Statement 4 Connor m the window.

[ Information

Enter the instructions for the question along with up to four statements. For each statement, using your mouse select the text that comprises the correct |
answer and dick the 'Highlight' button. |

|
< Back Cancel Help

The first stage of three is to enter instructions for the question and then up to four statements. Once
you have entered a statement, highlight the correct section of the statement. To allow for Student
error when highlighting the correct text, an error margin can be set, allowing you to specify how many
characters before and after the highlighted section can be selected before the answer is marked
incorrect (by default, this is set to one character before and two after the selection). The correct
answer is highlighted in dark green and the error margin is shown in light green.

If the text selected as the correct answer appears more than once in the statement, the duplicates are
highlighted in red. You may want to reword the statement, as if a student highlights the wrong section
of text, this will be marked as incorrect.

416



NetSupport School 15.10

Note: If a Student only partially highlights the correct answer, the question will be marked as
incorrect.

Click Next.
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Adding additional resources to questions

The resources database

Imagery in the form of pictures, videos and sound clips are often an integral part of any question you
create. Question types such as label image and drag and drop image are graphical by nature but any
question type can have an additional supporting resource included. The Test Designer provides an
'observation' mode which, if enabled, forces Students to view or listen to a resource before they can
answer the question.

Before you can attach a resource to a question, it must first be added to the programs internal
resources database. By default, this is stored in C:\\Program Files\NetSupport\NetSupport

School\resources but the location can be modified by selecting the Options <= icon in the ribbon
and clicking Change program options.

To populate the database, select the Resources tab in the ribbon. The Resource list appears.

NetSupport School Test Designer

FET Home Resources
b % ‘Q Image| == List
<}y Sound  |= Details |
Import Mone
H video O Thumbnail ~
Resources Filter View
QUEStiOf’IS + x | Description Type Ref Size/Length o
w Africajpa ipg 0 500 x 452 pixels
& angel ipg 0 48 x 48 pixels
& blue gif 0 48 x 48 pixels
B Literature & body gif 0 170 x 327 pixels
-0 Science ! diode gif 0 78 x 78 pixels
& earth ipg 0 192 x 144 pixels
& egypt gif 1 112 x 75 pixels
& Ethiopia gif 1 116 x 66 pixels
& Flag of Argentina gif 1 48 x 48 pixels
& Flag of Brazil gif 1 48 x 48 pixels
& Flag of Canada gif 1 48 x 48 pixels
& Flag of USA gif 1 48 x 48 pixels
& Ghana gif 1 104 x 72 pixels
& green gif 0 48 x 48 pixels
Exams > ¥ | @ maly ig 1 420 ¥ 438 pixels
-] Example Test & J-FET P Channel ... jpg 0 87 x 87 pixels
m LED ipg 0 100 x 100 pixels
& magician ipg 0 48 x 48 pixels
& Map of Oceans gif 1 768 x 386 pixels
& Map of World gif 1 531 x 345 pixels
w Map_americas ipg 0 350 x 498 pixels
W Mars ipg 0 192 x 144 pixels
& Morocco gif 1 115 x 76 pixels
& mosfet ipg 0 75 x 75 pixels
& pilot ipg 0 48 x 48 pixels
& policernan ipg 0 48 x 48 pixels
& Polinated flower ipg 0 354 x 193 pixels N
For Help, press F1 MUM

A range of tools is available, enabling you to import and manage items. Before importing a new

resource, select the relevant category, Image, Sound or Video in the Filter section of the ribbon.

This ensures that each resource type is stored in the appropriate folder within the database.
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Click Import and browse for the required file. Alternatively, you can simply drag and drop the file
directly into the list from its location using Windows Explorer.

At the stage where you add your resources to a question, if the required file isn't already in the
database, you can import it at that time.

Adding resources to a question

When you create a question, the wizard prompts you to add resources at the appropriate stage.

Question Resources X
Resource
[ mmece + X B
[j]) Audio + X
Eh Video +| B I3
Optional Settings
[(Jobservation mode

[ Information

If this question requires any supporting resources, add them now by selecting the appropriate resource type below, The
resource description will be desplayed in the box next to the resource type.

= S

1. Decide which resource type is appropriate - image, sound or video - and click the Add -+ icon.
The resources list for the selected type appears.

2. Ifthe required file has already been imported into the database, highlight it in the list and click
Use. You can preview the files before selecting them.

Or

To add a new item to the list, click Import and browse for the file. When you have selected the
file, you can preview it to ensure it is the correct one. It is also important that you include a
suitable description for the item, as this will appear in the Resources list rather than the file
name. Once added to the list, click Use to add the item to the question.

3. Click Next.

Observation mode

Selecting this option allows you to force the Students to view a resource file before the question
appears, they will not be able to view the resource in the question. When the exam is run at the
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Student machines, they will be advised that the question media will only be shown once. If this option
is selected, you cannot continue until a resource has been added to the question.
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Question details

The Question Details dialog completes the create question process. Decide where to store the question
and whether to add any additional author notes.

Stored questions are maintained in an internal database, school.mdb, within the NetSupport School
program folder. The questions are stored in the Questions pane tree view.

Question Details X

Question Subjedts Authors Information & Question Title

e Title Are the following statements true or false?

Y

T General
@ other Authors NSS Admin
= Geogra phy
O Capital Cities Level - Easy Medium Hard
Ij Oceans
ISE listory Notes
T Literature
¥ Authors
E Science
D Animals
[ Body
D Colours
D Electronics
[ Elements
D Flowers b

Create Subjedt Create Topic

Create another question of this type[ |

) Information
Select or create a Topic and Subject from the left hand menu, then enter the details for the question. Once done select the Finish button

< ook once icp

1. Select the subject and topic to assign the question to.

Note: To search for a subject or topic, enter a full or partial term in the search bar and click the
Search /~ icon. Any subjects or topics containing the term are highlighted. Click the Close <

icon to stop the search.

2. You can create new subjects and topics. Click Create Subject or Create Topic, enter the
required name and click OK. The new subject or topic is added to the tree view.

3. Ifrequired, edit the question title that appears in the tree view and add any additional
supporting text in the Notes field.

4. Alevel of easy, medium or hard can be assigned to each question to indicate the level of
difficulty.

5. If you want to create the same question type again, click Create another question of this
type.

6. Click Finish to store the question.
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Edit questions

To edit a stored question, highlight it in the Questions pane tree view, select the Home tab and click
Edit in the Questions section of the ribbon or right-click on the question and select Edit.

I Edit Drag & Drop Text X

Question & Answers Page | Question Resources \ Question Detalls |

Instructions Identify the correct capital cities for the countries listed below.

|
Statemnent 1 m is the capital of England. Set Answer
statement2 Y the capital of Italy. Set Answer

|
Statement 3 TP is the capital of America. Set Answer
Statement 4 I is the capital of Japan. Set Answer

Fake answers

Ar  Information
Edit the items on this page. Use the tab at the top of the page to edit other details or press OK to save

Cancel Help

Change the required details by selecting the appropriate tab on the Edit Question dialog and click OK
when complete.

Note: Questions can be duplicated. Select the Home tab in the ribbon and click Duplicate or right-
click on the question and select Duplicate. The Edit Question dialog appears, if required, make any
changes and click OK. The duplicate question now appears under the original question in the tree
view.
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Delete questions, subjects and topics

A question can only be deleted if it does not appear in an exam. A subject or topic can be removed if
there are no items beneath it in the tree view, the currently selected sort view determining the extent
of the deletion.

Delete a question
1. Select the question in the Questions pane tree view.
2. Select the Home tab and click Delete in the Questions section of the ribbon.
Or

Right-click and select Delete.

Delete a subject
1. Select the subject in the Questions pane tree view.

2. Select the Home tab and click Delete in the Subjects section of the ribbon.

Delete a topic
1. Select the topic in the Questions pane tree view.

2. Select the Home tab and click Delete in the Topics section of the ribbon.

Note: You can rename a subject or topic by selecting the required item and selecting Rename in the
Subjects or Topics section of the ribbon.

When deleting a subject or topic, the program checks to see if there are items beneath it in the tree
view and, depending on the current sort view, if the item appears anywhere else in the tree view.

When sorted by subject type, there will only be one occurrence of the item. Therefore, a topicis
removed if it does not contain any questions and a subject if it does not contain any topics. However,
when sorted by question type, for example, there may be multiple occurrences of the same subject
and topic in the tree view. If you delete the only occurrence of a Geography question in the multi-
choice category, that topic or subject will be removed from multi-choice but not from any other
category that Geography appears in.
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The exams interface

Having created a library of questions, you can now add them to an exam. Your own grading and
scoring schemes can be applied and exams can be centrally 'published' for shared use with other

teachers.

NetSupport School Test Designer

Gt Home Resources
-Lj 7 Delete ‘3 @ T foml [o= ® Q D [0 By Author By Subject Question tree
= Rename : |:|°7 I:"Z I:cﬁ Q| Dieyoifficutty 0 ByType Exam tree
New New Create Create Edit Delete Grades Publish Preview
Subjects Topics Questions Exams Preview
B ~
Quest\ons 4 General Information Optional details
- F General Title Example Test Age range ALL
-5 Geography
2 History Description An example to show the capabilities of Class Group ALL
-3 Literature Testing modules.
-3 Science
Notes
Timed Exam
Time Limit 00:10 Hours : Minutes
Exams -
5 Bl Grading Schema
Default scoring system
Question Topic Subject Level &
In these statements highlight the word that is a verb General other Easy
Identify the countries by dragging the correct name to the map ... Geography Countries Easy
Using the picture provided, answer thase questions on Ttaly. Geography Countries Hard
Identify the flags for each of these African nations. Geography Countries Medium
Put these oceans in order of size (Largest to Smallest). Geography Oceans Easy
Listen to the music and identify which country this is the national... Geography Countries Hard
Choose the correct year that these countries hosted the Summ... History Dates Medium
Which of the Seven Wonders of the World is stil standing? Geography Countries Easy
Camnlate the following sentences. Geoaranhy Countrias Fasv ¥
For Help, press F1 NUM

You can:

¢ Create an exam.
« Edit the content of an exam.
« Delete an exam.

» Publish an exam. Before an exam can be run at Student machines, it needs to be published. This
also enables you to store completed exams in a shared area for general use.

* Preview an exam. Enables you to step through the questions as the Students will see them.

+ Edit exam grades. Apply your own grading scheme to exams.
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Exam grades

Upon completion of an exam, teachers are provided with a detailed breakdown of results. You can
further enhance this report by categorising the students within specific bands.

Note: The exam grades need to be set up before you start creating an exam.

Select the Home tab in the ribbon and click Grades.

Exam score grading X

Please enter the percentage scores for the exam grades
Grading schema name lGradiﬂg 1 ‘
Report Image ‘star,’jl ‘ *
Grading Band
Band Name ‘
Band Values 101 To 101 J o Add
Band Name Grading
Edit
4 A 81%-100%
3 B 55%-80% Delete
2 C 28%-54%
1 D 0%-27%
ot | [t

Enter a name for the grading schema and add a report image. This provides a pictorial indicator of how
well the Student has done. For example, a Student scoring 20% might have one star appearing next to
their grade and someone scoring 80%, four stars. The image, restricted to 32x32 pixels, must be
imported into the Resources database.

Give each grading band a description and attach the appropriate percentage mark. Click Add to insert
each band into the list. Use the Edit or Delete icons to change any of the items in the list. When all
bands are added click Save.

You can view the grades each Student has achieved in the Test Report window.
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Create an exam

Having created a suitable mix of questions, adding those questions to an exam is a quick and easy
process.

The Exam wizard guides you through the process of selecting the required questions, setting a time
limit for the exam, using your own grading system and including supporting information. New
guestions can also be created during this process.

To create an exam

1. Selectthe Home tab and click Create in the Exams section of the ribbon.

Exam Details X
General Information Optional details
Title Geography exam| Age range | |
Description General overview
Class Group | ‘Year 7 |
MNotes
Timed Exam
Time Limit 00:30 5| Hours : Minutes

Grading Schema

Default scoring system

< Back Cancel Help

2. Thefirst stage is to enter general supporting information about the exam. Choose whether to
have the exam timed, if so, set the time limit, hh:mm. You can use your own grading system by
selecting from the Grading Schema drop-down (a grading schema must exist for this option to
be available). Decide whether to use the default scoring system (you can assign your own scores
to questions in stage two). You can then add some optional information such as the age range or
class group that the exam is aimed at.

3. Click Next.
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Exam Questions X
Sort by Subject v
+- 5 General > Level Type Score Question Title
= Geograph
g 0 gappn;cnms Easy Drag &Drop Text 4 Identify the correc
= D Coundries Easy Drag &Drop Text 3 Complete the follo
(I5) How many countries are in each of these ct Easy Label Image 3 Identify the count
& identify the flags for each of these African r Hard Multi Choice 1 Listen to the music
[5) Which of the Seven Wonders of the World Easy True or false 1 Is the following tr.
B D Oceans Hard Combo List 4 Using the picture ¢
i= Put these oceans in order of size (Largest t Medium Drag &Drop Im... 4 Correctly assign t
+- & History
+- & Science
0
+
< > 0 < >

100% mark is equal to 20 points.

Information: This exam has 7 question(s) in a time limit of 00:30 , that is 00:04. 17 per question

< Back Cancel Help

4, Stage two is to select the questions for the exam. Expand the tree view in the left-hand pane,
highlight the required question and click the Add ” icon. The tree view can be sorted by
author, level, question type and subject. Repeat this process until all questions are selected.

5. Selected questions appear in the right-hand pane. From here, you can use the icons to remove a
guestion from the exam, sort the questions into the required order, preview the question, assign
a new score to the question or even create a new question.

6. Click Finish to store the exam in the Exams pane tree view.

Once created, you can use the ribbon to edit or delete exams, preview exams and publish the exam.
Note: Although the newly created exam appears in the Exams tree view, it cannot be run at Student

machines until it is 'published'. This bundles the various elements of the exam, questions, pictures,
videos etc, into a single ZIP file which is then made available in the Testing Console.
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Question score

Questions are created with a default score, but you can allocate your own score to individual questions
when creating or editing exams.

1. Inthe Exam Question dialog, select the question you wish to amend the score for and click the
Question Score ® icon.
Note: You must ensure that the Default scoring system option is not selected in the Exam
Details dialog.
The default score shows the total score that would normally be awarded for answering this question correctly.
You can increase the value of this guestion by increasing the score value.
Question Type Question
Summary of Question . Default Score 4
Description : Using the picture provided, answer these que
Type: Combo List 2 -
E Level: Hard Score value -
Cancel Help
2.

The details of the question is displayed along with the current score. You can then adjust the
score by using the Up |« | and Down |~ | icons.

Note: Questions with multiple answers can only be incremented by a corresponding number.

3. Click Save to exit.
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Preview exam

You can preview an exam at any time to simulate what the Students will see. This is a useful way of
checking each question and viewing the resources that have been included. Although the exam runs
exactly how it would at the Student machines, the preview facility does not return any results.
1. Select the exam in the Exams pane tree view.
2. Select the Home tab in the ribbon and click Preview.
Or
Right-click on the exam name and select Preview.

Example Test

Questions -

In these statements highlight the word that is a verb

I

Please click and hold the left mouse button and drag to highlight the word or phrase that is your answer. Then confirm your
choice by dicking the 'Highlight' button.

John visited Buckingham Palace with his friends.

The boy played the piano at the concert.

W oo o BWN

Sarah loved her new toys.

e e
5 bn b

Connor broke the window.

= o e
o o &

17:

X ROXoXoX0X0LoX0X0XOLoXOX0XOLONOXY,

E u> u D Close

3. Use theicons at the bottom of the window to move between questions and end the preview. You
can also click each question number on the left-hand side of the window to view each one.

Note: Individual questions can also be previewed in this mode. Expand the tree beneath an exam to
reveal the questions, highlight the appropriate item and click Preview.
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Delete an exam

Although this removes the exam from the Exams pane, it does not delete the ZIP file that is created
when an exam is published. The exam is still available to run at Student machines.
1. Select the exam in the Exams pane tree view.
2. Select the Home tab and click Delete in the Exams section of the ribbon.
Or
Right-click on the exam name and select Delete.

3. Confirm that you want to delete the exam.
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Publish an exam

Before an exam can be run at Student machines it must be published. This bundles the various
elements of the exam, questions and resources into a ZIP file that can be stored in either the default
C:\Program Files\NetSupport\NetSupport School\Tests folder or in a shared network area of your
choosing. The latter having the added benefit of enabling other teachers to access the exam.

Once published, the exam can be selected in the Testing Console.

To publish an exam
1. Select the exam in the Exams pane tree view.
2. Select the Home tab in the ribbon and click Publish.
Or

Right-click on the exam name and select Publish.

Note: Exams published in this version should only be used with NetSupport School version
15.10 or later.

3. The Publishing Exam dialog appears, confirming the exam properties.

Publishing Exam

Name of exam: Example Test ~
Description: An example to show the capabilities of Testing modules.
Student Group: ALL

Time limit: 00:10 Minutes

Age range: ALL

Created by: NSS Admin

Authors notes:

Date created: 23 06 2008

List of questions in this exam:

:In these statements highlight the word that is a verb
:Identify the countries by dragging the correct name to the
:Using the picture provided, answer these questions on It
‘Identify the flags for each of these African nations.

:Put these oceans in order of size (Largest to Smallest).
:Listen to the music and identify which country this is the
:Choose the correct year that these countries hosted the ¢

‘Which of the Seven Wonders of the World is still standin: ¥
< >

Publish Help Cancel

0=l Wk =

Click Publish.

4. Enter a suitable name for the exam. This is the name that appears in the Testing Console when
selecting an exam to run. If you want the exam stored in a different location, click Change. Click
Save to create the ZIP file.
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Setting up user accounts

Multiple Test Designer user accounts can be created in addition to the default admin account.

Note: By default, the admin account has no password set. You are prompted to set one when you
create additional user accounts or exit the Test Designer.

1. Select the Options == icon in the ribbon and click Manage the users of this program.

2. The User Management dialog appears.

User Management

Login User Name Add

& 1 Smith Jane Smith :

o Edit

< M Brown Mark Brown

& admin NSS Admin Delete
Help
Close

3. Click Add and enter a user name, login name and password. Decide whether to assign admin
rights. This gives the user access to all features within the Test Designer, along with the ability

to edit/delete questions and exams created by other users. Non-admin users can only create
exams.

4. Click OK.
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Admin - Options

Questions, exams etc are stored in an internal database supplied with NetSupport School. This dialog
provides version information about the database. You also have an option to edit the path where
imported resources (images, video, sound clips) are stored.

Please salect an item in the list to edit its value. Please note that some items are for
information only.

B options
(1) General
%D‘dldbﬂh! WEFSIOnN
Last Modified: 26,06/2006
Version Murm: 4

E}l Spell Check Language
English (United Kingdom)
@Rﬂmnws
£83 Resource Path

KTt T T

Help

Closa

General

Tracks the version humber of the database, school.mdb, that is currently in use. NetSupport School
may on occasions supply updates to the internal database and this dialog indicates which version is
currently in use.

Shows the language for the spell checker included in the Test Designer. Click Edit to change the
region.

Resources

By default, imported resources such as images, video files and sound clips, are stored in the resources
area within the NetSupport School program folder. This option enables you to edit the path if required.
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Import/export data

The Test Designer provides an import/export facility enabling you to store external backups of data or
make information available to other users. Exported files can be password protected for security. You
have the choice of exporting all items in the database or just the exams, questions or resources.

Exporting data

1. Select the Options == icon in the ribbon and click Export selected items to file.

Note: The exported file should only be imported into NetSupport School version 15.00 and
above.

2. The Export Database dialog appears. Select what type of information to export and click Export.

3. The Export wizard appears. Specify the location for the exported data and provide a file name.
By default, files are prefixed with the current date, but you can enter a custom name. If
required, password protect the file, add any additional notes and click Next.

4. Depending on the type of information selected (exams, questions, resources, etc.), the wizard

now prompts you to choose the specific items to be exported (unless you selected to export all
items in the database). Select each item and click the Add | > | icon. When the Export list is

complete, click Next.

5. The wizard confirms the items to be exported. Any resources associated with exams or
questions are included. Check the details and if required, click Back to change the information.

6. Click Finish to begin exporting.

7. An Export Processing dialog appears. Click Close when complete.

Note: Exported data is not removed from the Test Designer.

Importing data

1. Select the Options <= * icon in the ribbon and click Import Data from exported files.
2. The Import Database dialog appears. Browse for the required export file and click Open.

3. Click Import DB to start importing. If the file has been protected, you are prompted for the
password.

4. AnImport database process dialog appears, showing the progress of the import. Click Close
when complete.
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The Testing Console

Having used the Test Designer to create questions and exams, you use the Testing Console option in
the NetSupport School Tutor program to run the exam at Student machines and monitor results.
Running an exam

1. Select the Feedback & Wellbeing tab in the ribbon and click Assessments.

2. The Test Modules dialog appears.

Test Modules *

Select the Students you would like to participate in the test:

~
MName

@; Emma
OF - Wt
@ o Mark

Help < Back MNext = Cancel

From the list of connected Students, indicate which ones should participate in the exam by
selecting or clearing the check mark next to their name. Click Next.

3. Details of the published exams are listed.

Test Modules *

Select the Test you would like the students to paticipate in:

~
Description

E Example Test - An example to show the capabilties of Testing modules.

@ 00:10 3 19

Preview Exam time limit |00:10 |2 Defautt
[ Unlimited Time

Help < Back Cancel
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Choose the one that you want to run at the selected Student PCs. If required, you can alter the
time limit for the exam. To preview the exam, click Preview. Click Finish when ready to run the
exam.

The NetSupport School Test Player will automatically launch at the Student PCs and a dialog
enabling you to administer the exam will appear on the Tutor screen.
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Testing Console - run exam

This window is used to start the exam, monitor Student progress and collect results.

E Test Console - Example Test bt
QUEGENEN | N g
View Chat Pause Stop
Client Test Test
The following Students are currently being tested: (v) Correct (%) Incorrect () Remaining
Name Login Name Description Progress
; sarah  Sarah P> Test is running HEOOHOOHOOOOOEOOe 00
& Andy  Andy B Student has finshedtest @O O P LR OOOEXQOOEE®®E
mo-CC : e )
i Unlock student machines when they finish Exit Test

The window enables you to track individual Student progress. Each question is marked in real-time so
you can see immediately how each Student is doing. At the end of the exam, you can view the results
by class and individual Student and print a permanent record. You can also show each Student their
results giving them the opportunity to see where they made mistakes.

Note: If a Student disconnects partway through the exam, the description shows they have
disconnected. The results of the questions they did answer are available in the exam report.

The following toolbar options are available:

View Client

You can view a particular Student screen at any point during the exam. All options normally associated
with the View window are available.

Chat

If required, you can open a Chat session with Students while the exam is running. Although the Test
Player provides a help button offering Students guidance with each question type, you may find that
you need to offer additional assistance.
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Test Login

Before starting the exam, you can ask each Student to login with their own name. This would be useful
if, for example, the machine name is listed and be more meaningful when checking results against
each Student.

Pause Test

You can pause the exam at any point. Click Start Test when ready to continue.

Start Test

Starts running the exam at Student PCs.

Stop Test

If Students answer all the questions within the time limit, you can stop the exam rather than wait for
the clock to tick down.

Report

This option gathers the results when the exam has finished. (When the Tutor stops the exam or the
time limit elapses.)
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Test Report window

The Test Report window enables the Tutor to review the results of an exam. You also have the option
to allow Students to see their own results.

m Test Report O X

o
cS
Print
Report

(&8 Class Summary
v [ Students Reports
-3 sarh (HPLAP2) Class summary report

o ANdy (INVHTE4)

Exam name : Example Test  Exam duration : 10 minutes

Number of question : 19 ;I'gtal points value of exam

Questions

Score
answered

Student Name

Sarah 15 42
| Andy 19 39

[¢]

By selecting the required item in the Tree view, you can display two types of report, a class summary
and individual Student summaries. Each can be printed and copies are also stored, in HTML format, in
the \\NetSupport\NetSupport School\Tests\Reports folder.

Note: An alternative location for the reports can be specified in the Tutor Profiles option.

Class Summary

This provides a summary of each Student's result in tabular format. The report details the number of
questions in the exam, the number of points available (questions other than multi-choice are worth
one point for each correct answer) and itemises each Student's score.

Students Reports

By selecting the Student name in the Tree view, you can display a full breakdown of the individual
results. This is ideal for highlighting any problem areas that the Student may have. If you have applied
a grading schema, the marked grade along with any comments you added is also displayed. An index
itemising the points scored for each question is provided from which you can jump to each question to
see how the Student answered.
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Note: If a Student disconnects during the exam, the status shows as interrupted. The results are
available for any questions they did answer but you are unable to send the results to the Student.

The toolbar provides shortcuts to a number of additional features:

Show Results

This enables you to show each Student their results and, if required, include the answers. To display to
all Students simultaneously highlight Students Reports in the Tree view, to show to an individual
Student select their name.

The Test Player will re-open at the Student machines enabling them to view each question in turn. The
window will indicate which questions they got right, wrong or, in the case of questions that have
multiple answers, partially correct.

If you have chosen to include the answers, a Show Answers button will appear on the Test Player
window enabling the Student to toggle between their response and the correct answers.

Show Report

This option enables you to display the individual summary reports at Student machines.

Print Report

Enables the Tutor to obtain a printed copy of the class and Student summaries.

Send to Journal

Allows you to send a copy of the Student's results to their Student Journal. The Student then has the
opportunity to review their answers after the lesson.

When ready, close the window to return to the Test Console window from where you can exit the test.
This will clear the results or reports from the Student screens.
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The Test Player

The NetSupport School Test Player is the testing utility that loads at Student PCs when an exam is
running.

The Tutor uses the Testing Console option to choose the Students to participate in the exam and select
the exam to run. At this point, the Test Player loads automatically at each Student PC. When the Tutor
starts the exam, the first question appears and the Students can then work their way through the

exam.
8 Example Test Y
Q":hm Put these oceans in order of size (Largest to Smallest)
2:
3 Please Lse your mouse 1o drag and drop the ems rta the comec arder
4:
1
6: O
72 O /  Adntc
g: O
% O 3 o
10 O
11: O
12: O
13: O
14: O
- —~
K QD O

The Test Player displays the following:

Question List

Numbered icons indicate how many questions there are in the exam. The Student can click these to
quickly move between questions. Useful at the end of the exam to review answers and to make
changes before the time runs out.
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Question Area

The main body of the window displays the question and, depending on the question type, the
associated options. Icons are provided in the top right to view any resources that may have been
included, pictures, videos or sound clips, and a help icon is available which provides Students with tips
on how to answer the particular type of question.

Exam Time

Counts down the time remaining.

Navigation icons

In addition to the numbered buttons in the question list, navigation icons are also available at the
bottom of the window enabling Students to move between questions. When they have completed the

exam, they click the Finish D icon.

When the exam has finished, the Tutor has the option to show Students their results and, if required,
include the answers. The Test Player will re-open at the Student machines enabling them to view each
question in turn. The window will indicate which questions they got right, wrong or, in the case of
guestions that have multiple answers, partially correct. If the Tutor has chosen to include the answers
a Show Answers © icon appears enabling the Student to toggle between their response and the
correct answers.
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Contact us

If you have any comments regarding the design, installation, configuration, or operation of
NetSupport please inform us.

UK & International

www.netsupportsoftware.com

Technical Support: support@netsupportsoftware.com

Sales: sales@netsupportsoftware.com

North America

www.netsupport-inc.com

Technical Support: support@netsupportsoftware.com

Sales: sales@netsupport-inc.com

Canada

WWW.netsupport-canada.com

Technical Support: support@netsupportsoftware.com

Sales: sales@netsupport-canada.com

Germany, Austria and Switzerland

www.netsupportsoftware.de

Technical Support: support@netsupportsoftware.de

Sales: sales@netsupportsoftware.de

Japan

www.netsupportjapan.com

Technical Support: support@netsupportsoftware.com

Sales: sales@netsupportjapan.com

443


http://www.netsupportsoftware.com/
mailto:support@netsupportsoftware.com
mailto:sales@netsupportsoftware.com
http://www.netsupport-inc.com/
mailto:support@netsupportsoftware.com
mailto:sales@netsupport-inc.com
http://www.netsupport-canada.com/
mailto:support@netsupportsoftware.com
mailto:sales@netsupport-canada.com
http://www.netsupportsoftware.de/
mailto:support@netsupportsoftware.de
mailto:sales@netsupportsoftware.de
http://www.netsupportjapan.com/
mailto:support@netsupportsoftware.com
mailto:sales@netsupportjapan.com

	What is NetSupport School for Windows?
	Conventions and terminology used

	Planning an installation
	System requirements
	Starting the installation
	NetSupport School Installer program
	Licence Agreement
	Licence Information
	Select setup type
	Custom setup
	Room identification
	Completing the installation
	Existing installation detected
	Creating an administrative (network) installation
	Silent installation
	Install Configuration options

	NetSupport School Deploy - Getting started
	About NetSupport School Deploy
	Deploy Main window
	Deploy - preparing a deployment
	Deploy a NetSupport School package
	Deploy package - Properties General tab
	Deploy package - Properties Options tab
	Deploy package - Properties Acknowledgement tab
	Deploy package - Properties Message tab
	Deploy package - Properties Restart tab

	Deploy a Client Configuration
	Deploy licence file
	Deploy - remote uninstall
	Remote uninstall - Properties General tab
	Remote uninstall - Properties Acknowledgement tab
	Remote uninstall - Properties Message tab
	Remote uninstall - Properties Restart tab

	Entering deploy settings in advance
	Deploy - log files

	Starting NetSupport School
	NetSupport School Deploy - Room mode
	Finding and connecting to Students
	Class wizard
	Connect to Students via Room mode
	Connect to Students using Browse mode
	Connect to Students using PC mode
	Connect to Students using User mode
	Connect to Students using SIS mode
	Integrating NetSupport School with Google Classroom

	Class lists
	Connecting to NetSupport School for Mac

	The Tutor Console
	The List view
	Status bar
	Selecting Students to work with
	Intermediate mode
	Easy mode

	Tutor Toolbar
	Student automatic login
	Student Register
	Display the login name of Students
	Save the Students login name

	Working with classroom layouts
	Setting a background

	Power management
	Student power on
	Student power off

	Student disconnects from an active session
	Removing a Student from a class
	Configuring NetSupport School for subnet browsing
	Understanding IP addresses

	Implementing NetSupport School in a Terminal Server environment
	Installing and configuring the NetSupport Tutor Assistant
	Installing and configuring the NetSupport School Student for Google Chrome
	Licensing for Google Chrome

	Installing the NetSupport School Tutor for Android
	Installing and configuring the NetSupport School Student for Android
	Installing and configuring the NetSupport Browser app (iOS)
	NetSupport School Windows 10 Tutor App
	Licensing for Tablets

	Integration with Active Directory
	Using NetSupport School in a wireless classroom
	Using the NetSupport Connectivity Server to find Student PCs
	Installing and configuring the NetSupport Connectivity Server
	NetSupport Connectivity Server Configuration Utility - General tab
	NetSupport Connectivity Server Configuration Utility - Keys tab
	NetSupport Connectivity Server Configuration Utility - Licences tab
	NetSupport Connectivity Server Configuration Utility - Security tab
	NetSupport Connectivity Server Configuration Utility - Classes tab
	NetSupport Connectivity Server Console

	Working with groups
	Deleting a group
	Assigning a group leader
	Suspend group leaders
	Remove group leader status

	Customise Student and group icons

	Using NetSupport School
	Lock/unlock Students' mice and keyboards
	Changing the graphic when locking a Student

	Viewing a Student's screen
	View modes
	Blanking the Student's screen while viewing
	Sending Ctrl+Alt+Delete

	Blank all Student screens
	Remote clipboard
	Scanning Students
	Scanning multiple Student screens
	The Scan window

	Monitor mode
	Keyboard monitoring
	Setting up word lists
	View typing history

	Screen capture
	Showing to Students
	To end the Show
	Allow the Tutor to continue working in the background while showing
	Resume a Show while suspended
	Show leader
	Exhibit - showing one Students' screen to others

	Student Feedback and Wellbeing
	Interactive Whiteboard
	Annotating screens
	Audio monitoring
	Using audio
	Using audio announce
	Using audio support while viewing and showing to a Student
	Adjusting microphone and speaker volume

	Video Player
	To play a video file on a Student machine
	Video Player control panel

	Using replay files
	Record replay files for all Students
	Record replay files for individual Students
	Record replay files at the Tutor
	Watching replay files
	Replay window - control panel
	Showing replay files to Students
	Converting replay files to video files

	Show application
	Chatting to Students
	The Chat window

	Sending a message to Students
	Preset messages

	Raising a help request
	Dealing with help requests

	Transferring files
	Managing files and folders
	Synchronising folders

	Distributing files
	Send work files
	Collect work files
	To change the properties of an operation

	Remotely launching applications and websites at Students
	To launch an application on a group of Students
	Edit a saved application or website
	Remove a saved application or website

	User defined tools
	Rebooting or logging out Students
	Manage user account
	Web Control module
	Identify websites currently running on the Student machine
	Managing websites on Student machines
	Setting up an Approved or Restricted Websites list
	Blocking/restricting internet access
	View web history

	Application Control module
	Identify applications currently running on the Student machine
	Managing applications on Student machines
	Setting up approved or restricted application lists
	View application history

	Student Surveys
	Survey lists

	Question and Answer module
	Question and Answer module - first to answer question type
	Question and Answer mode - enter an answer question type
	Question and Answer mode - pot luck question type
	Question and Answer mode Tutor display
	Using Question and Answer mode
	Bouncing questions
	Peer assessment

	Question and Answer team mode

	Printer Management
	Using Printer management
	View print history

	Device Control
	Tutor profiles
	Manage Student resources
	Student Journal
	Lesson planner
	Student Toolbar
	Student rewards
	Student stickers

	Configuring the Student
	Student Network settings
	Student Room settings
	Student Security settings
	Student Audio settings
	Student User Interface settings
	Student Advanced settings
	Student Journal settings
	Student Terminal Services settings

	Configuring the Tutor
	Tutor Start Options
	Tutor Startup Restrictions
	Tutor Network and Wireless settings
	Tutor Performance settings
	Tutor Student Selection settings
	Tutor Administration - Security settings
	Tutor Administration - Profiles
	Tutor Profiles - file locations
	Tutor Profiles - folder locations
	Tutor Profiles - file locations advanced

	Adjusting configuration settings
	Tutor View settings
	Tutor Keyboard/Mouse settings
	Replay file settings
	Audio settings
	Tutor Chat settings
	Tutor File Transfer settings
	Tutor User Interface settings
	Student User Interface settings
	Tutor Assistant settings
	Group leader settings
	Student Toolbar settings
	Tutor Journal settings
	Show settings


	Tech Console
	Searching for Students
	Stopping the Student service
	Remote inventory and system information
	The Inventory window
	The Task Manager window

	Policy management
	Define and view Student security settings
	Remote Command Prompt window
	PowerShell window

	About NetSupport School Testing module
	The Test Designer
	Starting the Test Designer
	The Questions interface
	Create questions
	Multiple choice question
	Drag and drop text question
	Drag and drop image question
	Create question - combo list
	Create question - label image
	True or false question
	Multi true or false question
	Order items question
	Highlight text question

	Adding additional resources to questions
	Question details
	Edit questions
	Delete questions, subjects and topics

	The exams interface
	Exam grades
	Create an exam
	Question score
	Preview exam
	Delete an exam
	Publish an exam


	Setting up user accounts
	Admin - Options
	Import/export data
	The Testing Console
	Testing Console - run exam
	Test Report window

	The Test Player

	Contact us

